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COPYRIGHT & CREDITS 
 
 
The contents of this guide are Copyright © 2009 Koroush Ghazi, TweakGuides.com and protected under US, 
Australian and International Copyright laws. No unauthorized reproduction, alteration or distribution of the 
guide, in part or in whole, in any language, is permitted. All Trademarks used in this publication are the 
property of their respective owners. 
 
This guide was formerly distributed under the name The Windows XP Tweaking Companion (XPTC). 
 
 

HOSTING OR DISTRIBUTING THIS GUIDE 
 
I do not grant permission for anyone to reproduce, alter, copy or host this guide. 
 
I do not grant permission for anyone to produce translations of this guide: unfortunately I can't be sure of 
the quality and accuracy of any translations and hence I don't allow my works to be translated. 
 
If you wish to support the site by linking to the guide, please link to the TweakGuides Tweaking Companion 
download page or to the main TweakGuides page - direct hotlinking to the file itself is blocked. 
 
I've invested a huge amount of my time and effort into creating and maintaining this guide and have also 
released a free version so that the widest possible audience can benefit from its contents. Out of respect for 
this do not rip off my work or host it on other sites. If I find or am informed of other sites hosting copies or 
portions of my guides, I will pursue the matter with the site owner, their webhost/ISP, their Domain 
Registrar, use Google's DMCA provisions to delist the site from Google, and finally if serious enough, seek 
recourse through a Court of Law. For those who may not understand why I am so strict about these 
conditions, please see the TweakGuides FAQ. 
 
In short there is no reason for anyone to copy, host or distribute this guide when it is always available for 
free from my site. People who do host this guide in breach of Copyright are usually doing so to generate 
easy traffic and income for themselves using my hard work, which is not acceptable. 
 

CREDITS 
 
This guide is a reference compilation borne out of a great deal of research, reading and personal experience. I 
give full credit to any third party sites and authors linked in this guide. The same goes for all the software 
developers whose excellent tools I recommend in this guide, especially those who provide their software for 
free. It is amazing that they invest so much time and effort into developing and testing this software then 
provide it free to PC users. I encourage you to support their work with donations and purchases where 
relevant. 
 
Thank you to my readers who, since TweakGuides began in April 2004, have provided incredible support. 
From those who support the site by linking to my guides on various websites and Internet forums, to those 
who take the time to write to me or contribute thoughtfully to the TweakGuides Forums, to those who 
donate to the site - I really do appreciate it. The only thing which motivates me to keep writing my guides is 
the fact that I know there are intelligent people out there who are patient enough to take the time to read 
them. I wish I could name everyone who has written to me and provided valuable feedback in the past, but 
again there are simply too many. A special thanks goes to Larry Kuhn for preparing several pages of very 
detailed and highly valuable feedback which was immensely helpful in an earlier revision of this guide. 
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INTRODUCTION 
 
Hi, 
 
Windows XP is a popular, well-established operating system and is still an 
excellent operating system to use on a home PC. I first started using 
Windows XP in late 2001, and in late 2002 I released my first Windows XP 
Tweak Guide: WinXP Tweaking: From Reformat to Relax. It became quite 
popular, so I wrote two follow up guides: WinXP Tweaking: From Relax to 
Righteous and The System Optimization Guide for Gamers.  
 
Looking back at these guides now I can see that they are far too simplistic 
and totally outdated, but they started me down the road to writing the 
'ultimate' Windows and System tweaking guide. I wanted to write a guide 
which covers all the major Windows tweaks and tips, yet takes them much 
further by providing information on understanding and optimizing your 
entire system all in one place: thus was born The TweakGuides Tweaking 
Companion, the Windows XP version of which you now see before you. It is 
by no means perfect, but I feel it brings me one step closer to my goal. 
 
The first version of this guide came out in December 2004, and since then it has proven to be very popular. 
Over the years the guide has been continually refined, and has undergone several major revisions - the 
culmination of a great deal of user feedback, experimentation and new discoveries, and of course recent 
changes to PC hardware and software. At almost 200 pages in length, the guide will no doubt frustrate 
people who are looking for a handful of tweaks or quick fixes to 'make XP faster'. Clearly that is not the sole 
aim of this guide. The main purpose of the guide - indeed my entire site - is to try to explain how things 
work in simple but sufficient detail so that readers can customize and optimize their machines appropriately 
while learning more about them. As computers become integral to almost every aspect of our way of life, it 
is no longer possible to simply ignore them or pretend that it's not important to know how they work. Now 
more than ever it has become extremely important that you begin to understand how your PC and Windows 
are working. Thus the guide is long because wherever possible I try to ensure that you are given enough 
details to actually see what is going on, and understand the logic behind my recommendations, rather than 
being treated like a small child who is simply told to change settings without a second thought. 
 
I promise you that if you patiently work your way through this guide over the course of a few days, that you 
will come out at the other end with not only a better performing, more stable and better customized PC, you 
will also be much more comfortable with using Windows on a daily basis; the mystery will disappear. More 
importantly, you will also be able to better diagnose, indeed prevent, any problems on your PC in the future. 
 
In any case use the guide as you see fit. Aside from the descriptive text it does contain all the major 
performance and customization tweaks for XP, if that's what you're after. If you find the guide useful, please 
consider providing constructive feedback, making a donation, or purchasing the Deluxe Edition at 
www.TweakGuides.com. This will allow me to work on further refining and maintaining this guide over 
time, and also to continue to create a range of new guides in the future. 
 
 
Cheers, 
Koroush 
 
Koroush Ghazi 
Owner/Author In honor of 2,500 years of Persian Culture  
TweakGuides.com Dedicated to the noble ideals of Cyrus the Great 

http://www.tweaktown.com/guides/324/winxp_tweaking_from_reformat_to_relax/index.html�
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http://www.tweaktown.com/guides/411/system_optimization_guide_for_gamers/index.html�
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BEFORE USING THIS GUIDE 
 
Please read the following information before attempting to make any changes using this guide. 
 

BASIC REQUIREMENTS 

There are several important requirements you must meet before using this guide: 
 
§ You should have prepared backups of all your important information prior to undertaking any of the 

changes detailed in this guide. Follow the instructions in the Backup & Recovery chapter. 
§ You should have your original Windows XP installation CD readily available - do not undertake the 

tweaks in this guide if you don't have an original Windows XP installation CD. 
§ You will need Administrator level access to Windows XP to make the majority of the changes in this 

guide. See User Accounts under the Control Panel chapter for more details. 
 
Unless you meet all of the requirements above, I do not recommend proceeding with the guide as you may 
be unable to successfully undertake the tweaks in this guide, or may run into problems. 
 

DIFFERENT VERSIONS OF WINDOWS 

This guide is designed equally to suit Windows XP Professional and Windows XP Home. There are no major 
content or performance differences between XP Pro and XP Home. The main differences between XP Pro 
and Home are covered in this article. 
 
Furthermore, there are no content differences between the various versions of Windows XP such as the OEM 
Edition, Academic Edition, and Upgrade Edition. These are all identical in terms of performance and content 
to the Full Version of Windows XP. The only difference between these editions is that certain purchasing 
conditions are attached to them: the OEM (Original Equipment Manufacturer) Edition can only be provided 
with the purchase of a new computer; the Upgrade Edition requires that you own an earlier version of 
Windows to install it; and the Academic Edition requires that you be a student or qualified educator to 
purchase it. However the tweaks and tips in this guide apply to all these versions equally. 
 
This guide does not apply to older versions of Windows such as Windows95/98/SE/ME - these are based on a 
different architecture to Windows XP, so many of the descriptions of Windows functionality in this guide are 
not correct for other versions of Windows. Windows 2000/NT/2003/x64 are based on the same underlying 
architecture as XP, so most of the general tips, descriptions and tools should work for those versions, 
however I cannot specify which do and do not work. I have only tested the tweaks and settings in this guide 
on Windows XP, and cannot provide recommendations for other Windows versions. Importantly, there is a 
separate TweakGuides Tweaking Companion for Windows Vista available from the main TweakGuides Tweaking 
Companion page - this is recommended for both existing Vista users and XP users who want to learn more 
about Vista. 
 

WHY IS THE GUIDE SO LONG? 

This guide is intended as a reference source. It is not intended for people seeking quick fixes. I provide 
detailed explanations for a wide range of features and procedures so that you understand what you're doing, 
rather than just taking my word for it. I firmly believe in the old saying "Give a man a fish and he will eat for a 
day; Teach a man to fish and he will eat for a lifetime". To find information on any topic in the guide at any time, 
use the Table of Contents, the Bookmarks tab to the left, or press CTRL+F to bring up the PDF search 
functionality. I will not be releasing a cut-down version of this guide; there will be no '10 best tweaks' or 
handful of changes which 'fix' or magically speed up XP, it is a complex interrelationship of hardware and 
software settings which determines how fast and how stable your PC runs. For those who find that the guide 
does not have enough detail about a particular aspect of Windows I encourage you to follow the link(s) 
provided and also undertake additional research to find out more. 

http://www.winsupersite.com/showcase/windowsxp_home_pro.asp�
http://www.tweakguides.com/TGTC.html�
http://www.tweakguides.com/TGTC.html�
http://www.tweakguides.com/TGTC.html�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  13 
 

Before U
sing This G

uide 

 
RECOMMENDED SOFTWARE 

Listed throughout this guide is a range of software which I recommend you download to enable you to carry 
out some of the procedures in the guide or to provide additional functionality. At no point do you have to 
purchase any software. I am not paid or sponsored by any software or hardware company, hence my 
recommendations are based on only two criteria: functionality and price. Specifically it must be the best free 
software available to do the job. In a few cases the software may require purchase, but usually the trial 
version of the software retains enough functionality to complete the job for which I have recommended it. Of 
course if you do find any of the software useful I encourage you to purchase it or donate to the software's 
author. Not everything on the Internet is free, nor should it be. 
 

PICTURES AND DIAGRAMS 

There is a distinct lack of pictures, diagrams and graphics in this version of the guide. This has been done to 
keep the guide as short as possible. The Deluxe Edition of this guide does contain screenshots and 
illustrative images, as well as higher quality image and text resolution, bookmarks, and the ability to copy 
text from the guide - all of which makes using the guide easier. If you want the guide with these features, 
and more importantly want to show your support, please consider purchasing a Deluxe Edition, the 
electronic version of which is only a few dollars. 
 

PROBLEMS WITH THE GUIDE 

While I have made every effort to ensure this guide is as accurate and detailed as it can be, I hope you 
appreciate that I cannot possibly test the information and recommendations in this guide on every potential 
type of PC hardware and software. I stress that I can't provide technical support to readers. Unfortunately I 
just don't have the time, so under no circumstances will I provide personalized tweaking advice, purchasing 
advice or tech support. The whole reason for writing this guide is to give each and every reader a thorough 
rundown on all the steps necessary to optimize your system. There are sufficient resources and links in this 
guide to help people understand and solve most any problem when combined with genuine research. 
 
However if there is anything you believe is genuinely inaccurate, or which needs fixing in the guide such as 
broken links please don't hesitate to Email Me with specific details. 
 

YOUR RESPONSIBILITIES 

The basic theme throughout this guide is that as long as you read and consider the advice given carefully 
and use common sense when applying any changes you will remain problem-free. In all respects the guide is 
safe to use if followed correctly. However for legal reasons, I cannot take any responsibility for any damage 
or loss incurred through the use of this guide. It is a condition of use for this guide that you agree to take 
full responsibility for your own actions. If you do not wish to take full responsibility for using this guide 
and any resulting impacts, then do not proceed any further - close the guide immediately. 
 

http://www.tweakguides.com/TGTC_Deluxe.html�
http://www.tweakguides.com/FAQ.html#Q11�
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BASIC PC TERMINOLOGY 
 
If you're not totally familiar with the various components of a modern PC, then this chapter will help you 
understand some of the common terminology used throughout the guide and what each hardware 
component does in layman's terms. Note that I use a human body analogy to describe the function of PC 
hardware components to hopefully clarify their functionality. Experienced PC users can skip this chapter. 
 
 

BITS & BYTES 

You will often see the terms Bits, Bytes, Kilobytes, Megabytes and Gigabytes (or their abbreviations) being 
thrown around in guides such as this one. A Bit is the lowest form of computer information and can take the 
value 0 or 1 (i.e. Off or On). All computer functionality is derived from the behavior of Bits. For our 
purposes, the main conversion factors you need to know are: 
 
8 bits (b) = 1 Byte (B) 
1,024 Bytes = 1 Kilobyte (KB) 
1,024 Kilobytes (KB) = 1 Megabyte (MB) 
1,024 Megabytes (MB) = 1 Gigabyte (GB) 
 
Note in particular that the general convention is that bits are shown as a small 'b', and Bytes are shown as a 
capital B. E.g.: 512kbps is 512 kilobits per second, which translates to 64KB/s (KiloBytes per second). 
 

PC 

A PC (Personal Computer), often referred to as a System, Machine, Rig or Box, is a collection of hardware 
(electronic components) which function as a unified system through the use of software (programmed 
instructions). This is similar to the way a human body has a range of organs, connective tissue and structures 
designed to work together to achieve an outcome. 
 

CPU 

The CPU (Central Processing Unit) is the single most important component of a PC. It is typically a thin 
square chip which is seated firmly on your Motherboard, usually covered by a large metal heatsink and fan 
to cool it. The CPU controls and co-ordinates the actions of the entire PC under instruction from software. It 
has the role of determining which hardware component does what, assigning tasks and undertaking 
complex calculations which are then fed through the various relevant components and back. In human body 
terms, the CPU is the brain. 
 

MOTHERBOARD 

The Motherboard, also called the Mainboard, or Mobo for short, is the large rectangular plastic Printed 
Circuit Board (PCB) into which a large range of electronic components are connected in a PC. The 
motherboard provides a network of pathways (or Buses) for the CPU to communicate to the various 
hardware components, and a range of ports for standard peripherals and devices to plug into the PC. The 
major pathway for information flow in the motherboard is the main Bus (Front Side Bus or HyperTransport). 
In human body terms, the motherboard is the nervous system and arterial system combined. 
 

MEMORY 

RAM (Random Access Memory), also called System RAM or just Memory, is the most common form of 
computer memory hardware used by a PC. RAM usually comes in long thin 'sticks' of set sizes that plug into 
the motherboard and through it provide a place for the CPU and other components to temporarily store 
information. RAM only holds information while the PC is on; if a PC is rebooted or switched off, any 
information in RAM is instantly cleared. Aside from System RAM, the graphics card usually has its own 

http://en.wikipedia.org/wiki/Bit�
http://en.wikipedia.org/wiki/Personal_computer�
http://en.wikipedia.org/wiki/CPU�
http://en.wikipedia.org/wiki/Motherboard�
http://en.wikipedia.org/wiki/Computer_memory�
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RAM called Video RAM, and the CPU and other hardware often have small memory chips called Caches to 
hold information temporarily. In all cases, memory is used to speed up data transfers because information 
can be written to and read from memory much faster than any other form of storage (such as the Hard Drive 
or CD ROM). This is primarily because such memory chips have no moving parts. 
 
ROM (Read Only Memory) is a permanent form of memory, and works similar to RAM, however unlike 
RAM it can only be read from and not written to under normal circumstances, and it will not clear when the 
system is rebooted or switched off. ROM is primarily used to hold small amounts of important information, 
such as the BIOS (Basic Input Output System) - the program which tells the computer how to function when 
it is first switched on - stored on the ROM chip in the motherboard. Certain ROMs can be written to by use 
of a process called Flashing, such as when the BIOS is flashed with a new version. In human body terms, 
Memory is like our own memory with RAM being short term memory and ROM being long term memory. 
 

HARD DRIVE 

The Hard Drive is a semi-permanent storage area that acts like Memory, except it is slower and far larger. 
The hard drive is a rectangular metallic box inside which is a stack of round platters and a read/write head. 
The hard drive plugs into the motherboard's IDE (Integrated Drive Electronics) Controller, SATA (Serial 
Advanced Technology Attachment) Controller or SCSI (Small Computer System Interface) Controller 
depending on the drive type and the motherboard type. Whenever the PC requires information, it must first 
be read from the hard drive, usually into RAM, from where it is then accessed by the CPU and other devices. 
Data such as installed software will remain on the hard drive regardless of whether the system is rebooted or 
switched off. Because the hard drive involves moving physical components, such as the read/write head and 
a spinning disk, it can never be as fast as RAM/ROM - which have no moving parts - in providing 
information. Often a system may slow down or stutter while waiting for more information to be loaded up 
or written to the hard drive. The amount of information on the hard drive itself usually has no significant 
impact on its performance. In human body terms, the hard drive and the information it holds is like a library 
of books, or a notepad that can be read from and written to. 
 

CD/DVD DRIVE 

Much like the Hard Drive, a CD, DVD, CDRW or DVD-R drive (broadly called an Optical Drive) is a storage 
device that reads from and sometimes writes information onto CDs or DVDs that permanently hold this 
information until overwritten or deleted. Such drives usually come in plastic rectangular boxes with a 
loading slot or extendable tray in the front. They usually plug into the motherboard's IDE Controller or 
SATA Controller depending on the drive and motherboard type. Specifically, CD and DVD ROM drives can 
read information from CDs or CDs & DVDs respectively, but cannot write anything onto them. CDRW and 
DVD-R drives can both read from and write information to writeable CDs and DVDs respectively. All these 
drives are slower than a hard drive in reading and writing information due to physical limitations once 
again and also the way in which they are connected to the main system Bus. In human body terms, these 
drives are again much like an external library and the CDs and DVDs themselves are like books or notepads. 
 

FLOPPY DRIVE 

Much like a Hard Drive or CD/DVD Drive, a Floppy Drive stores information on a recording medium, 
usually a thin plastic 3.5" Floppy Disk. The floppy drive comes in a rectangular plastic box with a loading 
slot at the front and a large ejection button, and plugs into the floppy controller on the motherboard. Floppy 
drives can read from and write information to floppy disks, but are incredibly slow compared to any other 
form of drive, and also hold very little information (1.44MB) and hence are not commonly used anymore. 
Most PCs retain a floppy drive for emergency use when Windows won't load up for example, or to flash the 
BIOS. Again, in human body terms a floppy drive is like a library, with the floppy disks a document or 
notepad for reading from and writing to. 
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GRAPHICS CARD 

The Graphics Card, also called the Video Card, Graphics Adapter or VGA Adapter, is a miniature computer 
of its own dedicated solely to graphics-related functions on the PC. It is a thin rectangular plastic PCB with a 
GPU (Graphics Processing Unit, or 'Core') - similar to a CPU - and Video RAM (or VRAM) - similar to 
System RAM - as well as Pipelines for transferring information internally, similar to the Buses on a 
motherboard. It plugs into the motherboard through the AGP (Accelerated Graphics Port) Port, a PCI 
(Peripheral Component Interconnect) slot, or a PCI-E (Peripheral Component Interconnect Express) slot. 
Most graphics cards have one or more heatsinks on the GPU and the VRAM, and often have a fan on the 
GPU or covering the entire card. The graphics card undertakes the majority of 2D and 3D graphics 
calculations and also sends information directly to the Display Device, which is usually a monitor. Some 
motherboards have built-in graphics functionality that works in much the same way as a graphics card, but 
is referred to as Onboard Graphics or Integrated Graphics. PCs with such graphics functionality typically 
process graphics-related information far less quickly than those with plug-in graphics cards. In human body 
terms, the graphics card is like the portion of the Brain that relates to visual or artistic expression. 
 

DISPLAY DEVICE 

A Display Device, or more commonly referred to as the Monitor, is the device through which the PC's 
information is displayed graphically. This graphical information comes from the graphics card, and a 
display device must usually be plugged directly into the graphics card through the back of a PC to facilitate 
this. While many computers still have a CRT (Cathode Ray Tube) monitor as their primary display device, 
modern PCs can utilize LCD displays, Plasma Televisions and sometimes multiple types of displays at once 
to output the graphics information. Display devices have the ability to display graphics at various 
resolutions, typically expressed in number of Pixels wide by number of Pixels high (e.g. a resolution of 1024 
x 768). A Pixel is the smallest component of graphics, and the higher the resolution, the more pixels are 
displayed on the display device and hence the clearer the image. At each resolution a display device can also 
redraw the image a number of times per second, referred to as the Refresh Rate. The higher the refresh rate 
the smoother your graphics will appear and the less flickering you will notice. In human body terms the 
display device is like a piece of paper or a canvas used by a person to convey thoughts as images and text. 
 

SOUND CARD 

The Sound Card, also called the Audio Card or Audio Device, is a thin plastic PCB or sometimes an external 
attachment that acts as a dedicated CPU for calculation of audio information. A sound card typically plugs 
into the motherboard through a PCI slot, or in some cases as an external peripheral, and usually has no 
heatsink or fan, as it does not require the same level of cooling as other major components. Some 
motherboards have built-in audio functionality that works in much the same way as a sound card, but is 
referred to as Onboard Audio or Integrated Sound. PCs with such audio functionality typically process 
audio-related information less quickly or less faithfully than those using proper sound cards. In human body 
terms, the sound card is much like the portion of the Brain that relates to audio interpretation. 
 

SPEAKERS OR HEADPHONES 

A PC speaker system (or headphones) is designed to output the audio signals of the PC, which usually come 
from the sound card, and hence it is typically plugged directly into the sound card. Even if a PC has no 
attached speakers/headphones, all PCs have a small built-in speaker that provides important system status 
information usually as beeps. In human body terms the speakers or headphones are like the voice of the PC. 
 

POWER SUPPLY UNIT 

The Power Supply Unit (PSU) is a square metal box, usually with a fan at the back, which is cabled to all the 
major components of a PC, particularly the motherboard, and provides the power for the PC to function. The 
power cord from the wall usually plugs straight into the back of the PSU directly, as it draws the appropriate 
power and regulates the precise voltages that certain devices need to function correctly. The PSU usually has 
a wattage rating which indicates the maximum power output of the PSU under load, with the more devices 
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connected to a PC the higher the wattage required to maintain ample smooth power to each and hence keep 
the system stable under stress. In human body terms, the PSU is like the heart which pumps blood through 
the arteries and organs. 
 

HEATSINKS AND FANS 

A Heatsink is a square or rectangular solid metal object typically with a perfectly flat surface on one side, 
and many long square 'spines' on the opposite surface. The role of a heatsink is to sit on top of a chip like the 
CPU or GPU, or even RAM - any component which gets quite hot - and draw out the heat these components 
are producing through conduction. This heat then travels along the length of the heatsink to the top of the 
individual metal spines where cooler air and a large surface area help in accelerating the dissipation of the 
heat. Typically a fan is bolted on top of the heatsink to aid in blowing more cool air over the heatsink's 
spines and hence dissipate the heat more quickly. In some cases where just a heatsink is sufficient for the job, 
no fan is used - such as the heatsinks on the motherboard or heatsinks placed onto VRAM. 
 
Often Fans are placed inside and around a PC case by themselves to draw in cool air and blow out hot air 
from the enclosed space around the hardware components on the motherboard. Given the way heatsinks 
work, the air around components will heat up quickly as heatsink(s) radiate the heat drawn from hardware 
components. Fans of varying sizes and speeds aid in cooling the air in the entire case.  
 
Other forms of PC Cooling such as refrigerator-like Peltiers, Heatpipes and Watercooling blocks can assist or 
replace heatsinks and fans in the role of cooling system components, but are less common due to their cost 
and complexity. In human body terms all these devices are like the respiratory and perspiration functions. 
 

CASE 

The PC case is a hardened structure, usually made of thin but strong metal and/or plastic, which encloses all 
the PC components and onto which the motherboard is firmly attached. The case usually provides the basic 
framework required for affixing additional components such as hard drives, floppy drives and the PSU. 
Often the case will also have a range of openings small and large to allow fans to draw and expel air for 
better circulation. In human body terms the case is like the skeleton combined with the skin. 
 

PERIPHERAL 

A Peripheral generally refers to any external device attached to a PC, such as a mouse, keyboard, printer or 
digital camera for example. The term 'peripheral' is used specifically to indicate that the device lies outside 
the periphery of the PC case. The only thing peripherals have in common with each other is that they 
provide additional input to the PC, and often capture some of the PC's output too. In human body terms 
peripherals are like the eyes, ears, nose, hands and feet of the PC. 
 

OPERATING SYSTEM AND SOFTWARE 

The Operating System (or OS) such as Windows XP, is a vital piece of software - a compilation of 
instructions that tell all the hardware components in a PC how to function to achieve particular outcomes. 
This information is interpreted and coordinated by the CPU, but is not confined to CPU functionality. An OS 
is a necessity on all modern PCs since without an overarching program to provide core functionality, all the 
computer components would not be able to function as a single machine. Additional installed software is 
like modular functionality which slots under the OS to perform specific functions or tasks, such as word 
processing or gaming. In human body terms the Operating System/software is like a combination of our 
basic education, instincts and emotions - the driving force behind our behavior that tells us how to act. 
 
Hopefully this information has helped you understand the roles of the various hardware components a little 
better. Ultimately a PC is an incredibly complex machine and as such the simplifications in this chapter don't 
do justice to the intricate and multi-faceted ways in which hardware and software components interact. 

http://en.wikipedia.org/wiki/Heatsink�
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SYSTEM SPECIFICATIONS 
 
The first step in optimizing your PC is to find out precisely what hardware components you have, and what 
their various capabilities are. This is known as your System Specifications, and to find out the specific details 
of your hardware you require an appropriate set of tools. Information about your system specifications is 
vital both for using this guide, and for general PC usage and maintenance. For example you must know the 
model and chipset type of your motherboard before you can upgrade your BIOS or install the correct 
motherboard drivers; you must know the full capabilities of your graphics card if you want to know if it can 
run certain games or again to update its drivers; or you may have a complex problem which you wish to 
resolve yourself or provide details of to a Technical Support person. This chapter covers the tools you need 
and the methods you can use to obtain all the relevant system information. 
 
 
< SYSTEM INFORMATION TOOLS 

There are several good free system information utilities to choose from, including some comprehensive ones 
built into Windows XP. A combination of these programs will tell you everything you need to know about 
your system specifications and capabilities, and I recommend you download and install as many of these 
programs as possible: 
 

WINDOWS SYSTEM INFORMATION TOOL 

You can access the Windows System Information Tool by going to Start>Programs>Accessories>System 
Tools>System Information, or go to Start>Run and type "msinfo32.exe" (without quotes) and hit Enter. Note 
that for this utility to work, you will need to have the 'Help and Support' service enabled - see the Services 
chapter for more details. 
 
The System Information Tool presents a range of basic information about your system. Unfortunately much 
of it can be a little difficult to comprehend or may not be quite what you're looking for. Some of the more 
useful pieces of information include the IRQ allocations under Hardware Resources>IRQs; the listing of your 
hardware components by type under the Components section; and a listing of all the system drivers loaded 
up and their status under Software Environment>System Drivers. In general the System Information Tool is 
best used by medium to advanced users who can comprehend the interface and the information much easier 
than a beginning user. Its major advantage is that it is a free and built-in utility that anyone can easily access. 
 

DEVICE MANAGER 

You can access the Windows Device Manager under the Control Panel>System>Hardware tab, or by going 
to Start>Run and typing "devmgmt.msc" (without quotes) and then pressing Enter. As a built-in Windows 
utility you can gain a great deal of useful information from this tool. Your major devices are displayed under 
various categories, and you can even choose to update individual device drivers or uninstall a device 
altogether should you wish. The device manager has several important roles and is covered in more detail 
under the Control Panel chapter. 
 

DIRECTX DIAGNOSTICS 

You can access the DirectX Diagnostic Utility (DXDiag) by going to Start>Run and typing "dxdiag" (without 
quotes) and pressing Enter. DXDiag is another built-in Windows Diagnostic/System Information tool that is 
part of the DirectX API. When DXDiag starts up you don't need to worry about WHQL (Windows Hardware 
Quality Labs) certificate checking - WHQL certification is not necessarily a solid indication of a driver's 
stability or functionality (See the Driver Installation chapter for more details). 
 
The main tab of DXDiag, called System, shows basic information about your system such as CPU type and 
speed, amount of physical RAM and the total pagefile (Virtual Memory) usage among other things. Under 

http://en.wikipedia.org/wiki/DirectX�
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the Display, Sound and Input tabs you can find more information about the particular hardware you are 
running for each of these functions, and also conduct some basic tests to ensure they are working to their full 
extent under DirectX. In particular you should ensure that all the DirectX Features listed are Enabled and 
that any Acceleration options are at maximum (slider to the far right). If you are experiencing problems with 
your hardware you can try the DirectX troubleshooting procedures under the 'More Help' tab. 
 
The most useful function of DXDiag for our purposes is its ability to create a text file with all your major 
system information, including your main hardware specifications, driver files, and environmental settings. 
To generate this text file click the 'Save All Information' button found at the bottom of the DXDiag screen. 
You will be prompted to save this report somewhere, and the default of the Windows Desktop is just fine. 
This DXDiag.txt file can now be attached to an email you can send to a Technical Support person, or its 
contents can be posted on an online forum to allow others to help you with any problems you may be 
experiencing. Don't worry - it doesn't contain any private information such as serial numbers or passwords. 
 

SIW 

SIW is the System Information for Windows tool which can be downloaded from the SIW Website. Once 
you've downloaded the standalone version of the program, you can simply run it from the file - there's no 
need to install anything. The interface is quite intuitive; click items in the left pane to see more details about 
them. For example, to find out more about your motherboard, click the Motherboard item under the 
Hardware section. After a short pause, the details will be shown in the right pane. Alternatively, you can 
access these items by going to the Software or Hardware menus at the top of the screen. Note that SIW also 
has some testing and tweaking tools built into it under the Network and Tools menus. These aren't covered 
here, but I don't recommending changing anything using them unless you feel confident that you know 
what they do - the best use for this utility is simply for gathering system information. 
 

3DMARK 

You can download the 3DMark from the Futuremark Website and you can read more about its main 
functionality under the Benchmarking & Stress Testing chapter. 3DMark is primarily designed as a graphics 
benchmarking utility, however it has a nice system information section that gives you plenty of important 
info. Start 3DMark and on the main screen, click the Details button under the System section. A browser 
screen will open with a vast array of information about your system. Everything from your CPU's clock 
speed and L1 & L2 Cache sizes, to your hard drive's capacity and interface type. Note that only 3DMark 06 
or older will run on XP; the newer 3DMark Vantage is Vista-only. 
 

SANDRA 

You can download Sandra from the SiSoftware Website. Once installed, run Sandra and you will see a wide 
selection of information and benchmarking modules to choose from. Under the free Lite version of Sandra, 
many of these modules are inactive, however the main ones we need have sufficient functionality for our 
purposes. For example, if you want to know more about your system, go to the Hardware tab and double 
click on the Computer Overview module. It will display a range of basic but important information about 
your system, such as the CPU speed and type, and your graphics card model. If you want to know more 
about your motherboard in particular for example, open the Mainboard module, and it will display the 
motherboard chipset type, and information related to your motherboard and the types of devices on its 
various ports. Sandra has several very useful benchmarking and stress testing features that are covered in 
more detail in the Benchmarking & Stress Testing chapter. Note that Sandra installs a new service for itself 
called the 'SiSoftware Deployment Agent Service' which you must leave at its default. 
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CPU-Z 

You can download CPU-Z from the CPU-Z Website. Run CPU-Z.exe and it will provide you with everything 
you need to know about your CPU, such as its precise speed, voltage, packaging type, cache sizes etc. It will 
also tell you about your system's current Bus speed and Multiplier under the CPU tab, your full 
motherboard details under the Mainboard tab, and your RAM's complete details under the Memory and 
SPD tabs. Note that for information to appear under the SPD tab you will have to first select the slot(s) on the 
motherboard that your RAM stick(s) occupy, otherwise the box will be empty. 
 

GPU-Z 

You can download GPU-Z from the GPU-Z Website. Note that GPU-Z is distinct from the CPU-Z utility 
covered above; it relates to your GPU (Graphics Processing Unit), which in other words is your graphics 
card. Run the GPU-Z.exe file, and much like CPU-Z, it will provide you with all the information you need to 
know about your graphics card. Under the main Graphics Card tab you will see all the specifications for 
your graphics hardware, including the amount and type of Video RAM, the level of Direct X support, and 
the BIOS version. Under the Sensors tab you will find your current clock speeds, temperatures, fan speed 
and so forth. Finally, note that the Validation tab is there only if you want to submit your specs to the GPU-Z 
Statistics Database, which is not essential. 
 
There are many other system information tools which are available, some of which are not free. However a 
combination of the tools above should be more than enough to give you all the details you need for every 
aspect of the hardware that is in your PC. I strongly encourage you to make sure that you are fully aware of 
your hardware specifications and capabilities, as incorrect knowledge can cause major problems when you 
try to install drivers or make system or BIOS changes for example. Make a list of your relevant system 
specifications now using the above tools and keep them handy - see the format below for further help. 
 
< PROVIDING SYSTEM SPECIFICATIONS 

At some point while you are seeking help for a computer-related problem you will have to provide your 
system specifications. Whether a qualified Technical Support person or simply a computer enthusiast on an 
online forum asks, you should provide your specifications in an appropriate format. Simply copying the 
entire contents of a DXDiag dump for example is far too large for most people to have the patience to wade 
through, so I recommend that you use the format shown below. 
 
Use the system information tools covered above to fill in the appropriate details. The more detail you can 
provide, the better - the bare minimum is the brand and model number of your major components. Add in 
details like whether any of the components are overclocked, whether there is any additional or modified 
cooling, and indeed whether any other modifications have been made to the system since purchased. I have 
filled in some sample information in italics to demonstrate how it should look: 
 
 

CPU:  AMD Athlon 64 X2 4400+ Dual-core CPU, stock speed, XP-90 cooling 
Motherboard:     DFI NForce4 SLI-DR 

Graphics card: Nvidia GeForce 8800GTS 640MB at Stock speed 
Sound Card:     Creative SoundBlaster Audigy 2ZS 

RAM:      2 x 1GB OCZ PC3200 at 400MHz, 2-3-2-5 (CAS 2) 
Hard Drive(s):     2 x 74GB Western Digital Raptor SATA RAID 0 

CD/DVD Drive(s):     Pioneer DVR-109 DVD-R 
Power Supply:      Silverstone 650W 

Operating System: Windows XP SP3 including all updates 
Driver Versions, Other Details: 02.09.0016 Audigy 2 ZS drivers, 174.74 Forceware, 6.86 nForce drivers 
 
 

http://www.cpuid.org/cpuz.php�
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You can also provide details of your monitor, keyboard, mouse, speakers/headphones, however these are 
usually not critical to solving a PC problem, unless of course your problem is with mouse input, display 
output, or audio output for example.  
 
If you are still at a total loss as to how to provide full details of your system, use DirectX Diagnostics (see 
above) to generate a report and attach it to an email or post its contents on a forum, but bear in mind that no-
one can magically solve a problem simply by looking at your system specifications, no matter how detailed 
they are, so despite the length of a DXDiag text dump, it is not a substitute for you becoming familiar with 
your own system and therefore troubleshooting your own problems, or actively being able to contribute and 
assist someone else who is trying to do so. You should also become familiar with the Windows Errors and 
Benchmark & Stress Testing chapters of this guide, as they provide important details on how you can go 
about resolving many common problems on your own PC. 
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BACKUP & RECOVERY 
 
Computers can store a great deal of information, and over time your PC may hold a lot of important, private, 
irreplaceable data such as digital photographs and home movies, financial documents, emails, passwords 
and login details. It is of critical importance that you establish an appropriate method for regularly backing 
up this information, so that if your PC is stolen, damaged, or its data is corrupted or accidentally 
overwritten, that you do not lose all this valuable data permanently. Hence backing up is a vital and 
unavoidable part of sensible computing. In fact once you are sure that your system is completely free of 
malicious software, you should make at least one backup copy of all your important and irreplaceable 
documents before proceeding any further with this guide. 
 
This chapter not only covers various backup strategies and tools, it also covers a range of useful data 
recovery methods you can use to regain valuable information which has been lost through forgetting 
passwords, accidental deletion of files, data corruption or damage to your Windows installation. 
 
 
< MANUAL BACKUP 

The most basic and reliable method of backing up your system is to do things manually. There are methods 
that can be used to create automated backups of your system which are covered further below, however I 
personally use the manual method regularly to ensure I have a 'clean' backup copy of all my important files, 
especially if I am going to do a reinstallation of Windows. Any automated backup utility you use may 
inevitably backup the problematic or sub-optimal settings you were trying to escape in the first place, so a 
clean manual backup is strongly recommended, especially if you are experiencing problems. 
 
How precisely you do a manual backup is up to you; below are my tips for preparing data and manually 
backing up your important files regularly: 
 
Logical Directory Structure: Create a logical directory structure under your 'My Documents' folder, with 
appropriately-named sub-folders, e.g. Music, Movies, Pictures, Patches, Downloaded Programs, Drivers, 
Personal Documents, Tax - as many as necessary.  Note that you can rename the default directories such as 
'My Pictures' or 'My Music' to Pictures or Music - right click on each folder and rename it. Now sort all your 
relevant documents into these directories. You might want to keep copies of downloaded programs, a copy 
of all the latest drivers, Service Pack, and so forth, but these are optional. Alternatively, if you have a 
separate data partition or drive, store your files there in appropriately named folders. Having a logical file 
structure makes storing and finding files easier, but importantly it also makes regular manual backups much 
easier. 
 
Internet Bookmarks: In Internet Explorer you can create a backup file of your Favorites by going to File 
menu>Import and Export>Export Favorites. Follow the prompts to export your Favorites to a suitable 
location under the default name Bookmark.htm. Back this file up, and to import your Favorites back into 
Internet Explorer at any time go back to the Import and Export function and choose 'Import Favorites'. If you 
use a browser like Mozilla Firefox, you can backup your bookmarks by going to the Bookmarks menu, 
selecting 'Manage Bookmarks', then selecting File>Export and choosing where to save the Bookmarks.html file. 
 
Saved Games: If you want to backup any saved games or game configuration files, these are typically held 
under the game's main directory, in a \Saves, \Savegames, or \[profilename] directory, or held under 
\Documents and Settings\[username]\ in the \My Documents, \My Games or \[gamename] directory. If you are 
having problems with a game, backing up its saved games should still be fine, but I don't recommend 
backing up the game's configuration files as it may just pass the problem onto your new install of the game. 
Also, don't attempt to backup an entire game directory, as you cannot restore games or other programs in 
this manner - these will not run properly if they are copied back onto another installation of XP due to the 
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lack of appropriate registry entries and files spread throughout various other directories. You must use the 
original installation files/discs to reinstall a game or program correctly. 
 
Usernames/Passwords: You can store all your usernames and passwords securely electronically - see the 
Backing Up & Restoring System Passwords section further below. If you have no faith in electronic storage 
systems then compile a written list/printout of the major usernames and passwords on your system. 
However you must then store this list safely in a physically secure place like a safe or lockable drawer. 
 
Backup to Disk or Hard Drive: Once you have determined the files to backup, you should regularly backup 
your important files/programs to another medium, such as another hard drive, or ideally to CDs or DVDs. I 
certainly don't recommend backing up your files to another partition on your main drive. I recommend CDs 
or DVDs simply because it is easier to transfer information between PCs via CD/DVD rather than having to 
plug in a hard drive, but the choice is yours. When selecting which files to regularly back up, give top 
priority to files that are genuinely irreplaceable, such as digital photos and financial documents. Anything 
that has a high sentimental or monetary value should be backed up often, ideally to more than one location. 
Information which changes regularly should also be backed up more often. 
 
< AUTOMATIC BACKUP 

If you want a more comprehensive method of backing up your data that will take up more space but is 
automated, and hence may be more foolproof, then you can use an automated backup tool. Note that if you 
are having any sort of general system problems or quirky behavior, I recommend against using this method 
to backup your data and settings. Any automated tool may capture and transfer the same problems you 
experienced before onto your new install of Windows XP - defeating the entire purpose of doing a fresh 
install of Windows. Only use these methods if you genuinely aren't experiencing any problems and have 
generally trouble-free performance. 
 

WINDOWS BACKUP UTILITY 

You can access the Windows Backup Utility by going to Start>All Programs>Accessories>System 
Tools>Backup, or by going to Start>Run and typing "ntbackup" (without quotes) and pressing Enter. 
Windows XP Home users will not have access to the Backup utility by default, but it can be manually 
installed from the Windows XP Home CD by following the instructions in this Microsoft Article. Basically it 
involves inserting the Windows XP CD into your drive, opening Windows Explorer, going to the 
\VALUEADD\MSFT\NTBACKUP\ directory on the Windows CD and double-clicking on the Ntbackup.msi 
file to start installation of it. 
 
The Backup Utility has several methods of usage, which are detailed in this Microsoft Article, but essentially 
it involves the following steps: 
 
1. Run the Backup Utility and click the 'Advanced Mode' link to switch to a more customizable method of 

backing up. 
2. Go to the Backup tab, and put a tick in the boxes next to the directories that you want to back up. 
3. Select the 'System State' box if you want to ensure all the additional system settings relating to your 

setup are backed up as well (i.e. your Registry settings etc.). Alternatively, if you don't want to save 
these as well (i.e. you want to restore your backups onto a clean install of Windows), then don't tick the 
'System State' box. 

4. Click the Browse button at the bottom, and select the destination for the backup. This is usually another 
hard drive given the amount of data involved; the Backup utility cannot backup to CDs/DVDs. 

5. Click the 'Start Backup' button to commence backing up. The process may take quite some time 
depending on how many directories you chose to back up, and the type of medium to which they are 
being transferred. 

6. To restore this backup in the future, run the Backup utility again, but this time under 'Advanced Mode' 
click the 'Restore Wizard' button and follow the prompts. 

http://support.microsoft.com/kb/302894�
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The Windows Backup utility has many more options and methods for backing up, so go through the options 
for configuring the utility under the Tools>Options menu in Backup. 
 

NORTON GHOST 

A popular package for backing up quickly and easily is Norton Ghost, though unfortunately it isn't free. 
However if you genuinely can't be bothered with manual backups and/or you have some very important 
information and want to make sure it's backed up completely and properly and/or you often install risky 
software, play around with system settings and/or overclock heavily on a regular basis, then Norton Ghost 
can save you a lot of time and grief. Since Ghost isn't free, and is not essential, it won't be covered in detail 
here, but I refer you to this Norton Ghost Guide for full details. 
 
You can also try Acronis TrueImage, which some users prefer over Norton Ghost. Once again this is not a 
free utility, so refer to the TrueImage User Guide for more details. 
 

ONLINE BACKUP 

Most ISPs provide their customers with a basic webspace, or if not, then free email services such as Yahoo 
and GMail provide large amounts of storage in the order of several Gigabytes. While I do not recommend 
uploading/emailing any sensitive data to these locations, or using them as a sole backup method, they do 
serve as good holding spots for additional backups of digital photos and other important but non-secretive 
documents. That way if you somehow lose all your local backup copies through fire or theft for example, 
there are still copies online which you can download and restore. 
 
If you really want to be secure and not worry about losing your backups - especially if you have extremely 
valuable information - then consider an online backup service, like Backup.com. This ensures that your data 
is encrypted and stored safely, but these services are usually not free to use, so they're only recommended 
for people who genuinely need that level of protection against data loss or theft. 
 
< SYSTEM RESTORE 

Once the initial backing up of your data and programs is done, and if you are not going to reformat and 
reinstall Windows XP, you need to create a new System Restore point as an additional safeguard before 
doing any tweaking. Using System Restore means that even if you make a large number of system changes 
you can 'undo' these changes if you run into any problems. More details of the System Restore functionality 
can be found in this Microsoft Article. It is strongly recommended that you create a new Restore Point prior 
to implementing any major tweak or system change by following these steps: 
 
1. Go to Start>Programs>Accessories>System Tools and launch System Restore, or open MSConfig 

(Start>Run>MSConfig), and click the 'Launch System Restore' button. 
2. In the System Restore Wizard, click 'Create a Restore Point' and follow the prompts to save your system 

state in a new restore point. 
3. At any time, if you wish to return your computer to the state it was in when you created a particular 

Restore Point, follow step 1 above to get to the System Restore Wizard. Then click 'Restore my computer 
to an earlier time', and select the date on which you created the restore point you wish to return to. 

 
Note that if System Restore is enabled, Windows automatically makes restore points under certain 
circumstances, such as during the installation of new drivers, or prior to the installation of certain 
applications. This gives you additional protection against catastrophic changes on your system. However a 
restore point is not a guarantee that you can just go back to the way things were if something goes wrong. In 
some cases trying to undo a change by going back to a recent restore point won't work, so only use System 
Restore as an additional layer of protection - you should always make backups of your important 
information often, regardless of whether you use System Restore or not. System Restore does not backup 
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personal files or folders, it is only a tool to capture the current state of important system files and settings, so 
it is not a general backup utility. 
 
If your system is currently stable and problem-free, and you have made a recent restore point, you can clean 
out all older restore points except for the latest one by using the Disk Cleanup utility (see the Cleaning 
Windows chapter) - freeing up a great deal of hard drive space. Finally, note that System Restore will not 
function if you've disabled the 'System Restore' service - see the Services chapter for details. 
 
< BACKING UP THE WINDOWS REGISTRY 

The Windows Registry is a critical component of Windows, and any problems you experience with it can 
make Windows unbootable, or result in a variety of errors or strange behavior - see the Windows Registry 
chapter. That is why it is important to have a backup of the Registry before undertaking any tweaking.  
 

ERUNT 

The most efficient and foolproof way of backing up the entire registry is not to use the Export function in 
Registry Editor - that method is only handy for saving individual branches of the Registry. Unfortunately 
full Registry backups made by Registry Editor will not restore correctly if your registry becomes corrupted. 
Instead, I strongly recommend you use a free utility called Erunt (Emergency Recovery Utility for NT). 
Download this small program and install it, but note that during the installation of Erunt you should answer 
'No' when asked if you want Erunt to be placed in the startup folder, as this is unnecessary. 
 
To make a backup of the Windows Registry using Erunt, launch the program. You will be prompted to 
backup your registry to a folder, which you should accept by clicking Ok until the backup has been made. If 
you want to restore this backup at any point, simply go to the directory where the backup was made, 
typically \Windows\ERDNT\[Date of backup]\, and launch the ERDNT.exe file there to restore that backup. 
 
< BACKING UP & RESTORING PASSWORDS 

One of the biggest headaches when running Windows would be losing your main login password, 
particularly if you're the Administrator on your machine. With the NTFS file system it is quite difficult to 
access the data on your hard drive without the correct login password (there is a method to reset this 
password - see further below). Clearly the best thing to do is back up your password now before anything 
happens, so that if necessary you can restore it without any difficulties. The recommended way to back it up 
is as follows, though note you will require a floppy drive or a USB flash drive for this to work: 
 

BACKING UP LOGIN PASSWORD 

1. Go to Control Panel>User Accounts and click on your User Account. 
2. Click on 'Create a Password Reset Disk' in the left pane. The Forgotten Password Wizard will open up. 

Click Next. 
3. Insert a blank formatted 3.5" floppy disk into your A:\ drive or attach a USB stick and click Next. If you 

need to format a blank floppy first, insert the disk into your floppy drive, open Windows Explorer, 
right-click on A:\ and select Format. Click Next. 

4. Type your current User Password in the box and click Next. Once the disk has been created, click Next 
and select Finish. Store this disk/stick somewhere safe, as anyone can use it to access your account. 

 
Note that most people will use any old 3.5" floppy they find to backup their password and often these disks 
are quite old. A floppy disk has an error-free life of about 10 years on average, so I urge you to obtain fresh 
3.5" floppies. If you don't have a floppy drive or fresh disks, consider buying a small USB flash drive just for 
this purpose. 
  

http://www.larshederer.homepage.t-online.de/erunt/�
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RESTORING LOGIN PASSWORD 

If you ever need to restore your password from the backup created above, follow these steps: 
 
1. Boot your PC as normal, and on the Windows Login screen select your User Name.  
2. Try entering your password (or just press Enter), and if it's incorrect you'll get a message saying the 

Username or Password is incorrect. Click OK and then select 'Reset Password', inserting the password 
reset disk or flash drive you created earlier. 

3. Follow the Password Reset Wizard to set a new password and log back into your system. 
 
Note that the password reset disk needs to be write-enabled so that Windows can update it with the new 
password automatically during this procedure. When done, you should once again put it away in a 
physically secure place. 
 

RESETTING YOUR LOGIN PASSWORD  

There is a method by which you can get to your data in case you've lost your main Admin login password. 
The utilities and methods are covered on this Offline NT Password & Registry Editor site. The site provides a 
bootdisk image (CD or Floppy) which when used to boot up your PC will provide an option to unlock user 
accounts that would otherwise be inaccessible. It is a method of last resort, since it can actually corrupt data 
if used incorrectly, or if your files have been EFS encrypted for example. Read the instructions on the site 
carefully, and use with caution. 
 

STORING PASSWORDS 

If you want to hold all your usernames and passwords in a central database which is protected by high level 
encryption, use the free KeePass Password Safe utility. To use it, run the program and select 'New Database' 
under the File menu, then enter a Master Password and/or select a 'Key Disk' - this is used to unlock the 
password list so make sure the password has a high bit-rate (e.g. 128 bit). Once created, you can populate the 
database with Group entries for home banking, Internet - any groups you require. Then in the right pane for 
each group you can right-click and select 'Add Entry' to create a new Username/Password entry to store. 
Make sure to read the help file under the '?' menu>Open Help File as there are many options in this utility. 
You can backup this password database to another location, and if needed access it using the master 
password or key disk as required. Because it is encrypted it is next to impossible to access the database 
without the right password/key disk. 
 

RECOVERING PASSWORDS 

If you haven't stored your passwords and you've managed to forget or lose a username/password, there are 
several utilities you can use to recover various passwords stored on your system. To recover passwords in 
Internet Explorer, MSN or for your Outlook Express accounts you can use the Protected Storage PassView 
Utility. If you have forgotten a password which is now only visible as a series of ****'s in a password dialog 
box or on a website, you can try using Revelation or Asterisk Key to show you the actual password being 
used. Finally, you can use RockXP to retrieve a series of passwords and keys on your Windows installation 
that are usually hidden. 
 
Detailed usage instructions for these utilities are not provided as they are relatively straightforward to use. 
The presence of these tools also lets you see that nothing is completely safe on your machine, so it is 
important to always restrict physical access to your machine only to trusted individuals, and always follow 
the tips in the PC Security chapter. 
 
  

http://home.eunet.no/~pnordahl/ntpasswd/�
http://keepass.info/download.html�
http://www.nirsoft.net/utils/pspv.html�
http://www.nirsoft.net/utils/pspv.html�
http://www.nirsoft.net/utils/pspv.html�
http://www.snadboy.com/�
http://www.lostpassword.com/asterisk.htm�
http://www.majorgeeks.com/download4138.html�
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< FILE DELETION AND RECOVERY 

Accidental deletion of files is one of the most common ways in which files are lost. By default Windows XP 
has minimal protection against accidental deletion; as noted earlier in this chapter, System Restore does not 
protect personal files and folders. Aside from leaving the Recycle Bin enabled and making sure that files are 
moved there when deleted, there isn't a great deal of protection against unintended permanent deletion of 
files. Fortunately, when you delete a file from your system the file is removed from view and you regain the 
space on your hard drive, however it is not actually permanently deleted from your hard drive. In fact, 
nothing on your drive is permanently removed when you delete it. Whenever you delete a file Windows 
simply marks it for deletion by changing one character in the file table. The entire file is still sitting on your 
hard drive, but is not visible. Windows then allows other files to write over the space where it resides if 
required, but the file is not gone from your hard drive until it is completely overwritten at some point. This 
means that you can recover files that have been 'permanently' deleted, but you need to act quickly and will 
require special software to do so. 
 

RECOVERING DELETED FILES 

The best free utility I have found to restore deleted files is a small tool called Restoration. To use Restoration 
first download the file and run it to extract the contents to an empty directory on your hard drive, or 
preferably to a blank 3.5" floppy disk or USB drive. Then run the Restoration.exe file and either enter a 
filename in the search box, or a file extension (e.g. JPG, DOC, TXT), or leave the box blank (to find all 
recoverable deleted files) and click the 'Search Deleted Files' button. Restoration will scan your hard drive 
for files which can be restored and will list them. Once done, you can highlight a file and click 'Restore by 
Copying' to recover it - however note that the file may not be complete since portions of it may have already 
been overwritten, so there is no guarantee you can recover an entire file this way. 
 
The more hard disk activity there is after you have deleted a file, the less chance you can fully recover it, 
since portions of it may have been overwritten by new data. If you have accidentally deleted an important 
file, try and minimize any further disk activity before running Restoration; if you can't run Restoration 
straight away it is best to shut down Vista immediately to prevent a background task from commencing as 
these will potentially overwrite the area where the file is sitting. Run an undelete program like Restoration 
immediately. 
 
If you want to recover deleted or damaged files on a CD or DVD disk, you will have to use a utility like 
IsoBuster. This utility can be downloaded for free, however it requires paid registration for full functionality. 
You can use the free version to first check to see if there is any recoverable data on your particular disk. See 
the program's help file for detailed instructions. However just like hard drive data recovery, there is no 
guarantee that any usable data can be recovered from a damaged or deleted disk - particularly if it has been 
overwritten. 
 

PERMANENTLY DELETING FILES 

If you ever want to permanently delete a file so that others can't undelete it, you can also use the Restoration 
program to do this. First delete the file(s) you want to permanently delete the normal way - i.e. highlight 
them and press Delete, then empty the Recycle Bin. Then launch Restoration and enter the name of each file 
in the search box and click 'Search Deleted Files'. When Restoration finds the file and lists it, highlight the file 
and go to the 'Others' file menu in Restoration and select 'Delete Completely'. This will permanently delete 
the file so it is unrecoverable by virtually any program or method. Note that the file may still be recoverable 
by law enforcement agencies using specialized methods, although it is highly unlikely that anyone could 
recover the bulk of this data regardless of the methods used. 
  

http://www.snapfiles.com/get/restoration.html�
http://www.smart-projects.net/isobusterdownload.htm�
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LOW LEVEL FORMAT AND ZERO FILL 

People might suggest that you 'Low Level Format' your drive to permanently remove data or fix a drive 
problem. This is not recommended unless you are experiencing severe hard drive problems, and even then 
only as a last resort. Modern hard drives are low-level formatted at the factory to create tracks and sectors 
and do not need to have it done again. The correct course of action is to Zero Fill your drive, which people 
often confuse for a low-level format. This method overwrites the entire hard drive with blank data, ensuring 
that everything is deleted permanently for most intents and purposes, but it is not as intensive or potentially 
disk-damaging as a low-level format. A note for the extremely paranoid - nothing short of physically 
destroying the drive (by burning it for example) can guarantee that data cannot be recovered from a hard 
drive by law enforcement agencies. So essentially a zero fill is your best bet in getting back to a 'good as new' 
hard drive. To zero fill a drive, check your hard drive make and model, then consult your manufacturer's 
website for an appropriate installation/diagnostic utility such as: Seagate DiskWizard & SeaTools for both 
Seagate and Maxtor drives, Western Digital Data LifeGuard, or Hitachi Drive Fitness. 
 
If you still believe you have to low level format your drive - for example if it seems heavily damaged with 
bad sectors and is unresponsive to a zero fill - then you will have to look for a specific utility available from 
your hard disk manufacturer's website to undertake this. I would only recommend this as a final step and 
even then it may not save your hard drive. 
 
< SYSTEM RECOVERY 

This section covers methods of recovering data and/or control of Windows after a major system error. Also 
refer to the Windows Errors chapter for more details of troubleshooting Windows errors which could be the 
source of such problems. 
 

RECOVERING FROM A CORRUPTED REGISTRY 

After any changes you make to Windows XP, if your system is crashing and you are having major problems 
booting into Windows, it is typically because the Windows Registry contains incorrect or corrupted settings. 
If you can't boot into Windows to use System Restore or Erunt to restore your system or registry, follow one 
of the steps below: 
 
§ During bootup, keep pressing the F8 key and you'll soon see a range of options, including 'Load last 

good configuration'. Select it and your computer should boot into Windows hopefully devoid of the 
recent changes you made which have caused problems. 

§ If you have a recent Restore Point, but can't boot to the Windows desktop for some reason, keep pressing 
F8 during bootup, but this time choose the option to 'Boot into Safe Mode' (See further below). In Safe 
Mode you can access System Restore by going to Start>Run, type "MSconfig" (without quotes) and press 
Enter, then clicking the 'Launch System Restore' button. 

§ Alternatively you can press F8 repeatedly at bootup once again, and this time select to boot into 'Safe 
Mode with Command Prompt', and at the command prompt which opens type 
"\Windows\System32\Restore\rstrui.exe" (without quotes) then press Enter to open System Restore. 

 
For more details on how to recover from a corrupted Registry, see this Microsoft Article. 
 

SAFE MODE 

Safe Mode is an important Windows mode which only loads up the bare essentials required for Windows XP 
to function. Third party drivers, graphical enhancements, startup programs, unnecessary processes etc. are 
all skipped and only the minimum required to display and use Windows and access your drives is provided. 
Safe Mode is provided precisely for troubleshooting purposes and not for general usage. The idea is that by 
reducing the number of software variables involved it is easier to identify the cause of a problem. You can 
read the full details of Safe Mode options in this Microsoft Article. To access Safe Mode do the following: 
 

http://www.seagate.com/www/en-us/support/downloads/�
http://support.wdc.com/download/index.asp�
http://www.hitachigst.com/hdd/support/download.htm�
http://support.microsoft.com/kb/307545�
http://support.microsoft.com/kb/315222�
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1. Make sure there are no discs in your CD/DVD drive(s) and reboot your PC. 
2. As your PC starts booting up keep pressing the F8 key and you will soon reach the Windows Advanced 

Options menu where you can see a range of options, each described in detail in the article linked above. 
3. Select the safe mode option you prefer - for most purposes I recommend the default 'Safe Mode' option 

which loads the least number of device drivers. 
4. You will reach the Windows Desktop which will be shown at lower resolution, low color bit-depth and 

with no graphical enhancements. The words 'Safe Mode' will appear around the edges of the screen to 
inform you that you are running a cut-down version of Windows XP. Note: if you cannot enter Safe 
Mode, this is the sign of a more serious problem, and you will need to see the Recovery Console section 
further below. 

 
The main use for Safe Mode is to determine whether your device drivers or installed software are the source 
of a problem you are currently experiencing. Because Safe Mode does not load any of your installed third 
party device drivers - instead using the default versions built into Windows XP - and because Safe Mode 
does not load up any unnecessary startup programs or services, this gives you the opportunity to determine 
whether your applications or one (or more) of your startup programs is causing problems. 
 
If you couldn't boot into Windows XP normally, but you can in Safe Mode for example, that is a clear sign 
that one of your recently installed driver(s) or application(s) is the likely cause of the problem. You can 
choose to remove recent software or drivers completely by going to Control Panel>Add/Remove Programs 
and uninstalling them from there. Alternatively you can experiment by using MSConfig or Autoruns (See 
the Startup Programs chapter) to temporarily disable suspected startup items, drivers and/or services (by 
unticking them) and try to reboot into normal Windows to see if this resolves your problem. 
 
If you made a change to a system setting or the Windows Registry that would normally prevent you from 
booting into Windows, you can undo the setting in Safe Mode, or revert to an earlier Restore Point, or restore 
a Registry backup here. 
 
If however you find that you cannot boot into Safe Mode, or are having similar problems in Safe Mode as 
you are in normal Windows - for example your graphics are garbled or show glitches - then the problem is 
most likely hardware-based such as overclocking, excess heat, permanent damage to a component/faulty 
component(s), related to a BIOS setting or incompatibility, or hard drive corruption which requires use of 
the Recovery Console to fix. 
 
Finally, a major use for Safe Mode is the removal of malicious software such as viruses or spyware, or for 
any other type of file which Windows says is 'in use' during normal Windows. Many of these will load into 
memory areas that cannot be unloaded during normal Windows XP operation. However in Safe Mode there 
are no such protected memory areas, and no additional startup programs, drivers or services are loaded with 
Windows, so this is the best way of removing such troublesome software. Enter Safe Mode and either  
manually enter Windows Explorer and delete the troublesome file(s), edit your startup items or Services to 
remove unusual or harmful entries (See the Startup Programs and Services chapters); or run several malware 
scanners in Safe Mode to find and remove any malicious software (See the PC Security chapter). 
 

RECOVERY CONSOLE 

The Recovery Console is an important repair and recovery tool built into Windows XP that allows you to do 
such things as check for faults on your drive and repair the Master Boot Records. You can read the full 
description of the Recovery Console, as well as its available commands and options in this Microsoft Article.  
The main use for the Recovery Console is when other methods of data recovery or troubleshooting have 
failed, and you simply cannot boot into Windows, even in Safe Mode. 
 
The quickest way to access the Recovery Console is to do the following: 
  

http://support.microsoft.com/kb/314058�
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1. Insert your Windows XP CD into your main CD/DVD drive. 
2. Reboot and go into your BIOS. Set the 'First Boot Device' (or similar) option in the BIOS to CDROM and 

reboot. 
3. As your PC starts booting up, keep pressing the F8 key until you see the message 'Booting from 

CDROM'. If this doesn't work, you should use a Windows XP Bootdisk instead (See the Installing 
Windows chapter). 

4. The blue Windows Setup screen will eventually appear.  
5. If you are running a SATA or RAID drive configuration, make sure to press F6 repeatedly when 

prompted during the loading of Windows Startup, and have your SATA/RAID driver disk handy; if 
these drivers are not loaded up the recovery console will not be able to identify your SATA/RAID hard 
drive(s) properly and/or will mistakenly identify them as corrupt volumes when they are not. 

6. Once in Windows Setup, press R to access the Recovery Console. 
7. If prompted, press a number that corresponds with your Windows installation - the default is 1. Enter 

your Admin password if required, or leave blank if you haven't set an Admin password for Windows 
XP, and press Enter. Note, if you cannot access your hard drive using the Recovery Console due to an 
incorrect Admin password, try the utility covered under the Resetting your Login Password section 
further above. 

8. Once the Recovery Console opens, there are a range of commands you can use. Just type "Help" (without 
quotes) and press Enter, and a list of commands will be shown. To see the options for each command in 
more detail, type the command followed by a blank space and then "/?" (without quotes). A full list of 
command line commands can be found in this Microsoft Article. 

 
The most common methods of attempting to repair a Windows installation in the Recovery Console are: 
 
§ Use the CHKDSK /R command to do a drive check and fix any errors if possible. If CHKDSK says the 

drive is unreadable or there are too many errors, make sure that if you have a SATA/RAID setup, you 
loaded the appropriate SATA/RAID drivers from a disk during Windows Setup loadup. If you're using 
the correct drivers and still see this error, it is likely your drive is actually corrupted or it may even be 
physically faulty. 

§ Use the LISTSVC command to list all current services and drivers and their startup status. Use the 
DISABLE or ENABLE commands to enable or disable particular services which you think are related to 
the problem. E.g. "Enable RPCSS Service_Boot_Start" (without quotes) tells windows to set the RPCSS 
service to start at Windows Bootup, in case you had accidentally disabled this vital service in Windows. 

§ Use the FIXBOOT command to repair the boot sector of the drive. 
§ Use the FIXMBR command to repair the Master Boot Record of the drive. 
 
If you find the drive still doesn't boot up into Windows after all these steps, you may just have to return to 
the Recovery Console, and use the CD and Copy commands to go to various locations on the drive and 
either copy across data to the faulty drive to replace a missing or corrupted file for example, or from the 
faulty drive to another drive to back up data before a reformat. 
 
Although the Recovery Console is a very useful tool, it still may not resolve some hard drive errors or 
problems. In such cases you can try using a Repair Install of Windows which if successful should fix your 
Windows without any data loss. Chances are that if the Recovery Console or a Repair Install don't work, 
either you have faulty hardware which is corrupting the data as it's being written (e.g. overclocked or faulty 
CPU or RAM), or your drive has simply experienced too much corruption and/or has too many bad sectors 
to recover your Windows; you will simply have to try reformatting your hard drive and reinstalling 
Windows. 
  

http://technet.microsoft.com/en-us/library/bb491071.aspx�
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SYSTEM FILE CHECKER 

The System File Checker is another built-in function of Windows XP that allows the system to go through 
and check all the major protected Windows XP system files against the original versions stored on a valid 
Microsoft Windows XP CD. This is extremely handy if you suspect corrupted/tampered system files that are 
leading to unusual Windows behavior. Full usage instructions for the System File Checker can found in this 
Microsoft Article. To access the System File Checker follow this procedure: 
 
1. Go to Start>Run and type "SFC /scannow" (without quotes) then press Enter to start an immediate scan 

of your system files. 
2. The System File Checker will go through all your important system files and make sure they have not 

been altered in any way. Where major system files are corrupted or shown to be different from original, 
they will be replaced with the originals from your \Windows\System32\Dllcache\ directory and/or your 
Windows XP CD. 

3. If prompted, reboot your PC as required. 
 
Note that instead of /scannow you can use the switches /scanonce (to scan after the next reboot) or /scanboot (to 
scan on every reboot). If you use /scanboot and then want to stop a scan after every reboot, use the /revert 
switch. 
 
 
While the tweaks in this guide are safe for the most part, there are times when human error or another issue 
may result in problems and even data loss. Get in the habit of backing up regularly if you don't already as 
that is the only guarantee you have of retaining your valuable information. In general the methods covered 
above are the most common and practical ways of both backing up your important information, as well as 
recovering from data damage or loss. 
 

http://support.microsoft.com/kb/310747�
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BIOS OPTIMIZATION 
 
The BIOS (Basic Input/Output System) is a program held on a small ROM chip on your motherboard. It 
provides the instructions for what your PC should do as soon as it turns on. Your BIOS is independent of 
your Operating System, which means it is not directly affected by the operating system you use, or which 
driver version you've installed, or what your settings are in Windows for example. The BIOS supersedes all 
of that, and your drivers and operating system will load after the BIOS has loaded up. The BIOS controls a 
range of hardware-related features and is the middle-man between your CPU and other devices. 
 
If there is an incorrect setting in your BIOS - that is a setting which is not optimal or correct for your 
hardware configuration - then you will have problems regardless of what you change in Windows, or which 
driver versions you install. Importantly, the BIOS is best configured correctly before installing Windows, as 
this reduces the number of unnecessary services and drivers which Windows may install, and helps reduce 
the potential for IRQ conflicts which is discussed further below. 
 
 
< THE BIOS 

BIOS POST SCREEN 

As your BIOS starts to load, the first thing it does is the Power-On Self Test (POST), a diagnostic program 
which quickly checks your components and makes sure everything is present and working OK. The POST 
sequence is usually extremely fast; you will only really notice it if it stops when encountering an error. POST 
error messages can be a bit obscure, but usually give you a lead as to where to look in your BIOS settings. A 
quick general guide to what the startup error beeps may mean is this POST Error Codes, but a more accurate 
description specific to your hardware is usually found in your motherboard's manual. 
 
If you have no POST errors you will then see your PC's startup screen, which shows such information as 
your BIOS type (e.g. Award BIOS), the key to press to access your BIOS settings (e.g. DEL or ESC), the type 
of processor and its speed, RAM amount and RAM test results, drive information, etc. Note that if any of this 
information is incorrect, it may be that your hardware is extremely new and hence not recognized correctly 
by the current BIOS version; you've overclocked your PC too far; or you have bad hardware or incorrect 
BIOS settings. 
 

BIOS SETTINGS 

To access the detailed settings in your BIOS, you typically need to press a particular key (the Delete key for 
example) repeatedly as your system is booting up. If your BIOS has a password then you'll need to enter it 
first to access your BIOS settings; if you've forgotten the password, then try this BIOS Password Site. Once in 
your BIOS screen you will see a multitude of settings. The layout of the BIOS, and the names of the various 
settings vary greatly depending on the particular motherboard brand and model you own, so I cannot 
possibly cover them all here. The best reference source is this Definitive BIOS Optimization Guide - scroll 
down that page to find the 'Free Access' link to the guide. It covers all the common BIOS settings in detail, 
and combined with your motherboard's manual and Google, you can undertake the very important task of 
optimizing your BIOS settings before doing any Windows tweaking. I cannot stress the importance of 
making sure all the major settings in your BIOS are correct for your particular hardware setup and that 
you've disabled unnecessary devices and options. It may take some time and some research, but it ensures 
maximum performance and stability. No amount of software tweaking can overcome a badly set up BIOS or 
resolve BIOS-related problems. 
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BIOS UPDATES 

The BIOS is written on a rewriteable ROM chip, which means that it can be updated (or 'flashed') with new 
information. Motherboard manufacturers often release new BIOS versions that can improve performance, 
stability and compatibility, add new features or modify existing features, and fix known bugs. These new 
BIOS versions are available for download on the manufacturer's website. I can't list all the manufacturer 
websites here, as there are far too many, however if you have a look through your motherboard manual you 
should see a relevant link to the appropriate website. Download the latest BIOS for your exact motherboard 
brand and model number and follow the instructions on the site to Flash (reprogram) the BIOS chip on your 
motherboard with this new BIOS version. A word of warning: flashing the BIOS is not to be taken lightly. If 
something does go wrong then your PC may not boot up and you may have to take your motherboard to a 
dealer to have the memory chip replaced. While this is rare, when updating your BIOS make sure you follow 
the instructions provided to the letter. 
 

FIRMWARE UPDATES 

Your motherboard is not the only device which has a BIOS. Many components, indeed most major electronic 
equipment like TVs and DVD players have their own inbuilt BIOS chips. The software on these chips is 
typically referred to as Firmware, and all firmware can be updated using the correct equipment and 
software. For consumer electronic equipment this is usually done by a qualified technician, but for PC 
components, it can be upgraded in much the same way as flashing your BIOS. You will need to check your 
manufacturer's website for more recent versions of the BIOS/firmware you require, and any specific 
instructions or software necessary. The most common firmware updates are for CD/DVD drives. If you want 
to find out more about these updates, see this Firmware Page. A firmware upgrade can help resolve 
problems like difficulties reading from a particular disk type, 'disk not detected' errors, and other issues. Just 
like BIOS flashing it involves an element of risk, so please read any instructions carefully before proceeding. 
 
The motherboard BIOS is a critical component of the PC which is often overlooked, so I urge you to take the 
time to become more familiar with your own BIOS, and to configure it correctly. Of course if you are not 
sure what a setting in the BIOS does, do not change it from its default. If necessary, contact your hardware 
manufacturer for more details. 
 
< INTERRUPT REQUESTS (IRQS) 

An important aspect of the way the BIOS manages your hardware is through Interrupt Requests (IRQs) - 
these are the way in which all of your major system devices get the CPU's attention for 
instructions/interaction as often as necessary. There are usually 16 - 24 main hardware IRQs in a modern PC. 
To view your current IRQ allocation go to Control Panel>System>Hardware>Device Manager and under the 
View menu select 'View Resources by Type', then expand the 'Interrupt Request' item. You will see all the 
devices currently active on your PC arranged by IRQ number, starting at 0 [System Timer]. Each IRQ has a 
priority assigned to it as to which gets the CPU's attention first when several are competing at once. While 
Windows XP is designed to allow several devices to share an IRQ, you may have problems or reduced 
performance if two or more major devices (such as the sound card and graphics card) share the same IRQ. 
To minimize IRQ sharing, try the tips below. 
 

DISABLE UNUSED DEVICES 

Under Windows XP, as this Microsoft Article explains, ACPI (Advanced Configuration and Power Interface) 
compliant systems - which is all modern PCs - will have their IRQs automatically allocated by Windows 
upon installation. Even if you manually reassign them in the BIOS (if the option exists), Windows XP 
typically assigns them back to the default IRQs it has chosen. This default assignment of the IRQs is done 
when Windows XP is first installed, and eight IRQs (IRQs 0, 1, 2, 6, 8, 9, 13 and 14) are automatically 
reserved for critical system devices on all PCs and cannot be altered or reassigned. 
 

http://en.wikipedia.org/wiki/Firmware�
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The best way to ensure that you are less likely to end up with shared IRQs (and potential problems) is to 
disable any unused devices in the BIOS before installing Windows XP. Some examples of common devices 
that can be disabled are: 
 
§ Serial Port1 (COM1) 
§ Serial Port2 (COM2) 
§ Parallel Port (LPT1) 
§ Game Port 
§ Midi Port 
§ Unused IDE Channels 
§ Unused SATA Channel 
§ RAID options 
 
Disabling unused devices not only frees up unreserved IRQs and reduces the chances of sharing, it can also 
speed up bootup time noticeably because Windows won't load up drivers for these devices. Clearly if you 
already have, or plan to have, a piece of hardware connected to any of these Ports, or need to use a particular 
device, then you should not disable them. For example if you have a printer which connects to the Parallel 
Port (LPT1) then disabling the Parallel Port in the BIOS is pointless as it will simply mean your printer will 
not function. If you have one or more IDE-based drives which connect to an IDE channel, then you cannot 
disable that IDE channel and expect the drives to work. You can always re-enable these devices in the BIOS 
at any time, so this is by no means a permanent disabling of particular devices. However you should only 
disable devices in the BIOS that you are certain will not be used during your normal Windows usage. 
 

MOVE CONFLICTING DEVICES 

If you are using an existing installation of Windows XP you can attempt to reduce IRQ sharing by physically 
moving a device. Note however that on certain motherboards particular IRQs are shared by default and 
cannot be changed. For example on many systems the USB Host Controller (for USB peripherals) is often on 
an IRQ shared by another fixed system device, such as your Serial ATA Controller - this is unavoidable and 
usually does not result in any problems. In such cases where you feel there may be a conflict or reduced 
performance, your only course of action is to physically move one of the items to another location on your 
system if possible. For example, if your sound card is sharing an IRQ with your graphics card, physically 
shift the sound card from one PCI slot to another free one; if the USB Host Controller is sharing with another 
device, avoid using the particular USB hub that controller relates to. If neither of the shared devices can be 
physically moved then you will have to accept the situation. Remember that Windows can share IRQs 
without major problems in most cases, so you shouldn't automatically assume that a shared IRQ is the 
source of any problems. 
 

DISABLING ACPI 

If the above methods do not work, there is one final method of reallocating IRQs short of reinstalling 
Windows. Since ACPI is one of the reasons why Windows XP automatically allocates IRQs, if you disable 
ACPI you can manually allocate and rearrange IRQs and hence remove any IRQ sharing. I strongly 
recommend that you do not disable ACPI, as the side effects are much worse than any potential problems 
IRQ sharing could cause. ACPI is there for a reason - disabling it can effectively destabilize your system and 
cause your components not to function correctly. The instructions provided below are for the sake of 
completeness, and for the truly desperate or the very curious: 
 
1. Backup all your important data before attempting this procedure as it is highly risky. 
2. Go into your Control Panel>System>Hardware>Device Manager and under the Computer component, 

double-click on the 'ACPI Uniprocessor PC' (or similar ACPI) device. 
3. Click the 'Update Driver' button, then select 'Install from a list or specified location'. 
4. Select 'Don't search. I will choose the hardware to install' 
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5. Untick the 'Show compatible hardware' box, and in the list below click on the 'Standard PC' option and 
select Next. 

6. The non-ACPI drivers will be installed and you will need to reboot your machine, perhaps several times, 
to redetect all your hardware components. Make sure to disable any ACPI options in your BIOS. 

7. You can now use any BIOS options available to manually assign IRQs to particular devices. Note that it 
depends on your particular BIOS as to how much flexibility you have in assigning IRQs to all the devices 
on your system; disabling ACPI doesn't suddenly add any new BIOS options. 

 
I can only repeat that disabling ACPI will cause a lot of problems, and you may not be able to return to using 
ACPI unless you reformat and reinstall Windows XP completely. 
 
 
If after all of the above procedures you still have major difficulties which you feel are attributable to IRQ 
sharing, you will have to simply reformat/reinstall Windows XP - making sure to first correctly configure 
your BIOS and disable all unused devices of course. 
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INSTALLING WINDOWS 
 
If you are going to do a full reformat and reinstall of Windows XP on your hard drive, follow the procedures 
in this chapter to find out more about your options, ensure the correct setup of your hard drive and get an 
optimal installation of Windows. 
 
 
< PRIOR TO INSTALLATION 

Here are some important things you should remember to do before formatting your hard drive and 
installing Windows: 
 
1. Scan for viruses and other malicious software - See the PC Security chapter. 
2. Backup your important data and passwords - See the Backup & Recovery chapter. 
3. Download any SATA/RAID drivers required during installation - See the Driver Installation chapter. 
4. Create some Windows XP Bootdisks if necessary - See further below. 
5. Read this Microsoft Article on partitioning and formatting hard drives. 
 
Here's a checklist of things you should have handy for a smooth installation of Windows XP: 
 
§ Your original Windows XP CD. 
§ Your Windows XP Product ID Number. 
§ An earlier 'Full Version' CD of Windows if you are using a Windows XP 'Upgrade Edition' CD. 
§ Your Windows XP Bootdisks if necessary. 
§ A disk containing a copy of the latest drivers and Service Pack 3 (SP3) - we want to minimize Internet 

usage immediately after installation, so it's best to have all the relevant core software ready to install on 
a separate disk. See the Driver Installation chapter for a list of all the major drivers and software needed. 

§ Any drivers which have to be installed during the Windows installation process - e.g. some 
motherboards require a floppy disk with SATA and/or RAID drivers to be used during the XP 
installation process in order to detect your hard drive(s) or RAID array correctly. Check your 
motherboard package for such disks, or download the drivers from your motherboard manufacturer's 
website and copy them onto a floppy. Note that if you're having problems with your nForce 
SATA/RAID drivers during installation, you can fix this using nLite (see below) along with these 
instructions. 

§ Your motherboard manual, a printout of relevant pages of this guide, and any other associated articles 
or guides below which you may need. Again since it's not recommended that you connect to the Internet 
immediately after installing XP for security reasons, ideally you should have offline copies. 

§ All your backups as well as any applications and games on CD/DVD. Also make sure to have software 
serial numbers or registration details handy. 

§ Pen and paper for recording passwords, registration numbers or other important information. 
 
Once you've gathered as much of this material as possible around you, familiarize yourself with all the 
information below before beginning the actual formatting and installation process. 
 

SLIPSTREAMING WINDOWS XP SP3 

If you own an older Windows XP CD that does not contain the latest Service Pack 3 (See the Driver 
Installation chapter) already built into it, you can create a new Windows XP Installation CD that neatly 
incorporates all the files from SP3 using a process called 'Slipstreaming'. When a slipstreamed XP CD is used 
for installation it automatically installs SP3 along with the rest of Windows XP, and hence you won't need to 
run SP3 separately after installation, nor do you need to worry about any outdated drivers/files being 
installed on your system first, or any SP3 installation problems. It's a detailed process, but relatively 
straightforward if you use nLite (see below). However using a slipstreamed CD is for installing Windows XP 

http://support.microsoft.com/kb/313348�
http://www.nliteos.com/faq.html#Q2�
http://www.nliteos.com/faq.html#Q2�
http://www.nliteos.com/faq.html#Q2�
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SP3 is not vital, so if you don't feel comfortable doing it you can skip this step. Note that you shouldn't 
slipstream XP SP3 from within Windows Vista as this will result in installation problems due to a bug. 
 

NLITE 

nLite is a free utility for customizing Windows XP prior to installation. It allows you to select the 
component(s) you wish to remove from Windows, as well as things you would like to add, such as SP3 or 
SATA/RAID drivers. Once you have integrated the relevant components and removed the components you 
don't need, nLite generates an ISO file which you can burn onto CD and use as your Windows installation 
disk. 
 
Personally I'm a traditionalist and I still recommend installing Windows XP as normal, then manually 
installing or uninstalling the relevant components. This is the only way to guarantee that things work as 
intended - in particular I recommend against removing core Windows components like Internet Explorer or 
Windows Media Player, as you may need them in the future. Don't fall into the trap of thinking that it's cool 
to strip out virtually every component of Windows and replace it with a third-party alternative - often times 
the Windows version of an application is not only required, it is actually the best method of viewing 
particular content.  
 
However nLite is a very handy utility and well worth downloading and investigating. It won't be covered in 
detail here as the user interface is quite intuitive to use, and if you need additional help check the nLite 
Forums. With some time and effort, and in conjunction with the information presented throughout this 
guide, you can create your own customized nLite Windows XP install disk which has everything the way 
you want it. 
 
< PREPARING THE HARD DRIVE(S) 

Before commencing the formatting of your hard drive to prepare it for Windows XP installation, read 
through the details below on the various options available to you when formatting a hard drive. Take the 
time to research this aspect of Windows installation carefully. 
 

NTFS VS. FAT 32 FILE SYSTEMS 

During the formatting of your hard drive, you will be asked whether you want to use the NTFS (NT File 
System) or FAT32 (File Allocation Table) File System for the drive. This is an important choice and the 
answer generally depends on your requirements: 
 
Use FAT32 if 
§ Your hard drive is smaller than 32GB. 
§ You want to install more than one operating system on your computer (aside from Windows Vista). 
 
Use NTFS if 
§ Your hard drive is larger than 32GB and you are running only one operating system on your computer. 
§ You want enhanced file security. 
§ You need better disk compression. 
 
For more details of the differences read this FAT & NTFS File Systems Article. Essentially NTFS is a newer, 
more stable and much more secure file system that has several benefits FAT32 doesn't. For example, if you 
format your hard drive in NTFS and password protect it, it is more difficult to access the information on the 
drive without the correct password (but still possible - see the Backup & Recovery chapter). As for the speed 
difference, for larger drives it is negligible. For more technical details on NTFS, see this NTFS Article. In 
short there is no real reason to format your drive in the older FAT32, unless you have a very small drive 
and/or want to install more than one Operating System on it - particularly an older version of Windows. For 
most everyone NTFS is the recommended file system. 
  

http://www.nliteos.com/�
http://www.msfn.org/board/nLite-f89.html�
http://www.msfn.org/board/nLite-f89.html�
http://www.msfn.org/board/nLite-f89.html�
http://aumha.org/win5/a/ntfs.htm�
http://www.digit-life.com/articles/ntfs/�
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CONVERTING EXISTING FAT32 DISK TO NTFS 

If you already have a FAT32 drive and don't want to reformat just to use NTFS, you can still convert the 
drive to NTFS using the Windows Convert tool - however note that this may result in a sub-optimal cluster 
size, especially for drives formatted in FAT32 under older versions of Windows. To set an optimal cluster 
size you will have to read this Converting Fat32 to NTFS Guide. 
 
The following is the simple (but not optimal) method of converting an existing Windows XP FAT32 
installation to NTFS: 
 
1. Go to Start>Run and type "cmd" (without quotes), then press Enter. 
2. In the Command Prompt which opens, type "Convert C: /FS:NTFS" (without quotes) and press Enter. 

Substitute the correct drive letter in place of C: above if it is different. 
3. Enter the name of your hard drive when prompted. If you don't know the name of the drive, type "Vol 

driveletter" (without quotes - e.g. Vol C:) to find it out. 
4. Reply Y to each of the prompts. Reboot if prompted. 
 
This will take some time to complete, so leave your system alone until the process is finished. 
 

MULTIPLE PARTITIONS 

During the formatting of your hard drive, you have the option of also Partitioning your hard drive. 
Partitions are simply fenced-off portions of a hard drive. By partitioning a drive you can effectively divide a 
single hard drive into several smaller logical drives of varying size, each with their own drive letter. For 
details on the potential advantages, disadvantages and optimal methods for partitioning, see this Partition 
Strategy Guide. If you're still not certain and you just want to install Windows on a single hard drive, I 
strongly recommend having a single partition (the default setup) as this keeps things simple and 
performance will be optimal. 
 
On any hard drive the first Primary partition is always the fastest, and performance is still limited by how 
fast the single hard drive head can seek (move around to read or write) information. It can't be in two places 
at once, whereas with two physically separate hard drives, each hard drive's head can seek information 
independently, such as one drive reading game information while the other concurrently reads/writes 
virtual memory information in the pagefile. Therefore partitioning is not a true substitute for having two or 
more drives, it is most useful as an organizational tool. For example one of the major reasons you may wish 
to create multiple partitions is to allow you to dual boot with Windows XP and Windows Vista, as discussed 
further below. This allows you to run Vista along with XP on the same hard drive for example, but 
completely separated from each other. 
 
Keep in mind that using multiple partitions on the same drive for backup purposes is not a good substitute 
for having backups of your important data on CD/DVD or another hard drive. Hard drives can and do 
become physically corrupted and this affects data on all partitions of a drive, so backing up from one 
partition to another on the same hard drive as your main backup strategy is not appropriate. 
 
It is ideal to format and partition a hard drive prior to starting Windows installation, and you can do this 
either using a third party tool or you can use the built-in formatting and partitioning functionality of XP as 
detailed in this Microsoft Article. If you use multiple partitions across a range of hard drives and you are 
after a utility that will make partition management easier, the most reputable one is Norton Partition Magic. 
It is not free, and I will not be covering it in detail here, however if you wish to undertake complex 
partitioning of your hard drive(s) it is a worthwhile investment. 
  

http://aumha.org/win5/a/ntfscvt.htm�
http://en.wikipedia.org/wiki/Partition_(computing)�
http://partition.radified.com/�
http://partition.radified.com/�
http://partition.radified.com/�
http://support.microsoft.com/kb/309000�
http://www.symantec.com/norton/products/overview.jsp?pcid=sp&pvid=pm80�
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DUAL BOOT/MULTIBOOT SYSTEM 

If you want to set up your system so that each time you bootup you get the choice of two or more Operating 
Systems to use - such as Windows XP and Windows Vista - read this Microsoft Article and see this Vista 
Multiboot Site for instructions. You will need to have at least two or more partitions on your current hard 
drive and/or have two or more hard drives to be able to multiboot. If dual booting with Vista, you should 
boot up into Windows XP first, insert the Windows Vista DVD and run Vista setup from there. This ensures 
that Vista will 'see' your existing Windows XP installation and configure the boot menu properly to give you 
the choice of booting into either OS. Importantly, if you run SATA or RAID hard drives, for Vista to correctly 
identify all of your hard drives prior to installation and correctly configure the dual boot, you must have 
appropriate SATA/RAID drivers on a floppy disk or CD/DVD and insert them during the hard drive 
identification stage of Windows Setup. For more details of dual booting with Vista, see the Windows 
Installation chapter of the TweakGuides Tweaking Companion for Vista. 
 
Note that there are no performance benefits in dual or multibooting - it is normally done if you use software 
or a particular feature that only works under another operating system for example. Once again, unless you 
specifically require this functionality I do not recommend a multiboot system. 
 

RAID CONFIGURATION 

RAID (Redundant Array of Independent Disks) is a common method of configuring multiple hard drives to 
perform better and/or provide better protection against data loss than a single hard drive. The various RAID 
levels are best demonstrated in this RAID Article - click the numbers at the top right of the article to see the 
various RAID levels demonstrated graphically, including RAID 0, RAID 1, RAID 5 and RAID 0+1. 
 
To set up a RAID array you need two or more hard drives, preferably of the same size and speed, and a 
motherboard with RAID support. You will then need to install the drives as normal and configure the 
appropriate RAID options in your motherboard's BIOS (include any 'RAID BIOS' options) - see your 
motherboard manual for instructions. If your motherboard supports RAID, there is no additional hardware 
required, it is all driven by Windows and the motherboard. Once configured correctly, the RAID 
configuration of multiple drives will be seen as a single large hard drive by Windows, and treated as such. 
 
To determine which RAID configuration best suits your needs, you will need to read the articles linked 
above and consider your most common PC tasks. The most commonly used RAID array is a pair of similar 
drives in RAID 0 formation, which provides the best all-round performance at minimal cost. RAID 0 usually 
beats a single hard drive configuration in terms of speed, particularly for gaming or large file movements, 
due to there being two independent drive heads constantly seeking data in place of one. However RAID 0 
also provides absolutely no fault tolerance at all, meaning if one of the drives suffers a serious error or is 
damaged, you lose all the data on both drives since the data is split evenly ('striped') across both drives. 
Therefore if you require stronger protection against data loss, you might want to consider a RAID 5 
configuration which is more costly, but far safer and still provides good performance for desktop PC usage. 
 
While setting up striped RAID arrays - that is, RAID arrays which split data evenly across two or more hard 
drives (such as RAID 0 or RAID 5), you will need to determine a Stripe Size to be used in your RAID BIOS. 
In general, if you are uncertain of the size to choose, use the Auto setting (if available) or a 64kb stripe. If you 
use the drives primarily for gaming I suggest a smaller stripe size of 16kb, as in my experience this can assist 
in reducing stuttering in games. 
 
In any case once you have connected your drives and set up your RAID array using the options in the 
motherboard's BIOS, you will need to have a floppy disk, CD or DVD handy with the correct RAID drivers 
prior to starting the Windows XP installation procedure. Then during Windows Setup, press the F6 key 
repeatedly when prompted at the bottom of the screen, and enter your driver floppy when prompted again 
and load up the RAID drivers, along with any other drivers (such as SATA drivers) as necessary. If you miss 
this step, the RAID hard drives will not be correctly detected by Windows as one large hard drive, and you 

http://support.microsoft.com/kb/217210�
http://www.multibooters.co.uk/�
http://www.multibooters.co.uk/�
http://www.multibooters.co.uk/�
http://en.wikipedia.org/wiki/RAID�
http://www.acnc.com/04_01_00.html�
http://www.pcguide.com/ref/hdd/perf/raid/concepts/perfStripe-c.html�
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will not be able to install Windows on them properly or you will break the RAID array and lose the benefits 
of RAID. 
 
Once XP is installed on your RAID drives, from that point onwards there are no special considerations as 
such; the drives are treated as one large normal hard drive for all intents and purposes in Windows. 
 
< INSTALLING WINDOWS 

At this point you are ready to begin the actual format and installation process, which differs depending on 
whether you're using a brand new/freshly formatted hard drive as opposed to a hard drive with an existing 
installation of Windows. See the relevant section below: 
 

NEW HARD DRIVE 

If you have a new or blank formatted hard drive, the entire procedure for installing Windows XP is 
relatively straightforward. Follow these steps: 
 
1. If it is not already in your system, connect the hard drive to your system by following the instructions 

that came with the drive. Typically this involves turning off your PC, plugging into the back of the drive 
both a power connector and either a wide IDE ribbon cable, or a thin SATA cable. 

2. Start your system, go into your BIOS and make sure the hard drive is being detected, whether on one of 
the IDE Channels, or as a SATA device - whichever is relevant to the particular type of hard drive and 
channel it's connected to. If the hard drive is not detected at all in the BIOS, you cannot install Windows 
XP on it. Look around the BIOS and make sure you've enabled the channel on which the drive is 
connected. You may have to re-check your drive cabling (i.e. SATA/IDE cable and power cable), and 
also whether any small switches on the back of the hard drive are set correctly (e.g. the main hard drive 
is typically set as the Master on the Primary Channel). In some cases (mainly for SATA or SCSI drives 
and/or RAID configurations) you will have to insert a driver disk into the floppy drive to load up 
appropriate hard disk drivers during Windows installation, so have those handy if need be and proceed 
with the next step. 

3. Insert your Windows XP CD into your CD/DVD drive, and reboot your system. 
4. Upon rebooting your system, since the hard drive does not have an operating system installed, the 

computer will skip loading from it and instead will attempt to boot from the next boot device - which 
should be the Windows XP disk in the CD/DVD drive - and should lead to the blue Windows Setup 
screen. If that doesn't occur, check your BIOS settings to ensure that firstly the relevant CD/DVD ROM 
drive is being detected as present on your system and that any option for 'First Boot Device' or 'Second 
Boot Device' (or similar) is set to CDROM. 

5. From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or 
Windows XP Home Installation Guide as relevant. These guides cover the procedure in far more detail 
(including screenshots for every step of the way) than I can do here due to space considerations. You 
should ideally have a printout of them handy for use during the installation. 

 
HARD DRIVE WITH EXISTING INSTALL OF WINDOWS 

If you have a hard drive with a current installation of any version of Windows on it, follow the steps below 
to begin a reformat and subsequent installation of Windows XP. Note you shouldn't just install Windows XP 
over an existing installation of Windows - start afresh with a full reformat of your hard drive and a fresh 
installation of Windows XP otherwise you will get sub-optimal results and experience many problems: 
 
1. Insert your Windows XP CD into your CD/DVD drive. 
2. Reboot and go straight into your BIOS settings. Set the 'First Boot Device' (or similar) option in the BIOS 

to CDROM. Reboot your system. 
3. As your PC starts booting up keep pressing the F8 key repeatedly until you see a message saying 

'Booting from CDROM' (or similar). 
4. The blue Windows Setup screen will eventually appear.  

http://www.theeldergeek.com/xp_pro_install_-_graphic.htm�
http://www.theeldergeek.com/xp_home_install_-_graphic.htm�
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5. From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or 
Windows XP Home Installation Guide as relevant. 

6. Make sure that you choose to format the hard drive and do a clean installation of Windows XP. Again, 
do not install Windows XP over an older version of Windows as an 'upgrade' installation (not to be 
confused with the Windows XP Upgrade Edition which is fine) - start with a new installation of 
Windows XP. 

 
WINDOWS XP BOOTDISKS 

If you still can't get to the Windows Setup screen using the instructions above, you can download a 
Windows XP Bootdisk image from the Microsoft site for your particular version of Windows XP as covered 
in this Microsoft Article. If you still have problems booting into Windows setup, or you just want an older 
version of a bootdisk, go to this Bootdisk Site to download free copies of various bootdisk versions. 
 

http://www.theeldergeek.com/xp_pro_install_-_graphic.htm�
http://www.theeldergeek.com/xp_home_install_-_graphic.htm�
http://support.microsoft.com/kb/Q310994�
http://www.bootdisk.com/�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  42 
 

W
indow

s Product A
ctivation &

 W
indow

s G
enuine A

dvantage 

WINDOWS PRODUCT ACTIVATION & 
WINDOWS GENUINE ADVANTAGE 
 
< WINDOWS PRODUCT ACTIVATION 

One of the first things you will notice after installing Windows XP is the Windows Product Activation 
(WPA) notice. Even if you skip Activation at Windows startup and go to the Windows Desktop, a little 
popup balloon in the System Tray tells you that you have 30 days left to activate Windows XP, and when 
you click on it, it provides various options for activation. Windows Product Activation is a protection system 
Microsoft uses to ensure that Windows piracy is reduced. If you're interested in the facts about Windows 
Activation, how it works and what parameters it checks on your system I recommend you read this detailed 
Windows Product Activation Guide and download this Technical Details of Activation document. 
 
Ideally if you've just installed Windows XP I recommend that you don't change any of your hardware - aside 
from attaching some peripherals. For performance and stability reasons major hardware changes (e.g. those 
involving your CPU, motherboard or graphics card) are best made prior to XP installation. If you are aware 
that your hardware setup may undergo some further changes shortly, it is recommended that you don't 
activate Windows XP right away. You have 30 days within which to bed down your final hardware 
configuration. Activating before your hardware setup is finalized could see you having to re-activate 
repeatedly, including having to call Microsoft to complete Activation. 
 
If you are certain that the major hardware components of your system are not going to change soon and/or 
that you are not going to reinstall Windows XP again shortly, then go ahead and activate XP. Otherwise 
ignore the constant nagging Activation gives you and wait until your system configuration is finalized 
before going through with Activation. Microsoft views multiple activations in a very short period of time as 
suspicious - precise details of this are in the links above. 
 
Something you can do after you have activated Windows XP is to backup your wpa.dbl file, found in the 
\WINDOWS\system32 directory. This file is the Windows Product Activation system file, and should your 
installation of Windows XP become corrupted and you need to attempt a recovery (See the Backup & 
Recovery chapter), you can use this backed up file to help in restoring your system. 
 
 
< WINDOWS GENUINE ADVANTAGE 

Microsoft has implemented an additional anti-piracy feature into Windows called Windows Genuine 
Advantage (WGA). Any time Windows attempts to connect to Windows Update or download certain 
Microsoft updates, it may be asked to validate itself to make sure it is a legitimate copy. If validation fails, 
the user cannot download updates from Windows Update, and can only download critical security updates 
through the Microsoft Download Center or through the Automatic Update service (See the Control Panel 
chapter).  
 
If you are having problems with WGA on a legitimate installation of Windows, visit the Windows Genuine 
Advantage Diagnostic Site to run through a set of diagnostic procedures which can help fix the issue. In 
particular, if you use Firefox as your main browser, Microsoft has released a Firefox plugin to allow WGA to 
work on this popular browser. 
 
Please note I will not provide any information on how to view or change your Windows Product Key, or 
how to bypass Windows Product Activation or Windows Genuine Advantage. If you experience problems 
with these particular features on a legitimate installation of Windows XP, the only correct course of action is 
to contact Microsoft Technical Support for your particular country. 
 

http://www.microsoft.com/piracy/mpa.aspx�
http://aumha.org/win5/a/wpa.htm�
http://download.microsoft.com/download/2/1/6/21654b16-6c81-4d96-9390-5203cd43d07d/WindowsProductActivationTechnicalMarketBulletin.doc�
http://www.microsoft.com/genuine/ProgramInfo.aspx?displaylang=en&tab=XP�
http://www.microsoft.com/genuine/ProgramInfo.aspx?displaylang=en&tab=XP�
http://www.microsoft.com/genuine/ProgramInfo.aspx?displaylang=en&tab=XP�
http://www.microsoft.com/downloads/Browse.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date�
http://www.microsoft.com/genuine/diag/�
http://www.microsoft.com/genuine/diag/�
http://www.microsoft.com/genuine/diag/�
http://www.microsoft.com/genuine/downloads/Validate.aspx�
http://www.microsoft.com/worldwide/�
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DRIVER INSTALLATION 
 
Device drivers are the software which give instructions to your system on how to deal with particular 
hardware. Graphics drivers for example tell your graphics card what to do in various situations, such as 
during 3D applications and games, as well as translating information to and from your CPU. While 
Windows comes with built-in driver support for virtually any type of common computer hardware, and 
hence most of your hardware will operate in Windows even without installing additional drivers, the built-
in drivers are neither optimal, nor do they guarantee stability or full compatibility under certain situations. 
Thus, you need to download and install the latest device drivers for your hardware to make sure your entire 
system performs optimally and with stability. 
 
The instructions below cover both the initial installation order of drivers on a fresh install of Windows, as 
well as being a list of which drivers and core software to install on an existing installation of Windows XP. 
The chapter also contains some general tips to clarify which types of drivers should be installed and why. 
 
 
< DRIVER INSTALLATION 

The first thing you should do with a fresh installation of Windows XP is to install the core system software 
and drivers that are vital in helping to run XP optimally. Installing these prior to anything else, and in the 
correct order, is key to reducing the chance of any problems and also ensuring peak performance. 
 
Note that during installation of these drivers, if you are prompted to reboot at any time, you must do so to 
allow proper driver installation. The reason for this is that some driver files are currently loaded into 
memory areas that are used by the system and protected from being overwritten by a different version. Thus 
they cannot be replaced without Windows first marking them for replacement, rebooting to remove them 
from memory, and subsequently replacing them with the newer version upon successful loadup of 
Windows. Therefore whenever Windows asks you to reboot after installing any driver or application, you 
should do so as soon as possible. 
 
If starting with a fresh installation of Windows, I recommend you download the following software and 
drivers in advance of reformatting and reinstalling Windows XP as for security reasons you should try to 
minimize your Internet usage at this point. If you have a permanent connection to the Internet and it is 
already enabled straight after installing XP, first follow the procedure in Step 8 further below to turn on the 
built-in Windows XP Firewall before following the rest of these steps. If you are using nLite (See the 
Installing Windows chapter), make sure to read this chapter and download the latest versions of all the 
relevant drivers below, however obviously once you've installed XP using your nLite install disk with 
integrated drivers, you don't need to follow these steps again. 
 
The initial core software installation process is provided below in order of first to last, starting immediately 
after you've installed Windows XP. If you're using an existing installation of XP, you should still follow these 
steps, installing/updating the relevant drivers which you may have missed previously. 
 

STEP 1 -  SERVICE PACKS 

Install the full version of Windows XP Service Pack 3 (SP3). A Service Pack is a compilation of important 
security, stability and performance updates for Windows, and SP3 is the latest Service Pack for Windows XP 
32-bit, containing every major Windows update released up to April 2008. You can read about the updates 
and types of changes it contains here. SP3 also contains all the fixes contained in SP1 and SP2, though note 
that you can install SP3 on a system which already has SP1 or SP2 installed on it. However SP3 can't be 
installed directly on an original pre-SP1 copy of Windows XP - you need to either install SP1 first; use an 
original Windows XP SP1 or SP2 CD to install XP; or use a Slipstreamed XP + SP3 install CD. 
 

http://www.microsoft.com/downloads/details.aspx?FamilyID=68c48dad-bc34-40be-8d85-6bb4f56f5110&displaylang=en�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  44 
 

D
river Installation 

You can download and install SP3 via Windows Update, or download and use the full standalone SP3 
package from here: Windows XP SP3. The standalone version is recommended as it should be the least 
problematic method of applying the Service Pack. Obviously if you used a Windows XP CD which already 
has SP3 incorporated into it to install Windows, such as a Slipstreamed XP + SP3 CD you've created with 
nLite (See the Windows Installation chapter), then you don't need to undertake this step as all the relevant 
SP3 files were automatically installed along with Windows XP. 
 

STEP 2 -  DIRECTX 

Install the latest version of DirectX from here: Microsoft DirectX. DirectX is already built into Windows XP, 
but you will need to install the very latest version of it to ensure maximum performance, security and 
compatibility with the latest programs and games. In fact many recent games come with the latest build of 
DirectX 9.0 on their disk, so check to see if that is the case and save yourself the extra download.  
 
Note that DirectX 10 is a version of DirectX designed solely for Windows Vista and Windows 7 and is not 
compatible with Windows XP, so any program or game which requires DX 10 can only be run on Windows 
Vista or Windows 7. 
 

STEP 3 -  DRIVER SIGNING & WINDOWS UPDATE 

Driver Signing is meant to ensure that the drivers being installed are verified as being authentic and are 
certified to work with Windows XP. However in practice, almost all unsigned drivers are perfectly fine to 
use, as long as you have downloaded them from your hardware manufacturer's website, or from another 
trusted source. Prior to installing any other drivers go to Start>Control Panel>System>Hardware and click on 
the 'Driver Signing' button. In the Driver Signing Options screen make sure 'Warn - Prompt me each time to 
choose an action' is selected so that unsigned drivers are not automatically blocked, and you will be asked to 
choose whether to install them. Then tick the 'Make this action the system default' box and click OK. 
 
If you click the 'Windows Update' button under Start>Control Panel>System>Hardware you will see several 
options which determine Windows behavior whenever you connect a new device, or a new device is initially 
detected. To start with I recommend selecting 'Never search Windows Update for drivers' and click OK. This 
is because to start with, you don't want any potentially out-of-date drivers on Windows Update installing on 
your system until you've had the chance to manually install the latest drivers for each major device as per 
the steps below. Once you've followed all the steps up to Step 8, you can then come back and set this option 
to 'Ask me to search Windows Update every time I connect a new device' if desired, or leave it to never 
search if this behavior bothers you. Again, the drivers on Windows Update are generally a bit older than the 
latest available, so manual updating of drivers is necessary, and then only if newer drivers are found on 
Windows Update should you install them. 
 

STEP 4 -  MOTHERBOARD DRIVERS 

Install your motherboard drivers. The motherboard is the hardware foundation of your entire system, so 
using the latest drivers for it is important in achieving optimal, trouble-free performance for your entire 
system, as well as providing additional motherboard-specific functionality such as onboard audio, onboard 
Network adapter, RAID, and so forth. 
 
When dealing with motherboard drivers it's important to understand that the motherboard chipset type is 
not the same as the motherboard brand or model number. The chipset type is based on the company that 
manufactures the actual chipset architecture used in the motherboard. The motherboard's brand is based on 
the company that buys this chipset, packages it with certain features and sells it under its own brand name 
with a specific model number. For example, a Gigabyte GA-965P-DS3 motherboard is manufactured by a 
company called Gigabyte, it uses an Intel P965 chipset and it has the specific model number GA-965P-DS2. A 
combination of the utilities covered in the System Specifications chapter, along with your motherboard 
manual and Google will give you all the details you need about your motherboard. 
 

http://www.microsoft.com/downloads/details.aspx?FamilyID=5b33b5a8-5e76-401f-be08-1e1555d4f3d4&DisplayLang=en�
http://www.microsoft.com/downloads/details.aspx?familyid=2DA43D38-DB71-4C1B-BC6A-9B6652CD92A3&displaylang=en�
http://technet.microsoft.com/en-us/library/bb491036.aspx�
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Your motherboard usually comes with a driver disk which contains the relevant drivers, however these are 
usually out of date. The first place you should look for the latest version of these drivers is on your 
motherboard manufacturer's website - there are too many to list here, so check your motherboard manual 
for links. Once at the site, you will need to look for chipset drivers for your motherboard model, as these are 
the core drivers which control your motherboard's key functionality - download and install the latest version 
of these. If you also wish to utilize other functions on your motherboard, such as onboard audio or video (if 
you're not using standalone sound and/or graphics cards), a RAID drive configuration, or onboard LAN, 
then also download and install the latest version of the relevant drivers as well. Note that if you're not using 
any of these functions on your motherboard, I strongly recommend disabling them in your BIOS as 
discussed in the BIOS Optimization chapter. 
 
If the drivers on your motherboard manufacturer's site appear to be fairly old, then you can download the 
latest chipset drivers directly from the chipset manufacturer: 
 
§ For Intel motherboards, download and install the latest Intel Chipset Software. If you have a RAID drive 

or AHCI setup also install the Intel Matrix Storage Manager. 
§ For Nvidia motherboards, download and install the latest nForce Drivers. 
§ For VIA motherboards, download and install the latest VIA Hyperion Drivers. 
§ For SiS motherboards, download and install the latest SiS Chipset Software. 
 
Finally, remember that motherboard chipset drivers are not the same as a motherboard BIOS. The 
motherboard drivers are Windows drivers that control the way the motherboard communicates through its 
various components under Windows, the same as graphics drivers or sound card drivers for example. The 
BIOS on the other hand is not dependent on Windows at all and operates at the machine level to control the 
motherboard's behavior the second your PC starts booting up. See the BIOS Optimization chapter for more 
details. 
 

STEP 5 -  GRAPHICS DRIVERS 

Install your graphics card video drivers. Just as with motherboards, graphics chipsets are usually sold to 
different manufacturers who then package them together with certain features and capabilities and market 
them under their own brand name. The important thing to know is the manufacturer of the chipset on which 
your graphics card is based - for most graphics cards this will be either Nvidia or ATI. For example, an 
EVGA 8800GTX graphics card uses an Nvidia GeForce 8800 series chipset packaged and sold by the 
company EVGA under its own brand. The chipset is the determinant of which driver to use, not the 
company selling the card. Determine your chipset using the utilities in the System Specifications chapter, 
then download and install the relevant package: 
 
§ For Nvidia graphics cards, download and install the latest Forceware Graphics Drivers. For details on 

how to install and set these up correctly read my Nvidia Forceware Tweak Guide. 
§ For ATI graphics cards, download and install the latest ATI Catalyst Drivers. For details on how best to 

install and set these up correctly read my ATI Catalyst Tweak Guide. 
§ For SiS graphics cards, download and install the latest SiS GPU Graphics Drivers. 
§ For S3 graphics cards, download and install the latest S3 Graphics Drivers. 
§ For Matrox graphics cards, download and install the latest Matrox Graphics Drivers. 
§ For XGI graphics cards, download and install the XGI Graphics Drivers. 
§ For motherboards with onboard graphics, the latest drivers for these are usually found on your 

motherboard manufacturer's website - see Step 4 above. 
 
Note that unlike motherboards, you do not need to download your graphics drivers from your hardware 
manufacturer's website. Installing the latest 'reference' chipset drivers shown above is the best method, and 
will not cause any problems. 

http://downloadfinder.intel.com/scripts-df-external/Product_Filter.aspx?ProductID=816&lang=eng�
http://downloadfinder.intel.com/scripts-df-external/Product_Filter.aspx?ProductID=2101&lang=eng�
http://www.nvidia.com/Download/index.aspx�
http://www.viaarena.com/Default.aspx?PageID=2�
http://www.sis.com/download/�
http://www.nvidia.com/Download/index.aspx�
http://www.tweakguides.com/NVFORCE_1.html�
http://support.amd.com/us/gpudownload/Pages/index.aspx�
http://www.tweakguides.com/ATICAT_1.html�
http://www.sis.com/download/�
http://www.s3graphics.com/en/products/vista/index.jsp�
http://www.matrox.com/mga/support/drivers/latest/home.cfm�
http://www.xgitech.com/sd/sd_download.asp�
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STEP 6 -  SOUND DRIVERS 

Install your Sound card audio drivers. These vary depending on the brand of the sound card you are 
running. Only the major brands are covered below: 
 
§ For Creative sound cards, download and install the latest Creative Audio Drivers. 
§ For ASUS sound cards, download and install the latest ASUS Audio Drivers. 
§ For Auzentech sound cards, download and install the latest Auzentech Drivers. 
§ For Turtle Beach sound cards, download and install the latest Turtle Beach Audio Drivers. 
§ For Hercules sound cards, download and install the latest Hercules Audio Drivers. 
§ For AOpen sound cards, download and install the latest AOpen Audio Drivers. 
§ For motherboards with onboard audio (e.g. AC '97 or HD Audio) the drivers for these are usually found 

on your motherboard manufacturer's website - see Step 4 above; or for newer drivers see your onboard 
audio chipset manufacturer's website (e.g. Realtek). 

 
STEP 7 -  PERIPHERAL DRIVERS 

Before installing any peripheral drivers, connect these devices (e.g. Mouse, Printer, Digital Camera) to your 
system and test their functionality. If they appear to work fine and all the major functions which you would 
use are intact, then do not install a new driver for them. For example, if you connect an optical mouse and it 
appears to have sufficient functionality, do not then install the drivers that come on the CD with the mouse, 
or download and install new drivers from the manufacturer's website. The reason for this is that such drivers 
typically need to load into the background at Windows startup and usually add to overall resource usage, 
increase boot times, and quite often don't add anything of real value to the device's function. XP already 
supports the important basic functionality of most major peripherals without the need for additional drivers. 
 
However obviously should your device not function correctly, or a feature that you need to use appears 
disabled, you will then need to install the latest driver for that device. In that case I recommend you go to the 
device manufacturer's website and download the latest available drivers rather than using the older drivers 
that come on the disk with the device. There are far too many device manufacturers to list here, but the 
website address is usually prominently listed on the device's box and/or in the manual. Where possible 
follow the device installation instructions in the device's manual (or on its website) for the best method of 
installation. Typically this involves connecting the devices to your machine one by one, and when Windows 
detects them and prompts for drivers, insert the appropriate driver disk or point Windows to the directory 
where you have downloaded the latest driver files for the device and continue from there. 
 
If you have an older device which is not compatible with Plug and Play, or your device isn't being detected 
correctly, see the Add Hardware section under the Control Panel chapter for more details of how to 
manually install such a device. 
 

STEP 8 -  FIREWALL, WINDOWS UPDATE & .NET  

You will need a connection to the Internet for this step. That means your network adapter or modem must 
be installed and set up correctly - refer to your modem/network adapter's documentation as each has unique 
setup procedures and requirements. You must also have your ISP (Internet Service Provider) details handy 
(e.g. username, password, configuration scripts, access number, proxy settings, port numbers, etc.). Once 
you have installed the modem or network adapter, and prior to connecting to the internet, you must enable a 
Firewall. A firewall prevents malicious access to your machine via the Internet, and your network device 
may already have a built-in firewall. However to start with, enable the Windows XP Firewall if you're not 
sure. 
 
To enable the default Windows XP Firewall, which is recommended for most purposes, go to the Windows 
Control Panel, open the Windows Firewall component and on the main screen of the Firewall settings, make 
sure it is set to On. Now you can safely connect to the Internet, but do not visit any other website, nor check 
your email, or download any programs. Go directly to the Windows Update website, either by clicking the 

http://support.creative.com/�
http://support.asus.com/download/download.aspx?SLanguage=en-us�
http://www.auzensupport.com/site/download/updates.php�
http://support.turtlebeach.com/site/support/kb.asp�
http://ts.hercules.com/eng/index.php?pg=files_faq�
http://download.aopen.com.tw/Default.aspx�
http://www.realtek.com.tw/downloads/�
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Windows Update icon in your Start menu, or by going to Internet Explorer>Tools>Windows Update, or by 
clicking this Windows Update link. Once on the Windows Update site, click the 'Custom' link and wait for 
the scan to finish. Note that Windows Update will only work on Internet Explorer by default - it will not 
have full functionality on other browsers. See the Internet Explorer chapter for more details of Windows 
Update. 
 
You will notice that after selecting a Custom scan, all the 'High Priority Updates' items have automatically 
been added to your 'Review and install updates' list. It is important that you install all of these critical 
updates for security, stability and compatibility purposes. Under the 'Optional Software' section, you should 
also add any fixes or updates you see which are relevant to the programs or features you use or wish to use. 
Note in particular that certain programs and drivers have a user interface which has been developed using 
Microsoft's .NET Framework. This means that for these drivers to function correctly, you will need to install 
.NET on your machine. You can download and install the latest .NET Framework through Windows Update, 
or download it separately here: .NET Framework Version 3.5. ATI graphics card users in particular will find 
that the latest ATI Catalyst graphics drivers require .NET 2.0 or higher for the Catalyst Control Center to 
work. 
 
Finally, add in all 'Optional Hardware' updates shown, as these are important updates of drivers for the 
hardware on your system. They are all safe to use and should only be available for installation if they are 
newer than the drivers you are currently using for your device(s). You can (and should) install newer 
versions of hardware drivers over these versions if and when they become available in the future. 
 
Once you've added all the relevant updates, click the 'Install Updates' button. It may take quite some time 
for the various updates to download and install depending on your internet connection. Reboot as often as 
prompted. Don't install any other applications or games, and don't browse any other websites yet - go 
straight to the PC Security chapter. 
 
< GENERAL DRIVER INSTALLATION 

THE LATEST DRIVERS 

The drivers installed on your system need to be kept up to date, so regularly check all the sites linked to 
above and make sure you have the latest versions. To check the current driver version on a particular 
component, go to Control Panel>System>Hardware>Device Manager and expand the various categories. For 
each device, right-click on it and select Properties, then under the Driver tab look at the Driver Provider and 
Driver Version details. Alternatively, check the System Specifications chapter for automated system tools 
which can give you this information. 
 
I usually announce major driver releases on the front page of TweakGuides so check there regularly for 
download links and details of the changes in the latest drivers. 
 

UNINSTALLING DRIVERS 

Before installing any new drivers, always make sure to go to 'Add or Remove Programs' under the Control 
Panel and uninstall any previous drivers for the relevant device, then reboot Windows. Furthermore, you 
can use the Driver Sweeper utility to attempt to remove any remaining traces of particular drivers. Launch 
the utility, tick the driver(s) you wish to remove, click the Analyze button first to see what will be removed. 
Then if you wish to continue, click the Clean button and reboot your PC to make sure all driver files and 
related registry entries are removed. If you really want to remove all possible traces of previous drivers, use 
the Autoruns utility to identify and remove individual driver files which may be resident on your drive after 
uninstallation - see the Startup Programs chapter for more details. 
 
This 'clean install' method ensures that your system is free of any 'driver residue' - leftover components of 
previous driver versions which may cause conflicts with newer drivers.  
  

http://windowsupdate.microsoft.com/�
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INSTALLING NON-EXECUTABLE DRIVERS 

Device drivers in .EXE format only need to be executed to automatically install the drivers. However drivers 
which come as a collection of files in archived format (i.e. .ZIP, .ACE, .TAR, .RAR) must have their contents 
extracted (using WinZip, WinRAR, WinACE or 7-Zip), and then follow the steps below to install them on 
your system: 
 
1. Go to Control Panel>System>Hardware>Device Manager, and double click on the device to update. 
2. Go to the Driver tab and click the 'Update Driver' button. 
3. Select 'Install from a list or specific location' then click Next. 
4. Select 'Don't search, I will choose the driver to install' 
5. Click the 'Have Disk' button. 
6. Click on the Browse button and go to the directory where you placed the latest drivers. 
7. Highlight the relevant driver file (usually an .INF file) and click Next to install. 
8. Reboot your system if prompted and upon reboot the device should be using the latest drivers. You can 

check this by checking the driver tab in device manager again (Steps 1 & 2 above).  
 
You can use the above procedure to manually update (or downgrade) any of your device drivers whenever 
you download an archived driver package for any device. 
 

GENERAL DRIVER TIPS 

The following are my recommendations with regard to device drivers: 
 
§ It is usually fine to install non-WHQL unsigned drivers (See Step 3 above for details), as long as they are 

from a fully trusted source such as your device manufacturer (e.g. Nvidia, Intel, Creative), or from a 
reputable third party modder. 

§ Only install beta drivers if they are from your device manufacturer, and only if the release notes (or user 
feedback) states that they resolve a specific issue you are currently experiencing, or you are running a 
recently released game or application. Beta drivers carry the risk of causing additional system problems 
and are usually unsupported by hardware manufacturers. 

§ Do not install alpha (pre-beta) drivers, as these can be much more risky. This includes 'leaked' drivers 
and/or heavily modded drivers. Don't be fooled by promises of large performance gains from the 
manufacturer, modder or other users - be patient and wait for a solid beta or final release version before 
installing such drivers. 

§ If you play recent games or use recent applications, you must keep your system up to date with the latest 
drivers. While the latest drivers don't necessarily contain performance improvements, they do contain 
bug fixes, resolutions to compatibility issues, and improvements to the driver interface among other 
things. More often than not, problems with recent games are fixed by installing the very latest drivers - 
whether graphics, sound, and/or motherboard drivers. 

§ If on the other hand your hardware is quite old and/or you don't use the very latest games or 
applications, you should examine the latest drivers and if no fixes or improvements are listed for your 
particular hardware or software, then you can stick with an older driver set. 

 
In general, even if you don't install the latest drivers regularly, you should try to keep an eye on what is on 
offer, and how it may affect you, because chances are that any problems you experience could be due to your 
drivers. They play a critical role on your system, so make sure you stay as up-to-date as possible. 
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PC SECURITY 
 
Whether starting with a clean install of Windows XP or tweaking an existing installation, one of the first 
steps in tweaking actually involves scanning all your current data for viruses and other kinds of malicious 
software (malware) such as trojans and spyware, and securing your PC. Ideally this must be done before you 
do any reformatting/reinstallation, backup any data, or any tweaking. That way you can be sure that what 
you do from this point onward will not all be wasted due to malware messing up your system and making 
you go through the whole process again. 
 
It is no longer true to say that only the very careless or novice user will succumb to a security-related 
problem or malware infestation. Even if you consider yourself an advanced user, you need to bear in mind 
that malware threats these days are becoming increasingly dangerous. In the past a malware infestation 
would usually result in little to no real harm; you'd have to delete a few files or at worst reformat and 
reinstall Windows. Now however, malware is increasingly being coordinated by organized crime groups for 
financial gain, and if you use your home PC for any type of financial transactions such as online banking or 
shopping, being exposed to malware may see you lose money or your online identity. Even if you're not 
concerned about your own security, it needs to be understood that much of the unsolicited junk email (or 
Spam) that is sent actually originates from home PCs which have been infected with malware and used as 
part of a Botnet. So having a somewhat carefree attitude towards PC security is a thing of the past. 
 
There is a wide range of malware which can infect your system and cause problems. The major categories of 
these are covered in this chapter, along with detection and removal methods, and important security tips. 
 
 
< VIRUSES & WORMS 

Viruses are small programs that load onto your computer without your permission and without your 
knowledge of their real function. They are called viruses because just like a human virus they are designed 
to replicate themselves and cause damage, attaching themselves to normal programs and files and spreading 
to other host computers. Viruses range from the mischievous to the truly harmful, and while none of them 
can cause physical damage to your computer, they can destroy valuable information, cause a range of 
system problems, and waste resources. 
 
Worms are a variation of viruses, with the primary difference being that they generally do not attach to other 
programs, they can spread independently. 
 
Virus scanners serve a valuable role in finding these hidden viruses and worms - as well as some other 
common malware - and removing them from your system. A virus scanner is an essential part of any system, 
and you run a major risk if you don't have one installed on your system: it is your first line of defense against 
serious infection. To start with, by regularly running Windows Update and installing all available Critical 
Updates, your system will have a good level of protection. The Windows Malicious Software Removal Tool 
in particular is a regularly updated free anti-malware tool provided through Windows Update. Once it is 
downloaded and installed it does an automatic scan of your entire system for the most common pieces of 
malicious software and removes them if detected. You can also manually download and run the latest 
version of the tool at any time from the link above. 
 
However a dedicated third party virus scanner is necessary, and I personally use the AVG Antivirus Free 
Edition. AVG strikes a reasonably good balance between effectiveness, ease of use and system intrusiveness, 
especially for a free product. However AVG is not the only good virus scanner around - there are several 
good scanners which you can try, though most of them are only free for a trial period: 
  

http://en.wikipedia.org/wiki/Spam_(electronic)�
http://en.wikipedia.org/wiki/Botnet�
http://en.wikipedia.org/wiki/Computer_virus�
http://en.wikipedia.org/wiki/Computer_worm�
http://www.microsoft.com/security/malwareremove/default.mspx�
http://free.grisoft.com/ww.download?prd=afe�
http://free.grisoft.com/ww.download?prd=afe�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  50 
 

PC
 Security 

Avast 
AntiVir 
NOD32 
Trend Micro AV 
 
There are many arguments about which virus scanner is 'the best', but any of the ones listed above should do 
a suitable job as long as it is kept up to date. I have yet to see security experts agree on which single scanner 
is the most efficient one at detecting and removing every virus and worm. Note however that I do not 
recommend Norton Antivirus as it is highly system intrusive, virtually impossible to remove, and does not 
strike a good balance between security and convenience. 
 
The following is information on how to set up the recommended AVG Antivirus Free Edition software for 
optimal performance and minimal intrusiveness: 
 

AVG ANTIVIRUS 

While AVG Free Edition is a good virus scanner, it requires a fair bit of effort to remove its intrusive and 
performance-sapping functionality. None of the steps below is critical for AVG to work properly, however it 
is strongly recommended that you follow all of the steps below to remove/disable features which will slow 
down your PC and may also introduce instability, particularly when gaming. 
 
1. During the installation of AVG, make absolutely certain that you select the Custom option, and I 

strongly recommend unticking the 'Email Scanner' , 'Plugin for Microsoft Office' and 'Linkscanner' 
components. These are unnecessary components which will result in performance issues. If you've 
already installed AVG before following this step then you can still uninstall the Linkscanner by using 
the method listed in this AVG FAQ. 

2. Once AVG has installed, start it and go to the Tools menu, then select 'Advanced Settings'. I recommend 
the following settings: 

 
§ Under the Appearance menu untick the 'Display system tray notifications' box to remove 

the unnecessary AVG icon in the System Tray/Notification Area. 
§ Under the Ignore Faulty Conditions menu, tick the 'Resident Shield' and 'Update Manager' 

boxes to prevent constant unnecessary nagging by AVG. 
§ Under the Linkscanner menu untick all available boxes. Note that this menu shouldn't exist 

if you followed Step 1 above. 
§ Under the Scans menu, for each type of scan you should tick all available boxes except 

'Automatically heal/remove infections' in each case - this ensures that should AVG detect a 
false positive, it won't automatically delete it from your system. 

§ Under the Schedules menu untick every available option - instead I recommend updating 
manually prior to doing a manual scan at a time of your choosing. 

§ Under the Resident Shield menu untick the 'Enable Resident Shield' box (if available) to 
disable this background functionality, as it can and will interfere with other programs and 
may reduce overall performance and stability. 

 
3. While the changes above will reign in most of AVG's intrusive and problematic behavior, in addition to 

these changes, it is also recommended that you take some additional steps to disable 
unnecessary/intrusive components. To start with, AVG installs an active Windows Service called 'AVG 
Free8 Watchdog'. While this service needs to be left at Automatic for AVG to work, it actually runs two 
separate files in the background: avgwdsvc.exe (for the Watchdog Service) and avgrsx.exe (for the Resident 
Shield service).  If you've disabled the Resident Shield feature of AVG, then it is also recommended that 
you to go to your \Program Files\AVG\AVG8 directory and rename the avgrsx.exe file (also called 
avgrsa.exe on some systems) to something else; this will prevent it from starting up in the background 
without affecting AVG scanning capabilities. 
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http://www.eset.com/download/index.php�
http://us.trendmicro.com/us/downloads/home-and-homeoffice/index.html�
http://www.symantec.com/norton/products/overview.jsp?pcid=mp&pvid=nav2008�
http://free.grisoft.com/ww.faq.num-1338#faq_1338�
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4. Now run Autoruns (see the Startup Programs chapter) and under the Everything tab, untick the 
following AVG startup components which are unnecessary if AVG is configured as above: 

 
§ AVG8_Tray - this item just relates to a tray icon which has no real benefit. 
§ Linkscanner - this item shouldn't be shown if AVG is installed as above, but if it exists, untick it. 
§ AVG Safe Search - this item shouldn't be shown if AVG is installed as above, but if it exists, untick it.  
§ AvgMfx86.sys - this item is related to the Resident Shield functionality. Note on 64-bit systems this 

file is called AvgMfx64.sys. 
§ Avgrsstx.dll - this item is related to the Resident Shield functionality. Note on some systems this file 

is called Avgrssta.dll. 
§ All incidences of AVG8 Shell Extension - this removes the 'Scan with AVG Free' context menu entries. 
 

Once all the steps above are completed, reboot your system and start AVG. You may see one or more red or 
orange warning prompts from AVG - you can safely ignore these. Click the 'Update Now' tab to run the web 
updater to ensure that AVG is up to date. If there are any problems, recheck the procedures above, and if 
nothing else works, uninstall AVG and reinstall it, then only follow steps 1-2 above this time. Note that for 
advanced users, if you want to further remove the resource usage and potential conflicts caused by AVG, 
you can set the 'AVG Free8 Watchdog' service to Manual so that it doesn't run in the background each time 
you start Windows. However if you do this then you must remember to manually start the service again 
before launching AVG for full functionality. 
 
To start a manual scan of your system with AVG click the 'Computer Scanner' tab and then select 'Scan 
whole computer' to scan everything, or 'Scan specific files and folders' and then specify the particular 
folder(s) you wish to scan. Note that the 'Scan process priority' slider at the bottom of the scanning page 
effectively controls the speed of scanning - set it to the far right if you want the fastest scanning, though this 
will use more system resources.  
 
I strongly recommend running the AVG Updater by clicking the 'Update Now' tab before doing any scan, to 
make sure the virus definitions are always up to date. Manually scanning your entire system once a week, 
and always scanning potentially harmful files which you have downloaded before you open or launch them 
is strongly recommended and more than adequate when combined with some common sense if you want to 
ensure your system remains clear of major malware. 
 
Again, the background functionality of virus and malware scanners is notorious for causing conflicts and 
slowdowns, and most people don't realize that their scanner may be the cause of increased startup times, as 
well as stuttering or crashes in games for example. Unfortunately however, security software is gradually 
becoming more and more system intrusive due to the ever-growing threat of malware. AVG Antivirus Free 
Edition is the most popular free virus scanner, and is quite effective. The advice provided above is intended 
to ensure that you can continue to use this free scanner with minimal intrusion and resource usage, while 
still retaining its key functionality as a virus scanner. You can trial the other virus scanners linked to further 
above if you prefer another scanner, however sadly they are all heading towards greater intrusiveness, so all 
will require some level of customization and tweaking to strip back unnecessary resource usage. 
 
< TROJAN HORSES 

A Trojan, short for trojan horse, is a malicious program that is often installed on your system under the guise 
of being another program. Trojans differ from viruses in that they typically attempt to steal information from 
your system such as passwords, or control certain aspects of your PC without your knowledge, all for the 
benefit of the distributor of the trojan. 
 
Trojans are increasingly becoming more of a threat than viruses. Many trojans are not detected by virus 
scanners, so you also need a dedicated trojan scanner. I personally use and recommend A-Squared Free to 
scan for trojans. It is one of the best free trojan scanners while also being the least intrusive. However you 
can also try one of the following scanners, though some are only free for a limited period: 

http://en.wikipedia.org/wiki/Trojan_horse_%28computing%29�
http://www.emsisoft.com/en/software/free/�
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The Cleaner 
Trojan Hunter  
 
The following is information on how to set up the recommended A-Squared Free trojan scanner. 
 

A-SQUARED 

To start with, make absolutely sure you are downloading A-Squared Free Edition as the other A-Squared 
versions are only free for the first 30 days. After installation of A-Squared, as long as you're running it under 
an Administrator account with full access privileges, you can set the new 'A-Squared Free Service' to 
Disabled as it is not needed. If you then have any problems, you can set it to Manual if necessary. 
 
Each time you run A-Squared, click the 'Update Now' button on the main Security Status screen. The 
program will download all the latest updates. Fortunately the more intrusive aspects of A-Squared, such as 
'Background Guard' background scanning, are not available in the free edition, so we do not need to 
configure/disable them. To set the depth of scanning used, click the 'Scan PC' option on the left of the main 
screen, and for normal usage select either Smart Scan or Deep Scan - I recommend Deep Scan which is longer 
but much more thorough. For more advanced users who want more control over the scan options, select 
Custom Scan and click the Scan button - you will be taken to a screen which allows you to configure 
individual scanning options. Once you've set your chosen scanning method, whenever you want to run a 
scan using A-Squared, you need only click the 'Scan Now' button on the program's main screen. 
 
Note that A-Squared may find software which it classifies as Riskware, but is not actually malware. Such 
software is not necessarily malicious, it just carries greater risk in usage if your system is compromised by 
malicious software. To disable detection of such entries, go to the Scan PC screen, select 'Custom Scan' and 
you can untick the 'Alert Riskware that is often used by Malware' option. 
 
< SPYWARE & ADWARE 

Spyware is similar to a Trojan, in that it is software that is usually installed on your system purporting to 
have different functionality, or as a component of a useful program. Just like a trojan it transmits information 
about you, such as your passwords, Internet usage behavior etc. to the distributor of the spyware. Adware is 
a form of spyware that is less malicious as it is mainly used to target online advertising, however again it is 
installed without your permission. In either case this software breaches privacy and security and uses 
system resources and bandwidth for no useful purpose whatsoever. 
 
A dedicated spyware/adware scanner will find and remove them from your system. I personally use Ad-
Aware. It is available as a completely free download. However Ad-Aware can be more complex and system 
intrusive for some, so you may wish to try one of these other free spyware/adware scanners: 
 
Spybot 
Windows Defender 
 
The bulk of spyware/adware found by these scanners is not always malicious, and typically consists of 
tracking Cookies - small files that keep information on your user preferences for a particular site. These have 
no real impact on performance or security, contrary to popular hysteria. However some spyware, such as 
keyloggers, are malicious and will seriously compromise your security for things like online banking, so in 
general you should find and remove all spyware and adware from your system just to be safe. 
 
Importantly you should be aware that there are a wide range of spyware/adware and malware scanners 
which purport to remove malicious software, but ironically contain malware themselves, or are bad knock-
offs of good scanners. Consult the lists below if you plan on installing any malware scanners other than the 
ones recommended in this guide: 

http://www.moosoft.com/products/cleaner/download/�
http://www.misec.net/trojanhunter/�
http://www.emsisoft.com/en/malware/?Riskware�
http://en.wikipedia.org/wiki/Spyware�
http://en.wikipedia.org/wiki/Adware�
http://www.lavasoftusa.com/products/ad_aware_free.php�
http://www.lavasoftusa.com/products/ad_aware_free.php�
http://www.spybot.info/en/spybotsd/index.html�
http://www.microsoft.com/athome/security/spyware/software/default.mspx�
http://www.cookiecentral.com/faq/�
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Spyware Warrior Suspect List 
2-Spyware Corrupt List 
 
The following is information on how to set up the recommended Ad-Aware scanner. 
 

AD-AWARE 

After installing Ad-Aware, it should automatically update to the latest resource file. If not click the 'Web 
Update' button on the front page. Note that the program also installs a new service called 'Lavasoft Ad-
Aware Service', and you can set it to Manual if you wish, though if you have any problems return it to 
Automatic. To set up Ad-Aware for the most effective and least intrusive scanning performance follow these 
steps. First click the Settings button on the top right of the main screen, then: 
 
§ Under the Updates tab, select the 'Do not automatically check for Updates' option under both categories. 
§ Under the Scanning tab, I suggest unticking the 'Add Ad-Aware to the Windows right-click menu' 

option at the bottom. The other available options can all remain ticked. 
§ Under the Ad-Watch Live tab untick the 'Process Protection' option to turn off Ad-Aware's background 

resource usage. 
 
Once done, click OK. These settings should reign in most of the unnecessary functionality and intrusive 
aspects of Ad-Aware, without affecting its ability to pick up adware or spyware when conducting manual 
scans. Be aware however that even after all these changes, launching Ad-Aware will result in it opening up 
the Tray utility and leaving it active, requiring manual closure. There are two more changes you can make to 
reduce Ad-Aware's intrusiveness: using something like Autoruns, disable the 'Ad-Watch' and the 'Ad-
Aware Update' items; you might also like to right-click and select Delete for the Ad-Aware icon added to 
your QuickLaunch bar, as it serves no real purpose. 
 
To start a scan, click the 'Scan System' button on the main page, and I generally recommend a 'Smart Scan' 
for most occasions. If you suspect an infection, or want to be extra careful, select 'Full Scan' which takes 
longer but is more thorough. Make sure you regularly update Ad-Aware's reference file and routinely do a 
manual scan after any heavy Internet browsing, especially after visiting unfamiliar or risky sites, or when 
you suspect infection. 
 
< ROOTKITS 

A Rootkit is similar to a virus or trojan horse, but is specifically designed to mask its presence on your PC to 
make it easier for an intruder to secretly access your machine and conduct malicious activity. The problem 
with a rootkit is that it is specifically designed not to be detected, and actively works to remove telltale signs 
of itself so that most scanners cannot see it. There are however specific tools being designed to find and 
remove rootkits, with varying success, and the best free ones at the moment are: 
 
Rootkit Revealer 
Sophos Anti-Rootkit 
 
Since one of the most common rootkits which has circulated in the recent past is actually installed on 
legitimate Sony music CDs (as part of their fight against piracy), you should also download and use the free 
Aries Rootkit Remover. Run the program, click 'Perform Scan' and you will see whether you have this 
rootkit installed. Note that to circumvent the installation of such rootkits on your PC from older Sony music 
CDs, make sure to disable the Autoplay functionality for CD/DVD drives (See the TweakUI chapter). 
 
There is no need for specific usage advice, as these scanners are relatively straightforward to use - run them, 
start the scan and if anything suspicious is found you will be informed. However they do require some 
advanced skills in identifying whether an actual rootkit has been found, as opposed to a normal system file. 

http://www.spywarewarrior.com/rogue_anti-spyware.htm#products�
http://www.2-spyware.com/corrupt-anti-spyware�
http://en.wikipedia.org/wiki/Rootkits�
http://technet.microsoft.com/en-us/sysinternals/bb897445.aspx�
http://www.sophos.com/products/free-tools/sophos-anti-rootkit.html�
http://www.lavasoft.com/support/securitycenter/aries_rootkit_remover.php�
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If you are not clear on whether the identified potential threat is genuinely a rootkit, you will need to do a fair 
bit of additional research on Google to confirm whether something is a genuine rootkit or not. 
 
< PHISHING 

While not a form of malicious software, Phishing is fast becoming a common and significant security threat. 
Typically it involves fooling unsuspecting users into revealing important information such as credit card 
numbers or passwords. For example a phishing attempt may involve tricking a user to click a fake 
'confirmation link' in an email which takes them to a fraudulent copy of the user's bank login page, 
whereupon they enter their login details, giving the phisher the details they need to then login to the user's 
real bank account and rob them. Phishing is not malware as such, since it does not involve software 
infection, it uses social engineering techniques instead to defraud its targets. There are no 'scanners' as such 
to detect phishing. It requires knowledge, vigilance and some basic verification techniques by a user to 
detect and prevent. Fortunately there is some assistance now, as the latest versions of the three most popular 
Internet browsers - Internet Explorer, Mozilla Firefox and Opera - all have some form of phishing protection 
built into them. 
 
In Internet Explorer 7, the Phishing Filter is enabled by default and will warn you if it suspects that a site 
you are about to visit is fraudulent. This checking process may add a slight delay to page loads as it checks a 
site. You can change this setting in IE7 by going to Tools>Phishing Filter and selecting 'Turn off automatic 
website checking'. You can still manually check any web page at any time by going to Tools>Phishing 
Filter>Check This Website, or click the small exclamation prompt in the Status bar. If you want to completely 
disable the Phishing Filter, go to Tools>Internet Options>Advanced and scroll down to the Phishing Filter 
section and select 'Disable Phishing Filter'. However unless you are an advanced user I strongly recommend 
against turning this feature off altogether; just turning the automatic website checking off is the best course. 
See the Internet Explorer chapter for more details. 
 
The Phishing Protection feature in Mozilla Firefox is covered in more detail in my Firefox Tweak Guide, and 
once again it is strongly recommended that you do not disable this functionality altogether unless you are an 
advanced user. More details of Opera's Fraud Protection features are in this Opera FAQ and it too is best 
kept enabled unless you feel you can detect phishing without its help. 
 
For the techniques required to prevent falling victim to phishing as well malware infestation, see the 
Important Security Tips section further below. 
 
< BROWSER HIJACKERS 

A certain category of malicious scripts attempt to alter certain aspects of your Internet browser's behavior, 
such as the default home page, the title bar of the window, additional toolbar icons - all without your 
permission. These scripts are typically called Browser Hijackers. 
 
Aside from the usual malicious software scanners which may find the source of the hijacking, there is a 
specific tool designed to detect and remove hijack attempts called HijackThis. This tool is slightly more 
advanced than the average virus scanner, and trickier to use, however it may be your last hope if your 
browser is exhibiting undesirable behavior.  

http://en.wikipedia.org/wiki/Phishing�
http://www.tweakguides.com/Firefox_1.html�
http://www.opera.com/docs/fraudprotection/�
http://en.wikipedia.org/wiki/Browser_hijacker�
http://www.trendsecure.com/portal/en-US/tools/security_tools/hijackthis�
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HIJACKTHIS 

To use HijackThis, download the program and run it, then click the 'Do a System Scan and Save a Logfile' 
button to begin a scan of your system. When the scan is complete you will see a list of entries - don't panic, 
these are not all browser hijack attempts or malware. Almost all of these entries are related to legitimate 
startup items and modifications you may have made to your browser, such as installing a messaging 
program. To understand what each entry relates to, read this HijackThis Tutorial as well as the Startup 
Programs chapter of this guide to determine what should be kept and what should be removed. If you don't 
have the time or patience to manually determine what should or shouldn't be removed, you can either click 
the 'Analyze This' button on the results page, or post the contents of the Hijackthis.log file to this automated 
HijackThis Logfile Analyzer to get an indication of what is safe and what is not. 
 
If you find that certain items are not necessary, or are malicious, then place a tick mark against every such 
item on the main HijackThis list after a scan (left-click on the small box next to each item), then click the 'Fix 
Checked' button. HijackThis will remove these items from your startup, but note that it keeps a backup of 
your changes under the Config>Backups section of the program, so if you need to undo anything you can 
highlight a backup and click the Restore button to return to the state you were in before. 
 
To keep HijackThis updated, make sure you are online then click the Config button, click the 'Misc Tools' 
button and use the scroll bar on the right to scroll down to the bottom of the options list. Click the 'Check for 
update online' button to check for a newer version of HijackThis and be sure to download and install any 
available updates. 
 
< IMPORTANT SECURITY TIPS 

All the malware scanners and phishing protection in the world are no substitute for learning how to prevent 
malware infestation and how to detect and avoid phishing and other forms of online fraud. Once your 
system is infected with malware, or once you've compromised your credit card details for example, then it is 
often too late to prevent serious damage or loss, especially if the infection has already spread to your 
backups as well. Despite advances in technology there is no fully automated way of protecting you against 
every threat, so I strongly encourage you to read and understand the tips below. 
 

BACKGROUND SCANNING VS. MANUAL SCANNING 

There is no definitive answer as to whether you should enable or disable the background scanning 
functionalities of the various scanners covered above (where applicable). Background scanning provides 
greater protection from malicious software by both blocking their installation and/or providing the earliest 
detection of their activities. However by the same token, background scanning is most definitely not 
foolproof, and more importantly, the methods used by these scanners to detect malicious software in the 
background can and will conflict with various games and applications, and generally slow down your  
entire system by scanning all reads/writes to your hard drive. It all depends on whether you're willing to (or 
need to) sacrifice performance and stability for greater security. 
 
For the average PC used in a home environment, I strongly recommend disabling all background scanning 
options in all your scanning software, both to maintain high performance and importantly to minimize any 
conflicts or issues with your applications and games. Most games and application developers now explicitly 
provide the same recommendation themselves in the installation and usage instructions for their software, 
so it is not just a personal belief of mine. Instead, I recommend doing regular manual scans using the various 
scanners above. The frequency should vary based on how often you visit risky or new sites, and install 
various software, but on average I recommend a full manual scan with each of these scanners at least once a 
week. Furthermore, follow the tips in this chapter to reduce your chances of picking up any malicious 
software in the first place - prevention is always better than cure. 
  

http://aumha.org/a/hjttutor.htm�
http://www.hijackthis.de/�
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FIREWALLS 

I feel the built-in Windows Firewall is sufficient - when combined with the information in the rest of this 
guide - in protecting against system intrusion (See the Control Panel chapter for Windows Firewall setup 
details). It prevents external intruders from accessing your system, as long as you do not open lots of Ports 
and/or have lots of Exceptions. It also allows what it feels is necessary outgoing traffic, and asks you to 
choose whether to block particular connection attempts (such as those initiated by games or programs). This 
is one of the reasons why I recommend the built-in Windows Firewall, since it is the least troublesome to 
use, particularly for online gamers and the average home user. 
 
However you do have other options if you want greater security. There are several commercial Firewall 
packages you can purchase and install. In particular the ZoneAlarm free firewall is recommended for those 
who want to use a third party firewall. 
 
Finally, note that your Network Device may come with a hardware firewall which you can configure - see 
your manufacturer's site or the device's documentation for more details. For the average home user who is 
using a Network Router, you can access your device's settings by going to http://192.168.1.1 - again check 
your device's manual for specific details. It is important that you change the default username/password 
combination for this device, which is usually just admin for both. Log into the device's settings and change 
the password to anything else, as the default is a security risk. 
 

EMAIL USAGE 

§ Avoid opening any emails from unfamiliar senders, especially if the subject of the email seems 
suspicious or inappropriate. Simply opening an email which contains a malware attachment will not 
infect your system, however it is still not advised. Most definitely do not click anywhere inside the 
email, as some emails use tricks such as text which is actually an image, and clicking anywhere on these 
will launch an undesirable link or launch a program download. 

§ Never save or open an attachment from a suspicious email, regardless of the format it appears to be in. It 
doesn't have to be an .EXE, .BAT or .ZIP file to be dangerous; seemingly innocuous formats such as 
.SCR, .GIF or .JPG files can be faked and may also contain malware. Remember that the most common 
method of infection for malicious software is accidental installation by users, so don't let your curiosity 
get the better of you - if you don't know the source of the email, then do not trust it or any attachments. 
If you believe an attachment is legitimate and save it, then manually scan it with multiple scanners first 
before opening it. 

§ If you receive an email purporting to be from your bank, financial institution or online store for example, 
never click on any links they provide, however genuine they may appear. Real institutions never use 
email to ask you to verify important details. These phishing emails usually refer you to a fake mirror 
image of the site you expect to see, and there they trick you into revealing your credit card number or 
personal details on a phony login screen. Links in emails can be 'masked' - that is they can seem real but 
the actual link is different to the underlined hyperlink text shown. Or the link may appear legitimate but 
have additional characters or other subtle alterations which actually point to another site. If you aren't 
sure if you actually do need to verify or alter details with an institution, close the email, open a new 
browser window and manually type in the known web address of your institution into your browser 
address window, and check for any notifications there. 

§ Never click on or use any links that contain just an IP address at the start (e.g. http://68.203.11.34). These 
links don't provide a site name because the name would tell you the site is a scam site, or not what it 
purports to be. Legitimate sites never use just an IP address. 

§ Never install any 'security patches' or 'important updates' that have supposedly been emailed to you 
from Microsoft, a software company or financial institution for example. Microsoft and other companies 
never send out updates or patches this way. Also never follow any provided links to an 'update site' or 
use a download link provided in such emails. 

§ Don't click on any links which supposedly remove you from a mailing list - these are used by spammers 
to verify that the email address is 'live' (i.e. a real person is receiving and opening their spam) and hence 

http://www.zonealarm.com/security/en-us/zonealarm-pc-security-free-firewall.htm�
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you will receive even more spam, or worse still the links could download malware. For the same reason, 
never send any kind of reply to spam emails however tempting it might seem. 

§ If an offer seems too good to be true, ignore it. This includes unfamiliar people offering you millions of 
dollars via email or chain letters purporting to give you good health or reward you with a free product 
after certain conditions. All of these are scams designed to either harvest active email addresses, 
perpetuate malware, or at best a prank. 

 
See the Outlook Express chapter later in this guide for details of how to set it up to filter spam and also 
prevent harmful files from being easily accessible in emails. 
 

INTERNET BROWSING 

§ I strongly suggest that you always run the very latest version of your Internet browser to ensure 
maximum security. Both the Firefox and Opera browsers will check for updates and notify you if any are 
available, so always install them when prompted. Also regularly run Windows Update and install all the 
critical updates available, as many of these apply to Internet Explorer. Make sure to also enable the 
phishing protection features on these browsers. 

§ If you are going to conduct a sensitive online transaction on a supposedly secure site, such as an online 
banking or online shopping site, make sure that once connected you look in your browser's address bar 
and see https:// in front of the address (note the difference between http:// and https://), and to further 
verify the credentials of a secure site before entering any sensitive details, double-click on the padlock 
icon which appears and make sure the certificate is verified as being issued to the web address or name 
of the company you believe it to be. If there is no https:// and/or no padlock then the site is not fully 
secure and hence you should not enter sensitive information there. Contact the company by phone or 
email for more details. 

§ If you have any doubts about a particular site you are visiting, note the site's name, then exit the site and 
do a Google search both on the site's name and its web address. You should be able to see if there is any 
positive or negative user feedback on the site. To see who actually owns and operates the site, go to 
Whois and enter the site address in the top box to see more details. If the details are unclear or 
suspicious, do not trust the site. 

§ Avoid visiting sites that purport to provide free software, music, movies etc. - basically anything that 
seems too good to be true or is illegal. These sites are usually designed to both earn money from 
advertising clicks or referrals to other websites, and more often than not attempt to install malicious 
software on your system or use scripts to compromise your browser through any known exploits. 

§ Never install any certificate, software or plugin for your browser that does not come from a trusted site. 
Even if a website insists that you must install certain software in order to view their content or perform a 
function, ignore or cancel all such attempts unless the site is reputable and completely familiar to you. 
The most common software you require for Internet multimedia functionality are the Flash and 
ShockWave players, as well as Java, which you can install safely by downloading the latest versions 
directly from here: ShockWave Player, Flash Player, and Java. 

 
See the Internet Explorer chapter later in this guide for more details of how to configure Internet Explorer 
properly, or see my Firefox Tweak Guide if you use the Firefox browser. 
 

PEER-TO-PEER, MESSAGING AND IRC PROGRAMS 

§ Peer-to-peer (P2P) programs (e.g. Bittorrent and its variants), instant messaging (e.g. ICQ, MSN or AIM) 
or Internet Relay Chat (IRC) programs (e.g. mIRC) can be used to send and receive files directly to and 
from other peoples' machines so you must be extremely careful when using them. Go through their 
configuration options and ensure that you are not sharing files or directories which contain potentially 
sensitive information such as passwords or licenses. Make sure to disable any automatic downloading 
features, so that you at least see a prompt before a file can be downloaded onto your machine. If you 
must swap files using such programs, I strongly recommend that you create a new empty folder and 
only allow download and upload access to this folder. Then place copies (not originals) of all the files 

http://www.whois.net/�
http://get.adobe.com/shockwave/�
http://get.adobe.com/flashplayer/�
http://www.java.com/en/download/manual.jsp�
http://www.tweakguides.com/Firefox_1.html�
http://www.bittorrent.com/�
http://www.icq.com/�
http://get.live.com/messenger/overview�
http://www.aim.com/�
http://www.mirc.com/�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  58 
 

PC
 Security 

you wish to share into that folder, and disallow access to any other directory or drive on your system. 
Scan any files downloaded through these programs with multiple scanners before opening them. 

§ Do not download or install any software which purports to allow you to steal other peoples' passwords 
or serial numbers, lets you 'store' your passwords/serial number, or lets you 'hack email accounts' for 
example. Ironically these are usually trojans designed to steal your passwords and serial numbers. 

§ Before downloading a file from a peer-to-peer program you can usually tell if a file is real or fake by the 
number of people who are sharing it: the less people sharing a particular file, the more likely it is that it 
is either a fake, a renamed file, or worse still it contains malware. However there is never any guarantee 
that any file is legitimate or indeed free of infection, even if it is popular. 

 
Downloading files over P2P is one of the more risky things you can do because there is absolutely no 
indication or guarantee that the actual contents of the file(s) you are downloading are legitimate or safe until 
you download and attempt to open them. It is strongly recommended that you minimize your exposure to 
such programs. If you insist on engaging in a lot of file sharing then I strongly recommend that you 
manually scan all your downloaded files with at least one each of a virus, trojan and spyware scanner before 
opening them, and that you increase the frequency of your regular manual system-wide scans. 
 

ENCRYPTING FILES 

If after reading all the tips in this chapter you suddenly feel the urge to protect certain files on your system 
even more carefully, you can do so by using Windows XP's built-in File Encryption technology on systems 
formatted with NTFS. To encrypt a file, open Windows Explorer, go to the file you want to encrypt and 
right-click on it, then select Properties. Click the Advanced button at the bottom of the General tab, and 
select 'Encrypt contents to secure data' and click OK then Apply. You may be shown the option to encrypt 
the entire folder, in which case select to do so for maximum security but note that all the folder's contents 
will also be encrypted. Now only a user with your account password and login can access the file. For all 
other users the file will remain encrypted and inaccessible. You can give access to other users manually by 
going back into the file's Properties>Advanced and clicking on the Details button and adding in a user.  
 
For more detailed Windows XP security information, read the Microsoft Windows XP Security Guide. 
 

BALANCING SECURITY VS.  PERFORMANCE 

In the past the balancing act between adequate security and convenience tended more towards convenience, 
since security threats were not as prominent, and even if you caught a virus, it was often just a harmless 
prank or at worst it ruined a few of your files. I recall as far back as 1987 I would regularly get viruses on my 
Amiga 500 computer, and they were little more than a nuisance, sometimes even entertaining in their own 
way. However unfortunately in the past few years there has been a significant rise in genuinely malicious 
software; namely software designed solely to do harm to your system and/or compromise your personal 
financial information. This coincides with the rise in the number of people who are using the Internet to pay 
bills, do their banking and go online shopping. 
 
The stakes are much higher now, so it is far more important to pay attention to the security of your PC, and 
it will continue to become even more important in years to come as the malware creators and online 
fraudsters find increasingly more complex and intrusive ways of getting into your system. They make 
millions of dollars from undertaking this sort of activity, so they have every incentive to innovate. This is 
why it's important to learn more about PC security. You will need to do more than just a couple of manual 
scans of your system every week or two, or enable a malware scanner or two in the background to keep it 
secure. The balancing act between security and convenience has now swung more towards security than 
purely convenience, so you must make some effort to keep your system secure, even if this can be a bit of a 
pain at times; it's simply unavoidable now. 
 
I've tried in the chapter above to give what I believe is still an acceptable balance between security and 
convenience, and importantly keeping in mind the impact on performance for people like gamers. Rather 

http://www.microsoft.com/technet/security/prodtech/windowsxp/secwinxp/xpsgch01.mspx�
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than just suggest the use of background malware scanners which can hurt performance, I have 
recommended a combination of Windows own built-in features, third party tools used in manual scanning, 
as well as preventative behavior to create a good layer of defence with no real performance impact. 
 



 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  60 
 

M
em

ory O
ptim

ization 

MEMORY OPTIMIZATION 
 
This chapter looks at the configuration and optimization of memory-related functionality on your system. It 
is very important to understand how your computer uses the various forms of memory on your hardware, 
as well as how the Windows Memory Management system works in conjunction with this hardware. 
Memory-related hardware and software settings have a major influence on your system's responsiveness, 
performance and stability, not to mention your data integrity. A system with mis-configured memory-
related settings risks slowing down, stuttering, becoming unstable, crashing to desktop, experiencing errors 
and sudden reboots, and ultimately causes data corruption which can eventually make your system 
unbootable. 
 
Each component of the memory subset is dealt with separately below, I urge you to read and understand 
how all of these components work. 
 
 
< MEMORY HARDWARE 

The following are the common forms of memory hardware used on most modern PCs: 
 

CPU CACHE 

The CPU Caches are memory chips that cache (buffer) information for faster usage by the CPU, since the 
CPU is the central component of your system. They assist in temporarily storing the information in 
anticipation of reading/writing by the CPU, preventing any bottlenecks or slowdowns. The cache chips 
themselves vary in storage capacity depending on your CPU, but essentially they are physical chips that you 
should not have to worry about. Windows and your associated hardware are designed to automatically 
detect the size of these caches and use them optimally as long as you have them enabled in your BIOS. That 
is, if options relating to the use of CPU L1 and CPU L2 Cache are present in your BIOS, never disable them 
unless troubleshooting. Aside from BIOS settings, there is a SecondLevelDataCache Registry setting for 
manually adjusting your CPU's L2 Cache setting. However altering this setting is not necessary, as the 
default value of 0 already allows Windows XP to automatically identify and use the correct L2 Cache size. 
 
In general since the user has no control over the CPU's L1 and L2 caches (aside from ensuring that they are 
enabled in the BIOS), this is one area of the memory subset you should not worry about unless you are 
troubleshooting a memory-related problem. For example, a CPU with a faulty cache may exhibit strange 
behavior such as constantly returning data errors and CRC errors. In these cases you can try temporarily 
disabling the caches in the BIOS to see if this reduces or resolves errors. Also see the Benchmarking & Stress 
Testing chapter to find out how to run a CPU-specific stress test to isolate whether the CPU is the source of 
such problems. 
 

PHYSICAL RAM 

This is probably the most well-known form of memory. RAM (Random Access Memory) usually comes in 
sticks composed of multiple memory chips adding up to a certain size (such as 256MB or 512MB). Physical 
RAM, also referred to as System RAM, Physical Memory or just RAM, holds information in storage that can 
be read from and written to by your system components. It is a temporary holding area for data, and is 
constantly being accessed when your machine is on. The advantage of RAM over other forms of storage such 
as your hard drive is that it is much, much faster to access, so optimal RAM usage means faster and 
smoother performance for your system. There are three main factors affecting RAM performance: RAM size, 
RAM speed and RAM timings, each covered below. 
 
RAM Size: This is the actual storage capacity of the RAM in MegaBytes (MB) or GigaBytes (GB). The main 
impact of having more RAM is that - when combined with appropriate Windows Memory Management 
settings - your system will perform more smoothly. This is because data has to be loaded less often from 

http://en.wikipedia.org/wiki/CPU_cache�
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your hard drive, as more of it is stored in RAM, making it easier to access rapidly by your CPU and the rest 
of your system. Windows XP requires a minimum of 64MB of RAM to operate, with 128MB or more 
recommended for normal functionality. Furthermore many recent games require 2GB or more of RAM to 
perform optimally without stuttering or displaying frequent loading pauses. There are no RAM size tweaks; 
essentially if you have a low amount of RAM (e.g. 512MB) then it is strongly recommended that you 
consider getting more RAM, especially if you constantly experience stuttering and long pauses in games or 
the Desktop for example. Bear in mind however that Windows XP 32-bit cannot practically use more than 
4GB of RAM; only the 64-bit version can do that. 
  
RAM Speed: This is the frequency at which RAM operates (in MHz), much like the speed at which a CPU 
operates. The higher the RAM's speed, the faster it can undertake the operations it needs to perform. Each 
stick of RAM has a speed rating, which is the speed up to which a stick of RAM is certified to safely operate. 
However the actual speed a RAM module is currently running at on a particular system varies depending on 
how fast it is set to operate in the BIOS and your Front Side Bus/HyperTransport speed. For example, a DDR 
PC3200 RAM module can operate at up to 400MHz (2x200MHz) while staying within specifications. 
However it is possible to adjust your BIOS such that the RAM can operate at a higher or lower speed in 
practice. The bottom line is, the faster the RAM's actual speed in MHz, the faster it reads and writes 
information and the better your performance. Remember though that the speed rating is not the same thing 
as the actual RAM speed - it is only an indicator of how fast it can potentially perform and has no direct 
bearing on performance. The more the RAM's actual speed surpasses its rated speed, the greater the chance 
for instability, so ideally you should keep the RAM at or below its rated speed for maximum stability and 
data integrity. See the Overclocking chapter for more details of how to adjust RAM speed and the impacts 
this has. 
 
RAM Timings: These are composed of several variables, set in your BIOS, which determine not the frequency 
of the RAM module (RAM speed), but the Latency of the RAM - that is, the amount of time it waits between 
updating various signals. For example the RAS (Row Access Strobe) and CAS (Column Access Strobe) 
latency settings measure in nanoseconds the delay in sending signals which specify firstly the row in which 
a particular memory cell is located, and then the column. The lower the RAM timings in nanoseconds, the 
less time the RAM rests between these operations, and hence the faster it performs, but the greater the 
chance for errors and instability. Just like speed ratings, RAM modules come with recommended timings 
already encoded in their Serial Presence Detect (SPD) on a special chip. These SPD settings are used by 
default by your system unless manually changed in the BIOS, and when used with the recommended speed 
rating (see above) ensure maximum stability. 
 
If you want to improve the performance of your RAM and your entire system, you can lower its timings 
and/or increase its speed - see the Overclocking chapter. However any time your RAM is running faster than 
its rated speed or timings, this can decrease your system's stability and increases the potential for errors 
particularly when the system is under stress. Importantly, if you want to test your RAM for stability, see the 
Benchmarking and Stress Testing chapter for more details. 
 

VIDEO RAM 

Video RAM (VRAM) is the memory built into your graphics card and the size of this is usually quoted in MB 
as part of the graphics card's specifications (e.g. 768MB 8800GTX). This RAM acts as a temporary storage 
location to hold graphics information for faster access by your graphics card, much the same as system RAM 
does for general information. For this reason the VRAM is also called the Frame Buffer, in that it holds 
(buffers) individual graphics 'frames' ready to send to your monitor one by one. Just like physical RAM, 
VRAM has a speed in MHz, and a latency in nanoseconds, with the higher the speed and the lower the 
latency the better the graphics performance. Unlike physical RAM, altering the latency of your VRAM is 
tricky and not recommended, though still possible. The speed in MHz can also be altered up or down using 
an overclocking utility, with the faster the speed the higher the performance, but once again the greater the 
chance of graphical glitches and freezes. See the Overclocking chapter for more details. 
 

http://en.wikipedia.org/wiki/SDRAM_latency�
http://en.wikipedia.org/wiki/Video_memory�
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If you want to see the actual amount of Video RAM being used at any time, for example during gaming, you 
can use the free Video Memory Watcher utility to dynamically monitor the amount of VRAM in use. Run it 
in the background during a brief gaming session, then exit and look at the graph it generates to see how 
much VRAM has been used. 
 
If you're interested in a plain English step-by-step overview of how the hardware memory features above 
are utilized for a task like gaming, check the Graphics Process section of my Gamer's Graphics & Display 
Settings Guide for details. 
 
< WINDOWS MEMORY MANAGEMENT 

Another important part of your memory subset is the Windows Memory Management settings. These are 
software settings which include the System Cache and related Windows Registry entries. This is an area with 
the most tweaking potential, and all the major memory management settings are covered below: 
 

DISK CACHE 

The Windows Disk Cache size can be set through the System component of the Control Panel, in the 
Windows Registry, or by using a utility like Cacheman. This setting controls how much RAM is set aside to 
assist in buffering information written to and read from your hard drive(s) to achieve faster information 
transfer. The optimal setting for most systems is the default 'Programs' option under Memory Usage in 
Control Panel>System, or the 'Balance' option in Cacheman. Selecting the 'System Cache' option ('Maximize 
throughput...' in Cacheman) may result in drive errors for some people, and is really only designed for 
server applications - that is, machines which are constantly writing/reading from the hard drive - and hence 
it is strongly recommended that it not be used for home PC users. 
 

ICON CACHE 

Windows keeps a copy of all your most commonly used icons in its icon cache, speeding up the display of 
these icons (on the Windows Desktop or in Explorer for example), rather than fetching them directly from 
each executable or file every time you view them. You can assign the number of icons to hold in the cache by 
editing the Registry entry below: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer] 
 
Max Cached Icons=2000 
 
Edit this STRING value to set the maximum number of icons which can be cached. A value of 2000 should be 
optimal for most systems. 
 

GENERAL MEMORY SETTINGS 

There are several registry settings that are presented as controlling various memory usage behaviors in 
Windows. Unfortunately, over time these have proven to be useless. Specifically these are the 
DisablePagingExecutive, IOPageLockLimit and AlwaysUnloadDLL entries. If you have already 
applied these tweaks, don't worry as they are totally harmless, but they appear to be unnecessary and 
completely non-functional, so I removed them from this guide quite a while ago. If you still want to apply 
these tweaks because you feel they have some impact on your system, you can use Cacheman (See below). 
  

http://translate.google.com/translate?hl=en&sl=sv&u=http://pcforalla.idg.se/2.1054/1.127411&ei=sd7OSdLIBoiGkQWLnZDdCQ&sa=X&oi=translate&resnum=2&ct=result&prev=/search%3Fq%3D%2522video%2Bmemory%2Bwatcher%2522%26hl%3Den%26safe%3Doff%26sa%3DG�
http://www.tweakguides.com/Graphics_1.html�
http://www.tweakguides.com/Graphics_1.html�
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WINDOWS PREFETCHER 

The Windows Prefetcher creates prefetch files for the most commonly used programs, and attempts to use 
these to more efficiently seek and load up data. You can configure it through the following Registry entry: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management\PrefetchParameters] 
 
EnablePrefetcher=3 
 
The allowable values for EnablePrefetcher are:  
 
0 - Disable Prefetcher 
1 - Application launch prefetching 
2 - Boot prefetching 
3 - Both application and boot prefetching 
 
The default is 3, which should be fine for most systems. Note that if the Task Scheduler service is Disabled 
(See the Services chapter), much of the Prefetcher functionality becomes disabled. If you wish to use full 
prefetcher functionality, do not disable the Task Scheduler service. 
 
I personally leave the Prefetcher registry setting above at its default of 3, and set the Task Scheduler service 
to Disabled. This means the prefetcher won't create application prefetch files under the Window\Prefetch 
directory. I also clear all out existing prefetch (.PF) files in that directory. I have found that this provides for 
the fastest Windows bootup time, and yet does not noticeably increase my game or application loading 
times. Experiment to see if this is the case on your system, or try a value of 2 in the prefetcher registry entry 
above. If you don't see any benefits, then simply re-enable the Task Scheduler service and/or reset the 
prefetcher value to the default. The relevant prefetch files will be automatically recreated and optimal within 
a few days of using your system. 
 

CACHEMAN 

Cacheman is a free utility that provides a user-friendly interface for making most of the memory and cache-
related changes covered above, and in the Windows Registry chapter. To access Cacheman, download 
Cacheman 5.50, install it and then launch the program. Cacheman is in no way an essential tool, as most of 
the important tweaks can be performed using the Registry Editor and TweakUI. However Cacheman does 
provide a simple interface for making these changes for those not willing to edit the Registry - just make sure 
to follow the recommended advice for each major setting as shown further above in this section, and also do 
not enable any 'memory recovery' features of Cacheman, nor do you need to have it run at Windows startup 
for the settings to work. 
 

VIRTUAL MEMORY 

Virtual Memory refers to a memory management technique used in several generations of Windows. During 
normal operation, system RAM is the best place to store information for fast access by your CPU and other 
components, since it has no moving parts and information in it can be accessed at many times the speed of 
any hard drive or CD/DVD. When RAM starts to run low, or if XP determines a particular application is no 
longer a high enough priority, it breaks up some of the portions of memory (called 'pages') and temporarily 
swaps them out from your RAM to your hard drive. This 'swap file' where the memory pages are held on 
your hard drive is called pagefile.sys, and resides in the base directory on your hard drive (e.g. 
C:\pagefile.sys). That's why you will often see the terms Virtual Memory, Pagefile and Swapfile being used 
interchangeably to refer to the same thing. Note you will only see the actual pagefile.sys file if you have 
unticked the 'Hide Protected Operating System Files' option under Folder Options - see Folder Options 
under the Control Panel chapter. 
 

http://www.microsoft.com/whdc/archive/XP_kernel.mspx#E3KAC�
http://www.majorgeeks.com/download.php?det=308�
http://windowshelp.microsoft.com/Windows/en-US/help/fd3e9104-1076-4600-9f9d-8739849387ec1033.mspx�
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The information provided here is based on this Virtual Memory in Windows XP Guide and Virtual Memory 
Optimization Guide. These guides give you a good insight into how Virtual Memory works in Windows XP. 
I recommend that you read them both if you want to gain a clearer understanding of what virtual memory 
is, and why most of what you may believe concerning virtual memory and 'freeing up RAM' are not quite 
true. What follows below are my personal recommendations for Virtual Memory configuration based on a 
combination of the above guides and my own experience. 
 
To access your Virtual Memory settings, go to the Control Panel>System>Advanced>Performance>Settings> 
Advanced>Virtual Memory section and click the Change button. 
 
Clearing the Pagefile: Before setting a new pagefile size or location, you need to first clear your existing 
pagefile. To do this select each relevant hard drive, choose the 'No paging file' option and click the Set 
button, then you need to reboot your system. This step does two things: first it clears the pagefile, fixing any 
potential pagefile corruption which can occur after a bad shutdown; and secondly it ensures that any new 
pagefile you create will start off as a single unfragmented contiguous block on your hard drive for optimal 
performance, which will remain unfragmented in the future. Note that if you have any problems booting 
back up into Windows due to a lack of a pagefile during this step, enter Windows in Safe Mode and continue 
the setup procedures for Virtual Memory from there - see the Backup & Recovery chapter. 
 
Location of the Pagefile: Once you've cleared the pagefile, you can now set its physical location. Highlight the 
logical drive where you want the pagefile to be placed under the Drive window. Which drive or partition the 
pagefile should be located on is based loosely on the following scenarios: 
 
§ 1 Hard Drive with 1 Partition - The pagefile can only be located on the first primary partition of your 

hard drive, which provides optimal performance. 
§ 1 Hard Drive with 2 or more Partitions - Make sure the pagefile is placed on the first primary partition as 

this is the fastest partition. Placing the pagefile on another partition of the same drive does not simulate 
the benefits of having two hard drives since the read head of a single drive can still only seek 
information from one place at a time. 

§ 2 Hard Drives or more (similar speeds) - If all your hard drives are similar in terms of their rated speed, 
you should put the main pagefile on the drive that doesn't contain your Windows installation and 
applications/games. If you've already separated your Windows installation from your 
applications/games, then place the pagefile on the drive which doesn't contain your applications/games, 
even if this is the Windows drive. This is primarily to reduce hard drive head movement on the main 
disk when an application or game is running, and speed up access to the pagefile on the other disk when 
needed. 

§ 2 Hard Drives or more (different speeds) - If one drive is faster than the others, you should put the 
pagefile on that drive, particularly if you have low system RAM (i.e. the pagefile is accessed more often). 

§ RAID Configuration - For striped RAID configurations such as RAID 0 or RAID 5, Windows sees these 
as a single large hard drive, hence you cannot actually choose which drive to place the pagefile on; it will 
be split evenly across the drives which is optimal. If you have a separate faster drive outside the RAID 
configuration, you can shift the pagefile there. 

 
After selecting the location of the pagefile, you can then determine its size in MB. In the Virtual Memory 
settings screen select the 'Custom size' option. Although there are many differing opinions as to how big the 
pagefile should be, it is important not to 'disable' your pagefile regardless of how much RAM you have. 
Windows and certain programs need a pagefile in order to operate correctly. Setting the pagefile to zero does 
not force Windows to use your physical RAM. Windows Memory Management does not work that way. 
 
To determine the optimal pagefile size you should ideally see how much memory your most memory-
intensive programs use and then set the pagefile to comfortably accommodate this. A rough and ready way 
of doing this is to configure your Task Manager as specified under the Task Manager chapter, then run what 
you believe is your most memory-intensive application or game and use it for a period of time. Then without 

http://aumha.org/win5/a/xpvm.php�
http://www.techarp.com/showarticle.aspx?artno=143�
http://www.techarp.com/showarticle.aspx?artno=143�
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quitting the game or application, bring up the Task Manager and check the peak memory usage figure for 
the largest process under the Processes tab - this should indicate how much memory the program usually 
needs. Also after a period of time using various applications and games on your system, open up Task 
Manager and go to the Performance tab, then check the Peak figure under the 'Commit Charge (K)' section - 
this is approximately the maximum amount of memory in KB required so far by your system. These will 
give you an indication of how much total memory you need when going through the next step. 
 
For most people however accurately working out which is the most memory intensive application or game, 
and more importantly predicting the amount of memory future software will require is tedious if not 
impossible. Therefore I provide a simple general recommendation which is both safe to use on all systems,  
regardless of how much RAM you have, and provides good performance:  
 

Set the Initial and Maximum pagefile sizes to 2048MB each -  i.e. allocate 2GB for the pagefile. 
 
This may seem like quite a lot, but the reason for this is that recent games now require a lot more real and 
virtual memory to function correctly, even if you have 2GB of RAM or more. Having a larger pagefile size 
does not hurt performance as such; it only takes up a bit of additional disk space. So on balance my 
recommendation is to play it safe. 
 
Once you've adjusted your Virtual Memory size settings click the Set button and reboot if required. Your 
pagefile will now be in a single fixed unfragmented file, created closer to the start of the hard drive for faster 
performance. There will be plenty of headroom for memory-intensive applications and games and you 
should notice smoother performance. It will also not become fragmented in the future. 
 
Note that the common advice about the pagefile being 1.5 x RAM or some other multiple is not intuitively 
correct. Consider the situation where you only have 128MB of RAM: setting the maximum pagefile size to 
1.5 x 128MB = a 192MB pagefile, which when combined with your 128MB of system RAM gives Windows 
only 320MB of total available memory for Windows XP which is obviously not anywhere near enough 
memory for modern games and applications. In effect it is about how much total memory (RAM + Pagefile) 
that should be made available for Windows to operate efficiently. 
 
If at the end of all this you still have doubts about what to do, or you run into any problems, you can either 
further increase the fixed pagefile size (make sure to reset to 0 first, then reboot); set a 'semi-permanent' 
pagefile which has an Initial size equal to your current system RAM, and a Maximum size which is high, e.g. 
3072MB; or failing all of the above, simply revert back to the 'System Managed Size' setting to let Windows 
manage the pagefile size. Whatever you do, don't set a zero pagefile. 
 
Finally, if after all the tweaking you find that you're still experiencing slow loading times and stuttering, you 
will simply have to increase the amount of physical RAM in your system and/or consider purchasing a faster 
hard drive. For example, 512MB or even 1GB of RAM is now generally insufficient for current games to run 
smoothly in Windows XP regardless of any virtual memory tweaking you undertake. 
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DRIVE OPTIMIZATION 
 
Windows Memory Management is tied closely to the way the hard drive is used in Windows. The reason for 
this is mentioned under the Memory Optimization chapter: your hard drive can be used as a temporary 
storage area, but is one of the relatively slower components of your system. Even the fastest hard drives 
cannot read or write data as quickly as RAM. So when one of your components such as the CPU or graphics 
card needs information, to prevent pauses, stuttering or slowdowns, as much of the information as possible 
should be held in RAM for fast access. However regardless of how much RAM you have, or how efficient 
Windows is with memory management, at the end of the day RAM is only a temporary form of storage 
which is cleared each time your PC shuts down. Therefore it is the hard drive where all your information is 
permanently held, and your system must regularly access the hard drive for data, from the moment the PC 
starts up to the time you run a program. 
 
This chapter covers the primary means by which you can improve and maintain the performance of your 
hard drive(s) in Windows. Many aspects of drive performance are already covered in other chapters - you 
should have already: 
 
§ Formatted and partitioned the drive correctly (See the Installing Windows chapter). 
§ Made sure to have the correct BIOS settings (See the BIOS Optimization chapter). 
§ Installed the latest motherboard drivers (See the Driver Installation chapter). 
§ Have correct relevant Windows settings (See the Control Panel and Memory Optimization chapters). 
 
Follow the rest of the instructions in this chapter to make sure your drive(s) remain fast and responsive. 
 
 
< WINDOWS DISK INDEXING 

This is a performance tip that I strongly recommend you implement. The Windows Disk Indexer constantly 
indexes all files on your machine to allow for faster searching using the Windows Search function for 
example. Since most people don't search their machine very often, having Disk Indexing enabled provides a 
performance hit for no good reason, and also increases fragmentation. Follow these steps to turn off the 
Windows Disk Indexer to improve general hard drive performance and responsiveness: 
 
1. Go to Windows Explorer, right-click on your hard drive name (e.g. C:) and select Properties. 
2. Untick the 'Allow Indexing Service to index this disk for fast file searching'. 
3. Select 'Apply changes to [Drive letter]\, subfolders and files' in the subsequent prompt.  
4. Your system will now go through and remove all indexing on existing files, and not index any new or 

moved files in the future - this will speed up drive read/writes and general responsiveness. Ignore any 
'errors' which are shown, this occurs simply because some files are in use or protected and can't have 
their properties changed to remove indexing - this is normal.  

 
Make sure you also disable the 'Indexing Service' service as it is no longer necessary when disk indexing is 
removed from your hard drive (See the Services chapter). 
 
< DRIVE CONTROLLERS 

To optimize the performance of your hard drive(s), first make sure you have installed the correct 
motherboard drives for your particular motherboard, as the drive controllers on your motherboard require 
these for optimal operation, as well as special functions like RAID - see the Driver Installation chapter.  
 
Next, open Device Manager, found under Control Panel>System>Hardware, and go to the Disk Drives 
section in Device Manager and expand it. Right-click on each hard drive available, select Properties, and 
under the Policies tab make sure 'Optimize for Performance' is selected. If available, also tick the 'Enable 
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Write Caching on the disk' option. The aim is to allow the hard drive to use a Cache – a small area of 
memory set aside specifically for the hard drive – to speed up reading and writing to the drive. Note that 
these options may not be available to be changed here for certain SCSI, Serial ATA (SATA) and/or RAID 
configured hard drives. If you are using such a configuration, select the 'SCSI Properties' tab and make sure 
that both 'Disable tagged queuing' and 'Disable synchronous transfers' are unticked for maximum 
performance. 
 
To optimize all system drives, in Device Manager go to the 'IDE ATA/ATAPI Controllers' section and 
expand it. Right-click on each sub-controller listed and select Properties and see the relevant section below: 
 
Parallel ATA Controller:  This controller affects all PATA drives which use the IDE interface - typically this is 
older IDE hard drives and CD/DVD (optical) drives. Go to the 'Primary Channel' and 'Secondary Channel' 
tabs and check the transfer speeds as relevant - the maximum possible speeds are Ultra DMA Mode 4 for 
optical drives, and Ultra DMA Mode 6 for IDE drives. If you untick the 'Let BIOS select transfer mode' box 
you may be able to alter the speed here, but if it is below the maximum then it may be due to one or more of 
the following factors: 
 
§ Your motherboard does not support Ultra DMA 6 or Ultra DMA 5 modes for hard drives - these are also 

called ATA 133 and ATA 100 respectively. Check your motherboard manual and make sure you have 
installed the correct IDE drivers for this motherboard. 

§ Your BIOS is not configured correctly to enable the highest speed - see the BIOS Optimization chapter. 
§ You are sharing a hard drive and a CD/DVD drive on the same channel - move them to separate 

channels. 
§ Your hard drive(s) or CD/DVD drives don't physically support the highest transfer mode available on 

your motherboard. This should only be the case if they are quite old. 
§ No drive should be running in PIO or Multi-word DMA mode as these provide poor performance. 

Check your BIOS and any switches on the back of the drive(s). 
 
Serial ATA Controller: This controller affects all SATA drives connected to your motherboard. Right-click on 
this controller, select Properties, then go to the 'Primary Channel' and 'Secondary Channel' tabs. If a drive is 
connected to these channels, the 'Transfer Mode' should show the correct maximum speed for the drive - 
1.5GB/s for SATA I, or 3.0GB/s for SATA II. Alternatively click the 'Speed Test' button to do an actual quick 
benchmark of the drive's speed and see the speed rating. The 'Let BIOS select transfer mode' box should be 
ticked unless you are troubleshooting, or you see 'PIO Mode' for your hard drive, which is sub-optimal; in 
that case untick the box and manually attempt to switch to a better mode. The other boxes should all be 
ticked for maximum performance. 
 
AHCI Mode: If you run a SATA drive, you can try enabling Advanced Host Controller Interface (AHCI) 
Mode on your SATA controller in your BIOS. This mode has a range of benefits, especially on SATA II drives 
with NCQ support - this includes quieter operation and better multi-tasking capabilities. However it will not 
necessarily result in a speed boost depending on how you use your system. Furthermore it requires 
appropriate drivers from your motherboard manufacturer (e.g. the Intel Matrix Storage drivers for Intel 
motherboards) to function properly. Most importantly, if you do not enable this mode in your BIOS prior to 
installing Windows, you will experience an error and may not be able to boot back into your system if you 
switch to AHCI on an existing install of Windows. It is recommended that if you wish to switch on AHCI 
mode, you make the appropriate changes in your BIOS and then reinstall Windows XP. 
 
If your hard drive is not set to the highest mode possible for its type, or some of the options are unavailable 
here then you have not set up your BIOS correctly or you have not installed the correct SATA motherboard 
drivers. To confirm your drive's actual speed, and whether there really is a problem, you can benchmark 
your drive using a utility like Sandra - see the Benchmarking & Stress Testing chapter. 
 

http://en.wikipedia.org/wiki/Advanced_Host_Controller_Interface�
http://en.wikipedia.org/wiki/Advanced_Host_Controller_Interface�
http://en.wikipedia.org/wiki/Advanced_Host_Controller_Interface�
http://en.wikipedia.org/wiki/Native_Command_Queuing�
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Most recent hard drives come with a technology called SMART - if available and enabled in the BIOS. This 
technology prevents drive errors and provides diagnostic information. To further diagnose any hard drive 
problems for non-RAID configuration hard drives using SMART, use a utility like PassMark Disk Checkup. 
 
< MASTER FILE TABLE 

The Master File Table is a system area of Windows which contains an entry for every file and directory on 
your drive with information on its size, attributes, permissions, timestamps and so forth. In a way, it is like a 
table of contents for your drive, and as such serves a very important function. By default Windows reserves 
around 12.5% of your total drive space to allow the MFT to grow without becoming fragmented. This space 
cannot be reduced, but over time it may need to be increased - especially after creating lots of new files or 
installing numerous applications and games. Fortunately Windows will automatically manage the MFT, 
increasing its size as necessary. 
 
However if your drive has a relatively large number of files, over time the MFT may become fragmented as 
it grows beyond the initial space allocated to it by Windows, and this can affect performance. You can use a 
third party defragmentation utility to defragment the MFT and thus keep it optimal - see further below for 
details of these. 
 
If for some reason you want to manually increase the amount of space Windows reserves for the MFT - and 
this is generally not recommended - you can do so via the Registry Editor by going to: 
 
[HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\FileSystem] 
 
NtfsMftZoneReservation=1 
 
The DWORD above is set to 1 by default, which means it is automatically managed. However you can give it 
a value of 1 - 4, with higher values reserving larger portions of the drive for the MFT. The specific 
percentages for each value are purposely not documented by Microsoft, as they may change in the future. 
 
< WINDOWS DISK DEFRAGMENTER 

As information is written to or deleted from your hard drive, portions of individual files will become 
fragmented and physically spread out all over the drive. This happens because as Windows starts writing 
the data for a file onto the drive, when it reaches an occupied portion of the drive it jumps to the next 
available empty spot and continues writing from there. So a single large file may actually be in several 
separate chunks in various locations on your drive. The more the files on your system are fragmented, the 
more time your hard drive takes to find all these fragments and access the information it needs at any time. 
It's like trying to read a book with the pages out of order. This can clearly reduce drive performance and 
increase the potential for stuttering and loading pauses. 
 
Windows Disk Defragmenter (Defrag) is a built-in utility that performs a very important function: it puts all 
these file fragments back together with each other in the same location on the disk and also attempts to pack 
them closer to the start of the drive to speed up reading and writing to these files. This reduces loading times 
and greatly reduces annoying loading pauses and stuttering. To access the Windows Defrag utility, go to 
Start>Run and type "Dfrg.msc" (without quotes) and press Enter, or look for the Disk Defragmenter in your 
Start>Programs>Accessories>System Tools menu. Make sure there are no open applications or games 
running in the background and then in the Defrag window simply click the Defragment button to begin 
defragmentation. Do not do anything else while this process is being completed. It may take quite a while to 
complete so be patient. The longer it takes, the more good it is doing your drive. If tweaking a new install of 
Windows, make sure to run Defrag immediately after installing the system drivers and core software as this 
will move all the important system files to the start of your hard drive where drive access is fastest. 
 

http://en.wikipedia.org/wiki/Self-Monitoring,_Analysis_and_Reporting_Technology�
http://www.passmark.com/products/diskcheckup.htm�
http://support.microsoft.com/kb/q174619/�
http://en.wikipedia.org/wiki/File_system_fragmentation�
http://support.microsoft.com/kb/305781/en-us�
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Note that for any defragmentation program to work, whether Defrag or a commercial package, you must 
have 15% or more free drive space to give the program room to temporarily relocate files as it defragments. 
 

BACKGROUND DEFRAGMENTATION 

By default, Windows also defragments your hard drive in the background whenever your system is idle.  It 
does this to maintain optimal layout of your important files, such as your boot files. That is why you may see 
hard drive activity even when there are no programs or games running in Windows. This is fine, since it 
does not interfere with your programs or games - it only occurs when the system is truly idle. You can 
disable this behavior if you really wish by using Cacheman for example, but this is not recommended. The 
other source of background drive usage is the Disk Indexer, which you should disable (See further above). 
 
< ADVANCED DEFRAGMENTATION 

If you want to do a more thorough defragmentation of your hard drive and get better results you will have 
to look beyond the built-in Disk Defragmenter in Windows XP - even Microsoft admit this in this Microsoft 
Article. There are several applications which can defragment a disk in more efficient ways, and also 
defragment files which the Windows Defragmenter cannot move, such as system files (the green blocks in 
Defrag). The benefits are spelt out more clearly in this White Paper. Note that the Windows pagefile will not 
become fragmented if configured correctly as detailed in this guide (See the Memory Optimization chapter), 
so pagefile fragmentation is not an issue. 
 

PAGEDEFRAG 

To defragment your system files for free, you can use the PageDefrag utility. It is fairly simple to use, and 
upon launching it you can see at a glance how many fragments your major systems files are in - to be 
optimal they should all be in 1 fragment each. To run a defragment using PageDefrag, launch the program 
and click the 'Defragment at next boot' option, then reboot. This will defragment your major system files, 
which can only be done at boot time - something which the regular Windows defragmenter cannot do. 
However even the author of PageDefrag suggests you use it in combination with other defragmentation 
software such as a commercial package, or his own Contig utility.  
 

DIRMS & BUZZSAW 

If you are an advanced user, you can try the Dirms and Buzzsaw defragmentation utilities. These utilities are 
free but require re-registration every 30 days. They also require a bit more work in figuring out and using, so 
they are not covered here in detail, and are not recommended for the average user. 
 
For ease of use and maximum safety, I recommend a third party defragmentation package for most users, 
since these usually come with detailed instructions, are fully automated and fairly foolproof. Defragmenting 
involves lots of file movements, sometimes sensitive system files, so it is important that the software you use 
to defragment be rock-solid. There are several advanced defragmentation utilities you can use in XP which 
are not free, but the free trial versions have full functionality with sufficient time for you to judge their 
usefulness before considering whether to purchase them or not: 
 
Diskeeper 
PerfectDisk 
O&O Defrag 
 
I personally prefer Diskeeper since the default Windows Disk Defragmenter is simply a cut-down version of 
Diskeeper anyway. Below is my advice for configuring and using the latest version of Diskeeper. 
  

http://support.microsoft.com/kb/130539�
http://support.microsoft.com/kb/130539�
http://support.microsoft.com/kb/130539�
http://files.diskeeper.com/pdf/ImpactofDiskFragmentation.pdf�
http://technet.microsoft.com/en-us/sysinternals/bb897426.aspx�
http://technet.microsoft.com/en-us/sysinternals/bb897428.aspx�
http://www.dirms.com/home/docs/dirms1.asp�
http://www.dirms.com/home/docs/buzzsaw.asp�
http://www.diskeeper.com/defrag.asp�
http://www.raxco.com/�
http://www.oo-software.com/home/en/products/oodefrag/�
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DISKEEPER 

While Diskeeper isn't free, you can download and try its full functionality for 30 days for free. I recommend 
that you trial the Pro Premier Edition as that is the edition that has all the functionality listed below, 
including the I-FAAST and Invisi-Tasking features. Once Diskeeper is installed, it takes the place of the 
Windows Disk Defragmenter, so if you click the regular Defrag icon it will also launch Diskeeper instead. 
Note that Diskeeper also installs an additional service called simply called 'Diskeeper', which is necessary for 
the day-to-day usage of Diskeeper, so it needs to be kept at its default of Automatic. 
 
Below is detailed advice on how to set up and use the recommended Diskeeper defragmenter optimally. 
 
Automatic Defragmentation: To start with, Diskeeper is now designed to automatically defragment files 'on the 
fly' using only available background resources via the Invisi-Tasking feature. This should ensure that your 
system is always defragmented even if you don't manually defragment. I recommend that you try this 
feature to see if you prefer it, and to gauge the performance impact it has on your system. To enable or 
disable this option right-click on the relevant drive and select 'Automatic Defragmentation'. I personally 
choose to disable it and prefer to manually defragment after specific events (as listed further above), as this 
minimizes the likelihood of any additional stuttering caused by this feature running in the background. 
 
Manual Defragmentation: To perform a manual defrag at any time start up Diskeeper and follow these steps: 
 
1. Click on the logical drive you want to defragment, and click the Analyze button. 
2. Once the drive analysis is over - the progress is shown in the bottom right corner - click on the 'Volume 

Map View' drop box and look at the results in both File Performance and File Structure views, paying 
attention to the color legend shown at the bottom. While not a perfect representation of fragmentation, 
in general, the more red and pink areas you see, the more benefits defragmentation will give. 

3. Click again on the logical drive you wish to defrag and click the Defragment button. As defragmentation 
begins you will see a graphical representation of the blocks of files which are being moved, and a 
progress meter at the bottom. 

4. Once the defragmentation is over, you will see that the layout shown under the 'Volume Map View' File 
Performance section has changed, showing a defragmented (blue) drive. If you can still see pink areas, 
see the boot time defragmentation instructions below. Note that any areas of cross-hatched green and 
white are normal reserved system areas, typically for the Master File Table (MFT). 

 
Note that the latest version of Diskeeper monitors the MFT using what it calls the 'Frag Shield', and 
automatically configures it for optimal performance as long as automatic defragmentation is enabled. There 
is no longer any need for manual adjustment of the MFT, nor any warnings regarding its size. 
 
Boot-Time Defragmentation: To defragment certain system files you must periodically do a 'Boot-Time 
Defragmentation'. This is because some files are protected system files and can't be moved while they're 
loaded up in Windows. To do a boot time defrag using Diskeeper, follow these instructions: 
 
1. Open Diskeeper and highlight the logical drive where your pagefile resides. 
2. Right-click on that drive and select 'Boot-Time Defragmentation' 
3. In the box that opens, tick the 'Enable boot time defragmentation to run on the selected volumes' box 

and select 'Run boot time defragmentation the next time this computer is manually rebooted'. Then tick 
all available options except 'Produce the summary log file'. 

4. Click the Apply button, and then OK and a boot-time defragmentation is now scheduled. Note if you 
change your mind and want to cancel this, simply follow steps 1-3 above but this time simply untick the 
'Enable boot time defragmentation...' box and click Apply. 

5. Reboot your system and upon rebooting Diskeeper will commence defragmenting system files for 
optimal performance. 
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Do not disturb this process and at the end of it press ESC to boot back into Windows. Upon booting back 
into Windows I recommend doing a manual defragmentation of your drive again with Diskeeper. 
 
The Diskeeper Professional Premier version contains a technology called I-FAAST which is not available in 
other versions of Diskeeper. It is basically an advanced analytical method. I-FAAST can result in an 
improvement in drive performance, but whether you want to invest in the Pro Premier version of Diskeeper 
to be able to use it is up to you. Again I recommend trialing it first to see whether I-FAAST makes any 
practical difference on your drive. If you run into any problems when using Diskeeper, you should check the 
Diskeeper FAQ. 
 
 
A third party defragmentation utility is not essential, as the normal Windows Disk Defragmenter utility is 
sufficient for most tasks. I do however recommend at least trialing a utility like Diskeeper for a few weeks to 
see if it makes a real difference on your system - it can have a noticeable impact particularly in reducing 
stuttering in games. Regardless of whether you use the built-in defragmenter or a third party utility, make 
sure to defragment regularly as it is essential to optimal drive performance. 
 

FREQUENCY OF DEFRAGMENTATION 

Whether using the Windows Defragmenter, or a commercial package, I strongly recommend also doing a 
manual defrag immediately after any of the following events: 
 
§ Installation of any game or application. 
§ Patching any game, application or Windows. 
§ Installation of any drivers. 
§ Adding or deleting very large file(s). 
 
This is particularly necessary for gamers, since games are already quite prone to stuttering and longer 
loading times due to their data-intensive nature, so by defragmenting your drive after a game installation or 
patch, you help reduce stuttering in the game. 
 
Neglecting to defragment your hard drive after a major drive operation such as those listed above may see 
your applications or games take longer to load, exhibit frequent stuttering and pausing, and generally 
reduce your hard drive's performance. There is no need to defragment daily or hourly, and indeed you 
shouldn't just defragment on a set time schedule. Manually defragmenting regularly also reduces the time it 
takes to defragment your drive, so that each time you do it, it should only take a few minutes at the most, 
even for a large drive, since only small portions of files need to be rearranged. 
 
< BOOT ANALYSIS & OPTIMIZATION 

By default Windows already detects and optimizes your Windows bootup time by placing the relevant files 
in optimal positions on the disk. This is done frequently, however you can speed up the process by doing it 
manually after you install major system drivers. Furthermore by analyzing your boot procedure you can 
troubleshoot any problems which may be slowing down your Windows startup. This is best done using a 
tool called Bootvis. 
 

BOOTVIS 

Bootvis is the Boot Visualizer tool from Microsoft, which shows information about the specific programs, 
drivers and services that are loaded up during your Windows startup procedure, and how long each one of 
them takes. This information can be very useful in identifying precisely what is taking the most amount of 
time at bootup, and if necessary lead to uninstalling or altering hardware and software which is causing any 
long delays. Bootvis does more than just analyze the startup procedure - it can also optimize it by laying out 
the required files in an optimal pattern for faster bootup times. This usually results in dramatically faster 

http://support.diskeeper.com/support/diskeeperfaqs.aspx?Page=5&Subpage=2&cust=1&RId=1&CId=1&SId=2�
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loading of Windows, and that is the primary purpose to which we will put Bootvis. To access Bootvis 
download it from this Bootvis Download Site and install it. 
 
Before you use Bootvis however you should note that although it is a Microsoft-produced utility, it was 
removed from the Microsoft Bootvis Page a while ago for an unspecified reason. The likely reason is that it 
can cause problems on certain systems, although it is unclear which particular types of systems. The bottom 
line is that you should backup your data before using Bootvis, just in case. 
 
Note that for Bootvis to operate correctly, the Task Scheduler service needs to be set to Automatic (see the 
Services chapter). This is very important, otherwise Bootvis will not complete its Boot Trace or Optimization 
tasks after rebooting. 
 

ANALYZING SYSTEM STARTUP 

To analyze your system with Bootvis, run the program and go to the Trace menu, then select 'Next Boot + 
Driver Delays'. Let Bootvis reboot the system, and on rebooting wait patiently for Bootvis to pop back up 
when it's finished analyzing. It will display several graphs that show the various startup components laid 
out sequentially in time shares. Make sure to use the scroll bars to look at the various graphs in their 
entirety. If you want to identify which programs are associated with particular applications or drivers, 
consult the Startup Programs and Services chapters for more details. 
 

OPTIMIZING SYSTEM STARTUP 

To optimize your bootup procedure using Bootvis, first go to your \Windows\Prefetch folder and delete the 
entire contents. Then start Bootvis, go to the Trace menu and select 'Optimize System'. Once again let Bootvis 
reboot and wait for it to restart after the reboot. It will say 'Optimizing System' for a while. Once this is done 
you can reboot your system and observe that your bootup times will now be much faster. Ideally any time 
you install new drivers or add new pieces of hardware to your system you should redo the entire Bootvis 
procedure to maintain an optimal startup time. 
 
In the end though, this is not absolutely necessary because by default Windows will automatically optimize 
your startup after several days, so if you don't feel confident using Bootvis for this purpose or don't have the 
time, it is not an important step. However using Bootvis to analyze your startup can be very handy in 
helping you identify potential slowdowns in the startup process, so if only for that purpose, Bootvis is worth 
having on your system. 
 

http://www.softpedia.com/get/Tweak/System-Tweak/BootVis.shtml�
http://www.microsoft.com/whdc/system/sysperf/fastboot/default.mspx�
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THE CONTROL PANEL 
 
This chapter covers all the general options available under the default Windows XP Control Panel, which is 
an important central location for accessing many Windows settings. I cannot go into each section of the 
Control Panel in great detail due to space considerations however all the important settings which are 
relevant to the average home PC user are covered here and where necessary you will be referred to other 
relevant chapters of this guide for more information. Take the time to go through this chapter carefully as 
although it is long, it is very important for Windows performance and functionality. 
 
Note that you may have additional items showing in your Control Panel, as some third-party programs will 
automatically insert shortcuts into the Control Panel, however only the default Windows XP items are 
covered below. If you wish to remove a third party shortcut from the Control Panel, in most cases you can 
right-click on it and select Delete to remove the icon (not the program itself). For some Control Panel icons 
you will have to find the relevant file under the \Windows\System32 directory - all Control Panel icons have 
the extension .CPL - so for example to remove the 'Nvidia Control Panel' icon rename or delete the nvcpl.cpl 
file in the directory above, then close and reopen the Control Panel, and it should be removed. Alternatively, 
you can go to the Control Panel section of the TweakUI utility and remove unnecessary components - see the 
TweakUI chapter. 
 
 
< ACCESSIBILITY OPTIONS 

There are a range of features here that can be used to accommodate different keyboard usage styles, make 
Windows easier to see on screen, or provide audible notification of events for example. Quite obviously 
which settings you choose will depend on your individual requirements. If you want to find out more about 
these options go to the Windows Accessibility Page. For the majority of users who do not need to use any 
accessibility functions, make sure that every option under each of the tabs is unticked for maximum 
performance and minimal interference with the functionality of games and applications. For example, if the 
'Sticky Keys' option is left enabled, it is known to cause unintended interruptions in some games (when the 
SHIFT key is pressed multiple times in a row it will activate it). 
 
< ADD HARDWARE 

This utility allows you to go through a set of procedures for adding a new piece of hardware to your system. 
In most cases though, since Windows XP is a plug-and-play operating system, and as long as you have 'Plug 
and Play' enabled in your BIOS (See the BIOS Optimization chapter) and the 'Plug and Play' service set to 
Automatic (See the Services chapter), all you need to do to add any new hardware is to connect it to your 
system and XP will detect it, and either automatically install basic drivers for it, or if it can't determine the 
type of hardware, request that you insert a driver disk - see the Driver Installation chapter. I strongly 
recommend that before adding any new piece of hardware, you spend some time and read through the 
installation instructions which come with the hardware, as some have unique requirements for optimal 
installation which may be different to what you might expect, and in some cases the default Windows XP 
driver will not function as well as the latest specific drivers for the device. 
 
< ADD OR REMOVE PROGRAMS 

The main use for this utility is not so much for the addition of new software - that typically only requires 
that you insert the installation CD/DVD into your drive and follow the procedures from there, or the 
execution of the software's setup executable file. Rather this tool is most useful for looking at existing 
software and drivers currently installed on your system and quickly being able to remove ones that are no 
longer needed. It is always a good idea to go through this list periodically and remove software that hasn't 
been used for a long time. You can sort this list in various ways by going to the top right corner and for 'Sort 
by', selecting either Name, Size, Frequency of Use or Date Last Used. 

http://www.microsoft.com/enable/�
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On the left side of the screen, you will see the major functions available under this utility. We've covered the 
addition and removal of software so far. You can also 'Add/Remove Windows Components', which is 
covered in the Cleaning Windows chapter. The final option is the ability to 'Set Program Access and 
Defaults' that is covered below. 
 

SET PROGRAM ACCESS AND DEFAULTS 

Click the 'Set Program Access and Defaults' button, and on the next screen you can choose from two presets 
(Microsoft Windows or Non-Microsoft), or as I recommend, click on the third Custom option. Next, click the 
double down arrows to the right of Custom. Here you can set the default Web Browser, email program, 
media player, instant messaging program and Java virtual machine. 
 
For example, if you want to make Mozilla Firefox the default Internet browser instead of Internet Explorer, 
as long as you already have it installed on your system the option to select it as the default should appear 
here. Select it, and make sure a tick appears in 'Enable access to this program' next to it. You can disable 
access to Internet Explorer by removing the tick in the 'Enable access to this program' box next to it as well. 
This won't uninstall Internet Explorer, it simply removes access to it, which is not recommended. I 
recommend you select 'Use my current Web browser' instead which should be fine for most purposes and 
ensure a tick appears next to all browsers below it so that you still can access them all as need be. 
 
Although Microsoft has incorporated this feature as a result of charges relating to monopolistic behavior, 
bear in mind that quite often you must use a Microsoft product for optimal trouble-free usage. For example, 
only Internet Explorer can access the Windows Update site properly by default, and only Windows Media 
Player can provide optimal playback of .WMA files. Other methods to access these sites and files do exist,  
and they are covered in the Internet Explorer and Windows Media Player chapters of this guide, but they are 
not necessarily as secure or as optimal, so don't disable access to these default applications for that reason. 
Instead configure them correctly as detailed later in this guide. In all cases I recommend selecting 'Use my 
current...' and allowing access to all the components beneath. There is one exception - if you want to disable 
access to Windows Messenger as part of removing it from Windows, untick the 'Enable access to this 
program' box next to it, as it has no other use. 
 
< ADMINISTRATIVE TOOLS 

There are seven main administrative tools under this category. Some of them may not be available if you run 
Windows XP Home. In particular if you are running Windows XP Professional, you will also have access to 
the Group Editor, but that is covered separately in the Group Policy chapter. If you have installed the .NET 
Framework on your machine, you may also have access to the .NET Config and .NET Wizard tools. I cannot 
go into detail about all the functions of these administrative tools because they are capable of a great many 
things, however I provide brief details of the primary Administrative Tools and point out their most useful 
aspects for the average home PC user below. 
 

COMPONENT SERVICES 

This tool allows system administrators the ability to deploy and administer component services applications 
or automate administrative tasks. For our purposes, the only real usage is the Event Viewer and the Services 
components, both of which also have separate tools to allow direct access to them - see each of these below. 
 

COMPUTER MANAGEMENT 

The main unique use for the Computer Management tool is the Disk Management sub-component, which 
you can access by expanding the Storage item in the left pane and then clicking on the Disk Management 
item that appears underneath it. You will then see your hard drive(s) listed in the top right pane, with all 
your available drives (including CD/DVD drives) listed in the bottom right pane. 
 

http://www.mozilla.org/products/firefox/�
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If you want to change any of the drive letters on your system - for example if you want to swap your 
CDROM drive from D: to E: or just change it to a new letter like Z:, you can do so here by right-clicking on 
the drive letter in the bottom right pane and selecting 'Change Drive Letter and Paths', then highlighting the 
drive letter which appears, and selecting the Change button, and assigning a new drive letter.  
 
If you want to convert a hard disk from a Basic to a Dynamic volume, you can do so here by right-clicking 
on the Disk 0 (or Disk 1, etc) box in the bottom right pane, and selecting 'Convert to Dynamic Disk'. Dynamic 
disks can emulate a RAID array - that is they can span multiple drives as though they are one large drive. 
The features of Dynamic Disks are discussed in this Microsoft Article. Note that dynamic disks are a storage 
type not supported on Windows XP Home Edition or earlier versions of Windows. It is not recommended 
that you convert your disk from basic to dynamic, because even though you can covert back to a basic disk 
you will lose all your data. If however you have a specific reason to use this function, the option is here. 
 

DATA SOURCES (ODBC) 

This tool lets you add and configure drivers for managing access to data on various database management 
systems. Unless you use databases extensively on your machine, you can ignore this tool. There are no 
general functions for this tool that can be discussed here. Note that this is the same tool as the Data Sources 
(ODBC) item in the main section of the Control Panel. 
 

EVENT VIEWER 

The Event Viewer tool shows a list of events under the Application, Security and System categories. These 
events are recorded by Windows over time, and reflect information alerts, warnings and errors that have 
occurred to date. You can view the (limited) details of an event by double-clicking on it. Event Viewer can be 
used to troubleshoot an event if you haven't had the chance to see an error message - for example because 
your system rebooted before you could read it. More details on using this tool are provided in the Windows 
Errors chapter. 
 

LOCAL SECURITY POLICY 

This tool allows you to establish and alter security-related settings. This is best left at default and I 
recommend that you do not change any of these settings unless directed to by a Network Administrator or a 
Technical Support expert. All the important security settings relevant to home users can also be adjusted 
elsewhere as detailed in this guide. 
 

PERFORMANCE 

This tool allows users to examine the various performance variables on their system, such as CPU usage or 
page file usage in graphical and numerical form. You can add components to the display by clicking the 
large '+' button above the graph. A more user-friendly interface can be added to the Performance Monitor by 
downloading the Microsoft Performance Monitor Wizard. 
 

SERVICES 

This tool is extremely useful in configuring service usage under Windows XP. Changes to settings made 
under this tool can affect performance, stability and XP functionality quite noticeably, so see the Services 
chapter dedicated to explaining these features in more detail and showing you how to optimize them. 
 
That covers the initial look at all the administrative tools in Windows XP. As mentioned, certain tools are 
covered in more detail later in this guide due to the need to use them often. Generally though, aside from the 
Services utility and Event Viewer, and possibly Computer Management, you should not need to access the 
administrative tools very often and great caution should be used when changing any settings with them. 
  

http://support.microsoft.com/kb/314343�
http://www.microsoft.com/downloads/details.aspx?FamilyID=31fccd98-c3a1-4644-9622-faa046d69214&displaylang=en�
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< AUTOMATIC UPDATES 

The Automatic Updates function in Windows allows your machine (when connected to the Internet) to 
periodically check for updates on the Windows Update website and depending on the options you set here, 
download and install them as necessary. When set to Automatic here, Windows will check for updates as 
often as you specify, and if an important update for your system is found it will download and install it for 
you at the same time. If you specify 'Download updates for me, but let me choose when to install them', 
Windows will download the updates but only install them when you choose. Neither of these two options is 
recommended, as updates may be downloaded and/or installed at inconvenient times and without your 
explicit consent. Although no Microsoft updates are harmful, I still recommend you keep tight control over 
the downloading and installation of Windows Updates. 
 
Instead, if you feel as though you will forget to check the Windows Update site regularly, and want to be 
told whenever important updates are available, select the 'Notify me but don't automatically download or 
install them' option. That way you will be told when an important update is available, but you can still 
choose if/when to download and install it. 
 
My personal preference (and the most optimal for performance and privacy) is the final option: 'Turn off 
Automatic Updates'. This means the Windows Update service will not constantly run in the background, 
taking up resources, and at the same time you can simply check the Windows Update website manually 
every few days to see if you should download any important updates. Not only does this give you full 
control over updates, you will also be able to access updates much sooner this way, as they are often 
available via Automatic Update much later than on Windows Update or the Microsoft Download site. 
 
Note that the 'Automatic Updates' service must be set to Automatic to allow you to access the Windows 
Update website, even if you set Automatic Updates to Off here, so don't disable it.  
 
< DATA SOURCES (ODBC) 

This tool is discussed under the Administrative Tools entry above, and has exactly the same function. 
 
< DATE AND TIME 

DATE AND TIME 

Set the current date and time under this tab.  
 

TIME ZONE 

Select the time zone that applies to you, and also tick the 'Automatically adjust clock for daylight savings' 
option. This means that whenever daylight savings changes in your area, the clock will be automatically set 
forward or back as appropriate - handy if you rarely remember when daylight savings actually occurs. 
 

INTERNET TIME 

In general you can leave the 'Automatically synchronize with an internet time server' option ticked so that 
the system time is always correct. Alternatively you can untick the box and periodically update manually 
whenever you are connected to the Internet by clicking the 'Update Now' button instead. See the Services 
chapter for details on how to disable the Windows Time service as well if you decide to disable this 
functionality here. 
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< DISPLAY 

THEMES 

You can switch between the Windows Classic theme, which makes XP look like previous versions of 
Windows, or select the Windows XP theme. You can also save any changes you make to Windows XP's look 
by creating a custom theme and saving it. Selecting the Classic theme will provide some memory savings 
due its less graphically intense nature, however if you prefer the Windows XP theme I recommend you use 
it regardless. There's no reason why you should tweak away the aesthetics of Windows XP for no major 
performance gain. You spend a great deal of time looking at the XP interface, so on balance a few MB of 
memory sacrificed to make the interface easier on the eyes is not that bad - uglier does not really equal faster 
in this case. See the Visual & Convenience Tweaks chapter for details of how to customize the interface and 
add more themes. 
 

DESKTOP 

Select a Wallpaper you would like to display in the background of the Windows Desktop. If the default ones 
listed in the preview pane are not to your liking, you can choose one from an existing picture anywhere on 
your hard drive or from an inserted CD/DVD by clicking the Browse button. Note that if you want to 
minimize memory usage and speed up bootup time, you should either not use a wallpaper at all, or 
preferably select a wallpaper that is the same size as your desktop and less intricate - that is, a picture with a 
smaller file size. 
 
Click the 'Customize Desktop' button. Here you can also select whether to display or remove the My 
Documents, My Computer or My Network Places icons on your Desktop. Removing these icons (unticking 
them) here will not disable their functionality, it will simply remove their icons from the Windows Desktop. 
Note that if for some reason you wish to remove the Recycle Bin from the Desktop see the Group Policy 
chapter or the Windows Registry chapter for the relevant tweak. You may also wish to change the 
appearance of any of the main system icons that appear on the Desktop. You can choose to alter their 
appearance by highlighting them in the scroll list below, selecting 'Change Icon' and assigning a new icon in 
their place. 
 

SCREEN SAVER 

You can select a particular screen saver here, to be displayed after a set period of idleness. Modern CRT and 
LCD monitors don't actually require screen savers to protect them from 'burn-in' (permanent image 
imprinting), so a screen saver is not an absolute unnecessary. However you may want to enable the 
screensaver to prevent static images becoming temporarily imprinted on some LCD screens, and of course 
Plasma screens are more susceptible to permanent burn-in and should definitely be protected by using a 
fully animated screensaver, or the Blank screensaver. Note that the settings under the Power button are 
covered under Power Options further below. 
 

APPEARANCE 

I personally prefer the Windows XP Style for Windows and buttons. This uses a small amount of extra 
memory over the Windows Classic Style, but looks much nicer in my opinion and has no significant impact 
on performance. If you are genuinely struggling (e.g. running 256MB of RAM), then you may notice an 
improvement in responsiveness by switching to the Windows Classic Style. You can adjust the individual 
elements of the desktop theme by clicking on the Advanced button, selecting the element you want to 
change from the drop-down list, and adjusting its properties accordingly. 
 
Under the Appearance tab, click the Effects button, and I recommend unticking the 'transition effects', 'show 
shadows under menus' and 'show window contents when dragging' options here for maximum 
responsiveness on the desktop. However once again if you particularly like these effects you can leave them 
enabled without any major impact on most modern systems. LCD users in particular should enable the 
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ClearType option here under the 'smooth edges of screen fonts' setting - see ClearType further below for 
details. 
 

SETTINGS 

You may find two monitors listed under the Display list. This is normal for some graphics cards, even when 
only one physical display is currently attached. Select the Screen Resolution you want for the Desktop, and 
the Color Quality to go with it. Note that some recent programs and games may experience problems if the 
Desktop is anything less than 32 bit Color quality, so 32 bit (if available) is recommended for maximum 
stability and compatibility - the performance degradation is insignificant on your Desktop, and there is no 
reason to select any lower bit depth on modern PCs. 
 
If you click the Advanced button under the Settings tab, you will be taken to the control panel for your 
graphics card. While many sections of this screen differ based on your particular graphics card, all graphics 
cards share the following common elements, which are described below: 
 
General: The DPI (Dots Per Inch) setting determines the relative size of everything on your screen. If you run 
at extremely high or extremely low resolutions for example, you can change the DPI to scale the elements of 
your screen to a more suitable size without having to change your resolution. The default of 96 DPI is 
recommended for most people. I also recommend selecting the 'Apply the new display settings without 
restarting' option, as you do not need to restart your machine each time you change a display setting. 
 
Adapter: Here you will find the details of your current graphics adapter (i.e. your graphics card). If the details 
are incorrect, this could indicate a poorly installed or incorrect graphics and/or motherboard driver, or 
modified hardware. Check your details against those provided by the tools in the System Specifications 
chapter. 
 
Monitor: Here you can set the Refresh rate used by your monitor for the current screen resolution. I strongly 
recommend that you first tick 'Hide modes that this monitor cannot display', then select the highest refresh 
rate listed. The refresh rate determines how many times per second the image onscreen is redrawn. The 
higher the setting, the more times the screen is 'refreshed', and the less strain there is on your eyes. It is 
strongly recommended that you use a utility called Refresh Force to force the highest possible refresh rates at 
each resolution on your system. This utility is easy to use, and is supported by all graphics cards. Note that 
many LCD displays generally refresh at 60Hz maximum, which is fine since LCD-based displays work on a 
different principle and don't need a high refresh rate - see this page of my Gamer's Graphics & Display 
Settings Guide for an explanation of what Refresh Rate is and how it works in Windows and in games. 
 
Under the Troubleshoot tab, move the slider under 'Hardware acceleration' to the far right, and tick 'Enable 
write combining'. This ensures maximum performance, and you should only change these if troubleshooting 
a specific graphics-related problem. 
 
Under the Color Management tab, select the color profile that matches your monitor model and click the 'Set 
As Default' button. If there is no profile listed for your monitor, click the Add button and select one which 
matches your monitor model, or if none seem appropriate, insert your monitor's driver disk, browse to your 
CD/DVD drive and find the correct .ICM file, then click Add. Alternatively go to your monitor 
manufacturer's website and download the latest driver for the monitor, then install it and recheck the list 
here when you click the Add button. The color profile ensures your monitor displays colors as they are 
intended to appear, which can be particularly important if you are doing things like web design. 
  

http://www.pagehosting.co.uk/rf/�
http://www.tweakguides.com/Graphics_7.html�
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CLEARTYPE 

For users of LCD panels and other fixed-pixel display devices that may require some enhancement to make 
text appear sharper and clearer on screen, particularly when using non-native resolutions, Microsoft has an 
option called ClearType you can enable by going to your Display properties (See above), selecting the 
Appearance tab, clicking the Effects button, and changing the 'Use the following method to smooth edges of 
screen fonts' to ClearType. However, to fully customize ClearType you need to use this Microsoft Online 
ClearType Tuner, or download and use the ClearType PowerToy Utility. In either case, ClearType greatly 
improves font display quality by reducing jaggedness, so it is recommended you use it if you run an LCD or 
other fixed-pixel digital display. 
 

GRAPHICS CARD CONTROL PANEL 

For full details on how best to configure the remaining graphic card-specific elements of Display Properties, 
for ATI graphics cards you should refer to my ATI Catalyst Tweak Guide, and for Nvidia cards you should 
refer to my Nvidia Forceware Tweak Guide. Also check my Gamer's Graphics & Display Settings Guide for 
clear explanations of how major graphics-related settings and features work. 
 
When you're done altering the settings in Display Properties click the Apply button. Then go back to the 
Themes tab, click the 'Save As' button and select a new name and location to save your customized theme. 
 
< FOLDER OPTIONS 

GENERAL 

Under the General tab, select 'Use Windows classic folders' to get rid of the lumped-together 'common task' 
icons. The choice is yours of course, but this guide assumes you are using the classic folders view when 
giving directions on accessing features. If necessary you can use classic folders only while following this 
guide, and then switch back to the default XP folder view once you're finished. 
 
Select 'Open each folder in the same window' to reduce open windows and hence unnecessary memory 
usage. 
 
Select 'Double-click to open an item (single-click to select)' as this is the default method most Windows users 
are familiar with, and the one which is assumed when providing descriptions in this, and most other guides. 
Again, you can always switch to the other method once you have completed using this guide. 
 

VIEW 

I recommend you tick the following options: 
 
§ Display file size information in folder tips 
§ Display simple folder view in Explorer's folder list 
§ Display the contents of system folders 
§ Show hidden files and folders 
§ Show and manage the pair as a single file 
§ Remember each folder's view settings 
§ Show encrypted or compressed NTFS files in color 
§ Use simple file Sharing 
  

http://www.microsoft.com/typography/cleartype/tuner/1.htm�
http://www.microsoft.com/typography/cleartype/tuner/1.htm�
http://www.microsoft.com/typography/cleartype/tuner/1.htm�
http://www.microsoft.com/typography/ClearTypePowerToy.mspx�
http://www.tweakguides.com/ATICAT_1.html�
http://www.tweakguides.com/NVFORCE_1.html�
http://www.tweakguides.com/Graphics_1.html�
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It is recommended that the following are unticked for best performance and functionality: 
 
§ Automatically search for network folders and printers (don't untick if you are on a Network) 
§ Hide extensions for known file types 
§ Hide protected operating system files 
§ Launch folder windows in a separate process 
§ Show popup description for folder and desktop items 
 
Any remaining options can be ticked or unticked according to your tastes and needs. 
 

FILE TYPES 

You can view and change which tools will open particular file extensions by default. For example, scroll 
down to the TXT extension (text documents) and highlight it. In the details below you can see that the 
default tool for opening .TXT files is Notepad, and if you click on the Change button you can choose another 
application as the default. Sometimes certain installed applications will quietly change these default 
programs to suit their own needs without asking you, so check back here if you find your files opening with 
something other than the application you want to use, and make changes as appropriate. 
 

OFFLINE FILES 

I recommend you untick 'Enable Offline Files'. You'll still be able to view saved/cached web pages offline. If 
the option is unavailable, it is because you have Fast User Switching enabled (See User Accounts below), in 
which case you can ignore this section. 
 
< FONTS 

This item displays the contents of your \Windows\Fonts folder, which contains all your currently installed 
system fonts. Fonts are the various types of text styles used by a variety of programs such as word 
processors, paint programs and the Windows Wordpad for example. You can install a new font simply by 
copying its .FON or .TTF files into this folder, or by going to the File menu and selecting 'Install New Font...' 
and pointing to the directory where the new font files reside. Note that TrueType is a font technology that 
ensures good scaling and that what is displayed on your screen should come out exactly the same on your 
printer - other types of fonts may look slightly different in different applications and/or when printed and/or 
when using different font sizes. To find out more about fonts, go to the Microsoft Typography Website. A 
good site that contains additional fonts you can download and install for free is Simply The Best Fonts. 
 
< GAME CONTROLLERS 

This tool allows you to add or remove gaming controllers on your system. This typically includes gamepads, 
joysticks and game simulation hardware. Note that although often used in PC games, the mouse and 
keyboard are not classed as 'game controllers' here - they have their own separate setup tools in the Control 
Panel (see Keyboard and Mouse below). 
 
Note that most joysticks require something called Calibration - a process under the device's Properties which 
tells Windows when the joystick is at absolute dead center, when it is at far right, far left, etc. If this is not 
done then often you will find the joystick may be unresponsive in certain directions, or it will constantly be 
read by Windows as moving in one direction when it is actually dead center, and so on. 
 
The majority of game controllers have their own software for installing and setting up the device, however 
firstly I recommend clicking the Add button in the Game Controllers section and using the closest device 
description which matches your device. If then during gameplay you find your device is not functioning at 
all, or missing certain functionality, you should then install and use the device-specific software. This will 
minimize the background resource usage that specialized device drivers often bring with them. 
 

http://www.microsoft.com/typography/default.mspx�
http://simplythebest.net/fonts/�
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Finally, if you play certain games only using the keyboard and mouse combination, and you find your 
character is displaying strange movement behavior (e.g. constantly moving in one direction with or without 
user input), then physically disconnect all game controllers from your system (excluding keyboard and 
mouse) and reboot, then relaunch the game. 
 
< INTERNET OPTIONS 

This setting in the Control Panel simply brings up the Internet Explorer 'Internet Properties' box. There is no 
difference between accessing it here and accessing from within Internet Explorer, so see the Internet Explorer 
chapter for full details of how to configure these options. Note if you are using another browser as the 
system default browser then clicking this item will still bring up the Internet Explorer 'Internet Properties' 
box - this is normal and cannot be changed. 
 
< KEYBOARD 

Under the Speed tab, I recommend you set the 'Repeat Delay' slider to the far right and also set the 'Repeat 
Rate' slider to the far right. This will increase the responsiveness of the keyboard in Windows XP. You can 
also adjust the 'Cursor Blink Rate' to your taste, and then click OK to apply. You can test these settings in the 
box provided to see if they suit you. Note you can further customize the cursor's blink rate and width under 
the Display tab of the Accessibility Options item in Control Panel. 
 
< MOUSE 

I only cover the basic mouse settings here, and most of the settings in this section can be adjusted to taste. If 
you have installed a special mouse driver for your mouse, you may see different settings under this screen, 
however the settings below should still be available on most systems with a mouse. 
 

POINTERS 

I recommend you untick 'Enable Pointer Shadow' at the bottom. 
 

POINTER OPTIONS 

I recommend ticking the 'Enhance pointer precision' option before you adjust your pointer speed. This 
option enhances the acceleration/deceleration of your mouse to provide for larger movements when you 
move the mouse fast, and finer movements when you move the mouse more slowly, allowing a balance 
between speed and precision. I recommend unticking the 'Display pointer trails' option to reduce mouse 
'lagginess' unless you have an older or less clear screen and/or have difficulty keeping track of mouse 
movements. 
 

WHEEL 

If your mouse has a mousewheel, you can increase the wheel's responsiveness by increasing the number of 
lines it will scroll on each turn of the wheel. Even an increase from the default of 3 to 4 for example will 
make a subtle, but noticeable difference if you previously found the mousewheel relatively unresponsive. 
 

INCREASING USB SAMPLE RATE 

If you have a USB mouse and want to increase the rate at which it takes samples of its current position - 
thereby increasing accuracy and responsiveness - check this USB MouseRate Switcher. Please note there is a 
fair bit of risk involved in using this utility as it affects all USB devices, so follow the instructions closely 
before implementing, and only use it if you are an advanced user. 
  

http://www.majorgeeks.com/USB_Mouserate_Switcher_d4469.html�
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< NETWORK CONNECTIONS 

Because of the sheer variety of network connection hardware, and the potential for doing more harm than 
good, altering your Network Connections settings is not a simple procedure and I will not be covering it in 
detail in this guide. If you have a Dialup connection - that is 56K or lower connection speed - then read this 
Dialup Modem Tweak Guide for more details. If you have DSL or Cable, use the information from this 
DSL/Cable Tweak Guide for guidance. If you are on a Network of computers, consult your Network 
Administrator before attempting to alter any of the Network Connection settings, and be very careful about 
which other settings you implement from this guide, especially those under the Services chapter, as the 
advice is not designed for Networked users. 
 
In general, I recommend that you do not alter your network-related settings, as more often than not, your 
connection will end up being slower rather than faster, and in many cases you may lose Internet 
functionality. Most network connections require specific procedures to set up optimally, and these are 
usually documented in the device's instructions which is the best place to look for tips and advice. 
 

QOS PACKET SCHEDULER 

The following is recommended for home dialup and Cable/DSL users (but not for Network or Shared users). 
Right-click on the device you use to connect to the Internet, and select Properties. Go to the General tab, and 
under the 'This connection uses the following items' list, make sure the 'Internet Protocol (TCP/IP)' option is 
available and ticked. Now select every other item listed, including the 'QoS Packet Scheduler' and click the 
Uninstall button to remove them. None of these are required for regular Internet usage by a single non-
networked machine, and removing them will reduce unnecessary resource usage. Should they be needed 
again you can always simply reinstall them from here at any time. Note if you disable the QoS Packet 
Scheduler you should also disable the 'QoS RSVP' service (see the Services chapter). Neither are required for 
the average home Internet user. 
 

WINDOWS FIREWALL 

Under the Advanced tab click the Settings button and turn the Windows Firewall On as advised previously, 
unless you have third party firewall software already installed, in which case activate that instead, and 
disable the Windows Firewall. To find out more about Firewalls see the PC Security chapter. 
 
< NETWORK SETUP WIZARD 

This wizard will take you through the steps required to connect a network device, including any device that 
connects your machine to the Internet. You can follow the steps in the wizard to connect your device, 
however I generally recommend you follow the instructions that come with your device instead, along with 
instructions from your particular Internet Service Provider (ISP). 
 
< PHONE AND MODEM 

As mentioned under Network Connections above, because of the variety of modems that can be used to 
connect to the Internet, or to other electronic devices, I cannot provide specific setting recommendations here 
for each device. Check the links under Network Connections above for more details.  
 
As with installing any other type of peripheral device under Windows XP, typically the best installation 
procedure is to simply connect the device to your system, and wait for Windows XP to identify the device 
and install the default drivers. However in the case of modems I recommend installing the latest available 
drivers or at the very least the drivers which come on the device's driver CD. If you have any doubts about 
what settings to use once the device is installed, I strongly recommend leaving them at their defaults. 
Changing these settings can see your modem or device not function correctly, and hence you may not be 
able to connect to the Internet. Note that devices listed under Phone and Modem may include devices 
loosely identified as 'modems' such as mobile phone/PDA data hookups. 
 

http://www.techspot.com/tweaks/modem-win2k/�
http://www.dslreports.com/tweaks�
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< PORTABLE MEDIA DEVICES 

If you have a portable media device connected to your system, such as an MP3 player, you can manage the 
device here. It is recommended that you refer to your device's instructions as to how best to configure it for 
connection and usage with Windows. 
 
< POWER OPTIONS 

POWER SCHEMES 

You can set the periods of time after which your monitor, your hard drive and/or your entire PC go into a 
power-saving standby state to conserve energy. You can select an appropriate preset scheme such as 
'Portable/Laptop' or 'Always On', or you can customize the settings yourself. 
 
Unless you have a power-limited device, such as a laptop running on batteries, I recommend selecting 
'Always On' to start with. Next, for the 'Turn Off Monitor' option, I recommend selecting a period which is 
not too short, so that the monitor isn't constantly switching off - e.g. select 30 minutes. Combined with a 
shorter period for a screensaver to kick in (See further above), such as 5 or 10 minutes, the two settings 
ensure that your monitor saves power without becoming a nuisance. I recommend against enabling the 
'Turn Off Hard Disks' option on a desktop PC - set it to Never. Even if you're not at your system, there may 
be scheduled drive-related tasks such as background defragmentation, and so switching the drive off will 
only hurt performance for minimal power savings. Similarly, I don't recommend using the System Standby 
option for desktop PCs, as putting your entire system into standby mode once again prevents background 
tasks from executing. 
 

ADVANCED 

I recommend unticking the 'Always show icon in the taskbar' option to remove the unnecessary power icon 
in the system tray. If you don't use system standby, or if physical security is not a concern then I also 
recommend unticking 'Prompt for password when computer resumes from standby'. In the Power Buttons 
section, select the action you want for 'When I press the power button on my computer' - I recommend 
selecting Shut Down from the list for the most obvious and trouble-free result. 
 

HIBERNATE 

I recommend not using Hibernation for desktop PCs and hence I suggest you untick the 'Enable Hibernation' 
option here. Hibernation uses a great deal of disk space to store the state of your machine at the time of 
hibernation - equivalent to your physical RAM size in hard disk space - and for optimal stability I 
recommend that you start each computer session with a clean bootup. This will reduce the possibility of 
memory-related problems and crashes. 
 

UPS 

If you have a power supply that is specifically classified as an Uninterruptible Power Supply (UPS), you can 
configure it here. Most people do not have UPS power supplies, and if you're not sure whether you have one 
then it's almost certain that you don't, hence you can ignore this section. See the Services chapter for more 
details about how to disable the UPS Service if you don't have a UPS power supply. 
 
< PRINTERS AND FAXES 

This section allows you to view all connected printers and faxes, and add or remove such devices. It is 
recommended that you refer to the particular device's instructions for optimal setup information under 
Windows XP as each can differ. 
 
Importantly, note that if you have disabled the 'Print Spooler' service then any printer on your system will 
not function - this also includes 'printer-like' utilities such as PDF makers. Make sure the 'Print Spooler' 
service is set to Automatic if you want to use a printer. Furthermore if you have disabled the port to which 

http://en.wikipedia.org/wiki/Uninterruptible_power_supply�
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the printer is connected in the BIOS or in Device Manager (e.g. LPT1 or a specific USB Host Controller), 
perhaps to free up an IRQ, then once again your printer will not function - you will have to re-enable it. 
Finally, if you are connected to a network printer and you have followed my service configuration 
recommendations under the Services Utility chapter - which as noted are not intended for networked 
computers - then your network printer may not be detected by Windows. Go through this guide again and 
make sure all network-related functions are enabled so you can access your network printer. 
 
< REGIONAL AND LANGUAGE OPTIONS 

REGIONAL OPTIONS 

Select the language format that suits your particular region of the world. You can also set your country at the 
bottom, and it is recommended that you do so to allow all your software to be able to customize options and 
text displays to suit you, not just in Windows XP itself, but also in all the games and applications you use. If 
you wish to customize any specific settings, such as data/time display formats, currency formats etc. click the 
Customize button and do so accordingly. If you've selected the appropriate country though, the defaults 
shown here should already be correct. 
 

LANGUAGES 

Click the Details button and select your default input language. 
 
If you only ever use one particular text service on your machine for each language, such as Keyboard (the 
default, and a necessary service), then remove any other text services displayed under each language (such 
as Speech Recognition) as they take up additional memory. Do this by highlighting the displayed text service 
in the Installed Services box, and click on Remove.  
 
Alternatively, if you want to Add a text service, or configure these advanced text services for various 
functionality, see this Microsoft Article for more details. Remember, the use of advanced text services takes 
up memory and can reduce system performance, so only enable these functions if you really use them often, 
and not just as a novelty. 
 
In the Preferences section below it, if you have more than one text service installed you can click the 
'Language Bar' button (otherwise it is unavailable). I recommend selecting 'Close the language bar' to 
remove it from your desktop unless you specifically need it there. If you do use more than one language 
often, I still recommend closing the Language Bar, and instead assign keyboard shortcuts for switching 
between these languages, by clicking on the 'Key Settings' button here. This is a much more efficient and 
quicker method of switching languages. 
 
Under the Advanced tab, unless you use any advanced text services such as speech or handwriting 
recognition, tick the 'Turn off advanced text services' option. If you do wish to use advanced text services, 
and also want them to be available to all your programs and applications, then tick the 'Extend support of 
advanced text services to all programs'. Click Apply and OK to go back to the Regional and Language 
Options box. 
 
Back under the Languages tab of the main Regional and Language Options box, unless you use a right-to-left 
language (such as Arabic or Thai), or an East Asian language, then make sure both boxes under the 
Supplemental language support area are unticked, and click Apply. This removes unnecessary files from 
your hard drive. 
 

ADVANCED 

Select the language you want for non-unicode programs. Since Unicode basically allows most modern 
programs to automatically adapt their menus and dialogs to your system's default language, this setting 
only applies to older non-unicode programs. These older (non-unicode) programs will use the Code page 

http://support.microsoft.com/kb/306537�
http://www.unicode.org/standard/WhatIsUnicode.html�
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conversion tables listed to convert from other languages to your preferred language. While you can choose 
to remove or add (untick or tick) various conversion tables in this section, I recommend against doing so as 
this can affect the correct language display of any older programs you use. Some of the conversion tables are 
greyed out as these are installed by default for Windows XP and cannot be removed. 
 
If you want to make the settings you have modified in the Regional and Language Options box the default 
for every user account created on this system as well as the current account, tick the 'Apply all settings to the 
current user account and to the default user profile' box. 
 
< SCANNERS AND CAMERAS 

This section will allow you to manage any digital image devices such as scanners or digital cameras 
connected to your machine. Refer to your device's manual for specific setup recommendations. Typically 
you will simply need to attach your device, turn it on and Windows XP should detect it and install basic (but 
adequately functional) drivers. I recommend that only if you are having problems accessing the device, or 
any of its important functionality, that you install device-specific drivers or software. Otherwise the default 
Windows XP drivers are the most efficient and minimize background resource usage. 
 
< SCHEDULED TASKS 

The Scheduled Tasks utility allows you to set up particular tasks that your machine will then run at a 
predetermined time and in a predetermined sequence. To create a new task, click the 'Add Scheduled Task' 
item, and the Scheduled Task Wizard will commence, allowing you to detail the task to be run. You can also 
view and edit existing scheduled tasks in this panel. I recommend you go to the Advanced menu and select 
the 'View Hidden Tasks' option to ensure all scheduled tasks are shown. I generally do not recommend 
having scheduled tasks; regular system maintenance for example is best carried out manually, at intervals 
determined by frequency and type of use and not set periods of time (See the Regular Maintenance chapter). 
Note that the 'Task Scheduler' service must be set to Automatic for scheduled tasks to function. 
 
< SECURITY CENTER 

The Windows Security Center unifies access to, and monitoring of, major security-related Windows settings 
on your system. Primarily these are the Windows Firewall for protecting against externally-initiated 
intrusions into your system; Automatic Updates which ensures notification and/or installation of important 
Windows XP updates as they are released by Microsoft; and Virus Protection which works in conjunction 
with your virus scanner to make sure your system is free of infected files which can compromise your 
system's security, stability and privacy. 
 
Each of these areas and appropriate recommendations is covered in the relevant section of this guide: the 
Windows Firewall is covered in the Windows Firewall section below; Automatic Updates is detailed in the 
Automatic Updates section above; and Virus Protection is covered under the PC Security chapter above. The 
Security Center is simply a means of gaining access to all of these and changing some of their settings in a 
central location. As such, it's not actually a dramatic improvement in security - simply one that makes users 
more aware of the types of things they have to monitor and change to maintain system security. 
 
The one setting which I do find very annoying and I recommend you change is the Virus Protection setting. 
In the 'Virus Protection' box in the Security Center click the Recommendations button. In the 
Recommendation box which opens, I suggest you tick the box at the bottom. This will prevent Windows 
from constantly reminding you that your virus scanner's reference file is out of date, or that your virus 
scanner is not found, or that it is not currently active. For starters many popular antivirus programs are not 
supported by this feature. Secondly, it should be part of your regular maintenance procedure to manually 
update your virus scanner and run manual scans as often as possible. Finally, as I recommend throughout 
this guide, having a virus scanner running in the background can and will reduce your system performance 
for marginal gains in security. For all intents and purposes as long as you follow the other recommendations 
in this guide your system should be quite secure and clear of malicious software. If however you are 
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genuinely forgetful and your virus scanner appears to be supported by this feature, you may wish to keep 
the monitoring function of Virus Protection enabled. 
 
Note the Windows Security Center won't function fully if the 'Security Center' service has been Disabled (See 
the Services chapter). I recommend that the 'Security Center' service be set to Automatic to begin with, adjust 
your settings as recommended above, then disable the 'Security Center' service again as it is not necessary to 
continually access the Security Center to maintain security on your system. That is, disabling the 'Security 
Center' service will not disable the Windows Firewall, Automatic Updates or Virus scanner functionality at 
all. Also see the PC Security chapter of this guide for more tips on how to secure your PC. 
 
< SOUNDS AND AUDIO DEVICES 

VOLUME 

Adjust the volume to suit your taste, and make sure the Mute option is unticked. I recommend ticking the 
'Place volume icon in the taskbar' option as adjusting the volume is something you may do often in 
Windows, so this provides quick access by placing a speaker icon in the System Tray. I will cover the settings 
under the Advanced button a bit later below, as part of my instructions for optimal sound output. 
 
Under the Speaker settings section, you can independently adjust each speaker's volume level by clicking the 
Speaker volume button. In general this volume can be adjusted under the Volume tab as described above, so 
you only need use this section of the Sound options to check and make sure all speakers are outputting at the 
same volume, or adjust the individual speakers to have different volume levels each if that is what you want.  
 
Click the Advanced button here, and under the Speakers tab select the type of speaker setup you are using, 
such as Headphones or Desktop Stereo Speakers. Choose the setting closest to your particular setup. Under 
the Performance tab, move the 'Hardware acceleration' slider to the far right. This ensures full use of your 
sound hardware's features. Only reduce the slider by one or two notches if you are troubleshooting sound 
problems in a game for example. Move the 'Sample rate conversion quality' slider to the far right. This 
ensures optimal sound quality, and there is no real performance difference between the various settings on 
this slider as such. 
 

SOUNDS 

You can assign different sounds to particular system events in this section. Click on the relevant Program 
events (e.g. 'Start Windows') and either scroll through the list of default system sounds in the Sounds list 
below and select one, or click the Browse button to find a sound file elsewhere on your system which you 
can use. Press the Play button to hear a preview of the sound. 
 
I strongly recommend that you disable as many system sounds as you can, as they take up system memory 
by being loaded into RAM at startup. In particular I recommend disabling sounds for 'Start Windows' and 
'Exit Windows' to both reduce memory usage and speed up booting up and shutting down Windows. Also 
note that various programs add sub-entries to this section and include their own specific sounds, even if you 
uninstall them later on. Go through the entire list carefully and disable all unnecessary sounds.  
 
You can quickly disable all system sounds by selecting the 'No Sounds' item under the Sound scheme area - 
this doesn't turn off sound on your system, it simply removes sounds effects from all the various system 
events thereby reducing memory usage by these sounds. If you want to keep sounds for certain important 
events, such as Default Beep or System Notification, I recommend you apply the same sound to several 
similar events. For example, on my system I use the Exclamation.wav sound for all warning and alert events 
(i.e. Asterisk, Critical Stop, Default Beep, Exclamation, New Mail Notification and System Notification). That 
way if Windows runs into a problem or provides a warning/notification I can still hear an audible indicator 
of it, but by using the same sound for each event, my memory usage is greatly reduced. 
 
Once done, save these new settings by clicking 'Save As...' and entering a new name. 
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AUDIO, VOICE 

Make sure the default device in each of these categories is your primary sound hardware then tick 'Use only 
default devices' to minimize problems and conflicts with any other sound devices which may also be present 
on your system.  
 

OPTIMAL SOUND CONFIGURATION 

My suggested method for configuring your Sound settings for optimal sound output is provided below: 
 
1. Click the first Advanced button under the Volume tab of the Sounds and Audio Devices box. 

Alternatively, simply double-click on the Volume icon in the system tray. 
2. In the Volume Control dialog box that appears, go to the Options menu and make sure the 'Advanced 

Controls' option is ticked. 
3. Select the Properties item under the Options menu, and in the box that appears select your main sound 

output device in the Mixer Device list. Select Playback in the next section. Place a tick against every item 
in the list shown, and click OK. Back in the Volume Control window, you will notice it has expanded to 
show Volume, Balance and Mute options for every audio output method on your system. 

4. Go to the master Play Control (far left) and adjust the master Balance setting. Unless you specifically 
need an offset balance, the neutral (absolute middle) position is recommended.  

5. Make sure the 'Mute All' option is unticked 
6. Set the master Volume level to around the center position on the slider, then play a high quality music 

or audio file on your system (e.g. an MP3 file, not CD Audio as that uses independent sound) and adjust 
your speaker hardware's physical volume controls until the sound level is correct. 

7. Click the Advanced button, and if available to you (depending on your sound hardware) adjust the Bass 
and Treble settings to taste. If you don't have Digital Output capable sound hardware, make sure the 
'Digital Output Only' box is unticked, otherwise you will not hear any sound. Click Close when done. 

8. Now go to the Wave output method in the Volume Control box and make sure the Mute option is 
unticked. Again, while playing some music on your system adjust the Wave volume and your speaker 
hardware volume control together until the combination suits your taste and has the least amount of 
background noise/hiss. The Wave output method is the output method used by most games, 
applications and audio playback software so it's important to set it up correctly and at a tolerable level. 

9. Go through and adjust all the other sound output methods' Volume and Balance settings to taste. To 
further reduce background noise and hissing, I recommend muting (tick the Mute option) for every 
sound output method you do not regularly use. Input devices, such as Line-In, TAD-In and Microphone 
in particular can significantly contribute to background hissing, so mute them unless needed. 

10. Once done, go to the Options menu and select Properties, then untick all the sound output methods 
except those that you will be adjusting the properties for quite often. This will not disable these 
methods, only remove them from displaying in the Volume Control box, making it more manageable 
the next time you open it. At a minimum I recommend you leave the Play Control and Wave items 
ticked, as these are used most often on all machines. 

 
If you have a complex speaker setup or third party audio software you may wish to use that to adjust 
equalizer settings for example. In which case after you've followed the advice above go into that software 
and conduct more setting tweaks as necessary. 
 
Importantly, if your sound hardware has any Environmental Audio or Special Effects settings in your sound 
card-specific software (such as the EAX Control Panel for Creative sound cards), open these settings and 
disable all effects. These additional effects typically cause problems in games and can distort music and 
other audio played back on your machine. 
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< SPEECH 

This utility allows you to configure the speech recognition and text-to-speech capabilities of Windows XP. To 
use speech recognition, you will require an input device (i.e. microphone) connected to your system. To use 
text-to-speech functionality, you don't require anything other than audio playback hardware such as a sound 
card and speakers/headphones. You can select the voice style used to convert text to speech, and adjust its 
speed here. Note that this functionality must be supported by the program or game you are using if you 
want it to work. Also note that in most games or applications where you can enable a synthesized voice, you 
should be able to adjust the characteristics for this voice in this section of the Windows Control Panel since it 
is likely using the default Windows voice engine. If you want to download additional synthesized voices to 
use see this Text-to-Speech Voice site. 
 
< SYSTEM 

This is an important section of Windows XP, and each of the tabs under System Properties is covered below: 
 

GENERAL 

If any of the details displayed are incorrect then it is a sign of a bad install, new/unsupported hardware, IRQ 
conflicts, poorly installed/incorrect drivers or overclocking problems. In general if your system is 
functioning correctly then the information in this section should be correct. You may notice your CPU's 
speed rating is shown slightly higher or lower than its actual rating - this is normal. Importantly, you should 
make sure that after your Windows version, it says 'Service Pack 3' - if it doesn't, make sure to follow the 
instructions under the Driver Installation chapter to install the latest Service Pack, as it is an essential update. 
 

COMPUTER NAME 

Leave the Computer Description field blank, or use a generic description. To change your computer name, 
click the Change button. In both cases I strongly recommend against placing anything uniquely identifiable - 
such as your real name or address - in these fields. Unless you are part of a network of computers (the 
Internet doesn't count as a network), there is no need to alter your Network ID, nor the Workgroup you 
belong to. If you are part of a network, consult your System Administrator before attempting to change any 
of the settings above as it may result in problems and confusion, or completely dropping out from the 
Network. 
 

HARDWARE 

The 'Driver Signing' and 'Windows Update' options are covered in more detail in the Driver Installation 
chapter. 
 

DEVICE MANAGER 

Click the Device Manager button, go to the View menu and select 'View Devices by Type' and also tick the 
'Show Hidden Devices' option. You will see all the devices connected to your system at the moment, most of 
which are physical devices, some of which are virtual devices. Devices with a yellow question mark or 
exclamation mark next to them will need further troubleshooting to correctly identify and install. Typically 
this involves ensuring the device is correctly attached to your system, then double-clicking on the device in 
Device Manager, selecting Update Driver under the Driver tab, and following the prompts to install or 
reinstall the correct driver for the device. You may also need to install any software that came with the 
device to correctly use it. See the Driver Installation chapter for more details of drivers, and the Windows 
Errors chapter for more details of Device Manager error codes. 
 
You should disable devices that you don't regularly use to speed up windows and free up resources. Ideally 
this should be done first in the BIOS - See the BIOS Optimization chapter. However, to disable a device in 
Device Manager, double-click on the device and select 'Do not use this device' under the Device usage area 
at the bottom of the box. A red cross will appear next to the device, indicating it has been disabled. Make 

http://www.bytecool.com/voices.htm�
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sure to only disable devices you knowingly do not use. If in doubt leave them enabled, or re-enable them if 
you experience any unusual behavior. 
 
Go to the View menu and choose 'View Resources by type', then expand the 'Interrupt Request (IRQ)' item. 
Make sure each major device in your system (graphics card, sound card etc.) is on a separate IRQ from other 
major system devices. See the BIOS Optimization chapter for more details of IRQ sharing. 
 

REMOVE UNUSED DEVICES 

For each device that has ever been connected to your system, Device Manager will retain a range of entries in 
the Windows Registry relating to the device type, and the drivers and settings it used. That way if it is ever 
reconnected it can be quickly recognized again and ready for use. However there are times when you have 
permanently discontinued the use of a device and you want to clean out the Device Manager of these 
unused devices. To first view unused devices in Device Manager, do the following: 
 
1. Open a Command Prompt by going to Start>Run and type "cmd" (without quotes) then press Enter. 
2. Once the MS DOS prompt is open, type the following lines exactly as shown, pressing Enter after each: 
 

Set devmgr_show_nonpresent_devices=1 
 
Devmgmt.msc 

 
3. You can now type "exit" (without quotes) and press Enter in the command prompt window to close it. 
4. In the Device Manager window that opens go to the View menu and select 'Show Hidden Devices'. Now 

expand the categories and start looking through all the devices. Devices in gray are usually old/unused 
and safe to remove by right clicking on each one and selecting 'Uninstall'.  

5. In particular, you might find several entries under the Monitors section from previous graphics driver 
installations. You can typically delete all the greyed out entries but at least one un-greyed entry should 
remain. You may also find old entries for previous graphics cards under the Display Adapters section 
that again can be removed. Remember that even with only one monitor connected there may be two 
entries for some graphics cards, one of which is the Secondary - this is normal. 

6. You should not remove any Microsoft devices such as those under the Sound section, or devices that 
you are unclear about, or know that you will be reconnecting to your system regularly. 

7. Once done, you can close Device Manager the usual way and the next time you open it up it will not 
shown unused devices until you again use this method to do so. 

 
Use this method with great caution. In particular I recommend you create a new System Restore point 
beforehand. At the same time however if you do accidentally uninstall a hardware device which is currently 
connected to your system, in many cases you can simply disconnect and reconnect the device, or reboot 
Windows, and it will be redetected by Windows and the appropriate drivers installed again - so this method 
doesn't permanently remove any device nor prevent it from future usage. 
 
Back under the Hardware tab of System Properties, click the 'Hardware Profiles' button and for optimal 
bootup speed have only one hardware profile and choose 'Select the first profile listed if I don't select a 
profile in' and set the time to 0 seconds. 
 

ADVANCED 

The Advanced tab of System Properties has three major areas of settings - Performance Settings, User 
Profiles Settings and Startup and Recovery Settings - these are covered separately below: 
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Performance Settings: 
 
Visual Effects: For fastest performance, I recommend unticking everything except 'Use visual styles on 
windows and buttons' and 'Use drop shadows for icon labels on the desktop'. That will reduce usage of 
system resources for graphical effects, while still retaining the majority of Windows XP's trademark 
appearance. Obviously you can tick other effects if you specifically want to keep them. 
 
Advanced: In the Processor scheduling section select the Programs option for optimal performance on most 
systems. The 'Background Services' option will only improve performance on systems where multiple 
programs are often run together. 
 
Under the Memory usage section, once again select the Programs option. The 'System Cache' option is 
designed for servers, where more memory is used to speed up disk access at the expense of available 
memory for programs. Importantly, data corruption may occur under certain conditions if the 'System 
Cache' option is enabled, so it is strongly recommended you do not select it. 
 
For optimal settings under 'Virtual Memory', see the Memory Optimization chapter for full configuration 
details. 
 
Data Execution Prevention (DEP): This is a technology introduced with Windows XP SP2, and uses software 
and (where supported) hardware detection of programs that try to access and run code from designated 
'non-executable' memory areas. Full details of it are in this Microsoft Article. In practice DEP protects against 
malware that has become resident on the system and which then tries running malicious code from such 
memory areas. When DEP detects an attempt to launch an executable from a non-executable memory area it 
will shut the program down and provide a notification that it has done so. Hence if you are experiencing 
crashes or problems in games for example, unless you see Windows give you a specific DEP-related 
warning, it is highly unlikely that DEP is the cause of the problem. 
 
By default when 'Turn on DEP for essential Windows programs and services only' is selected, DEP 
protection is only enabled for programs that choose to work with DEP, along with Windows system files. 
This is the minimum form of DEP protection. You can choose to extend this protection to all programs by 
selecting 'Turn on DEP for all programs and services except those I select' - and then choose which programs 
to manually exclude from DEP by using the Add and Remove buttons. I recommend leaving DEP at its 
default setting ('Turn on DEP for essential Windows programs and services only') as it is not problematic 
and helps reduce any potential damage from malware activity on your computer. However if you want to 
change your DEP settings in more depth, including the total disabling of DEP, you can do so by editing your 
Boot.ini file (To access and edit Boot.ini see further below). The entry to change in Boot.ini is the /NoExecute= 
option. By default it is set to /NoExecute=OptIn however you can change the OptIn value to one of the ones 
below to change DEP's implementation: 
 
OptOut - Applies DEP to all processes and you must then set which programs are excluded manually. This is 
the same as the 'Turn on DEP for all programs and services except those I select' option above. 
 
AlwaysOn - Provides full DEP coverage for your entire system. If you are concerned about potential malware 
activity on your system and want maximum protection you can use this setting, although older software 
may have problems with it. 
 
AlwaysOff - This option turns off DEP completely. It is not recommended unless you are having a lot of 
problems with program crashes directly related to DEP even after thoroughly cleaning your system by 
following the advice under the PC Security chapter of this guide. 
 
Once again, it is recommended that you leave DEP at its default setting unless you are specifically having 
DEP-related errors and problems, which is usually quite rare. 

http://support.microsoft.com/kb/875352�
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User Profiles Settings: 
 
Back under the Advanced tab of the main System Properties box, click the Settings button under User 
Profiles, and examine the profiles stored on your computer. There will always be at least two profiles - the 
Administrator, and the default User profile here. If you are absolutely certain any other profiles are no 
longer in use, you can select them and press Delete to remove them from the system, which will free up disk 
space. 
 
Startup and Recovery Settings: 
 
Under the Startup and Recovery section, click the Settings button. For a system with a single operating 
system, select '"Microsoft Windows XP [Home/Professional]" /FASTDETECT...' in the list presented. For a 
multiboot system with two or more operating systems, select the one that you want to boot up by default 
each time you start your machine. If you only have one operating system, or you don't want to select a 
different operating system each time you boot up, untick the 'Time to display list of Operating Systems' 
option. Note that if you have an XP/Vista dual boot, you can still untick this option, because the Vista boot 
files which control dual booting are not affected by these settings. You will have to adjust your bootup 
options directly in Vista - see the Boot Configuration chapter of the TweakGuides Tweaking Companion for 
Vista. 
 
Tick the 'Time to display recovery options when needed' option and select at least 10 seconds if not more. 
This is the amount of time you'll get to choose the type of bootup from the recovery menu after a bad system 
crash. 
 
Click the Edit button to edit your Boot.ini file. Change the timeout= value in the second line to =0. You can 
also change the /NoExecute= setting here as covered under the DEP information above. When done, save and 
exit the text editor and the changes will be made to your Boot.ini file in your base directory. Note again that 
under an XP/Vista dual boot, the Boot.ini file is not used and hence editing it is irrelevant. 
 
Under the 'System failure' section untick all three options for optimal performance, and the 'Write 
Debugging Information' option should be set to None. That way if you run into problems you'll see the error 
displayed (usually a Windows Blue Screen of Death (BSOD) message) and your system won't automatically 
reboot, giving you time to read and record the error details at your leisure. At the same time you won't get 
lots of logfiles and dumpfiles of the event cluttering up your hard drive. Re-enable these options if 
troubleshooting a vague problem, or if relevant Technical Support personnel ask you to provide these files. 
See the Windows Errors chapter for more troubleshooting tips. 
 
Environment Variables: 
 
Under the Environment Variables screen I suggest you leave all the listed variables at their default settings, 
as most are needed by Windows and various programs to operate correctly. These should only be changed if 
instructed by a particular program or by Technical Support, and even then you should record the original 
settings in case something goes wrong. 
 
Error Reporting: 
 
Click the Error Reporting button and select 'Disable Error Reporting' and tick 'But notify me when critical 
errors occur'. This will prevent your system continually informing Microsoft of errors occurring on your 
system, but at the same time will still show you important system messages and errors for notification and 
troubleshooting purposes. 
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SYSTEM RESTORE 

Only tick the 'Turn off System Restore' box if you feel extremely confident about your Windows expertise. 
System Restore can take up a great deal of disk space, however I recommend that you leave it enabled since 
it can also save you a great deal of heartache if things go wrong. See the Backup & Recovery chapter for 
more details of how to use System Restore to backup your system state. Also see the Cleaning Windows 
chapter for details of how to delete older restore points to reduce the amount of disk space used up by 
System Restore. If you choose not use System Restore, see the Services chapter for details on how to disable 
the 'System Restore' service to save on system resources. 
 

AUTOMATIC UPDATES 

See the Automatic Updates section earlier in this chapter for more information on this functionality. 
 

REMOTE 

I strongly recommend that you disable (untick) the available options in this section for security and 
performance reasons. Only re-enable these options if specifically asked to do so by a trusted Technical 
Support person who requires remote access to your machine. Allowing remote access pretty much lets 
someone else access your machine and all its various files and settings as though they were sitting in front of 
your PC, so clearly it can compromise your security if left enabled. 
 
< TASKBAR AND START MENU 

TASKBAR 

The Taskbar is the long bar which sits at the bottom of your screen and contains your Start button, buttons 
for any open programs, and the System Tray. Most settings in this section can be set to suit your taste. 
 
The 'Lock the taskbar' option prevents accidentally moving or resizing the taskbar when ticked. When 
unticked, you can resize the Taskbar by dragging the top edge of it upwards, or you can move the entire 
Taskbar to sit at the left, right or top of the screen by dragging the bar itself - if you wish to do this, unlock 
the Taskbar, reconfigure it as desired, then lock it again to prevent unintended changes. 
 
I recommend you initially untick 'Hide Inactive Icons' so that you can see all the programs which are loading 
in the background in your System Tray area. I then recommend disabling as many of these as possible - see 
the Startup Programs chapter for more information on how to identify and disable unnecessary 
startup/background programs. If you want to eventually enable 'Hide Inactive Icons', perhaps to hide an 
annoying but necessary icon in the system tray (such as the 'Safely Remove Hardware' icon), tick the option 
and click the Customize button to select precisely which applications to always hide in the system tray, 
which to always show, and which should be hidden when inactive. Again, I recommend no applications be 
hidden when inactive, or hidden at all, unless you are absolutely certain they are essential and thus can be 
left running in the background at all times. Many application or game incompatibilities and crashes occur 
due to background programs, so hiding them will only make it harder to troubleshoot problems in the 
future. 
 

START MENU 

I recommend you select the 'Start Menu' option here to use the Windows XP default menu system. It has 
many advantages over the Windows Classic menu system. Click on the Customize button next to it and 
under the General tab, choose settings to taste. If you want to remove the Frequently Used Programs listing 
normally available on the Start Menu under the pinned items, set the 'Number of Programs on Start Menu' 
option to 0 and click the 'Clear List' button. 
 
Under the Advanced tab, I recommend you tick 'Open submenus when I pause on them with my mouse' to 
speed up menu access, and untick 'Highlight newly installed programs' as it is generally unnecessary.  
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Under the 'Start Menu Items' section, I recommend you tick the following: 
 
§ Enable Drag and Dropping 
§ Run command 
§ System Administrative Tools - Display on the All Programs menu 
 
These features should be enabled when using this guide, and I recommend keeping them enabled 
afterwards also. The other settings in this section can be ticked or unticked according to what you wish to 
have displayed on your Start Menu. 
 
When finished, click the Apply button and your changes will immediately be made to the Start Menu. 
 
< USER ACCOUNTS 

Windows XP allows multiple users to have varying levels of access to the same machine. By creating a 
separate User Account, each user can store their own settings, keep their own documents private, and have 
limited access to the system-wide settings on the same computer.  
 
My recommendation is that unless you have several people using the computer and each need separate 
accounts, you should only use one Administrator-level user account for fastest performance. That way you 
don't need to worry about logging into and out of two or more separate accounts (the Administrator and a 
lower level User account) just to make system changes and install/uninstall system software. Some recent 
software, as well as many games, require administrator-level access to use properly. 
 
Technically this is a security risk, as using an Administrator level account by default allows greater access to 
your system if you are infected by malware. However if you follow the instructions in the PC Security 
chapter, as well as the rest of this guide, the risks should be minimal when compared with the performance 
and convenience benefits. At the end of the day however, if security is your primary concern, you should 
create a separate account for day-to-day usage with more limited access so that if your regular account is 
compromised by a malicious program, it cannot be used to make changes to system files and settings. 
Remember though that you have to be logged in as the Administrator to make the majority of changes in this 
guide, as well as being able to use certain programs and games properly. 
 

FAST STARTUP -  SKIPPING LOGIN SCREEN 

If you have only one user on your machine, to have the fastest startup in Windows XP you can bypass the 
Login screen altogether by doing the following: 
 
1. Click 'Change the way users log on or off' and tick 'Use the Welcome screen', and untick 'Fast User 

Switching'. 
2. Go back to the main User Accounts screen and click the Guest account, and then click the 'Turn Off the 

Guest Account' button. 
3. Delete any unused accounts other than your primary one on the main User Accounts screen by clicking 

each one and selecting 'Delete the Account'. 
4. Click on your main account, and if your account has a password select 'Remove my Password'. 
 
Click 'Apply Options' to finish. 
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< USER ACCOUNTS - ADVANCED 

Aside from the User Accounts tool in the Control Panel, you can access a further set of user account features 
by going to Start>Run> and typing "Control Userpasswords2" (without quotes) then pressing Enter. The 
following are details of the settings in this advanced user accounts tool: 
 

USERS 

If you have only one User account and you left your password field blank during Windows installation you 
shouldn't be prompted for a username and password each time you bootup XP. This is the method I 
recommend for the fastest (though less secure) way to bootup. However, if you have several user accounts 
with associated passwords, but want one of those accounts to automatically log on to XP at bootup without 
being prompted for a password, go to the Users tab and untick 'Users must enter a username and password 
to use this computer', and click Apply. In the new dialog box that appears, enter the username and password 
for this 'autologon' user. Now each time you bootup Windows this user will automatically login to Windows 
- but this is not as fast as not have a password in the first place. It all depends on your particular security 
needs. 
 
In general you should remove all user accounts from the list of 'Users for this computer' except for the 
Administrator and the individual accounts for known users of your PC. Accounts such as ASPNET (the 
.NET Framework account) can safely be removed by highlighting them and clicking the Remove button. The 
less accounts you have on your machine, the safer and more optimal your machine will be. Furthermore, as 
soon as you have two or more user accounts (aside from the Administrator), your system will prompt you to 
select an account on the welcome screen when booting up Windows, so if you find this has suddenly 
happened to you, you will need to remove any additional accounts recently created if they are not needed. 
 
You can also change the access level of individual accounts here by highlighting them and selecting the 
Properties button. Go to the 'Group Membership' tab and you can select the level of access they have. Aside 
from the Administrator and your own user account, you should ensure all other accounts have 'Standard 
User' or 'Restricted User' level access, not Administrator level access. 
 

ADVANCED 

Under the Advanced tab click the Advanced button under the 'Advanced user management' section. Select 
the Users folder in the left pane, right-click on the 'Help Assistant' account if it exists, select properties and 
make sure the 'User cannot change password', 'Password never expires' and 'Account is disabled' boxes are 
ticked for security purposes. You should do the same for the Support and Guest accounts. The only time you 
should enable these accounts is if someone you trust such as Microsoft Technical Support, asks you to do so. 
 
Under the 'Secure logon' section, if you want to increase your security you can tick the 'Require users to 
press CTRL+ALT+Delete' option. This will mean that users have to press the CTRL, ALT and DEL keys 
together to bring up a logon prompt which then allows them to enter their username and password for 
logging into Windows. This adds an extra layer of security however it can also be an inconvenience so I 
don't recommend it unless you need extra security. 
 
< WINDOWS FIREWALL 

The Windows Firewall is an important security feature of Windows. A firewall is a barrier between your 
machine and anything that attempts to connect to your system from outside, usually via the Internet. Unless 
you are using a separate software or hardware-based firewall, it is strongly recommended that you enable 
the Windows Firewall. 
 
In the General tab under the Window Firewall settings, I recommend you select On, and untick 'Don't allow 
exceptions' for maximum compatibility. Exceptions are temporary instances of connections to your machine 
that you have consciously authorized, such as connections for online games or messaging programs. To 

http://www.microsoft.com/windowsxp/using/security/internet/sp2_wfintro.mspx�
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completely disallow exceptions would mean that many of your online games and programs will not function 
correctly. 
 
Whenever you launch an application or game which requires external access to your machine, you will be 
prompted by the Windows Firewall whether you want to 'Keep Blocking' the attempt, to Unblock it, or to 
'Ask Me Later'. The simple rule is that you should only allow exceptions for (i.e. only Unblock) applications 
or games which you use often, and which you know should definitely require Internet communication with 
your machine, and which you trust. If a program that should have no need for Internet connectivity 
suddenly raises the firewall's alert without providing a sound reason, I recommend you 'Keep Blocking' it - 
at least until you can find out more about it through some research, such as reading its documentation. 
 
Under the Exceptions tab of the Windows Firewall settings you can see all the applications and games which 
you are currently allowing to have Internet access to your machine. Remove any which you are no longer 
using, or which you do not know or do not trust. You can do this by unticking them and/or highlighting 
them and selecting Delete. For more details on exceptions, see this Microsoft Article. 
 
Some specific applications or games might require that you open a particular Port. A 'port' in this context is 
like a small doorway into your machine, so opening a port also lessens your machine's security. However 
some programs must have access through a specific port to be able to communicate with your machine. If 
the application or game which requires the open port is on your Exceptions list then highlight it, otherwise 
select 'Add Program' and add it to the list, then highlight it. Then select the 'Add Port' button and enter the 
port number and protocol exactly as specified by the application or game's manual, help documentation or 
technical support personnel. Remember that certain trusted programs simply cannot function without 
appropriate access through the correct port, so this must be done from time to time. Technically speaking 
though, the more ports you have open, the less secure your machine is - so remove all open ports for 
programs you have not used in a while. 
 
Finally, the Advanced tab of the Windows Firewall settings contains a range of options that you can alter to 
allow or disallow greater access to your machine. I strongly recommend you leave these at the default 
settings, and only alter them if required by an often-used and trusted application or game. Almost all games 
and applications should function correctly without the need to alter any of the Advanced settings. If you 
want to know more about them refer to the articles linked above. 
 
See the PC Security chapter for more details of both preventing and detecting infection by malicious 
software, and other security tips which can help you secure your PC. See the Windows Errors chapter for 
potential solutions to Windows Firewall problems. 
 
< WIRELESS NETWORK SETUP WIZARD 

This feature launches a Wizard that takes you through the steps of connecting a security-enabled wireless 
device, such as a Bluetooth device. In many cases a wireless device shouldn't require additional drivers, 
however if necessary you may have to install them from your device's driver disk or its website. It won't be 
covered in detail here. 
 

http://www.microsoft.com/windowsxp/using/security/internet/sp2_wfexceptions.mspx�
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STARTUP PROGRAMS 
 
Windows loads up a range of programs into memory during its startup procedure, including drivers and 
programs needed to provide the main functionality in XP, just prior to showing the Windows Desktop or the 
logon screen. However many of the startup programs can be removed as they are not necessary for the 
specific functionality you require. Importantly, removing unnecessary startup programs will help reduce 
Windows startup time, and also reduce background resource usage, which in turn can improve overall 
responsiveness, reduce stuttering, and even prevent program conflicts and errors.  
 
The process of identifying and removing unnecessary startup items requires some patience and 
troubleshooting using the tools and methods covered in this chapter. 
 
 
< FINDING STARTUP PROGRAMS 

The first step in the process is to find the names of all the programs and files which are running at startup on 
your system. To do this you will need to use one or more of the several tools covered below: 
 

MICROSOFT SYSTEM CONFIGURATION UTILITY 

Windows XP comes with a built-in utility which allows for additional tweaking and troubleshooting of your 
system. This tool is usually hidden, in that no icon is provided for it by default. To access it, go to Start>Run 
and type "MSConfig" (without quotes) and press Enter. The main use for the Microsoft System 
Configuration Utility (MSConfig) is to provide a brief snapshot of key system variables, and perform some 
diagnosis and troubleshooting of your Windows startup, as detailed in this Microsoft Article. Details of each 
section of the utility are provided below. 
 
General: This section shows the current status of system startup procedures. The default is Normal, which 
loads up all your device drivers, services and startup items. If you disable any startup items or alter system 
variables using MSConfig, the Selective Startup option becomes highlighted, showing which processes and 
items have been changed. You should only use Selective Startup mode for temporary troubleshooting 
purposes. 
 
If at any point you want to quickly troubleshoot your system, and only want the essential services and 
drivers to load up with Windows, select the Diagnostic Startup item. This can help you determine if a 
problem is hardware or software based. This is similar to starting up using Safe Mode - see the Backup & 
Recovery chapter for more details. 
 
There is an option here to start System Restore (if the System Restore service is enabled) by clicking the 
'Launch System Restore' button. See the Backup & Recovery chapter for details of System Restore 
functionality. 
 
The 'Expand File' button provides a utility for extracting archived files from cabinet files (.CAB) such as those 
on the Windows XP CD. By selecting the location of the cabinet archive, and the specific file required, you 
can extract and restore individual files from the Windows XP CD in case the installed ones are corrupted or 
deleted. This is much more handy than having to reinstall Windows completely. There are other methods of 
repairing a Windows installation such as using the System File Checker - again, see the Backup & Recovery 
chapter. 
 
System.ini & Win.ini: These sections allow you to see and change the entries stored in the System.ini and 
Win.ini files, which typically reside in your \Windows directory. However unlike previous versions of 
Windows, Windows XP does not use these files at startup. The contents of these files are usually only 
required by very old 16-bit applications. As such, you should leave all the entries under these tabs at their 

http://support.microsoft.com/kb/310560/�
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default settings, unless specifically instructed to change them for a particular application. There are no 
performance gains to be had by editing them. 
 
Boot.ini: This section allows you to see and change the entries stored in the Boot.ini file, which sits in the base 
directory of the hard drive you have installed Windows XP on (typically directly under the C:\ directory). 
This file determines what XP should do at startup time, such as which options to display prior to loading up 
Windows. In general you should not change this file otherwise you may have problems booting into 
Windows. Details of what the most important boot.ini options do are covered under the Device Manager 
section of the Control Panel chapter. Note that if you're using an XP/Vista dual boot arrangement, the 
Boot.ini file is not used. 
 
I recommend that you make sure all options under the 'Boot Options' area at the bottom of this section as 
well as those found under the 'Advanced Options' button are unticked for the fastest full-functionality 
startup. These options are only provided to remove certain features from Windows at startup primarily for 
troubleshooting purposes: 
 
/SAFEBOOT - Ticking this option will force Windows to boot into Safe Mode the next time you restart - see 
Safe Mode under the Backup & Recovery chapter. 
 
/NOGUIBOOT - This option prevents the Windows XP startup screen (the scrolling bar) from appearing 
prior to the Windows Desktop loading up. This won't make any real speed difference, but if you find that 
screen annoying this is how to remove it. 
 
/BOOTLOG - Generates a log of the bootup files in your hard drive's base directory, handy if you are 
troubleshooting an error which occurs during Windows bootup. 
 
/BASEVIDEO - This option will force Windows to load up in standard VGA mode - that is no graphics 
drivers will be loaded up. This can be useful for troubleshooting purposes if you feel your graphics drivers 
are the source of a particular problem. 
 
/SOS - Ticking this option will remove the Windows Startup screen, allowing you to see what goes on 
behind the scenes as Windows starts up, such as which drivers are being loaded up. 
 
One setting you can safely edit in Boot.ini is the timeout= line - which is the same as the Timeout setting 
shown on the right side of this box. It should be set to 0 seconds for fastest bootup, however it can't be set 
below 3 seconds in MSConfig, so you must manually go to the Boot.ini file, open it with a text editor such as 
Windows Notepad, and edit the timeout= line to timeout=0, then save and exit the file. 
 
Services: This section shows all the services currently installed on your system, and their present status - that 
is whether they are running or stopped. If you want to temporarily determine whether a service is necessary 
or not for troubleshooting purposes, you can untick a service here and it will not load up the next time 
Windows is booted. However this is not the recommended method for permanently disabling services. The 
most useful feature here is the ability to tick the 'Hide All Microsoft Services' box, and hence quickly see all 
the third party services which are currently installed (and active) on your system by software other than 
Windows. Many of these services can be disabled to reduce memory usage and speed up bootup time. See 
the Services chapter for full details on how to correctly configure your Windows Services. 
 
Startup: This section shows all the additional programs which load into system memory upon booting up 
your system (aside from Services). Many of these startup items are unnecessary and you will gain 
performance and most importantly stability from removing them from your Windows startup. The hard part 
is determining which startup items are absolutely necessary, and which aren't. Unfortunately there are no set 
rules for doing this; each individual startup item has to be assessed on each system to see whether it is truly 
necessary in providing certain functionality for a specific program, or whether it is a useless entry which can 
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be safely removed without any negative impact. Follow the instructions below to correctly identify and 
remove unnecessary startup items on your system. 
 
Tools: As of SP3, a new Tools tab has been added which simply provides quick links to handy XP utilities. 
 

REGISTRY EDITOR 

The Registry Editor is detailed under the Windows Registry chapter, however here we look at its 
functionality related to startup programs. To launch the Registry Editor go to Start>Run and type "regedit" 
(without quotes) and press Enter. Below is a brief run-down of where startup items are held in the Registry 
and how to remove them. The Windows Registry holds a record of the specific programs to launch at 
startup, contained in four separate areas: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Run] 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\RunOnce] 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run] 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\RunOnce] 
 
If you find any items listed under any of these keys, it means they are set to run at Windows startup, with 
those under the Run keys being permanent items, and those under RunOnce being temporary items which 
only run for the next bootup. You cannot temporarily disable a startup item here, however to permanently 
delete any of these items, right-click on it and select Delete. Note that there is no backup functionality, so 
you should consider doing a backup of the Registry in part or in full, as detailed under the Backup & 
Recovery chapter, before deleting any items you're not completely certain about. 
 

AUTORUNS 

Autoruns is an advanced and highly useful startup identification and removal utility with unique features 
not available in the utilities covered above. Download the program, extract its contents to an empty folder 
and run the Autoruns.exe file. Under the 'Everything' tab you will see a large number of items which are 
loaded up with Windows - far more than most other utilities will ever show; this is what makes Autoruns so 
valuable for a range of purposes. Most of the entries shown are required for various programs to run, and a 
large proportion of them are Microsoft items which Windows XP absolutely needs to function correctly. 
 
Correctly identifying and removing the truly unnecessary items using Autoruns is more complex precisely 
because it shows so much detail, however to first narrow down the list to startup items you may want to 
remove, click the Logon tab in Autoruns. Note the particular filenames shown under the 'Image Path' 
column, or right-click on an item and select Properties to clearly see the filename. If you want to filter out 
Microsoft entries from this list, go to the Options menu and tick the 'Hide Microsoft Entries' item, then click 
the Refresh icon on the taskbar (or press F5). The list of items shown will be reduced, leaving only third-
party programs showing, making it easier to spot unnecessary programs. 
 
If you are an advanced user, or you're feeling more confident, click the Everything tab, and follow the steps 
above again to list only the non-Microsoft entries. What remains will be a range of startup programs, scripts, 
services and driver files. Some of these can be safely disabled, however you will need to research carefully 
before doing so. To do some basic research on an item, right-click on it and select 'Search Online' and 
Autoruns will launch a search in Google for that item's name. 
 
You can disable any item temporarily by unticking its entry, and Autoruns will prevent that item from 
loading up the next time Windows starts up. This is a good way of testing to see if the item is essential, and 
what impact its removal may have, without actually removing it. If you then wish to permanently remove an 
item in Autoruns, right-click on it and select Delete, though clearly this must be done with caution. 
  

http://technet.microsoft.com/en-us/sysinternals/bb963902.aspx�
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WINDOWS STARTUP INSPECTOR 

Windows Startup Inspector is a basic startup identification utility you can use to make the task easier. 
Download and install the program, then launch it. You will see all your startup items listed on the main 
screen. Now make sure you have an active Internet connection, and click the Consult button in the top 
menu. The program will connect to its Online Database and try to provide information for each of your 
startup items - click on each startup item to see the details. While details may not be available for every 
startup item, there is a handy 'Find More on Google' link at the bottom of the information panel, which when 
clicked automatically initiates a Google search using the startup item's exact name - very useful. 
 
If you want to disable a startup item using Windows Startup Inspector, simply click the green tick mark next 
to the startup item's name, and when the tick mark has been removed click the Apply button at the top of the 
screen. Close Startup Inspector and reboot for the item to be removed from your startup.  
 

HIJACKFREE 

HijackFree is an advanced free utility which provides details of all running processes, startup programs, 
services, even the open Ports and ActiveX controls currently in use by your system, all in one neat interface. 
It is intended for advanced users who have some knowledge of what they're looking for. You can choose to 
do an automated online analysis of your data by clicking the 'Online Analysis' button at the top right of 
HijackFree, however note that the results can be confusing as it often lists both the good and bad potential 
uses for particular services/processes/files, but it can make it look like you're actually infected with a 
particular piece of malware when you're not. If you've followed the instructions in the PC Security chapter 
you can generally ignore these malware warnings - unless an item is listed as solely being bad. 
 
< IDENTIFYING STARTUP PROGRAMS 

Follow the steps below to try to correctly identify your startup programs: 
 
1. Some filenames will tell you quite clearly what the startup program relates to. If in doubt, also check the 

directory path of the file and see if there are any other indications as to which program it relates to. It's 
important to know the actual program the file is for, firstly so you can tell what functionality may be 
affected for testing purposes, and secondly as covered in the step below. Importantly, some files may 
relate to Windows services, so see the Services chapter and check against the list of filenames provided 
there. 

2. Launch the program which the file relates to and look through its options for settings like 'Load with 
Windows', 'Load at startup', 'Enable System Tray', 'Enable Shell Integration', and so on. In most cases 
you should be given the option to disable any such settings, and you may also find text which explains 
whether doing so will affect the program's functionality in any major way. Typically disabling a 
program from loading at startup means it won't be available after Windows loads; you will have to 
manually open it yourself. For some programs this is not an issue, for others it can prevent them from 
working automatically in the background or even from being able to be launched. 

3. If the filename still isn't clear, and you can't determine from its directory path which program it relates 
to (e.g. it resides in the \Windows\System32 directory) then you will have to do some online research to 
find out more details. Start by searching one or more of the following databases using the exact filename 
(e.g. wpcumi.exe): 
 
Google 
SysInfo Definitive Startup List 
WindowsStartup Online Search 
ProcessLibrary 
Security Task Manager List 
 
Some of the more obscure system files and services, as well as files for lesser-used programs may not be 
listed in the sources above, so Google will likely be the best place to search for obscure filenames. 

http://www.windowsstartup.com/download.php�
http://www.windowsstartup.com/wso/search.php�
http://www.hijackfree.com/en/hijackfree/�
http://www.google.com/ncr�
http://www.sysinfo.org/startuplist.php�
http://www.windowsstartup.com/wso/search.php�
http://www.processlibrary.com/�
http://www.neuber.com/taskmanager/process/�
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4. Run several malware scanners to ensure that none of the startup files relate to malicious software. If any 
such files are flagged as malware by your scanner, you can usually click on their names or a provided 
link to find out more details from the scanner's own database. 

5. Use MSConfig or Autoruns to temporarily disable the startup item(s) in question - that is, untick it but 
don't delete it. Restart Windows and see if over time any of your program functionality is impaired. You 
should be able to see after a few days of normal usage whether the startup item(s) was necessary or not, 
and which particular program(s) it relates to. 

 
< REMOVING STARTUP PROGRAMS 

Once you've followed all the steps above, and you're confident that you've found a truly unnecessary startup 
item, the final step involves permanent removal. You can do this in several ways (in order of preference): 
 
§ Go to the program in question and make sure there are no options to disable it from running at 

Windows startup. As noted further above, if any options such as 'Load with Windows', 'Load at startup' 
or similar exist, disable them otherwise if you just manually delete the item it may be recreated each 
time you boot into Windows or start that program. 

§ Go to Autoruns, right-click on the relevant entry and select Delete. 
§ Go to the Registry Editor, find the item under the relevant key, highlight it and select Delete. Remember 

that Registry Editor does not have any 'undo' capabilities, so it is best used as a last resort. 
 
Once the item is removed from your startup, you should reboot Windows and see if it is indeed gone. If at 
any point any of your programs start to behave strangely or do not function at all, then uninstall and 
reinstall that particular program and its relevant startup items will be recreated. In general it's wise not to 
permanently remove any Microsoft startup programs unless you're certain you will never use such 
functionality. Having removed unnecessary startup programs make sure to run through the Services chapter 
and disable unnecessary services as well. 
 
Note that some startup items require special additional steps to completely remove from your startup. For 
example the CTFMON startup item, which relates to an unnecessary 'alternative user input text input 
processor' function for the Microsoft Office suite, requires following the procedures detailed in this 
Microsoft Article to completely remove. Simply removing its startup item from the registry will not remove 
it as it is recreated every time you run an MS Office application. 
 
 
Once again, it is important not to ignore your startup programs, and actually spend time both identifying 
what they do, and removing the unnecessary ones. Importantly, in the future as you install new programs 
you should continue to regularly examine and identify new startup items which are being added. I generally 
recommend that after each installation of a new program you open MSConfig and quickly look under the 
Startup tab to see whether new item(s) have been added, and determine whether the program really needs 
these or not. 
 

http://support.microsoft.com/kb/282599�
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Services are programs that run in the background and support specific functionality in Windows XP. They 
can be initiated by Windows itself, or they can be installed and initiated by third party programs. They may 
start automatically at bootup (Automatic), they may be triggered to start by the launching of certain 
programs or functionality (Manual), or they can be blocked from running altogether (Disabled). There is 
scope to improve system resource usage and startup time by disabling unnecessary services. As with startup 
programs in the previous chapter, it is wise to learn more about what a particular service does before 
considering altering its default status.  
 
In this chapter we look at customizing services, and I provide safe recommendations for service 
configuration for the average home PC user. 
 
 
< SERVICES UTILITY 

The Services Utility gives you the ability to edit your Service configuration. To access the Services Utility, 
you can either go to Control Panel>Administrative Tools>Services, or you can go to Start>Run and type 
"Services.msc" (without quotes) and press Enter. This opens the Services Utility which lists all installed 
services, tells you whether they are currently running or not under the Status column, and whether they're 
set for Automatic, Manual or Disabled startup under the 'Startup Type' column. A brief description of each 
service is also provided. 
 
You can see the details of each service by left-clicking on it and the default Extended view will show the 
description to the left of the service. To see more details and configure a service, either double-click on the 
service, or right-click on it and select Properties. Here you can where the actual program file resides for the 
service, and you can also manually Start, Stop or Pause/Resume a service as applicable. Importantly, you can 
change its startup type here - the startup type of a service is defined as follows: 
 
Automatic: This service is automatically started during the Windows boot process. 
 
Manual: This service must be started manually by the user, or typically, as requested by a program when 
needed. It does not reside in memory nor load at startup otherwise. 
 
Disabled: This service is blocked from running and does not load into memory at any point, even if a 
program requires it. It can only be started by manually setting it one of the above startup types then clicking 
the Start button, or rebooting. 
 

DEFAULT SERVICES 

Before we move on to service customization, it is important to backup your default service configuration in 
case you have any problems and need to return any of your services to their default state. Services may be 
configured differently on various machines based on the particular features and programs you are using, as 
well as your specific hardware configuration, so the best thing to do is save your current service 
configuration. To do this, open the Services utility, then right-click on the 'Services (Local)' item in the left 
pane and select 'Export List'. In the box which opens, enter a name for the list and save it as the default 'Text 
(tab delimited) (*.txt)' option. This file will then save with all the details of your services as they currently 
stand, and can then be viewed with correct formatting in a program like Microsoft Excel. 
 
For convenience sake, I have also listed my default Windows XP Professional SP3 service configuration in 
the table further below under the column labeled 'Startup Type (Default)'; but again, remember that this will 
vary from system to system, and also doesn't include non-Microsoft services, so as a precaution take the 
steps above before altering your own services. 

http://msdn2.microsoft.com/en-us/library/ms685141.aspx�
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CUSTOMIZING SERVICES 

While we can customize services, it is important to note that by setting a service to Disabled you may cause a 
particular function or feature(s) of Windows or your programs to stop working without warning. If you 
change several services at once in particular, it can sometimes be extremely difficult to track back your 
problems to a particular service - not all services are obvious in what they affect.  
 
The main aim of customizing services is to: 
 
§ Help speed up Windows startup time especially on systems with slower hard drives. 
§ Reduce unnecessary RAM usage by removing unwanted services. 
§ Speed up shutdown time since Windows has to close some running services before shutdown. 
 
Keep in mind that altering the service configuration will not increase your framerate in games (though it 
may reduce stuttering due to reduced RAM usage), and it can impair your functionality if not done 
carefully. It is not something to be taken lightly - it does have benefits, but they won't necessarily be 
dramatic. 
 
With all of the above in mind, on the next few pages are a list of the services in Windows XP, the defaults for 
XP Professional SP3 and my recommendations for any services that can be changed on an average 
standalone home PC not connected to a network of other PCs, but retaining full Internet functionality. This 
configuration should be safe on most any PC, however if your system is unique in some way, or is on a 
network of PCs, make sure to read the descriptions for any service in the Services utility before altering it. 
 
Important: There are some unnecessary services which are already set to Manual, and hence don't need to be 
altered. Many services don't need to be set to Disabled as that has no benefit whatsoever - a service set to 
Manual is not taking up any resources nor will it load up unless it is needed, yet provides a safeguard 
because if it is truly needed it can be restarted by Windows or a program. Only disable a service if it keeps 
restarting and/or you are 100% certain that it is not needed on your system. Some services can be very tricky 
in the impact they have, so I urge you not to consider the disabling of services as some sort of major 
performance tweak and go crazy turning everything off. 
 
If you want to research services in more detail refer to the BlackViper Service Configuration Guide and The 
Elder Geek Services Guide. These guides contain additional details on precisely what each service does, and 
a range of service configurations for differing needs. 
 
On the next few pages I provide my recommended Windows XP service configuration. 
  

http://www.blackviper.com/WinXP/servicecfg.htm�
http://www.theeldergeek.com/services_guide.htm�
http://www.theeldergeek.com/services_guide.htm�
http://www.theeldergeek.com/services_guide.htm�
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Service Name 
Startup Type  

(Default) 
Recommended 

Change Notes 

    
Application Layer Gateway Service Manual   
Application Management Manual   
Automatic Updates Automatic   
Background Intelligent Transfer Service Manual   
ClipBook Disabled   
COM+ Event Service Manual   
COM+ System Application Manual   
Cryptographic Services Automatic   
DCOM Service Process Launcher Automatic   
DHCP Client Automatic   
Distributed Link Tracking Client Automatic   
Distributed Transaction Coordinator Manual   
DNS Client Automatic   
Error Reporting Service Automatic   
Event Log Automatic   
Extensible Authentication Protocol Service Manual  Added in SP3 
Fast User Switching Compatibility Manual Disabled If not using multiple 

accounts on one PC 
Health Key and Certificate Management Service Manual  Added in SP3 
Help and Support Automatic   
HID Input Service Automatic Manual Set back to Automatic 

if peripherals don't 
function properly 

HTTP SSL Manual   
IMAPI CD-Burning COM Service Manual Disabled Not required if using 

third party burning 
software 

Indexing Service Manual Disabled If you've also disabled 
disk indexing 

IPSEC Services Automatic   
Logical Disk Manager Automatic   
Logical Disk Manager Administrative Service Manual   
Messenger Disabled   
MS Software Shadow Copy Provider Manual   
Net Logon Manual   
NetMeeting Remote Desktop Sharing Manual Disabled Network related 
Network Access Protection Agent Manual  Added in SP3 
Network Connections Manual   
Network DDE Disabled   
Network DDE DSDM Disabled   
Network Location Awareness (NLA) Manual Disabled Network related 
Network Provisioning Service Manual Disabled Network related 
Performance Logs and Alerts Manual   
Plug and Play Automatic   
Portable Media Player Serial Number Service Manual Disabled Set back to Manual if 

any DRM-protected 
media doesn't play 

Print Spooler Automatic Disabled If not using a printer 
or printer-like device 

Protected Storage Automatic   
QoS RSVP Manual Disabled Provides no benefit 
Remote Access Auto Connection Manager Manual   
Remote Access Connection Manager Manual   
Remote Desktop Help Session Manager Manual Disabled If not using remote 

assistance 
Remote Procedure Call (RPC) Automatic   
Remote Registry Automatic Disabled Security risk 
Removable Storage Manual   
Routing and Remote Access Disabled   
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Service Name Startup Type  
(Default) 

Recommended 
Change 

Notes 

 
Continued... 

   

Secondary Logon Automatic Disabled If main user is 
Administrator 

Security Accounts Manager Automatic   
Security Center Automatic Disabled If you follow advice 

in PC Security chapter 
Shell Hardware Detection Automatic   
Smart Card Manual Disabled If not using a Smart 

Card 
SSDP Discovery Service Manual Disabled Network related 
System Event Notification Automatic   
System Restore Service Automatic Disabled If not using System 

Restore 
Task Scheduler Automatic   
TCP/IP NetBIOS Helper Automatic Disabled Network related 
Telephony Manual   
Telnet Manual Disabled Security risk 
Terminal Services Manual   
Themes Automatic   
Uninterruptible Power Supply Manual Disabled If not using a UPS 
Universal Plug and Play Device Host Manual   
Volume Shadow Copy Manual   
WebClient Automatic Manual  
Windows Audio Automatic   
Windows Firewall/Internet Connection Sharing 
(ICS) 

Automatic   

Windows Image Acquisition (WIA) Manual   
Windows Installer Manual   
Windows Management Instrumentation Automatic   
Windows Management Instrumentation Driver 
Extensions 

Manual   

Windows Time Automatic   
Wired AutoConfig Manual  Added in SP3 
Wireless Zero Configuration Automatic Disabled If not using wireless 

network devices 
WMI Performance Adapter Manual   
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RESTARTING A SERVICE 

If for some reason you find that a Disabled or Manual service is actually required for certain functionality 
you want to use, but is not starting up, then you can simply go to the General tab for that service, change the 
Startup Type back to Automatic or Manual, and then click the Start button. If the Start button is greyed out 
or the service fails to restart, it is because it is dependent on another service which is currently disabled or 
stopped. Go to the Dependencies tab for the service and under the first box you will see the other services it 
relies on - go to those services and set them to Manual or Automatic as required and start them. The bottom 
box displays the services which depend on this service to function, so also keep that in mind when disabling 
a service, as other dependent services will also stop working. 
 

NON-MICROSOFT SERVICES 

You may notice that your services list has several additional services that are not on the list provided on the 
previous pages. This is because particular programs and drivers, such as graphics drivers, antivirus 
programs and system utilities, can install their own unique services. These services power some of their 
specialized functionality, but as with many of the Microsoft services some of these can be set to Manual or 
even Disabled to reduce background resource usage and prevent conflicts without affecting the program's 
functionality. 
 
The best way to quickly find all non-Microsoft services is to run MSConfig (See the Startup Programs 
chapter), go to the Services tab and tick the 'Hide All Microsoft Services' box at the bottom. The only services 
which will then be shown are those that have been installed by third party software. To determine which of 
these are truly unnecessary, you will have to work out which software package has installed the service - in 
most cases it is fairly obvious. For example the 'Diskeeper' service clearly relates to the Diskeeper 
defragmentation program. However some services are either not clear, or may even be part of malware and 
hence difficult to identify. 
 

IDENTIFYING NON-MICROSOFT SERVICES 

To correctly identify which program a service relates to, and in particular which file is launching it, follow 
these steps: 
 
1. In MSConfig, under the Services tab having ticked the 'Hide All Microsoft Services' box, write down the 

exact name of each non-Microsoft service (e.g. PnkBstrA). 
2. Go to Control Panel>Administrative Tools>Services and find the same service name in the listing. 
3. Double-click on the name of each non-Microsoft service and under the General tab for that service, look 

at the 'Path to executable' item and note both the filename and its directory path. For example the 
service 'PnkBstrA' service has the path C:\Windows\system32\PnkBstrA.exe. Write down the filename 
(i.e. PnkBstrA.exe). 

4. Search Google or one of the databases shown under the Startup Programs chapter for this particular 
filename. This should give you an indication of what its functionality is related to. If necessary you can 
temporarily set the service (one at a time) to Manual or even Disabled to see what functionality it 
impacts on. 

 
As with Microsoft Services, you should be able to Disable a range of these third-party services as they are not 
necessary. In some cases, Manual is the correct choice, and in other cases Automatic must be chosen 
otherwise the relevant program will not launch or will have problematic functionality. I cannot provide 
guidance in this respect as it depends on the program and the functionality you wish to use. If in doubt, 
leave a non-Microsoft service on its default setting. 
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CHANGE SERVICE STATUS VIA COMMAND LINE 

If you wish to change the status of a service without opening the Services Utility, you can do so by using an  
MS-DOS Command Prompt - go to Start>Run and type "cmd" (without quotes) and press Enter. To change a 
service status here you will first need to know the name of the service, either its short name or full name. For 
example the full name for the Application Layer Gateway Service is 'Application Layer Gateway Service', 
while its short name is simply ALG. You can find these details in the Services utility by double-clicking on a 
service, or under the following key in the Windows Registry: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services] 
 
To start or stop a service via command line, go to the Command Prompt and use the form: 
 

Net [Start/Stop] "servicename" 
 
Note, if using the short name for a service, quotes are not necessary, but if using the service's full name, 
quotes must be used around the name. For example to start the Application Layer Gateway Service, you can 
use either command below to achieve the same result: 
 

Net start alg 
Net start "application layer gateway service" 

 
You will receive a confirmation that the service has been started or stopped if successful. This method is 
really mainly useful if you want to compile a batch file to start or stop particular services, or if you can't 
access the Services utility for some reason. 
 
 
Service editing is an area of ongoing debate. Some people suggest that altering services from their default is 
completely pointless and unnecessary and should not be done due to the potential problems it can cause; 
others will argue that many services should be disabled to 'increase performance'. I tend to be in the middle - 
there is certainly a case for disabling genuinely unnecessary services for functions you will never use, but 
this must be done with a bit of thought and research: only disable services if you are absolutely certain of 
their functionality and that you don't need them, and if in doubt, leave the services set at their defaults. This 
is particularly true of most Manual services which do not need to be set to Disabled as this has no impact on 
resource usage. 
 
Editing services wisely is one more way of reducing resource usage and improving startup times, but it is 
not a major performance-boosting exercise. I've tried to provide the best of both worlds in this chapter by 
giving you a thorough list of 'safe' changes you can make, and also showing what the default settings are in 
case things go wrong. However if you are not confident in what you are doing, or don't have the time or 
patience to do the research and sort out your own service needs properly, then leave your services on their 
default Windows configuration for the moment. This will prevent a lot of problems in the long run. 
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CLEANING WINDOWS 
 
As you use your system in day-to-day activities, a vast range of temporary, backup and unnecessary files can 
build up on your hard drive. Most temporary files are automatically deleted whenever you close an 
application, or whenever you shut down Windows. Unfortunately some of them aren't, and over time they 
can build up, taking up a lot of disk space and generally making a mess in your directories. The main reason 
to clean Windows is to free up additional drive space, reduce clutter and possibly prevent file version 
conflicts. 
 
 
< DISK CLEANUP 

The Disk Cleanup utility provides the ability to automatically find and remove unnecessary Windows files, 
old System Restore points, and unwanted Windows components. To access the Disk Cleanup utility go to 
Start>Run and type "Cleanmgr.exe" (without quotes) and press Enter, or look for it under your 
Start>Programs>Accessories>System Tools menu. 
 
The Disk Cleanup utility has several functions, which are covered below: 
 

REMOVE UNNECESSARY WINDOWS FILES 

To remove unnecessary Windows files at any time, open the Disk Cleanup utility and under the main Disk 
Cleanup tab you can safely tick the following: 
 
§ Recycle Bin 
§ Setup Log Files 
§ Temporary Files 
§ Catalog files for the Content Indexer 
 
Also tick the 'Temporary Internet Files' option if you want to clean out your Internet Explorer cache. If you 
are short on disk space you can also tick the 'Compress Files' option, however I strongly recommend against 
this as disk compression can be time consuming and will reduce your overall performance in Windows XP, 
increasing the frequency of fragmentation. Click OK when done, and OK again. This will remove a lot of 
unnecessary files on your system and may take a while. 
 

ADD OR REMOVE WINDOWS COMPONENTS 

To add or remove Windows XP components under the 'More Options' tab click the 'Clean Up' button under 
the 'Windows Components' section. In the 'Windows Components' box that opens, items with ticks next to 
them are currently installed. You can install additional items by ticking them, and untick any existing 
components that you want to remove. Note that some items, such as Windows Messenger or Internet 
Explorer, cannot be fully uninstalled this way - unticking them only removes the shortcut to the program 
which is not much use. 
 
When you highlight certain components, you may see a Details button appear on the bottom right. Click it to 
see which particular sub-components you can select to install/keep/uninstall. For example, if you highlight 
the 'Accessories and Utilities' component, click Details and you will see two types of sub-components - 
Games and Accessories. Highlight the Accessories sub-component and click Details again, and you'll see the 
full list of Windows accessories installed on your system. Untick the ones that you know you do not need or 
use, and tick those which you want to install or keep. If in doubt, do not install or uninstall any items. Items 
that are already ticked are currently installed, and leaving the tick mark against them won't see them 
installed again - it just means you wish to keep them. 
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Once you're finished, click OK until you are back at the main Disk Cleanup utility screen and click Next. 
Any changes will see the relevant components installed/uninstalled as specified. Note that you may be 
prompted to insert your original Windows XP CD if you've chosen to install a new Windows component. 
 
To access a more detailed list of the components you can install or uninstall on your Windows, do the 
following: 
 
1. Go to your \Windows\Inf directory and open the Sysoc.inf file with Windows Notepad. 
2. Do a search for all occurrences of the word ,hide, and replace them with ,, (i.e. delete the word hide)- 

make sure there are no spaces around, or in between, the commas. 
3. Save the file and close it. 
 
Now when reopen the Windows Components section under Options in Disk Cleanup, you will see many 
more items listed. Note that some of them - such as those shown with grey box icons - are important system 
files which may result in problems if removed. Be very careful here as to what you add or remove.  If you 
really want to strip out a large number of Windows components, I recommend using nLite instead (See the 
Installing Windows chapter), that way these components will never be installed in the first place. 
 

REMOVE OLD SYSTEM RESTORE POINTS 

If you have System Restore enabled, and want to remove all System Restore points other than the most 
recent one, thereby freeing up a great deal of disk space, under the 'More Options' tab click the 'Clean Up' 
button under the 'System Restore' section. Click Yes on the subsequent prompt, then click the OK button. 
 

ADVANCED DISK CLEANUP USAGE 

You can access more disk cleanup options by going to Start>Run, typing "cleanmgr /sageset:1" (without 
quotes) and pressing Enter. In the dialog box which opens, tick the items you wish to clean - I suggest ticking 
all boxes except the 'Compress old files' option - and then click OK. Now to execute this extended cleanup at 
any time, go to Start>Run and type "cleanmgr /sagerun:1" (without quotes) and press Enter, and cleaning 
will commence immediately.  Note that this method will clean all your drives - you cannot choose a specific 
drive to apply it to, so keep this in mind before using this method in case you don't want any other drives 
affected by Disk Cleanup in this way. 
 
< RECYCLE BIN 

The Recycle Bin provides a storage area for deleted files and acts as an additional layer of protection against 
permanently deleting files on your system. This section covers the optimal configuration of this essential 
Windows tool. 
 

CONFIGURATION ADVICE 

If you don't want deleted files to automatically move to the Recycle Bin and instead want them permanently 
deleted every time, right-click on the Recycle Bin icon on your Desktop, select Properties and under the 
Global tab tick the 'Do not move files to the Recycle Bin. Remove files immediately when deleted' option. I 
don't recommend that you do this, since the Recycle Bin is useful insurance to have against accidentally 
deleting important files. 
 
I recommend you untick the 'Display delete confirmation dialog' option under the Global tab of the Recycle 
Bin Properties. This will stop Windows from asking you each and every time you want to delete a file 
whether you really want to do it - instead the file will go immediately into the Recycle Bin when deleted. 
 
If you have enabled the Recycle Bin, but at any time want to delete a file and not have it moved to the 
Recycle Bin first, highlight the file(s) and press SHIFT + DELETE. You will be asked to confirm this action 
each time, but this will delete them immediately without placing them in the Recycle Bin. 
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You can specify the maximum amount of disk space the Recycle Bin can take up at any time by adjusting the 
slider under the Global tab of the Recycle Bin Properties. I recommend allowing enough disk space so that 
should you delete several large files on your system you can still recover them if necessary. Typically around 
4GB is sufficient for most people. Work out what percentage of your drive that would be, and apply it here 
(e.g. 4GB of an 80GB drive = around 5%). To see the exact amount of maximum space allocated, click the tab 
that has your hard drive's name. 
 
For more details of how to recover files which you have permanently deleted from the Recycle Bin, see the 
Backup & Recovery chapter. 
 

RENAMING OR DELETING THE RECYCLE BIN 

You can rename the Recycle Bin or even delete it from your Desktop by using this tweak. Open the Registry 
Editor and go to: 
 
[HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-101B-9F08-00AA002F954E}\ShellFolder] 
 
CallForAttributes=0x00000000(0) 
 
Attributes=50 01 00 20 
 
First double-click on the CallForAttributes DWORD and change its value to 0. Then double-click on the 
Attributes DWORD and change its value to 50 01 00 20 to add a Rename option to the Recycle Bin 
icon's context menu (when you right-click on Recycle Bin, the Rename option now appears). To add a Delete 
option as well, change the value to 70 01 00 20. You will have to reboot your machine for this tweak to be 
implemented. Note, it is strongly recommend that you do not delete the Recycle Bin. 
 
< CCLEANER 

CCleaner is a free utility which can automatically find and remove a wide variety of essentially useless files 
from your system. CCleaner automates a task that you can perform manually to some extent (see further 
below), but which takes longer to do by hand; CCleaner finds and removes a range of files with common 
extensions identifying them as unnecessary (e.g. .TMP, .BAK, .OLD) and also files which reside in known 
temporary or rubbish folders. It excludes important backup/temporary files that should not be deleted, and 
if used with caution it is usually quite safe in removing only unnecessary files. 
 
Run the program and click the Options button, and first adjust the following settings: 
 
1. Under the Settings section, untick all available boxes as none are vital to running CCleaner correctly. 

Selecting the 'Normal file deletion' option is fine as well. 
2. Under the Cookies section, in the left pane are a list of cookies CCleaner will automatically delete if the 

Cookies option is ticked under Internet Explorer and/or Firefox on the main CCleaner screen. Select 
which cookies you would like to keep by highlighting it in the list and moving it using the '->' arrow to 
the 'Cookies to keep' list. 

3. Under the Include and Exclude sections you can manually add particular files or folders which you 
would specifically like CCleaner to scan for deletion or exclude from deletion. 

4. Under the Advanced section I suggest unticking everything except 'Only delete files in Windows Temp 
folders older than 48 hours' which should be ticked for maximum safety, along with the 'Show prompt 
to backup registry issues'. 

5. If you're not sure if you're running the latest version of CCleaner at any time, click the 'Check for 
updates' link at the bottom right corner to see if a newer version of CCleaner is available. 

 
To start the cleaning process, first make sure you close all open applications to prevent conflicts if CCleaner 
tries to delete actively used files. Then open CCleaner and under the Cleaner>Windows tab make sure to 
untick anything which you don’t want deleted. For example, if you use Internet Explorer you should check 

http://www.ccleaner.com/�
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to make sure you untick any components which you wish to keep (e.g. untick 'Temporary Internet Files' if 
you don't want your IE browser cache cleaned out). Note that you should only tick the options under the 
Advanced list at the bottom if you know what you are doing, otherwise they are all best left unticked. 
 
Next, under the Cleaner>Applications tab CCleaner lists all relevant installed applications which it can help 
clean up. Once again, make sure you untick anything you wish to keep. For example, if you have a browser 
like Firefox installed, make sure you untick any portions of it which you don't want 'cleaned' (e.g. untick the 
'Internet Cache' option). If in doubt, untick everything. 
 
Once you have all the relevant options ticked, click the Analyze button and after a while CCleaner will come 
up with a list of files it wants to delete. At this stage nothing has been deleted yet, so scroll through the list 
and make sure no files which you wish to keep are listed. Most of what CCleaner removes is not needed by 
the average user, but each person differs in what they want, so review the list carefully. The files typically 
found unnecessary by CCleaner include Most Recently Used (MRU) lists (i.e. the path to the last few 
documents you opened in a particular application), log files, temporary setup files for drivers and 
applications, and browser cache files.  
 
If you have any doubts, or want some of these files kept, go back to the Windows and/or Application tabs 
and untick any areas you don't want CCleaner to clean and click Analyze again. Once you're happy to 
continue click the 'Run Cleaner' button to permanently remove the listed files. 
 
Finally, the Registry function in CCleaner attempts to find redundant Registry entries. To start with, tick all 
the options available and then click the 'Scan for Issues' button. A whole range of "issues" may be found, all 
of which are generally harmless. Click the 'Fix selected issues' button, and make sure to save a backup when 
prompted, then when prompted again click 'Fix All Selected Issues'. If in doubt, do not use this functionality, 
and see the Windows Registry chapter for more details of what Registry cleaning entails. 
 
< MANUAL DRIVE CLEANING 

Below is the basic manual method for cleaning out the more obvious redundant files in your system. If you 
don't trust an automated cleaner or just want to be certain you delete all unnecessary files, follow these steps: 
 
1. Close all open applications and games as some of these may have created temporary files that cannot be 

deleted because they are in use. Restart your system just to be certain. 
2. Make sure you empty your Recycle Bin. Also ensure that the option to move files to the Recycle Bin is 

enabled. This will provide protection against accidentally deleting a necessary file in the next few steps. 
3. Open Windows Explorer and navigate to the following directories on the hard drive where you have 

installed Windows. Delete any files or subdirectories beneath them, but not the directories themselves: 
\Documents and Settings\[Username]\Local Settings\Temp 
\Windows\Temp 

4. Go to \Windows\ and delete any $NTUninstall directories. These are directories which allow you to 
uninstall Microsoft updates typically installed through Windows Updates. Unless you've installed a 
beta Microsoft product, it is highly unlikely you will ever need to uninstall a Microsoft patch. Note that 
you should not delete the $hf_mig$ directory. 

5. Find files with extensions that identify them as redundant. Go to Start>Search and select 'All files and 
folders' to bring up the Search box.  Enter the following text, and in each case you can usually delete all 
incidences of these files without a problem: 
*.BAK 
*.TMP 
~*.* 
*.OLD 

6. Delete any files you are sure are not needed anymore, such as older versions of downloaded driver 
packages, setup files from downloaded programs, log files and so on. 
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7. Note, if any files cannot be deleted because they are in use by Windows, reboot your system and go into 
Safe Mode (See the Backup & Recovery chapter) and from there you should be able to delete any file.  
Alternatively you can use the method further below. Usually however if a file is in use it is a good 
indication the file is needed and best not deleted unless you are certain it's unnecessary. 

 
Once you've deleted these files, keep them in your Recycle Bin and don't empty it for a few days until you've 
had a chance to see if any of your applications or games are not functioning properly without these files. If in 
doubt, I recommend only using an automated cleaning utility such as CCleaner. 
 

CLEANING UP AFTER SERVICE PACK 3  

During the installation of Windows XP Service Pack 3 (SP3), it will create a range of backup files which allow 
you to uninstall SP3 if necessary. However for all intents and purposes, once you've installed SP3 there 
should never be any need to uninstall it again. To delete these unnecessary files, you should go to your 
\Windows directory and delete the $NTServicePackUninstall$ directory and all its contents. Once this 
directory is deleted, you will no longer be able to uninstall SP3, but once again, this should never be required 
as Service Pack 3 is a necessary update. Generally speaking, if you are having issues with SP3 on your 
system, it is wiser to reinstall XP and then install SP3, or better yet, use an installation image of XP with SP3 
incorporated into it. 
 

DELETING 'IN USE' FILES 

If during manual file cleaning you find that you cannot delete an unnecessary file because Windows claims 
that it is 'in use' by another person or program, or simply denies you access to the file or folder, then reboot 
your system and try again. If that doesn't work, then it is usually either a driver or some other system-level 
file which is loading up during bootup, or a file required for an active program. Go through and close all 
active programs, particularly ones which load at startup and try again. If necessary, temporarily disable the 
suspected startup program(s) using MSConfig, reboot and try again. Alternatively use AutoRuns and see if 
the file is shown there, and untick it to prevent it being loaded up at startup, then reboot and try again. See 
the Startup Programs chapter for more details of how to use both these programs. 
 
Ultimately however some files will refuse to be deleted no matter what you try, in which case you should try 
the free Unlocker utility. To use the program, right-click on the relevant file or folder and select Unlocker, 
then click the 'Unlock All' button to unlock the file. Alternatively choose from the list of actions at the bottom 
left of the box shown, and reboot if necessary for the action to complete. 
 
Be warned however that in general Windows locks files or prevents deletion for a reason, so only use 
Unlocker if you're absolutely certain that that file in question is genuinely no longer required. 
 
 
That covers the bulk of unnecessary files on your system. Importantly do not empty your Recycle Bin just yet 
- reboot your system and use it normally for a few days just to be sure the files you have deleted are 
genuinely no longer needed. In general I recommend using the automated methods further above for regular 
Windows cleaning, but you can supplement them with manual cleaning every once in a while. 
 

http://ccollomb.free.fr/unlocker/�
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TASK MANAGER 
 
The Windows Task Manager is a utility that allows you to view important real-time information about 
which applications and processes are running on your system. You can also see how much memory, CPU 
usage and network bandwidth is being consumed at present by these various processes. As an information 
and troubleshooting tool it is invaluable. To access the Task Manager at any time, press the CTRL, ALT and 
DELETE keys together, or go to Start>Run and type "Taskmgr" (without quotes) and press Enter. 
 
The Task Manager's primary use is to allow you to attempt recovery from system lockups and crashes. 
Whenever a program stops responding you can attempt to launch the Task Manager (CTRL+ALT+DEL) and 
under the Applications or Processes tab you can select the offending task or process and select 'End Task' or 
'End Process', usually regaining control of your PC without the need to reboot. If the Task Manager does not 
appear after pressing CTRL+ALT+DEL several times then your system has 'hard locked', meaning a reboot is 
required to regain use of your computer. However Task Manager also allows you to undertake several other 
useful tasks, which are also covered in this chapter. 
 
 
< CONFIGURATION ADVICE 

To customize the Task Manager so that it displays the specific system information you want to see, go to the 
View menu and under it click the 'Select Columns' option. You will be presented with a dialog box that 
allows you to select a range of items that can be displayed as separate columns under the Processes tab of the 
Task Manager. I recommend that at the very least the 'CPU Usage' and 'Memory Usage' items be ticked. 
These will show you for each process the proportion of the CPU's resources the process is currently using, 
and how much system memory (RAM + Virtual Memory) it is using. I recommend also ticking the 'Peak 
Memory Usage' item as well, as this will show you just how large a particular process has been at some point 
- we discuss one use for this information in the Memory Optimization chapter when ascertaining Virtual 
Memory requirements. 
 
Next, go to the Options menu and make sure the 'Show 16-bit tasks' setting is ticked, then under the 
Processes tab make sure the 'Show processes from all users' option is also ticked. This ensures that all 
running programs and processes will be shown. Note that at any time if you cannot see any menu items or 
tabs in the Task Manager window, simply double-click anywhere on the borders of Task Manager and it will 
revert to its normal view. Also note that you don't usually require the 'User Name' column, however if you 
are on a PC with multiple users you can enable this functionality by making sure the 'Fast User Switching 
Compatibility' service is set to Automatic - see the Services chapter. 
 
< RESOURCE USAGE MONITORING 

One use for Task Manager which can be of great benefit to system performance and even security is that of 
monitoring your startup state. That is, the programs and processes which are running in the background 
after a fresh bootup, and the amount of memory being used. After a fresh bootup immediately open Task 
Manager, and click on the Processes tab, then examine the following areas of Task Manager: 
 

PROCESSES 

Check the list of running processes - there should be as few as possible. Note that certain processes can 
appear multiple times - this is fine for svchost.exe for example, since it is the Service Host process and as such 
runs groups of several Windows services. However some processes may be initiated by a virus or 
completely unnecessary program, so see the Services and Startup Programs chapters for details of precisely 
how to identify the programs behind these processes and how to disable or remove unnecessary ones. 
  

http://support.microsoft.com/kb/323527�
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COMMIT CHARGE 

Look at the total Commit Charge at the bottom of the Task Manager window. This shows the amount of 
system memory (RAM + Virtual Memory) that has been used out of the maximum available. Although this 
may grow dramatically after you have run several programs - and this is quite normal - the main point to 
consider is that the first figure in the Commit Charge section should be quite low at Windows startup. Once 
again, see the Services and Startup Programs chapters for details on how to reduce such resource usage. 
Minimizing memory usage at startup is not about 'freeing up' as much RAM as possible. Rather, the aim is 
primarily to speed up startup times and reduce the likelihood of program conflicts. The less information is in 
memory prior to launching a program or game, the less chance there is for memory conflicts, and the less 
pagefile usage you will experience. Games manufacturers specifically recommend that background 
programs and processes be minimized precisely to prevent game conflicts and stuttering. 
 

CPU USAGE 

Pay attention to the CPU usage for your system when it is idle - that is, when you have no open games or 
applications. It should be at or close to 0%, and the 'System Idle Process' process should have around 99% 
CPU usage, indicating that the CPU has as minimal a load as possible. A CPU that idles correctly stays 
cooler and uses less power. More importantly though, if your system is using CPU resources even when 
supposedly idle, this indicates that you have a background program(s) or process(es) which may be 
unnecessarily drawing resources and hence there is scope for you to improve performance by disabling 
it/them. 
 
You can also open the Task Manager during the running of an intensive game or application and check the 
CPU % being used by its process - for a single-core CPU it should be consistently at, or close to, 100% CPU 
usage. If for some reason it is quite low, again check to see if any other processes are drawing CPU resources, 
and once again refer to the Startup Programs and Services chapters of this guide to remove/disable 
unnecessary background programs. Note that on systems with dual core or multi core CPUs, the CPU usage 
figure shown here may be lower, since each core may share a proportion of the total load, hence overall CPU 
usage for a particular process may only be around 50% for example. For more details see further below. 
 
I do not recommend manually changing the process priority. For example you can right-click on a process 
and select Set Priority>High. Such tweaks are more likely to increase system instability, and should have no 
impact on an optimized machine since by default your current program should have maximum potential 
usage of the CPU (which isn't always 100% by the way - it depends on the program), thus the highest 
priority. 
 

MEMORY USAGE 

Examining the memory usage for each process can provide valuable information. If you have selected the 
'Peak Memory Usage' item to add to the list of columns under the Processes tab (as recommended above), 
you can combine that information with current Memory Usage to learn some interesting facts about the 
performance of the processes over time. For example, you can open the Task Manager while running a 
particularly intensive application or game and check to see how much memory its process is currently using, 
and how much it has used at its peak so far. Compare these figures to the number on the right of the Commit 
Charge figure at the bottom of the Task Manager window – which is the total amount of memory (RAM + 
Virtual Memory) available to the system. If the game or application is using close to the total amount of 
memory available on your system, you may have to increase the maximum size of your pagefile (See the 
Memory Optimization chapter) otherwise you may experience crashes, increased stuttering, or 'Out of 
Virtual Memory' errors. 
 
Note that whenever a program is minimized, i.e. shrunk down to the Taskbar, it will use less memory and 
resources than normal. Therefore check the resource usage of a program when it is taking up the full screen 
or running in a large window to get an indication of how intensive it is during normal usage. 
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< PROCESSOR AFFINITY 

Many desktop PCs now contain a CPU with two or more cores - that is, a single CPU which is actually made 
up of two (or more) separate CPU chips. Furthermore some Intel CPUs have a technology called 
HyperThreading which in effect emulates two physical cores on each single core of a CPU. For a program to 
truly take advantage of both cores on a CPU, it needs to be multi-threaded. That means several program 
'threads' will run in parallel, with each thread assigned to a particular core to handle. Alternatively, multiple 
separate programs can be run together much more smoothly on a multi-core system, as each program can be 
run on a separate core. However some older programs and games are not multi-threaded, and hence show 
no real benefits when run individually on a dual core system. In fact some programs exhibit problems, such 
as stuttering, skipping or incorrect speeds when run on a multi-core CPU. 
 
Where programs show problems launching or running on a dual core system - and some older games and 
applications do indeed have such problems - then dual core users have two options. For AMD Dual Core 
CPU users, install the AMD Dual Core Optimizer which resolves these issues. For both AMD and non-AMD 
users, you can install the Microsoft Dual Core Hotfix. These steps will ensure that any problems in older 
games or applications due specifically to multi-core CPUs are removed or minimized. 
 
However if you feel you are still having multi-core CPU related problems, or want to troubleshoot a 
potential hardware issue with any specific core of your CPU, you can manually force the main process for a 
program to temporarily run on only one specified CPU core. Do this as follows: 
 
1. Launch the program in question, and as soon as it appears to be loading, or immediately after it has 

loaded up, open the Task Manager. 
2. Under the Processes tab, find the game/program's main process; if necessary go to the Applications tab, 

right-click on the program and select 'Go to Process'.  
3. Right-click on the relevant process and select 'Set Affinity'. 
4. In the box which appears, untick 'CPU 1' (and any other available CPUs), so that only 'CPU 0' is ticked. If 

you're troubleshooting problems you suspect on one particular core, you can do the opposite - disable all 
cores except CPU 1 (or CPU 2 or CPU 3 etc.). The aim is to restrict the program to run on only one core. 

 
The program is now forced to run on only one CPU core, which should resolve any problems if they were 
genuinely related to the multi-core setup. If this works, or if you have problems attempting to change 
affinity this way, or you find it inconvenient, there is a way of permanently forcing the affinity change on a 
program each time it loads. Before undertaking it, be aware that it modifies the executable file to which it is 
applied, so backup that file first before using this method: 
 
1. Download the file imagecfg.exe from this page and put it into your \Windows\System32 directory. The file 

is safe to use, as it is a Windows NT system file. 
2. Identify the problematic program's main executable. To do this go to the program's launch icon, right-

click on it, select Properties and highlight and copy the text in the Target box. 
3. Make a backup copy of this executable first and put it somewhere safe. 
4. Go to Start>Run and type "cmd" and press Enter. This will open up a new command prompt. 
5. In the command prompt window type: imagecfg -a 0x1 followed by the text you copied from step 1 above 

(right-click in the command prompt box and select Paste) then press Enter. Make sure to put quote 
marks around the path if it's not already there. E.g.: 
 
imagecfg -a 0x1 "c:/program files/RegCleaner/RegCleanr.exe" 
 

6. Windows will now only allow that program to see and use the specified CPU core each and every time it 
is launched by using that particular executable. 

 
Alternatively if you're having problems with imagecfg, you can use this small SetAffinity program instead. 
Download and extract the contents to an empty folder, and run the setaffinity.exe file. This will bring up the 

http://www.intel.com/technology/platform-technology/hyper-threading/index.htm�
http://www.amd.com/us-en/Processors/TechnicalResources/0,,30_182_871_9706,00.html�
http://support.microsoft.com/kb/896256�
http://www.robpol86.com/menu.php�
http://www.megaupload.com/?d=PNX2NO1U�
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interface where you can select to run a particular process or executable with only one CPU core, either 
temporarily or permanently. 
 
For all other intents and purposes a multi-core CPU-based system will behave the same way as a single core 
system. You should only use the steps above if you run into a problems with a particular program which 
you genuinely believe is associated solely with multi-core CPU usage - usually the program will be an older 
one; recent programs are designed to take into account the existence of multi-core CPUs, so even if they 
don't take full advantage of your CPU they won't cause problems because of it. 
 
< PROCESS EXPLORER 

If you want an advanced form of Task Manager which provides even more details about processes and has 
multiple options for performance analysis and troubleshooting, you can download Process Explorer. When 
launched, Process Explorer looks similar to Task Manager, however aside from the same sort of functionality 
as Task Manager covered above, you can also see much more information about a process by double-clicking 
on it. In the box which opens, there are various tabs which provide valuable information specific to the 
process. For example under the Performance Graph tab you can see resource usage graphs for the process; 
under the Performance tab is a range of data which is neatly summarized to give a good overview of 
resource usage, and under the Image tab you can details about the file itself, including the ability to verify if 
a file is a Microsoft system file. Process Explorer is a valuable tool to add to your system and is safe to use. 
 
 
As you can see, the Task Manager has multiple functions as detailed above. Familiarizing yourself with its 
various uses will help give you a good idea of what is happening on your system at any time. For example, 
regularly checking active processes and memory usage will give you early warning of things such as 
malware infections, since they often cannot be hidden from the Task Manager's Processes list or memory 
usage statistics. If you see a sudden increase in memory usage at startup, or a new and unknown process 
appears, or CPU usage increases at idle, you can be sure it is the result of a new program or service running 
in the background. Most often this is the result of recently installed legitimate software adding a program or 
service to your startup, and you should use the procedures in this guide to determine whether it is necessary 
or not. If left unmonitored, your background resource usage can and will blow out, slowing down your boot 
time and causing stuttering and potential program conflicts, so stay vigilant. 
 

http://technet.microsoft.com/en-us/sysinternals/bb896653.aspx�
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WINDOWS REGISTRY 
 
The Windows Registry is a central database for a range of system and program-related settings. Whenever 
you change your Windows settings, add or remove components or install new programs and/or change their 
settings, or even move or resize open windows, the registry will be updated with key pieces of information 
marking these changes. This chapter covers the optimization and editing of the Windows Registry. 
 
 
< REGISTRY EDITOR 

To access the Windows Registry Editor, go to Start>Run and type "regedit" (without quotes) then press 
Enter. You can also access the Registry Editor by typing "regedt32" instead of Regedit, but Regedt32 is a just 
a small program that runs Regedit anyway, so there is no difference between either method. For our 
purposes, the main reason for editing the registry is to alter settings that cannot otherwise be changed using 
the normal Windows interface. Learning to use the Registry Editor is important because it is a powerful tool, 
and unlike any third-party utility designed to edit the registry, using Registry Editor provides the most 
direct access to the entire Windows Registry and ensures that you are aware of precisely what has been 
changed each time, and where it originally resides should you need to change it back. I recommend you take 
the time to learn more about using this important tool. 
 
To use the Registry Editor correctly, open it and you will see what looks like a directory listing under 
Computer, with five folders starting with 'HKEY_', e.g. [HKEY_CURRENT_USER]. Under these Root Keys 
are a series of sub-folders called Keys. Within each key there is at least one Value called (Default), visible 
in the right pane of the Registry Editor window when you click on the key name. Typically there are several 
other values underneath the Default entry. These values can be of several types, including STRING, 
DWORD and BINARY values. 
 
The most common form of registry editing involves changing the contents of values, or adding new values 
under certain keys. Note that in this guide the key name and location is provided in square brackets [ ], and 
the name of the value to be edited is shown underneath. The data to be entered into the value is given after 
the '=' (equals) sign. An example is provided below. 
 

EDITING REGISTRY ENTRIES 

To edit an existing Registry entry follow the example below to see the correct procedure: 
 
[HKEY_CURRENT_USER\Control Panel\Desktop] 
 
CursorBlinkRate=600 
 
The text above indicates that to make this registry change, you should open Registry Editor and then: 
 
1. Double-click on the HKEY_CURRENT_USER root key (or click the '+' sign next to it) in the left pane of the 

registry editor window. This will show every key sitting directly under it. 
2. Next, you must double-click on the Control Panel key.  
3. Highlight the Desktop key by left clicking on it once, and in the right pane of the Registry Editor 

window, look for a value called CursorBlinkRate.  
4. Double-click on this item and in the box that opens, click in the Value box, delete the current number 

there, and enter '600' instead. 
5. As soon as you click OK the change has been saved - you can now close Registry Editor if you wish.  
 
Note that the impact of changes made to the Registry can either come into effect straight away, or may 
require a reboot - it depends on the change. If in doubt reboot and test for new or altered functionality. 
 

http://support.microsoft.com/kb/256986�
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CREATING NEW REGISTRY ENTRIES 

You may need to create a new key or value if it does not exist by default in your registry. To create a new 
entry from scratch correctly, follow this procedure: 
 
1. Go to the particular area under which you have been instructed to create the key. 
2. Make sure you highlight the key name of the particular key under which the new entry is to be created. 

If the new entry is a key, then right-click on the name of the key under which it must be created in the 
left pane, and select New. If the new entry is a value, skip to step 4 below. 

3. Enter the name for the new key and press Enter. It should now sit as a folder in the tree listing one level 
below the key it was intended for. 

4. If the new entry is a value, left-click on the name of the key in which it must be created in the left pane, 
then in an empty area in the right pane, right-click and select New, then choose the type of value it will 
be - the main types we use are String, DWORD and Boolean. Enter the name for the new value and press 
Enter. Double-click on the new value, and enter the data for the new value as recommended. 

 
Note that you will not see any confirmation or sign that you've entered a valid key or value. 
 
A more detailed guide to editing the Registry is in this Microsoft Article. Just remember that the Windows 
Registry is very important, and editing it is not to be taken lightly, so if in doubt, don't edit the registry 
unless you absolutely have to. 
 

BACKING UP AND RESTORING PORTIONS OF THE REGISTRY 

The registry is an important component of Windows and it is crucial for you to understand that the Registry 
Editor does not have an 'undo' function. Hence the best course of action prior to using the Registry Editor to 
alter any part of the registry is to back up your important data and settings, as well as your entire registry 
(See the Backup & Recovery chapter for details). A more practical precaution is to make a backup of the 
particular registry key(s) you are about to edit, especially if you don't feel confident about making the 
change, or aren't sure how the change will impact on your system. That way if anything goes wrong you 
don't have to go through a lengthy process - you can restore the individual key(s) that you have changed 
quickly and easily. The steps to backing up a specific registry key are as follows: 
 
1. In the left pane of the Registry Editor window, right-click on the name of the key that holds the settings 

you wish to edit. 
2. Select the Export option, and choose a suitably descriptive name and appropriate location for the file. 

Make sure that the 'Selected Branch' option is ticked at the very bottom of the box, so that only the 
particular key and all its sub-components are saved, not the entire registry. Click the Save button and 
the file will be saved with a .REG extension. 

3. Once the relevant section of the registry has been saved, you can go ahead and edit the registry entries 
underneath the key you've just saved. 

 
If you experience any undesirable behavior after your registry changes - and remember that some registry 
changes require a reboot before their effects can be seen - then you can restore the backup of your registry 
keys by going to the place where you saved them, and double-clicking on the relevant .REG file. This will 
overwrite the existing sections of the registry with the backed up versions, effectively undoing your changes 
quickly and easily. 
 
If you don't feel comfortable with the above method, or if you want to backup the entire Registry, see the 
Backup & Recovery chapter for more details on how to make proper full Registry backups, as well as forms 
of protection against unintended Registry changes. 
  

http://support.microsoft.com/kb/256986�
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< MAINTAINING THE REGISTRY 

The Windows Registry has thousands of entries, and can grow to be quite large in size on a common PC. 
Over time some of its entries can become obsolete due to changes in hardware and software, and some 
entries can even become corrupted due to bad shutdowns, overclocking or faulty software or hardware. 
Therefore it can be beneficial to periodically undertake some basic Registry maintenance using the tools 
below. 
 

REGISTRY CLEANING 

A registry cleaner trawls through the registry to find any invalid or unnecessary entries, such as entries that 
point to non-existent files or programs or corrupted entries. Since the registry loads into memory and 
controls a great deal of system behavior, the leaner and cleaner the registry is, the less space it takes up, and 
the less the likelihood for errors or strange behavior. This is a risky process and if in doubt, do not clean your 
Registry as it is not absolutely necessary. If you do wish to use a registry cleaner, I suggest trying JV16 
PowerTools as covered below, or use the registry cleaning function in CCleaner covered in the Cleaning 
Windows chapter. 
 

JV16 POWERTOOLS 

JV16 PowerTools is a package of various tools relating to system cleaning and modification. The registry 
cleaning functionality is the main reason why this software is being covered here, and note that the latest 
version of JV16 PowerTools supersedes the RegSupreme and RegCleaner software previously released by 
the same company.  
 
To access the registry-related functionality we require, download the software from the JV16 PowerTools 
Site and install it, but note that it is only free for a limited trial period. However this should be sufficient to 
undertake the bulk of the registry cleaning we require. Once JV16 PowerTools is installed, click on the 
Registry Cleaning module on the main page. The default options are fine for most users, however I 
recommend that you can make the following adjustments: 
 
§ Under Engine Settings move the slider down a notch (i.e. one notch from the bottom). This will increase 

the effectiveness of the registry cleaning without introducing too much more risk. Also untick the 'List 
MRU and other history data', as these items shouldn't be regularly cleaned out. 

§ Under Advanced Options, tick the 'Don't show items that would automatically be recreated' and 'Don't 
show the scan report after finishing'; both options are redundant features. 

 
Once configured, click the tiny disk icon in the bottom left corner of the box to save your settings, then click 
the Start button to begin scanning. When completed you will see a full list of all the 'invalid' entries the 
registry cleaner has found, though note that nothing has been deleted or altered yet. Sometimes thousands of 
supposedly invalid entries may be found (especially when using the default options), but don't be distressed: 
this doesn't mean your registry was a total mess. Most of these are just MRU (Most Recently Used) entries 
for example, and are harmless and perfectly normal. 
 
Now go to the Select menu and choose All to tick all the entries. Advanced users can scroll through the list to 
see if there's anything you want to individually exclude or delete. Otherwise once everything is selected, 
click the Fix button, and make sure to create a backup before proceeding. JV16 PowerTools will then attempt 
to fix, or delete if necessary, the invalid entries. This may take a while so be patient. Again, if you have 
doubts, don't use this form of registry cleaning as there is an element of risk involved when altering the 
Registry this way. 
 
JV16 PowerTools has a range of other potentially useful registry-related functionality, particularly via the 
Registry Manager component. This component allows you to view various types of registry entries sorted 
under different categories in a user-friendly manner. You can then delete entries related to unwanted 

http://www.macecraft.com/�
http://www.macecraft.com/�
http://www.macecraft.com/�
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functionality or left over from an incomplete uninstall of software for example. There's also a Registry 
Compactor component which performs the same sort of task as NTRegOpt (See below). 
 
There are a range of other system cleaning and maintenance modules, however in general I recommend 
against using these. I only recommend using JV16 PowerTools primarily for its registry cleaning 
functionality as covered above - the other functionality is best done manually and with the full benefit of 
understanding through research and using the other tools and techniques covered in this guide as 
appropriate. It is quite easy to make an absolute mess of your system and subsequently have no idea what 
caused the problem - or how you can fix it - if you become reliant on an 'all-in-one' tweaking utility like JV16 
PowerTools. Each task requires different tools, and every aspect of Windows tweaking requires knowledge 
to perform correctly, for which there is no automated replacement. 
 

NTREGOPT 

After cleaning the registry, and before we enter into any registry editing, there is a utility called NTRegOpt 
you can use to optimize the size and layout of the Windows Registry. If you have installed Erunt as covered 
earlier in the guide then you will have already installed NTRegOpt. If not, or you're not sure, download it 
from the link above and install it. Then run the NTRegOpt.exe file to start the program and click OK to begin 
the optimization procedure. It may take some time, so be patient. You will have to reboot for the 
optimization procedure to complete. This process compacts your registry, which can help improve Windows 
startup times and memory usage. NTRegOpt is best used infrequently, perhaps once every month, to ensure 
optimal registry size is maintained. Note however the program does not physically defragment your 
registry; only one of the defragmentation utilities under the Drive Optimization chapter can do that. 
 
< MISCELLANEOUS REGISTRY TWEAKS 

Once you've learned how to edit the registry, you can use a range of tweaks to customize your system using 
the Registry Editor. This section only covers the miscellaneous tweaks; most registry tweaks are actually 
covered under the chapter relevant to the specific area of Windows they relate to. For example, registry 
tweaks relevant to Internet Explorer are covered in the Internet Explorer chapter. Remember that some 
registry changes require a reboot before they come into effect. Importantly, don't forget to backup your 
Registry properly before changing anything in it. 
 
Below are a range of miscellaneous performance and convenience tweaks - implement the ones you want to 
use. My recommended values are provided for the performance-related tweaks: 
 

IMPROVE MENU RESPONSIVENESS AND SHUTDOWN SPEEDS 

The following tweaks improve the responsiveness of Windows. The values shown for each are the 
recommended values for your system. If you don't feel comfortable making these changes using Registry 
Editor, use Cacheman instead (See the Memory Optimization chapter). 
 
[HKEY_CURRENT_USER\Control Panel\Desktop] 
 
HungAppTimeout=4000 
 
This STRING controls the delay before a hung application is allowed to terminate (each 1000 = 1 sec). 
 
WaitToKillAppTimeout=4000  
 
This STRING controls the delay before windows finally starts to shutdown (each 1000 = 1 sec)  
 
MenuShowDelay=20  
 
This STRING controls the delay before a menu or sub-menu pops open (each 1000 = 1 sec)  
 

http://www.larshederer.homepage.t-online.de/erunt/�
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AutoEndTasks=1  
 
If enabled this STRING automatically closes all running applications when Windows shuts down. 
 

INCREASE NTFS SYSTEM PERFORMANCE 

These tweaks improve the performance of Windows systems that use the NTFS File System. See the 
Installing Windows chapter for more details of NTFS. If the following entries don't exist, create them and 
assign the recommended values shown: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem] 
 
NTFSDisableLastAccessUpdate=1 
 
This DWORD disables the constant updating of dates a file/folder was last accessed if set to 1, improving 
disk performance. 
 
NTFSDisable8Dot3NameCreation=1 
 
This DWORD disables support for old MSDOS 8-character filenames if set to 1, which can improve 
performance. 
 

CHANGE FOREGROUND APPLICATION PRIORITY 

For users who usually run one major application or game at a time on their machine, you can set Windows 
XP to give even higher priority in allocating resources to such 'foreground applications'. Follow the tweak 
below to implement the change: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\PriorityControl] 
 
Win32PriorityControl=38 
 
Create a new DWORD called Win32PriorityControl and allocate a value of 38 to it in Decimal view. 
 

PREVENT MSN MESSENGER FROM RUNNING 

If you don't use the Windows MSN Messenger utility and want to prevent it from running - e.g. when it is 
launched automatically by certain applications - then implement these changes to your Registry. 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client] 
 
PreventRun=1 
 
This DWORD will prevent MSN Messenger from running if set to 1. 
 
PreventAutoRun=1 
 
This DWORD will prevent MSN Messenger from popping up automatically if set to 1. 
 

TURN OFF CD AUTOPLAY 

By default Windows XP will automatically detect the presence of any CDs or DVDs inserted into CD/DVD 
drives on your system. As soon as such disks are detected, any applications, audio or movies files on these 
disks will automatically be launched. This Autoplay functionality can be annoying to some, and can also 
lead to unwanted software being automatically installed (such as Rootkits - see the PC Security chapter). To 
disable Autoplay functionality, make the following change: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\CDRom] 
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Autorun=0 
 
Setting this DWORD to 0 disables Autoplay, setting it to 1 enables Autoplay. Note that instead of this tweak, 
you can temporarily disable Autoplay behavior at any time simply by holding down the SHIFT key while 
inserting a CD or DVD. 
 

TURN OFF WINDOWS XP BUILT-IN CD BURNING 

Windows XP has a basic form of CD burning which although adequate is not good enough to replace the 
functions of a dedicated burning package like the recommended Nero Burning ROM. If you are using a 
third-party burning package you can disable the built-in XP burning functionality by doing the following: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer] 
 
NoCDBurning=1 
 
This DWORD disables the built-in Windows burning functionality if set to 1, but still allows other burning 
software to work. 
 

TURN OFF SYSTEM BEEPS 

By default Windows XP makes beeping noises under certain situations, regardless of your Windows sound 
settings. To alter this behavior, go to the following Registry entry: 
 
[HKEY_CURRENT_USER\Control Panel\Sound] 
 
Beep=Yes 
 
Set this STRING to No to disable any system beeps that occur during Windows usage. Note that to disable 
other Windows event-based sounds you will still need to go into Control Panel>Sounds and Audio Devices -
see Sounds & Audio Devices under the Control Panel chapter. 
 

CHANGE THUMBNAIL QUALITY & SIZE 

Whenever you view a folder with pictures in it, by default Windows will show the contents in Thumbnails 
view. To change the size and quality of these thumbnails use this tweak: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer] 
 
ThumbnailQuality=50 
 
To alter the quality of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in 
Decimal view between 50 and 100. The larger the value, the better the thumbnail image but the slower the 
thumbnailed images will load up. 
 
ThumbnailSize=32 
 
To alter the size of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in 
Decimal view between 32 and 256. The larger the value, the larger the thumbnail but the slower the 
thumbnailed images will load up. 
  

http://www.nero.com/en/index.html�
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DISABLE THUMBNAIL CACHE 

When displaying folder contents in Thumbnails view, Windows creates caches of thumbnailed images, 
usually saved in files called Thumbs.db in each folder that has been viewed in Thumbnails view at any point. 
Thumbnail caching helps speed up repeated viewing of these folders in Thumbnails view, but you can 
disable thumbnail caching by doing the following: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced] 
 
DisableThumbnailCache=0 
 
Set this DWORD to 1 to disable thumbnail caching, or set it to 0 to enable thumbnail caching. If you disable 
thumbnail caching you should also go to Windows Search and find and delete every instance of the file 
Thumbs.db on your system as they are no longer necessary. 
 

TURN OFF 'LOW DISK SPACE' NOTIFICATION 

Once the free space on your hard drive falls below a certain percentage Windows XP will give you a 'Low 
Disk Space' notification. To disable this, implement this tweak: 
 
[HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer] 
 
NoLowDiskSpaceChecks=1 
 
Set this DWORD to 1 to turn off the notification altogether. 
 

DISABLE BALLOON TIPS 

Balloon Tips are the small yellow pop-ups that appear throughout Windows informing you of various facts 
or functions. To disable these, implement this tweak: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced] 
 
EnableBalloonTips=0 
 
Setting this DWORD to a value of 0 turns off the balloon tips. 
 

DISABLE WINDOWS KEY 

If you want to disable the Windows Keys on your keyboard, perhaps because they are interfering in a game 
you are playing, use this tweak: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Keyboard Layout] 
 
Scancode Map= 
 
Under the Keyboard Layout key (not Keyboard Layouts) create a new BINARY value called Scancode 
Map and then double-click on it and click once in the top right hand side of the value data box and manually 
type in the following values in the exact order as shown (note all the 0's are zeros, and no spaces are 
necessary): 
 
00 00 00 00 00 00 00 00 03 00 00 00 00 00 5B E0 00 00 5C E0 00 00 00 00 
 
You will need to reboot for this change to come into effect. If you want to reverse this tweak, delete the 
above key and reboot. Since the Windows keys are useful for many keyboard shortcuts, I generally don't 
recommend implementing this tweak. 
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That's just a small number of what I believe are the more useful miscellaneous registry tweaks. If you're in 
the mood for more registry tweaking, a large range of Windows Registry tweaks can be found on this 
Registry Tweaks for XP Page. Note that some of them may not work correctly on Windows XP SP3, so please 
backup before using any of them. I don't recommend implementing a large number of Registry tweaks at 
once, as this makes troubleshooting difficult in the future. Select the ones that you feel are the most 
necessary for performance and convenience sake, implement them and reboot. If your system remains stable 
and trouble-free, implement a few new ones at a time, and repeat the process. Remember, there is no 'undo' 
for the Registry Editor, so take the appropriate backup precautions as spelt out earlier. 
 

http://www.kellys-korner-xp.com/xp_tweaks.htm�
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GROUP POLICY 
 
The Group Policy editor is an Administrative Tool designed primarily for network administrators to alter 
the way in which Windows XP behaves for groups of users on their network - see Administrative Tools 
under the Control Panel chapter. It is only available in Windows XP Professional, but fortunately for 
Windows XP Home users the majority of the tweaks covered in this chapter can be performed using other 
utilities, such as TweakUI. To access the Group Policy settings, go to Start>Run and type "gpedit.msc" 
(without quotes) and press Enter. This will open the Group Policy editor, which shows two main branches: 
'Computer Configuration' and 'User Configuration'. Changes made under the 'User Configuration' sections 
only affect the current user, while changes made under the 'Computer Configuration' section apply to the 
entire machine and affect all users on that machine. 
 
 
< GROUP EDITOR TWEAKS 

Below are a range of tweaks that you can apply through the Group Policy editor. To change a setting, go to 
the sub-folder shown and double-click on the setting in the right pane and then choose Enabled, Disabled or 
'Not Configured' as required then click Apply. My recommended settings for each are provided in brackets, 
however you should first click once on the setting you wish to change and in the Extended view you can see 
a brief description of the setting to the left of it. If in doubt, do not change a setting - leave it at its default. 
 

DISABLE AUTOMATIC SYSTEM RESTORE CHECKPOINTS 

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Installer 
Setting: Turn off Creation of System Restore Checkpoints  (Leave at default) 
 

TURN OFF BUILT-IN XP CD BURNING 

Folder: User Configuration\Administrative Templates\Windows Components\Windows Explorer 
Setting: Remove CD Burning Features (Enabled) 
 
Note: Still allows third party burning software such as Nero Burning ROM to work without problems. 
 

PREVENT WINDOWS MEDIA DIGITAL RIGHTS MANAGEMENT FROM 
INTERNET ACCESS 

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Media 
Digital Rights Management 
Setting: Prevent Windows Media DRM Internet Access (Enabled) 
 

REMOVE 'SHARED DOCUMENTS' FOLDER 

Folder: User Configuration\Administrative Templates\Windows Components\Windows Explorer 
Setting: Remove Shared Documents from My Computer (Enabled) 
 

REMOVE SHUTDOWN/LOGOFF/RESTART MESSAGES 

Folder: Computer Configuration\Administrative Templates\System 
Setting: Remove boot /Shutdown /Logon / Logoff messages (Leave at default) 
 

TURN OFF USER TRACKING (WILL ALSO DISABLE PERSONALIZED MENUS) 

Folder: User Configuration\Administrative Templates\Start Menu and Taskbar 
Setting: Turn off user tracking (Enabled) 
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PREVENT ACCESS TO WINDOWS COMPONENTS 

Folder: User Configuration\Administrative Templates\System 
Setting: Don't run specified Windows applications 
 
Note: You can also prevent users from accessing the Registry Editor and Command Prompt in this folder. 
 

TURN OFF CD/DVD AUTOPLAY 

Folder: Computer Configuration\Administrative Templates\System 
Setting: Turn off Autoplay (Enabled) 
 

DISABLE WINDOWS MESSENGER 

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Messenger 
Setting: (Set both to Enabled) 
 

CUSTOMIZE INTERNET EXPLORER TITLE 

Folder: User Configuration\Windows settings\Internet Explorer Maintenance\Browser User Interface 
Setting: Browser Title (Personalize as desired) 
 

REMOVE RECYCLE BIN ICON FROM DESKTOP 

Folder: User configuration\Administrative Templates\Desktop 
Setting: Remove Recycle Bin icon from Desktop (Leave at default) 
 

REMOVE MY DOCUMENTS ICON FROM DESKTOP 

Folder: User configuration\Administrative Templates\Desktop 
Setting: Remove My Documents icon from Desktop (Enabled) 
 

REMOVE MY COMPUTER ICON FROM DESKTOP 

Folder: User configuration\Administrative Templates\Desktop 
Setting: Remove My Computer icon from Desktop (Leave at default) 
 
Note: Use this tweak with caution as enabling it can cause a great many problems. 
 
 
There are a range of other Group Policy tweaks you can undertake, so have a look through the other areas of 
the Group Policy editor and see if there is anything you would like to change. However be very careful to 
remember precisely what you have changed, because when troubleshooting problems people tend to forget 
the changes they implemented in Group Policy and spend a great deal of time checking elsewhere, especially 
since you can perform many of these same tweaks in a variety of other places. 
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TWEAKUI  
 
TweakUI is a free Microsoft utility that provides a convenient tweaking User Interface (UI) for safely 
customizing many of Windows XP's hidden settings. It is easy to use and includes helpful instructions on 
what the various settings do. If you don't feel confident in using the Registry Editor or Group Policy editor 
to make certain changes for example, TweakUI allows you to change many of the same settings in a 
relatively foolproof way. To access TweakUI, first download it from the Microsoft PowerToys site, then 
install it and launch it. To navigate to the various areas of TweakUI, click once on the name of the section 
(e.g. General), and in the right pane tick or untick the appropriate settings and then make sure to click the 
Apply button for every section or sub-section you change. The effects of most changes will be visible 
immediately. 
 
 
< CONFIGURATION ADVICE 

TweakUI covers a large number of settings, and as such I can't possibly cover them all here. Below are a 
selection of the more significant settings which I recommend people change in order to improve general 
performance and functionality. Descriptions for each can be seen in TweakUI whenever you highlight the 
relevant setting. These changes should be safe for almost every system, but obviously you can undo them by 
reversing the changes in TweakUI should they not suit you. 
 

GENERAL 

Tick 'Optimize hard disk when idle' 
 

GENERAL>FOCUS 

Tick 'Prevent applications from stealing focus' 
 

EXPLORER 

Tick 'Detect accidental double-clicks' 
Untick 'Maintain network history' 
Untick 'Show Links on Favorites menu' 
Tick 'Use intuitive filename sorting' 
 

EXPLORER>SHORTCUT 

Select None to remove the shortcut arrows from shortcuts 
 

EXPLORER>THUMBNAILS 

Move the slider to the far left for Image Quality 
 

EXPLORER>CUSTOMIZATIONS 

To conserve memory use a relatively low setting like 400 folders 
 

TASKBAR AND START MENU 

Untick 'Enable balloon tips' 
Untick 'Warn when low on disk space' 
  

http://www.microsoft.com/windowsxp/downloads/powertoys/xppowertoys.mspx�
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MY COMPUTER>AUTOPLAY>TYPES 

To disable the Autoplay functionality of your drive(s), untick 'Enable Autoplay for CD and DVD Drives'. 
Some malicious software such as Rootkits can be prevented from installing by turning off Autoplay (See PC 
Security chapter). 
 

CONTROL PANEL 

Untick all the Control Panel components you never use, or which are installed by third party programs and 
are unnecessary. Note that this only removes their icons from the Control Panel and not the programs 
themselves, and doesn't affect that program's functionality in any way. I recommend you do this tweak after 
you have adjusted all the settings in the Control Panel (See the Control Panel chapter). 
 
You should customize the remaining settings as you see fit, then click OK when done. 
 
 
Although TweakUI is very safe to use, don't change settings that you are unclear about. If anything goes 
wrong, it may be difficult for you to figure out which change in TweakUI is causing the problem, or has 
removed the functionality you want. Take it slow and change a few things at a time. Also have a look at the 
other XP PowerToy utilities on the PowerToys site, as some of them are very useful. 
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WINDOWS EXPLORER 
 
Windows Explorer is the primary means for manipulating files and folders in Windows XP. This interface 
appears in the Windows Explorer application itself, as well as in many applications which prompt you to 
open or save files, and of course in most standard Desktop windows. Windows Explorer can be accessed in 
several ways, including by going to Start>All Programs>Accessories, or by going to Start>Run and typing 
"explorer" (without quotes) and pressing Enter, or by pressing WINDOWS+E at any time to name just a few 
methods. The interface is familiar to any Windows user and the basics have remained the same. Importantly, 
there are many settings you can alter in Folder Options that have a direct impact on what you can see when 
in Windows Explorer. These are covered under Folder Options in the Control Panel chapter, so make sure 
you use the recommended settings there for maximum performance and functionality. For example, by 
making sure that file extensions and system files aren't hidden in Folder Options, you will be able to see 
these files in Explorer and perform some of the tweaks in this guide, as well as making general 
troubleshooting easier. 
 
Below are a range of tweaks and tips for Windows Explorer: 
 
 

SET EXPLORER'S DEFAULT STARTUP FOLDER 

If you usually open Explorer from a shortcut, this tweak allows you to set which directory it will start in by 
default when launched from that shortcut: 
 
1. Right-click on the shortcut icon you use to launch Explorer and select Properties. If no such shortcut 

exists, you can first create one by right-clicking on a blank spot on your desktop or in a directory and 
then selecting New>Shortcut. 

2. In the Target box replace any existing text with the following: 
 
%SystemRoot%\Explorer.exe /e, path 

 
3. In place of path above you should enter the actual path to the directory you want open by default. The 

path doesn't require quote marks around it. For example:  
 
%SystemRoot%\Explorer.exe /e, C:\Windows  
 

4. Click OK, and now using this shortcut will open a Windows Explorer window in the directory specified. 
 
Note that there are several other switches and options you can use in the Properties box to further customize 
Explorer's default view as detailed in this Microsoft Article. 
 

SPEED UP EXPLORER 

The following tweak can improve the response time of Windows Explorer (and also Internet Explorer). Go to 
the following key in the Windows Registry: 
 
[HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\RemoteCom
puter\NameSpace] 
 
To prevent Windows Explorer from searching for remote scheduled tasks, under the Namespace key in the 
left pane find the {D6277990-4C6A-11CF-8D87-00AA0060F5BF} key if it exists, right-click on it and 
select Delete to remove it. To also prevent Explorer from searching for remote shared printers, delete the 
{2227A280-3AEA-1069-A2DE-08002B30309D} key as well. This will speed up the time it takes for 
Explorer to open and navigate. If you are connected to a network of computers do not undertake this tweak. 
  

http://support.microsoft.com/kb/307856�
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REMOVE 'SHARED DOCUMENTS' FROM MY COMPUTER 

If you want to remove the 'Shared Documents' folders under My Computer use this tweak: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\MyCompute
r\NameSpace\DelegateFolders] 
 
{59031a47-3f72-44a7-89c5-5595fe6b30ee} 
 
Delete the key above by right-clicking on it in the left pane and selecting Delete. This will remove all the 
superfluous 'Shared Documents' folders permanently. 
 

FORCE ALL COLUMNS IN EXPLORER TO BE VISIBLE 

Sometimes when you open Windows Explorer or Explorer-based interfaces (and there are many, such as the 
Registry Editor) there may be columns that are much too wide or narrow to show everything they contain. 
To quickly force Windows to resize these columns appropriately press the CTRL key and the + (plus) key 
together. This will instantly resize all columns so that even the largest value in each column is visible. This 
may require you to expand the surrounding window or use the bottom scroll bar to see them all, but at least 
there won't be any hidden or overly wide or thin columns. See the Visual and Convenience chapter for other 
handy keyboard shortcuts. 
 

RENAME MULTIPLE FILES 

If you have a large number of files you want to rename, you can do it rapidly by doing the following: 
 
1. Highlight the group of files you want to rename in Windows Explorer. You can do this two ways:  
§ Hold down the SHIFT key and click on the first file in the group, then while still holding down shift, 

click on the last file in the group and everything in between will also be highlighted; or  
§ Hold down the CTRL key and click on any individual files you want to select until all the files you 

want to select are highlighted.  
You can also combine the two methods, i.e. SHIFT select a range of files, then use CTRL to remove or 
add individual files to the highlighted ones. 

2. Without clicking anywhere else, right-click on the first file you want to rename, and select Rename. 
3. Enter a name for the file and press Enter.  
 
Now all the remaining highlighted files will be renamed with the same name you gave the first file, however 
they will also have a number in brackets after them. For example, if I rename the first in a series of files 
Screen.jpg using this method, the remaining highlighted files will be renamed Screen (1).jpg, Screen (2).jpg, etc. 
 

EDIT CONTEXT MENUS 

Many programs insist on becoming a part of your context menus. A context menu is the small menu which 
pops up when you right-click on a file, folder or icon for example, whether in Explorer-based views or on 
your Desktop. Many of the entries in the context menu have been unnecessarily put there by programs you 
have installed. The first step in getting rid of any unwanted entries involves opening the programs in 
question and looking through their options to see if you can unselect any 'shell integration' or 'context menu' 
options they have. If that fails, you can manually remove these entries by opening Registry Editor and 
following these steps: 
 
1. Create a System Restore Point, then back up the registry keys which you plan on changing - see the 

Backup & Recovery and Windows Registry chapters for details of how to do this. 
2. The specific keys you should look under in Registry Editor are: 
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[HKEY_CLASSES_ROOT\*\shellex\ContextMenuHandlers] 
[HKEY_CLASSES_ROOT\Directory\shellex\ContextMenuHandlers] 
[HKEY_CLASSES_ROOT\Drive\shell] 
[HKEY_CLASSES_ROOT\Drive\shellex\ContextMenuHandlers] 
[HKEY_CLASSES_ROOT\Folder\shell] 
[HKEY_CLASSES_ROOT\Folder\shellex\ContextMenuHandlers] 
 

3. Under each, aside from standard Windows items such as Sharing or Offline Files, you may find 
keys which relate to particular third party programs. Right-clicking on the relevant program key in the 
left pane and selecting Delete will remove its context menu entries. 

4. As you remove unwanted program entries, you can test the effects immediately by checking to see if the 
relevant entry was removed from the context menu. 

5. If you make a mistake and remove an important entry, restore the relevant branch of the Registry you 
backed up in Step 1 - do not proceed without backups of each branch.  

 
If you're not comfortable manually editing the Registry and want to delete (or add) the main context menu 
entries, you can use the Context Menu Editor utility instead, or try the CMenu context menu management 
utility. 
 
Note: if any of the programs whose context menu entries you've edited or removed start displaying strange 
behavior, or you accidentally deleted the wrong entry, restore the registry entries you backed up previously, 
or just reinstall that particular program. As long as you only delete clearly marked program entries and none 
of the default Windows entries, all the normal context menu items will still remain. 
 

ADD 'COPY TO' AND 'MOVE TO' CONTEXT MENU ITEMS 

If you want to add two useful commands to your context menus - namely 'Copy To' and 'Move To', follow 
the steps below: 
 
[HKEY_CLASSES_ROOT\AllFileSystemObjects\shellex\ContextMenuHandlers] 
 
Copy To= {C2FBB630-2971-11d1-A18C-00C04FD75D13} 
Move To= {C2FBB631-2971-11d1-A18C-00C04FD75D13} 
 
Create two new keys under the ContextMenuHandlers folder - that is, right-click on 
ContextMenuHandlers and select New>Key twice and name them 'Copy To' and 'Move To' (without 
quotes) respectively. Then left-click once on each folder, go to the right pane in Registry Editor and double-
click on the (Default) entry and assign the appropriate values shown above, including the parentheses 
around the numbers. This will create two new entries that allow you to select either 'Copy To Folder...' or 
'Move To Folder...' in the context menu for a particular file or folder and then specify the location to copy or 
move them to. Obviously if you wish to add just one of the above entries to the context menu then only 
create the relevant key. 
 

FOLDER VIEWS NOT BEING SAVED 

Sometimes when you change the way a folder's contents look, or its position on your Desktop, or the size of 
the window it opens in, after a reboot the changes don't seem to have been saved. The first thing to do is go 
to Control Panel>Folder Options and under the View tab make sure that 'Remember each folder's view 
settings' is ticked. However even with this setting ticked you may inevitably end up with unsaved settings. 
This can be due to corrupted registry entries brought on by a bad shutdown for example. The easiest way to 
fix this problem is to open the Registry Editor and go to the following keys: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\ShellNoRoam\BagMRU] 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\ShellNoRoam\Bags] 
 
Right-click on each key (i.e. BagMRU and Bags) and select Delete to get rid of both of them. Reboot your PC 
and open up each folder or window you want to customize. They will be back at their default appearance, 
and you will need to adjust again them to suit your tastes. However this time after you reboot your PC the 

http://www.softpedia.com/get/System/OS-Enhancements/Context-Menu-Editor.shtml�
http://www.mediafire.com/?12g0rzv2ucd�
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view settings should be exactly as you set them prior to the reboot. By deleting the registry entries above 
Windows is forced to recreate them and in doing so get rid of corrupted entries. If you find you have to do 
this very often, then see the tips throughout this guide for stabilizing your system. This is a clear sign that 
your system is not completely stable, and contrary to popular belief, it is not normal behavior for Windows 
to constantly forget folder views. Also see the Explorer Customizations section of the TweakUI chapter for 
details of how to set the maximum number of folders for which Windows retains the saved customization 
settings - if this is set too low it may be the reason why your folder views are being lost. 
 

REPAIR INCORRECTLY DISPLAYED ICONS 

By default Windows stores a range of commonly used icons, such as Desktop and folder icons, in a cache to 
speed up their display. If you are experiencing problems with your icons displaying incorrectly, go to your 
\Documents and Settings\[Username]\Local Settings\Application Data directory and delete the file IconCache.db. 
Reboot Windows and this file will be recreated afresh, resolving any icon incorrectly displayed. Also see the 
Memory Optimization chapter for details of how to set the size of the Icon Cache. 
 

MOVE THE MY DOCUMENTS FOLDER 

By default the 'My Documents' folder is in a specified location, and moving it manually will not work. To 
move the My Documents folder to another location, you must do the following: 
 
1. Click on Start, go to My Documents and right-click on it, then select Properties. Alternatively in 

Windows Explorer find the My Documents folder under your \Documents and Settings\[Username]\ 
directory, right-click on it and select Properties. 

2. Click the Move button and select a new location, then click OK. 
3. Choose whether you wish to move your existing documents across to this location. 
 
Alternatively you can just type the new path in the Target box. When you're done, Windows will now 
recognize the new location as the home of My Documents. Note that you can also change the name of My 
Documents to something else if you wish, such as simply 'Documents'. 
 

MAKE THE MY DOCUMENTS FOLDER PRIVATE 

If you want to password protect your My Documents folder, or in fact any folder which is unique to your 
user account (such as My Photos, Favorites, Desktop, Start Menu), and you're using the NTFS file system, 
you can do the following: Right-click on the folder in Explorer, select the Sharing tab and tick the 'Make this 
folder private' box. Now the folder and all its subdirectories will be password protected with your user 
password. If you're logged in as the Administrator, or you have not set a user password (for quicker logon to 
Windows), this tweak won't do anything - if you try it, you'll be prompted to set a password, and unless 
you're worried about others accessing your private folders, I do not recommend setting a password. Also see 
the PC Security chapter for more details on how to protect files and folders using Windows Encryption. 
 

DISABLE WINDOWS FILE PROTECTION 

By default Windows XP protects a range of important system files from accidental deletion. This tweak 
allows you to remove that protection - I strongly recommend against using it though: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon] 
 
SFCDisable=0 
 
Setting this DWORD to 1 will allow you to view, alter and delete protected system files. This is not 
recommended as these system files are protected for a reason - to specifically prevent harmful changes or 
deletions to core system files that can destabilize your system. Note you need to untick the 'Hide protected 
operating system files' option under Control Panel>Folder Options>View to be able to see protected files in 
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Windows Explorer. Use this tweak only if troubleshooting a problem, such as malware infection, and only as 
a last resort. 
 

CHANGE DEFAULT LOCATION FOR PROGRAMS AND COMMON FILES 

To change the default location for the Program Files and/or Common Files folders, open Registry Editor and 
go to the following key:  
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion] 
 
ProgramFilesDir=C:\Program Files 
 
Change this STRING entry to another path if you want to change where Windows points to by default when 
installing new programs.  
 
CommonFilesDir=C:\Program Files\Common Files 
 
Change this STRING entry to another path if you want to change where Windows points to by default when 
installing common files for programs.  
 
Reboot Windows to bring the changes into effect. Keep in mind that using this tweak may result in problems 
with existing installed programs and file associations, as well as running Windows Update. You may have to 
manually move some of the existing program folders to the new location for them to work correctly. 
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INTERNET EXPLORER 
 
Internet Explorer (IE) is the most popular Internet browser in the world today. Most Windows users are 
extremely comfortable and familiar with Internet Explorer, and also know that it is the one browser upon 
which pretty much all Internet content will display as intended. Even if you use an alternate browser as your 
main browser, you may need to use Internet Explorer from time to time because certain websites will not 
display or function properly on other browsers. The best example of this is Microsoft's own Windows 
Update website which is only fully functional and secure when viewed with Internet Explorer. While I 
recommend that you begin trialing alternatives to Internet Explorer, it is a fast, efficient browser, and you 
should not feel you have to use another browser if you are happy with it.  
 
Internet Explorer 6 is the version built into Windows XP, even with SP3 installed. However Internet Explorer 
8 is now the latest official version of IE and the one I would strongly recommend all IE users to upgrade to 
for security, performance, stability and compatibility reasons. Accordingly, the advice in this chapter now 
relates solely to IE8. You can download Internet Explorer 8 from here. 
 
 
< CONFIGURATION ADVICE 

To configure Internet Explorer, open the browser, go to the Tools menu and select 'Internet Options' - note 
this is the same as if you go to the Windows Control Panel and choose 'Internet Options'. Below are the 
descriptions and my recommendations for the important settings under each tab of Internet Options in IE: 
 

GENERAL 

Home Page: Here you can set the page that opens by default whenever you start Internet Explorer. If you 
don't want any homepage to start when IE is opened, click the 'Use blank' button; if you want to set the 
website you are currently viewing as your homepage, click the 'Use current' button; clicking 'Use default' 
will restore IE's default homepage which is a Microsoft site such as MSN (depending on your location). If 
you are using tabbed browsing (see further below), then you can enter multiple website addresses in the box, 
one on each line. Then whenever you open IE, all of these pages will open at the same time, as separate tabs. 
 
Note, if the home page will not change regardless of what you do here see the Programs section further 
below as well as the PC Security chapter - this may be caused by malware such as a browser hijacker. 
 
Browsing History: As you browse the Internet, certain files and settings are stored on your hard drive 
(cached) by IE to make your browsing faster in the future. Click the Settings button and you can select how 
IE uses this cache to speed up your browsing. Under the 'Check for newer versions of stored pages' you can 
tell IE how often to check to see if a web page has been updated; any parts of a site which don't appear to be 
updated will be loaded from your cache rather than site, and this can increase page load times especially for 
sites which have a lot of items to load up. I recommend selecting 'Automatically' as this allows IE to detect 
updated content and reload from the site only when it believes it is necessary. However this does not 
guarantee that you will always see the very latest content on the sites you visit, so if you want to see the 
absolute latest version of every page you visit select 'Every time I visit a webpage', though note this may 
increase page loading times. If you only want to view the latest version of certain pages at any time, press 
CTRL + F5 when on that page and this forces IE to reload the entire page from the site rather than from its 
own cache. Importantly, do not select the Never option here as that will mean IE will not update web pages 
you commonly view; it will always rely on the cached version which always results in out-of-date web 
pages. 
 
If for privacy purposes you wish at any point to delete any components of your browsing history from the 
cache, click the Delete button back under the General tab - see further below for details. If you just wish to 

http://www.microsoft.com/windows/products/winfamily/ie/default.mspx�
http://www.microsoft.com/windows/internet-explorer/worldwide-sites.aspx�
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browse privately from time to time, see the InPrivate Browsing feature covered in the section of the same 
name further below.  
 
Disk space to use: You specify the maximum amount of space IE uses for its cache (in MegaBytes) in the box 
provided. If the cache is too small, it will generally result in longer page loading times; if the cache is too 
large then depending on your Internet connection speed and your hard drive speed, you may get longer 
page loading times as IE has to search its cache to find the components of a web page to load, when it may 
actually be faster just to reload them from the original site. Therefore I recommend 100MB of disk space for 
the cache as a balance of size and speed. If you have a faster hard drive and view more complex sites with 
lots of large images or scripts you may wish to double or even triple the size of this cache. 
 
Current Location: Internet Explorer lists the current location of its cache - this is where all of IE's stored 
content is held on your hard drive. You can view the files already there by clicking the 'View files' button, 
and you can view any downloaded programs necessary for certain sites to run by clicking the 'View objects' 
button. If you wish to move the cache, for example to a faster drive, click the 'Move folder' button. To delete 
cache contents, it is recommended that you follow the instructions further below rather than manually 
deleting any files here. 
 
History: Internet Explorer can keep a record of the addresses of all the websites you have viewed for a certain 
number of days. Here you can select how many days worth of recently viewed websites IE keeps. If you 
don't want a history of visited sites to be kept at all enter 0 in the box. Alternatively, see the InPrivate 
Browsing section if you just want to browse periodically without keeping a record of your history. 
 
Delete Browsing History: By clicking the Delete button under Browsing History, you will open a new box 
which contains a range of options. These options list the individual components of your browsing history, 
giving you greater control over the specific elements you can delete. If you don't wish to leave any trace of 
your browsing history for each and every session, you can use the InPrivate Browsing feature of IE, which is 
covered later in this chapter. In general it is completely safe to tick all of these boxes and click the Delete 
button to remove all traces of browsing, however doing so too often will also decrease the efficiency of your 
browsing. For this reason, there is an option entitled 'Preserve Favorites website data' which if ticked 
(recommended) will keep your preferences and cached files for any sites you have in your Favorites. This 
increases convenience and speed when accessing your favorite sites, without retaining date for non-favorite 
sites. However if you want to remove all stored content then untick this box as well. In any case once you've 
selected which components you want to remove, click the Delete button at the bottom and they'll be 
removed immediately. 
 
Search: The Instant Search box at the top right of Internet Explorer allows you to quickly initiate a web search 
using the search engine of your choice, the results of which are displayed on the main IE screen. By default it 
is set to use Windows Live, however if you wish to set it to another engine such as Google, click the Settings 
button and select a new engine, then click the 'Set as Default' button. If you want to use a search engine not 
listed here, click the 'Find more providers' link at the bottom of the box. If you don't want sites or programs 
to suggest changes to your default search provider, then tick the relevant box at the bottom as well. If you 
just want to use a particular provider for particular searches, then in the main IE window click on the small 
arrow to the right of the Search box, select a provider from the list, enter your search query and press Enter - 
that search provider will be used only for that search, it will not change your default provider. 
 
Tabs: Tabbed browsing means that new web pages launched from links or popups can be opened as tabbed 
pages within the current browser window, rather than opening a new browser window. This helps reduce 
resource usage and it is also much easier to manage multiple open pages this way. To configure tabbed 
browser, click the Settings button. In the box which opens you can select whether to enable or disable tabbed 
browsing altogether, and set the behavior of it if enabled. Briefly, I recommend ticking the following 
settings: 
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§ Enable Tabbed Browsing - As mentioned above, tabbed browsing reduces resource usage by only 
keeping one IE window open; each new tab takes up far less memory than new IE windows. 

§ Enable Quick Tabs - Quick Tabs places a small box at the far left of your tabs when you have multiple 
open tabs. Clicking it opens a page which contains previews of the content of every open tab. 

§ Enable Tab Groups - Tab Groups allows IE to group together tabs which are related. Tabs originating 
from the same source page are grouped next to each other and use the same color. 

§ Always open popups in a new tab - This prevents popups from using extra resources by forcing them to 
open in a new tab instead of a new window. 

§ A new tab in the current window - When a program launches a web page, this option forces it to open a 
tab in any existing IE window rather than open a new IE window, again conserving resources. 

 
You can select the other options as you wish, but the main aim of tabbed browsing is to make viewing 
multiple web pages more manageable and prevent having lots of separate open IE windows which can use 
resources and space for no good reason. Some tips you can use to make tabbed browsing easier in IE include: 
 
§ Clicking on any hyperlink with the middle mouse button opens that link in a new tab. 
§ Clicking on any tab with the middle mouse button closes that tab. 
§ Holding down SHIFT and left-clicking on any link forces it to open in a new IE window. 
§ Holding down CTRL and left-clicking on any link forces it to open in a new tab. 
§ Use CTRL+TAB to quickly switch from tab to tab. 
§ You can reopen a recently closed tab by pressing CTRL+SHIFT+T. 
§ Left-click and hold on any tab and you can then drag and drop it to rearrange tab order. 
§ Right-click on any tab to bring up a tab-specific context menu. 
§ If you want to save a set of tabs as a single bookmark folder, click the Add to Favorites icon (the star 

with a plus sign), select 'Add to Favorites' and select 'Add Current Tabs to Favorites'. 
§ To open the contents of an entire Favorites folder in a series of tabs, right-click on the folder under 

Favorites and select 'Open in Tab Group'. 
§ To manage Tab Groups, right-click on a tab within the group and you can close the entire group for 

example by selecting 'Close This Group'. 
 
Appearance: These options allow you to change the appearance of web pages, customizing colors, fonts and 
even forcing particular style sheets. In general you shouldn't alter these options unless you have specific 
needs. 
 

SECURITY 

Security level for this zone: You can set the level of security Internet Explorer uses on the slider here, from 
Medium to Medium-High, to High. I recommend the default Medium-high level of security as it designed to 
allow most normal Internet functionality without being overly restrictive nor too relaxed. However if you 
constantly browse unsafe or untrusted websites, you may wish instead to set the High security level, though 
this will impact on Internet functionality. If you want to be even more selective, click the 'Custom level' 
button and manually select each security function; clearly though this is for more advanced users. 
 
Note that the Windows XP version of Internet Explorer differs from the Windows Vista version of IE, as it 
does not include Protected Mode. 
 

PRIVACY 

Settings: The slider here controls the level of privacy in IE, which for the most part pertains to Cookies - small 
files stored on your machine designed to hold your preferences for particular websites. Cookies are not 
usually malicious or dangerous, and can be very useful. For this reason, the 'Medium-High' level is 
recommended as it provides the best security/functionality compromise and should not prevent legitimate 
cookies from being placed on your machine while still protecting your privacy. However to be even more 
selective, you can click the Advanced button and tick 'Override automatic cookie handling'. Third-party 

http://msdn2.microsoft.com/en-us/library/bb250462.aspx�
http://www.cookiecentral.com/faq/�
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Cookies can usually be Blocked without any major issues, as these are mainly from advertisers. First-party 
Cookies on the other hand are often useful (e.g. for holding your login details for forums, or recording visual 
settings for particular sites), and blocking them can impair a site's functionality. If you do decide to block all 
first party cookies, and/or if you select a higher Privacy setting on the slider, click the Sites button and here 
you can manually allow or block specific website's cookies. I recommend adding your trusted favorite sites 
to this list and allowing them, to prevent any problems with functionality. For example, if you set a High or 
Very High privacy setting this will block almost all cookies, but you can still allow specific sites' cookies by 
making sure they're in the list of allowed sites. For broader blocking of third party content see the InPrivate 
Filtering section further below. 
 
Pop-up Blocker: A 'popup' is a new window which opens when you visit particular sites and/or click on 
particular links or areas of a site. They are most commonly used for advertising, and hence the option here to 
block them. I recommend ticking the 'Turn on Pop-up Blocker' box, but you should also click the Settings 
button and manually add the names of websites you trust which have legitimate popups that would 
otherwise be blocked. For example you may wish to add your Internet banking site to the list, or 
Microsoft.com. By default when a popup is blocked by IE, a small yellow warning bar will appear at the top 
of the page to inform you of this, and you may also hear a sound. If you want to disable either or both of 
these visual warnings, untick the relevant boxes here. Bear in mind that this may mean you will not be 
aware that a legitimate site is trying to open a necessary popup box, and thus you may run into problems on 
some sites - again make sure to add trusted sites manually to the list if you want them to function properly. 
 
InPrivate: InPrivate Browsing is a new feature of IE8 which allows you to surf the web without leaving any 
trace of your activities on the PC. This is covered in more detail in the InPrivate Browsing section further 
below. The options here relate to the way in which the InPrivate Browsing and InPrivate Filtering features 
operate when enabled. By default IE keeps a record of the sites you visit for the purposes of determining 
what data to automatically block from third party providers. If you tick the 'Do not collect data for use by 
InPrivate Filtering' box, IE will not record any such data. This will impact on how effective InPrivate 
Filtering is at automatically blocking third party content, but start off by ticking this box and if you find 
problems on particular sites, make manual adjustments in the InPrivate Filtering settings box - see the 
InPrivate Filtering section further below.  
 
When using InPrivate Browsing, ticking the 'Disable toolbars and extensions when InPrivate Browsing starts' 
box will disable all such toolbars and extensions to prevent them from saving any private data during an 
InPrivate session. This is recommended for maximum privacy, but if you absolutely require their 
functionality during InPrivate Browsing, then untick this box but make sure to research your installed 
toolbars and extensions to ensure they do not breach your privacy, as otherwise it will defeat much of the 
purpose of InPrivate Browsing in the first place. Note that in general I strongly recommend against installing 
many (if any) toolbars and extensions wherever possible, for both security, stability and performance 
reasons. 
 

CONTENT 

Content Advisor: If enabled, the Content Advisor allows you to attempt to filter out and control access to 
websites that contain offensive or inappropriate material. Go through each category of content and use the 
slider below the box to set the restrictions on that category. Once done, click OK and you will be prompted 
to set a Password, as well as a Hint in case you forget that password. IE will now attempt to restrict content 
based on content advice from the ICRA (Internet Content Rating Association), so this is not fool-proof. 
 
Certificates: Certificates are a form of electronic authentication method to verify that a particular website or 
individual is what/who it claims to be. They are described in more detail in this Microsoft Article, and are 
too complex to discuss here. I don't recommend altering any of the settings in this section unless you are 
acting under advice from a qualified tech support person. If a particular site displays a certificate error or 
warning, I recommend pursuing this further with the site owner or researching via Google before 
conducting any financial transactions with the site, as advised in this Microsoft Article. 

http://www.fosi.org/icra/�
http://technet.microsoft.com/en-us/library/cc785237.aspx�
http://support.microsoft.com/kb/931850/en-us�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  137 
 

Internet Explorer 

 
AutoComplete: AutoComplete can save any website address you have typed into the address bar (or already 
stored in your History), any text you've entered into online forms, and any usernames and/or passwords 
you've entered on a web page. The aim is that next time you visit that site it will automatically restore your 
typed text, speeding up logging in or filling out details, or typing URLs into the address bar. Click the 
Settings button to configure which particular aspects of a web page AutoComplete will function for, but in 
general for security purposes I don't recommend enabling any of these options unless you have strong 
protection on your User Account and/or the PC is physically isolated from anyone else. 
 
Note that ticking the 'Use Windows Search for better results' box will mean that an item called 'Internet 
Explorer History' will be added to the Indexing Options used by Windows Search. This item cannot be 
removed from within the Indexing Options; to remove it, untick the box here and click OK. 
 
Feeds and Web Slices: If a website you're viewing has RSS or Web Slice capability, you will see the orange RSS 
or green Web Slice icon. You can then click the relevant icon to view the feed or to preview relevant slice 
information. Clicking the Settings button here allows you to configure how often such feeds and slices are 
updated, how they're read, and how IE warns you about capable websites. If you don't use these features, 
untick all the boxes on the Settings page. 
 

CONNECTIONS 

You should set up and customize the details of your Internet connection as provided to you by your Internet 
Service Provider (ISP), and make sure the settings here match your connection type and details. 
 

PROGRAMS 

Default web browser: If you have installed any other browsers, you can choose to set or reset IE as your default 
browser by clicking the 'Make default' button. Unless you are worried about another browser taking over 
this default association, you needn't tick the 'Tell me if Internet Explorer is not the default web browser' box 
for optimal startup speed. If you wish to make another web browser your default, see 'Set Program Access 
and Defaults' under the Add or Remove Programs section of the Control Panel chapter for details. 
 
Manage Add-ons: Clicking this button allows you to configure Add-ons in IE. Any small program installed for 
use within Internet Explorer is an add-on, and generally you will be aware that a site is installing an IE add-
on through prompts. However you can view all the main add-ons here by selecting the relevant category 
and making sure that the Show drop down box under the Toolbars and Extensions category says 'All add-
ons'. For example Adobe Flash Player is a common add-on which allows flash-based content to play on web 
pages, such as YouTube videos. When you first visit a web page with a flash animation, IE will prompt you 
with a yellow warning bar that 'This website wants to install the following add-on:' and mentions the name 
of the add-on, in this case 'Adobe Flash Player from Adobe Systems Incorporated'. If you wish to continue 
you then click the warning bar and follow the prompts. 
 
For the most part some add-ons are legitimate, such as allowing you to view PDF files from within Internet 
Explorer, or run free browser games. You can also download a Range of Add-Ons which provide useful 
additional functionality for Internet Explorer, such as spell checking. Many of these add-ons are free and 
operate similar to Extensions for Firefox, making Internet Explorer more customizable. 
 
The problem is that some sites try to install add-ons which contain malicious scripts designed to alter its 
settings to suit their purposes. Furthermore some sites and programs will insist on installing useless toolbars 
in IE which take up space, collect data on your browsing behavior, and add to resource usage. For this 
reason it's extremely important that you don't just automatically accept the installation of any add-on; only 
install add-ons from trusted websites and only if absolutely necessary. In general the less add-ons the better 
both for security and performance purposes. Even legitimate add-ons can potentially slow down the launch 

http://en.wikipedia.org/wiki/RSS_(protocol)�
http://www.microsoft.com/windows/internet-explorer/features/web-slices.aspx�
http://windowshelp.microsoft.com/Windows/en-US/Help/e85a03aa-c7c6-428e-9891-67ea76df9b7e1033.mspx�
http://get.adobe.com/flashplayer/�
http://go.microsoft.com/fwlink/?linkid=50893�
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and browsing speeds of Internet Explorer. Regularly check the list of add-ons in this section and disable 
those you don't trust; do a Google search if the name does not seem familiar. 
 
The Search Providers category in the Manage Add-ons box is covered under the General section further 
above; the Accelerators category is covered under the Accelerators section later on in this chapter, as is 
InPrivate Filtering.  
 
HTML Editing: Here you can set the program IE uses for editing the HTML code of web pages when you 
select the 'Edit with...' option under the Page menu. 
 
Internet Programs: Clicking the 'Set Programs' button here simply opens the Default Programs component of 
Control Panel, covered in full detail under the Default Programs section of the Control Panel chapter. 
 

ADVANCED 

This section contains important settings for Internet Explorer's functionality, security and general behavior. 
There are too many settings to be able to describe each one of them in full here, however I want to discuss a 
few important options in more detail before going into the recommended settings: 
 
Phishing Filter/SmartScreen Filter: As discussed under the PC Security chapter, Phishing is a form of deception 
designed to illegally secure your personal details, such as logon, password and credit card numbers. It is 
usually done for financial gain, and is becoming an increasingly significant threat. Internet Explorer 7 
introduced the built-in Phishing Filter which warns you if a particular site seems to be deceptive or a known 
phishing perpetrator. Internet Explorer 8 has changed the name of this option to the SmartScreen Filter. 
More than just a name change, the way in which the filter works has also changed. The filter now works 
much more efficiently, has new features to detect and block potential malware downloads, and in general it 
is strongly recommended that you leave the 'Enable SmartScreen Filter' box ticked under the Advanced tab. 
If you visit a potentially unsafe site, the prompts you will receive are quite intuitive. If you still wish to 
continue visiting the reported site, click the 'More Information' link at the bottom of the warning, or click 
'Disregard and download unsafe file' to continue downloading an allegedly unsafe file download. Obviously 
in both cases this is not recommended. 
 
To manually check a particular site using the SmartScreen Filter, go to the Safety menu in IE, highlight the 
'SmartScreen Filter' menu and select 'Check this Website'. To report a website as being unsafe, go to the same 
menu and this time select 'Report Unsafe Website' - however bear in mind this doesn't automatically add the 
site to the list of unsafe websites, it only reports it for further examination by Microsoft. Finally, you can 
disable SmartScreen Filter by selecting the 'Turn Off SmartScreen Filter' option, but this is not recommended.   
 
Zoom: Different web pages have different sized text and pictures. Internet Explorer allows you to zoom 
in/out of any page at any time simply by selecting the zoom level using the Zoom box at the bottom right of 
the screen - click on it and select the desired zoom level. However a quicker method is to hold down the 
CTRL button and scroll up or down on your mousewheel. Alternatively you can use CTRL + (plus key) or 
CTRL - (minus key) to zoom in and out respectively, and to reset the page to its default size, use CTRL 0 
(zero). Under the Advanced options you can alter how this behavior works, particularly for new tabs and 
windows. For example if you tick the 'Reset zoom level for new windows and tabs', regardless of how 
zoomed in or out you are on your current tab, opening a new tab will mean the page will open at the default 
zoom level; if unticked, the new tab will open at the same zoom level as your current page. Experiment with 
these settings as well as the zoom feature to determine what suits your tastes. 
 
Compatibility View: Internet Explorer 8 introduces Compatibility View which helps correctly render web 
pages that use code designed for older browsers. You can switch to Compatibility View at any time by 
selecting the option under the Page menu, or by clicking the small 'broken page' icon to the right of the 
Address Bar. This essentially changes IE8 into IE7 for the purposes of rendering the page. You should only 
use this option if you believe a web page is being shown incorrectly, typically when elements on the page are 

http://windowshelp.microsoft.com/Windows/en-US/Help/1a460290-632a-4fb1-b50b-4df7e40771c41033.mspx�
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out of alignment, obscured by other elements, glitchy or missing objects/text is visible, and so forth. Most 
sites will render correctly in IE8, so this is not a common problem. To manually force any page to 
permanently show itself in Compatibility View, select the 'Compatibility View Settings' option under the 
Page menu and add it to the list. You can also tick the 'Include updated websites lists from Microsoft' to use 
a pre-compiled list held by Microsoft which determines which sites require Compatibility View to 
automatically be enabled - more details can be found in this Microsoft Article. Of relevance to this section, 
under the Advanced tab in the main IE Internet Options, there is an option entitled 'Automatically recover 
from page layout errors with Compatibility View' - if ticked, as the option implies, page layout rendering 
errors will result in the page being shown in Compatibility View. You can leave this option ticked, however 
if you notice a site you regularly visit triggering this option, it is better to add it to the list under 
Compatibility View Settings for faster rendering. 
 
The rest of my recommendations for the more important Advanced settings in IE are provided below. 
 
I recommend that the following options be ticked for maximum performance, stability and convenience: 
 
§ Disable script debugging (Internet Explorer) 
§ Disable script debugging (Other) 
§ Enable automatic crash recovery 
§ Enable third-party browser extensions 
§ Enable visual styles on buttons and controls in webpages 
§ Show friendly HTTP error messages 
§ Use Passive FTP 
§ Use smooth scrolling 
§ Use HTTP 1.1 
§ Use HTTP 1.1 through proxy connections 
§ Always use ClearType for HTML 
§ Enable automatic image resizing 
§ Show pictures 
§ Check for publisher's certificate revocation 
§ Check for server certificate revocation 
§ Check for signatures on downloaded programs 
§ Do not save encrypted pages to disk 
§ Enable DOM storage 
§ Enable Integrated Windows Authentication 
§ Enable native XMLHTTP support 
§ Enable SmartScreen Filter 
§ Use SSL 2.0 
§ Use SSL 3.0 
§ Use TLS 1.0 
§ Warn about certificate address mismatch 
§ Warn if POST submittal is redirected to a zone that does not permit posts 
 
I recommend the following be unticked, again for maximum performance, stability and convenience: 
 
§ Display a notification about every script error 
§ Enable Suggested Sites 
§ Allow active content to run in files on My Computer 
§ Allow software to run or install even if the signature is invalid 
 
Settings for which I have no specific recommendation, but which are noteworthy: 
 

http://msdn.microsoft.com/en-us/library/dd567845(VS.85).aspx�
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Display Accelerator Button on selection: Accelerators are covered in more detail in the section of the same name 
further below. If ticked, this option brings up the blue Accelerators button whenever you highlight a 
selection on a page for example. This may be annoying for some people, especially if they keep accidentally 
clicking the button. Unticking this option removes the button. 
 
Do not submit unknown addresses to your auto-search provider: If selected, this option prevents the search 
functionality of the Address Bar. Given IE already provides an Instant Search box at the top right of the 
screen, this functionality appears superfluous. If you wish to retain it, select 'Just display the results in the 
main window', then whenever you enter some plain text in the Address Bar it will initiate a search using the 
default search engine used for the Instant Search box. 
 
Empty Temporary Internet Files folder when browser is closed: As discussed under the General section above, the 
use of the browser cache speeds up browsing in IE. However if for privacy and/or security purposes you 
want the cache cleared every time you close IE, tick this option. This may result in slower browsing each 
time you start a new session of IE. A better alternative might be to browse with InPrivate Browsing 
automatically enabled - see the relevant sections later in this chapter. 
 
The remaining settings not covered above can be set to suit your taste, or simply left at their default. 
 

INPRIVATE BROWSING 

InPrivate Browsing is a new feature in Internet Explorer 8, the primary purpose of which is to allow you to 
surf the Internet without leaving any trace on the PC you are using. To access this feature, select the 
'InPrivate Browsing' option under the Safety menu, or press CTRL+SHIFT+P - a new browser window will 
open, clearly marked as 'InPrivate'. Any browsing done using this InPrivate session will not store data on 
your drive. This is ideal for people who browse the Internet using publicly shared machines, but it is also 
useful if you simply want to ensure that there is no potential for potentially embarrassing Internet-related 
material to be stored on your PC via normal browsing. 
 
While using an InPrivate session, IE will generate and store several temporary pieces of information, mainly 
to ensure that website functionality is maintained. Cookies and cached internet files will be stored 
temporarily for example, but as soon as you close the InPrivate browser window, these are all automatically 
removed. Importantly however, there are a range of caveats to keep in mind when using InPrivate Browsing:  
 
§ If you add any Favorites, RSS Feeds or Web Slices while using InPrivate, or you install any software, or 

add a new home page, then such changes will be saved and kept permanently even after you close it. 
§ If you don't close the InPrivate window before terminating your session, then others may be able to view 

your browsing history and temporary files on the same PC. 
§ InPrivate functionality does not extend to protecting your anonymity when surfing - your IP address for 

example will still be visible and stored on various sites as you browse the Internet. 
§ An InPrivate session does not offer any greater security than using the standard IE mode. Do not 

mistake InPrivate as a form of protection against malware or phishing for example. 
 
Note also that if you have installed any third party toolbars or extensions in IE, then unless you tick the 
'Disable toolbars and extensions when InPrivate Browsing starts' box as covered under the Privacy section 
further above, these toolbars and extensions may be saving and transmitting private data regardless. For that 
reason, I recommend ticking this box, but more importantly, resisting the urge to install additional software 
for IE as much as possible unless absolutely necessary. 
 
While InPrivate Browsing is a useful feature, especially for those using shared machines, it is not a substitute 
for correctly configuring all of IE's options (see the rest of this chapter), and also exercising common sense as 
to general browsing. InPrivate does not guarantee that others will not find out about your browsing habits 
through other techniques, so minimize the extent to which you undertake potentially embarrassing or secure 
browsing on shared PCs for example. 

http://www.microsoft.com/windows/internet-explorer/features/browse-privately.aspx�
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INPRIVATE FILTERING 

InPrivate Filtering is an additional feature which goes hand-in-hand with InPrivate Browsing. As noted 
above, InPrivate Browsing is designed to remove traces of your activity from the PC, but it does not protect 
your privacy when online. InPrivate Filtering attempts to do just that, to a reasonable extent, by preventing 
your private data from being broadcast unnecessarily to third party sites which are displaying content on the 
page you are viewing. For example, when you visit a trusted site, it may have content such as an interactive 
map or advertising which is drawn from another provider. You may wish to block data regarding your 
current actions on the trusted site from being transmitted to these third party providers. 
 
To turn on InPrivate Filtering, go to the Safety menu in IE and select the 'InPrivate Filtering' option to enable 
it; this must be done each time you start IE, although there is a advanced tweak to overcome this covered 
later in this chapter. Once enabled, you can then refine the way in which it works by selecting the 'InPrivate 
Filtering Settings' option under the Safety menu. Alternatively, you can access these options by clicking the 
small lock icon in the Status Bar at the bottom of the screen. 
 
You have three main options for InPrivate Filtering: Automatically Block; Choose Content to Block or Allow; 
or Off. When 'Automatically Block' is chosen, if the same third party content appears frequently across a 
range of sites it will be tracked and eventually blocked by IE to protect your privacy. However you can 
manually choose to block or allow content yourself if you're not satisfied with the automated results. At the 
bottom of the Settings box there is a small box which allows you to change how many websites need to be 
visited with the same third party content before it appears on the list of Content Providers in the Settings 
screen at the bottom of the screen. The default is 10, but you can lower it to 3 or raise it to 30; the lower the 
number the more third content will be blocked and hence also appear for you to choose to block or allow in 
the list. 
 
Alternatively, click the 'Advanced Settings' link at the bottom of the Settings box and you will be taken to the 
Manage Add-Ons box which then allows you to import pre-made filters for InPrivate Filtering. One example 
is this list which a user has compiled, mimicking the filter list from Adblock plus, a popular ad-blocking 
extension for Firefox. Save the list and use the Import feature in the InPrivate Filtering category of Manage 
Add-Ons to apply it to IE. 
 
Remember however that InPrivate Filtering is not specifically designed to block advertising as such, it is a 
general tool to limit the amount of data you send to third party providers. Enabling InPrivate Filtering can 
result in some sites not displaying correctly, or missing importantly functionality. However more 
importantly, constantly using InPrivate Filtering and thus blocking advertising can and will affect the 
viability of many sites on the Internet which rely on third party advertising income to remain free to view. If 
you block the ads on sites you enjoy, consider donating to them directly if you wish to see them remain open 
and free. 
 

ACCELERATORS 

Accelerators are browser-based tools which provide additional functionality for a site. You can access an 
Accelerator by highlighting a portion of a site and clicking the blue Accelerators button which appears. To 
access a list of Accelerators currently installed on your IE, right-click the blue button and select 'All 
Accelerators', or go to the Tools menu in IE, select 'Manage Add-Ons' and then select the Accelerators 
category. There are a range of additional free Accelerators you can download, you can view the full list by 
right-clicking on the Accelerators button and selecting 'All Accelerators'>'Find More Accelerators', or by 
clicking the 'Find More Accelerators' link in the 'Manage Add-Ons' screen. While they provide useful 
functionality, I recommend exercising constraint in how many you add to IE and keep active at any time to 
reduce resource usage. 
 

http://windowshelp.microsoft.com/Windows/en-US/Help/d3b8a320-ec04-49f8-984c-1387619bda5e1033.mspx#section_4�
http://www.dslreports.com/forum/r22124619-IE8-InPrivate-filter-from-adblock-plus-list�
http://www.microsoft.com/windows/internet-explorer/features/accelerators.aspx�
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If you find the Accelerators functionality unnecessary, then disable all the available Accelerators in the 
'Manage Add-Ons' box, and also disable the blue Accelerators button - see the Advanced settings section 
further above. 
 
 
< ADVANCED SETTINGS 

The following are some more advanced customizations to make IE easier to use: 
 

CUSTOMIZE INTERNET EXPLORER 8'S APPEARANCE 

Unlike Internet Explorer 7 which had virtually no options for altering its default appearance, IE8 does allow 
some room for customization in that regard. To streamline IE8's appearance, I recommend trying the 
following changes: 
 
1. Right-click on an empty area of the main IE toolbar (e.g. in the blank area to the right of any open tabs) 

to access the customization options. 
2. Untick any components you do not wish to view. For example the Menu Bar and the Compatibility View 

button are two prime candidates for removal, as they are not frequently used by most people and their 
functionality is duplicated in a range of places. 

3. Select the 'Lock All Toolbars' option to turn it off, and you can now move the Command Bar - the icon 
bar on the right side of the screen holding your main IE options. Grab the dotted line to the left of the 
Command Bar and you can move it up slightly to sit on a new line above your Favorites button and tabs 
for example; this might make access to it quicker for some people. Once done, be sure to select the 'Lock 
All Toolbars' option again to prevent accidental movement of any toolbars. 

4. Select the Customize option and tick or untick the 'Use Large Icons' option to toggle the size of the icons 
to suit your taste, and also tick or untick the 'Show Stop and Refresh Buttons Before Address Bar' option 
if you wish to move the location of the Stop and Refresh buttons accordingly. 

5. Select the Customize option and then select whether you wish to display any text next to icons or not - 
selecting 'Show Only Icons' will reduce the space they take up and is recommended. 

6. Select the Customize option and then select 'Add or Remove Commands'. 
7. Highlight the commands you wish to add or remove to/from the Command Bar and use the Add and 

Remove arrows to make the appropriate changes in the box on the right. For example you may wish to 
remove the Read Mail and Help buttons, and instead add a 'Delete Browsing History' button to the 
Command Bar. Once done, click Close to see the changes. 

 
Unfortunately there doesn't appear to be much more scope to truly customize IE8's appearance, but it is an 
improvement over IE7, and in general the browser does look quite streamlined as it is. 
 

CHANGE OR DISABLE INTERNET EXPLORER CLICK SOUND 

Every time you navigate anywhere using Internet Explorer, or for that matter in Windows Explorer, you will 
hear a 'click' sound. To disable this clicking sound, or to change it to another sound follow these steps: 
 
1. Go to Control Panel>Sounds and Audio Devices>Sounds. 
2. Under the Program Events list, scroll down to 'Start Navigation' under the 'Windows Explorer' section.  
3. Left-click on 'Start Navigation' to highlight it. 
4. To disable the sound completely go to the sounds list below and select [None] at the very top of the list, 

then click Apply. 
5. To change the sound, pick another more suitable sound from the list, or click the Browse button to find 

another sound file on your hard drive to use - remember, the larger the sound file the more memory is 
used (See Sounds & Audio Devices under the Control Panel chapter). Click Apply when done. 

 
Note that changing or disabling this sound will affect both Internet Explorer and Windows Explorer equally. 
Further note that the default click sound is called Windows XP Start.wav.  
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CHANGE INTERNET EXPLORER DEFAULT DOWNLOAD DIRECTORY 

By default Internet Explorer uses the same directory path to save files whenever you download a file from 
the Internet. You can change this default path at any time by opening the Registry Editor and going to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer] 
 
Download Directory=C:\Documents and Settings\User\Downloads 
 
This STRING specifies the default directory where IE will save downloaded files. Enter the path to wherever 
you want the new default to be. 
 

START WITH INPRIVATE BROWSING MODE ENABLED 

By default the InPrivate Browsing mode in IE8 requires that you start up IE normally, then select the 
'InPrivate Browsing' option under the Safety menu (or press CTRL+SHIFT+P) to open a new browser 
window which specifically uses InPrivate. To avoid all this, you can create a shortcut which opens IE already 
in InPrivate Browsing mode, ready to go at the start of every session. To do this, follow these instructions: 
 
1. Right-click on the icon you normally use to launch Internet Explorer 8. 
2. Select 'Send to>Desktop' if you wish to create a duplicate of it. 
3. Right-click on the icon to be modified and select Properties. 
4. In the Target box, go to the very end of the existing text, insert one blank space and then add the -private 

switch, and click Apply then OK to close the box. 
 
Now whenever IE is launched from this modified icon, it will automatically open already in InPrivate 
Browsing mode every time. 
 

START WITH INPRIVATE FILTERING MODE ENABLED 

By default InPrivate Filtering needs to be enabled each and every time you start a new session of IE if you 
wish to use it. If you want InPrivate Filtering to be on by default all the time, then open the Registry Editor 
and  go to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Safety\PrivacIE] 
 
StartMode=1 
 
This DWORD needs to be created. When set =1 it forces IE8 to automatically begin with InPrivate Filtering 
mode enabled with each session. Delete it if you wish to undo this option. 
 

CUSTOMIZE INTERNET EXPLORER TITLE BAR 

If you want to customize what is displayed at the top of each Internet Explorer window - typically the name 
of the site followed by Windows Internet Explorer - go to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main] 
 
Window Title= 
 
Create a new STRING called Window Title (there is one space between the two words), and assign 
whatever text you wish to use. The next time you launch a new Internet Explorer window this text will be 
displayed at the top of IE. 
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BUILT-IN FLASH BLOCKING 

If you want to block Flash-based content on any web page, you can use the new functionality in the 'Manage 
Add-Ons' screen in IE8 which allows greater control of ActiveX content, as described in this Microsoft 
Article. Follow these steps to customize how Flash content is allowed/blocked on a per-site basis: 
 
1. Go to the Tools menu in IE, select 'Manage Add-Ons'. 
2. Highlight the 'Toolbars and Extensions' category and make sure the 'All add-ons' option is selected 

under the Show drop-down box. 
3. Left-click on the Flash-related entry (e.g. Shockwave Flash Object), and at the bottom of the screen select 

the 'More Information' link, or simply double-click on the entry. 
4. In the box which opens, at the very bottom you will see a section where you can manually enter the 

names of sites which are allowed to use Flash-based content. By default it says * which means all sites. 
Remove the *, or click the 'Remove All Sites' button and click Close to disallow all Flash-based content 
on all sites. Alternatively, remove the * and manually enter the names of specific sites for which you 
wish to allow Flash functionality. 

5. With Flash functionality disabled for sites, you will see a yellow information bar when a site requires 
flash for full functionality. You can either ignore this bar, or if you wish to add the site to your allow list, 
click on the bar and select the 'Run Add-On' option and follow the prompts. 

 
Once again, be aware that blocking flash-based content not only affects the functionality on certain sites, but 
it may also affect their viability. 
 

SPEED UP /  FIX INTERNET EXPLORER 8 

Many users report that this tweak has improved IE8's speed and/or stability, and in general it should be 
quite harmless either way, so it is included here. If you believe IE8 is running slowly on your machine, or 
you are experiencing problems with the browser, open a Command Prompt and type "regsvr32 actxprxy.dll" 
(without quotes) and press Enter. Reboot your system and open IE8 to see if there is any difference. 
 

GENERAL INTERNET EXPLORER ISSUES 

If you are having problems with Internet Explorer, you can browse through this Microsoft Article for a list of 
official solutions to common problems, including instructions on how to correctly uninstall IE8 for example. 
 

INCREASE MAXIMUM SIMULTANEOUS CONNECTIONS 

By default Internet Explorer only allows two items to be downloaded at a time from a server, which can be 
slow for sites which have multiple items that need to be downloaded before the page can be displayed. This 
limit is the Internet Standard for maximum number of simultaneous connections to a server, however you 
can increase the value beyond 2 by going to: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings] 
 
MaxConnectionsPer1_0Server=0x0000000a(10) 
 
MaxConnectionsPerServer=0x0000000a(10) 
 
Create two new DWORD keys with the names shown above. Double-click on each one and in Decimal view 
enter the maximum number of simultaneous connections you want in the 'Value data' box (e.g. 10), then 
click OK. Reboot your system and see if Internet Explorer is faster as a result. You can experiment with even 
higher values if you wish, but note that increasing the maximum number of simultaneous connections to a 
server is technically a breach of Internet Standards, so if you experience any problems reset these values to 2 
or simply delete these keys altogether. 

http://msdn.microsoft.com/en-us/library/dd433050(VS.85).aspx�
http://msdn.microsoft.com/en-us/library/dd433050(VS.85).aspx�
http://msdn.microsoft.com/en-us/library/dd433050(VS.85).aspx�
http://support.microsoft.com/gp/cp_fixit_main�
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DNS CACHE ISSUES 

Whenever your browser tries to load up a page on the Internet, it has to access a Domain Name System 
(DNS) server to resolve or translate the text address you use (e.g. www.Google.com) into the actual IP 
address for the website (e.g.: 216.239.57.99). As you can see, the concept of having text for an address rather 
than a bunch of numbers makes remembering addresses a lot easier for users. 
 
However since your browser needs to check DNS addresses each time it loads any web pages, the browser 
speeds up this process by caching (locally storing) the addresses you use for a period of time so that next 
time you try to go to the same address it uses the IP address it has cached rather than looking it up again on 
a DNS Server. Unfortunately if a site is down temporarily, or has recently moved, then your DNS cache may 
store the site as being inaccessible for a while even if it comes back online shortly afterwards, and therefore 
every time you try to connect to it for several hours you will get an error message.  
 
To resolve any DNS problems with web pages not loading up at all or loading up with outdated 
information, go to Start>Run and type "CMD" (without quotes) and press Enter to open a new Command 
Prompt window, then in the Command Prompt type "ipconfig /flushdns" (without quotes) and press Enter. 
This will clear your DNS cache.  
 
Furthermore, to make sure that your browser never stores a 'negative' DNS cache entry – i.e. one which says 
a site is inaccessible - then go to the Registry and do the following: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters] 
 
MaxNegativeCacheTtl=0 
 
If the value above doesn't exist, create it as a new DWORD and assign it a value of 0 so that no negative DNS 
entries can be kept in the DNS cache. 
 
You can also set the length of time in 'Time To Live' (TTL) for a 'positive' (or working) DNS cache entry to 
remain active before being updated. To do this, in the Registry go to: 
 
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters] 
 
MaxCacheTtl=10800 
 
If this entry doesn't exist, create it as a new DWORD and assign it a value which measures (in seconds) the 
total Time To Live for the positive cache entry. Make sure to enter the amount of seconds in Decimal - not 
Hexadecimal - view. Also do not set this value too low as your DNS cache will effectively become useless 
and browsing will take longer. A value of between 3 and 6 hours (10800 - 21600 seconds) should be fine. 
 
 
< WINDOWS UPDATE 

Windows Update is an essential website which you should access regularly to download and install 
important updates for Windows. To access Windows Update at any time, open Internet Explorer, go to the 
Tools menu and select Windows Update. Alternatively, if you want to create a shortcut or bookmark to it, 
the address is Windows Update. If you are having problems accessing the site through the common methods 
above, you can try accessing it using a secure server through this link: Windows Update Secure. Note that 
the secure link differs by having https:// instead of http:// in the address. Note also that Windows Genuine 
Advantage does not allow pirated copies of Windows to fully access updates on Windows Update - see the 
Windows Product Activation & Windows Genuine Advantage chapter for details. 
  

http://en.wikipedia.org/wiki/Domain_name_system�
http://windowsupdate.microsoft.com/�
https://windowsupdate.microsoft.com/�
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WINDOWS UPDATE USAGE 

Whenever you access Windows Update I strongly recommend that you click on the Custom button instead 
of the Express method. This is because Custom allows you to see what updates are available, and you can 
select which you want to install. Once you've clicked on Custom you will see Windows Update scanning 
your machine and after a while it provides a list of updates. If the scanning doesn't seem to stop, or you have 
problems getting Windows Update to work, see further below. 
 
Now click on the 'Review and Install Updates' option and make sure all the High Priority security-related 
updates are selected - these should be installed on any Windows XP installation. However you should then 
check the 'Optional Software' and 'Optional Hardware' links on the left and go through the list of optional 
updates. These updates include important application updates, newer versions of drivers for the hardware 
on your system, etc. and I recommend that you first follow the procedures in the rest of this guide to update 
your drivers, and then if these driver updates still appear you should install them as well. They won't cause 
any harm to your system and you can always manually install newer versions over them. 
 
If you feel adventurous and want to see any pre-release software in Windows Update, click on the 'Change 
Settings' link under Options in the left pane and place a tick against the 'Show beta products and related 
updates' box at the bottom of the screen and click the 'Apply Changes Now' button. Do a rescan with 
Windows Update and a new 'Beta Software' category will be visible in the left pane. 
 

SECURITY PATCH LINKS AND RELEASE DATES 

Microsoft usually releases new drives and software updates as necessary, but they have a set release 
schedule for security patches - typically they are released together on the first Tuesday of every month. To 
find out when the next update is due, check the Microsoft Security Bulletin Site. You can find the direct 
download links to major security updates at any time on the Windows Security & Updates Download Site. 
 

WINDOWS UPDATE ON OTHER BROWSERS 

Browsers other than Internet Explorer cannot access Windows Update correctly by default. If you use Firefox 
or Opera for example, you can use an updating service like WindizUpdate. This site should be safe enough 
to download updates from, however I strongly recommend using Internet Explorer and the proper 
Windows Update site to ensure maximum security and minimum delay in obtaining critical updates for 
Windows. Also see the Windows Product Activation & Windows Genuine Advantage chapter of this guide 
for an official Microsoft Firefox plugin to validate the browser for use with downloads that require WGA 
verification. 
 

REPAIRING WINDOWS UPDATE 

Windows Update can exhibit strange behavior such as endlessly scanning your machine but never providing 
any list of updates, or gives strange error codes. The following are some things you can try to repair 
Windows Update: 
 
1. Try the secure Windows Update address instead: Windows Update Secure. 
2. If Windows Update seems to scan forever, or no updates appear, see this Microsoft Article. 
3. If you are experiencing specific Windows Update errors such as error code 0x800A138F, see this 

Windows Update Fails page. There is no single fix for all error codes and each one has several methods 
you can try to resolve the issue. 

 
 
As always, remember to run Windows Update at least once a week and install all important updates to 
maintain the security of your PC. Alternatively keep an eye on the front page of TweakGuides.com as I 
provide details of the latest patches and miscellaneous Windows updates of importance, and when to check 

http://www.microsoft.com/technet/security/bulletin/advance.mspx�
http://www.microsoft.com/downloads/Browse.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date�
http://windizupdate.com/�
https://windowsupdate.microsoft.com/�
http://support.microsoft.com/kb/836973�
http://www.updatexp.com/0x800A138F.html�
http://www.tweakguides.com/�
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Windows Update for Microsoft patch release days. If you're paranoid or forgetful and want to ensure you 
always have the latest patches and updates, see Automatic Updates under the Control Panel chapter. 
 
< OTHER INTERNET BROWSERS 

You may be wondering if there are other browsers you can try if you are not happy with Internet Explorer. 
Fortunately there are at least three other major free browsers which are a viable and secure alternative to IE: 
Mozilla Firefox, Google Chrome and Opera Browser. 
 
My personal preference is for Firefox. It is an excellent browser which is free and well-supported and runs 
without any problems alongside Internet Explorer, giving you the opportunity to try it out to see if you 
prefer it. The main advantage of Firefox over Internet Explorer is that Firefox is much more customizable. If 
you want to find out more about Firefox I recommend you read the Firefox Tweak Guide which covers all 
aspects of Firefox from the basic to the advanced. 
 
You have nothing to lose by trying other browsers out, since none of them conflict with each other 
whatsoever. I strongly recommend installing at least Firefox and Chrome alongside Internet Explorer, and 
getting into the habit of switching between them if a major unpatched vulnerability or security breach is 
reported in one browser. All three major browsers function quite well, have similar functionality, and similar 
levels of performance. 
 

http://www.mozilla.org/products/firefox/�
http://www.google.com/chrome�
http://www.opera.com/�
http://www.tweakguides.com/Firefox_1.html�
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OUTLOOK EXPRESS 
 
Outlook Express - not to be confused with the full version simply called Outlook - is a useful email and 
newsgroup program which is built into Windows XP. It should meet all your basic email needs, but it also 
has some features people rarely get around to configuring or using. This chapter covers advice for how to 
configure Outlook Express, as well as some tips and tweaks. Note, if you don't have the latest version of 
Outlook Express use Windows Update to update it to the latest version for security and functionality 
reasons. 
 
 
< CONFIGURATION ADVICE 

The first thing to do is optimize Outlook Express' basic settings for efficient, trouble-free operation. Open 
Outlook Express, go to the Tools menu and select Options. Below are my recommendations for the  more 
important settings under each tab of Options: 
 

GENERAL 

Tick 'When starting go directly to my Inbox folder' 
Untick 'Automatically Log on to Windows Messenger' if the option exists 
 
Note if you have removed Windows Messenger from your system, you may also have to apply the Outlook 
Express slowdown fix (See below) otherwise Outlook Express may take a long time to load each time it 
starts. 
 

READ 

Untick 'Automatically download message when viewing in the preview pane' 
 
This is recommended for security reasons, so that unsolicited/spam email is not automatically downloaded 
in the preview pane when it is highlighted. 
 

RECEIPTS 

Read receipts tell the sender of a message whether a message has been opened by the recipient. I personally 
don't like sending or receiving read receipts. They can be quite annoying, and whether you want to use them 
is up to you, but for the 'Returning Read Receipts' section I recommend selecting 'Notify me for each read 
receipt request'. That way you know when someone has sent an email to you with a receipt request, and you 
can choose whether to accept the request when you open the email.  
 
Secure receipts are similar, but might be more useful if you're sending a very important message and you 
want to make sure that the recipient has opened the message, and that the message arrived at the other end 
unaltered. Otherwise the same settings apply. 
 

SEND 

Tick 'Send messages immediately' 
Untick 'Automatically put people I reply to in my Address Book' 
 
Making sure that you don't add everyone to your Address Book is one way of preventing any viruses on 
your system from emailing everyone in your Address Book with the virus. I recommend instead either 
writing down email addresses or keeping at least one existing email from various people so you can reply to 
them that way. 
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COMPOSE, SIGNATURES, SPELLING 

There are no specific recommendations for these tabs. Configure them to suit your taste. If you want to know 
what any of these features do, right click on them and click 'What's this' or press F1 for Windows Help. 
 

SECURITY 

The security features in Outlook Express are reasonable in protecting against most viruses and malicious 
code sent in emails. However you need to know how they work and configure them correctly.  
 
There is an option to select either the 'Internet Zone' or 'Restricted Sites Zone' for your default email 
behavior. When in Internet Zone mode, HTML-based emails with active content will display their content 
just like a web page in Internet Explorer. In fact the security settings you choose under the Security tab in 
Internet Explorer Options also apply to Internet Zone email content. When in Restricted Sites Zone mode, 
Outlook Express will disable active content from HTML-based emails, which is much more secure, but 
reduces email functionality. I recommend running in Restricted Sites Zone mode, as most HTML-based 
emails nowadays are spam or malicious in intent. 
 
Tick 'Warn me when other applications try to send email as me' so that no other application can 
automatically send out an email under your name without you knowing about it. 
 
Tick 'Do not allow attachments to be saved or opened that could potentially be a virus'. This important 
feature will protect you against email attachments, the vast bulk of which are dangerous, unsolicited 
malware. See the PC Security chapter for tips on how to prevent infection through emails. If you receive an 
attachment from an address you know, it may still be malware which was auto-mailed from that user's 
account, so double-check with the sender if you're genuinely unsure of whether to save or open the 
attachment. If you believe it's a legitimate attachment, then save the attachment and scan it with several 
malware scanners. If you're not allowed to save the attachment, first close the email, open Options and 
untick this setting, go back and open up the email and save the attachment, then make sure to retick this 
option afterwards. Once again, make sure to thoroughly scan all suspicious attachments, and remember that 
executable attachments in particular (e.g. those with .EXE, .BAT, .COM extensions) are almost always bound 
to be malware unless you are 100% certain of the source of the email. 
 
As noted, certain file types (e.g.: .EXE files) are automatically blocked with this setting enabled. To configure 
which other types of files are affected when this setting is ticked, go to Control Panel>Folder Options>File 
Types, highlight a file extension and click the Advanced button. Select 'Confirm open after download' to add 
the file type to the unsafe file list which Outlook Express uses to block attachments when this setting is 
enabled. Some file types are permanently on the unsafe list and cannot be taken off. 
 
Tick 'Block images and other external content in HTML email' - once again for security reasons. In practice 
very few people send legitimate HTML-based emails with images. 
 
You shouldn't have to change the remaining settings in this section. 
 

CONNECTION 

Uses the same settings as Internet Explorer, so see the Internet Explorer chapter. 
 

MAINTENANCE 

I recommend the following settings to reduce wasted disk space: 
 
Tick 'Empty message from the Deleted Items folder on exit' - this means any messages you have in your 
Deleted Items folder will be permanently deleted each time you quit Outlook Express. 
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Tick 'Purge deleted items when leaving IMAP folders' - only affects email accounts which use IMAP 
protocol, which is not necessarily common. 
Click the 'Clean Up Now' button and select Compact to reduce existing wasted space immediately. 
 
If you are wondering where your emails are physically being saved, then the following option will show you 
email store directory: 
 
'Store Folder' – This is the location of your emails and Outlook Express folder settings. Typically it is the 
\Documents and Settings\[username]\Local Settings\Application Data\Identities\{ID String}\Microsoft\Outlook 
Express directory. 
 
Once you've changed all the settings you wish to change in Outlook Express, click the Apply button and exit 
the settings screen. You will need to close and relaunch Outlook Express for some of the settings to come 
into effect. 
 
< TIPS & TWEAKS 

BACKING UP EMAILS 

If you want to manually back up the emails you've saved in Outlook Express, follow these procedures: 
 
1. Open Outlook Express, go to Tools>Options and open the Maintenance tab.  
2. Click the 'Store Folder' button and highlight the directory path shown with your mouse (right-click on 

the text and choose Select All).  
3. Right-click again on the highlighted text and select Copy.  
4. Go to Start>Run and right-click in the box. Select Paste, then click OK. This opens an Explorer window 

in the folder where Outlook Express holds your emails and email folders as .dbx files. 
5. The folder names should be self-explanatory. Select individual .dbx files where you stored emails and 

copy them to another location for backup purposes. 
 

RESTORING EMAILS 

To restore these emails back into Outlook Express at any point, say after a reformat of Windows, follow 
these procedures: 
 
1. Open Outlook Express, go to File>Import>Messages. 
2. Select 'Microsoft Outlook Express 6' from the list (or whichever version of OE you saved the messages 

under). 
3. Select 'Import mail from an OE6 store directory' and click OK. 
4. Browse to the directory where you backed up your Outlook Express messages as .dbx files. Click OK, 

then click Next. 
5. Click All Folders, select Next, then select Finish. Your messages should be restored as you saved them. 
 
You can also use these Import and Export functions in Outlook Express to save and restore your Address 
Book, Email account and Newsgroup account data. These aren't detailed here, but the procedure is similar to 
that outlined above. 
 

FILTERING SPAM 

Spam is unsolicited email with useless and often offensive content. Outlook Express has some built-in 
features which can be used to sort mail automatically and prevent spam. Note that these features won't work 
for IMAP and HTTP (i.e. Web-based) email accounts such as Hotmail. Use these tools for your POP3 
accounts such as the ones your ISP provides. To access and configure these tools: 
  

http://en.wikipedia.org/wiki/Internet_Message_Access_Protocol�
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1. Open Outlook Express and go to Tools>Message Rules and select Mail. 
2. Click the New button to create a new rule. The New Mail Rule window will open. 
3. Select a condition for your rule. For example, we will choose 'Where the message is more than size'. We 

can set the size parameter for this rule in Step 5.  
4. Select the action for the rule. For example, 'Move it to the specified folder'.  
5. Set any parameters required for the rule by clicking on the blue underline text in the Rule Description 

box. For example, we will click on the Size text and choose 40KB as our size limit for the rule set up in 
step 3. We will click on the Folder text and choose Deleted Items. 

6. Give the rule an appropriate name, such as 'Large email filter' and click OK. 
7. In the Mail Rules window, put a tick next to this new rule and click the Apply Now button. If you want 

to add more parameters or change the rule, click the Modify button, and go back through steps 3 - 6 
above until you're happy. 

8. Create as many rules as you like, and arrange them in order of priority/application to new messages by 
using the Move Up and Move Down buttons. 

 
Now when you check for new emails, the above rule will automatically check each email's size and if it is 
over 40KB, will redirect it to your Deleted Items folder automatically. You can have a quick look in there 
after checking your mail and see if it's anything you want to keep, otherwise just empty the deleted items 
and you've cleared some hefty spam straight away. Create more rules once you identify patterns in your 
email. For example I was getting a lot of spam emails with phony virus screensavers attached. So I set up a 
new rule which automatically deletes from my mail server any emails with 'Screensaver' in the message 
body (i.e. I chose the 'Delete it from server' action for the rule) - that way I don't even download them, saving 
time and bandwidth. 
 
Of course you can do a lot more with Message Rules, such as block certain individuals, block any email 
accounts from particular domains (such as MSN, Yahoo or AOL), etc. Experiment with the tool as it is more 
useful than most people would believe. To begin with I strongly recommend setting the action for any rule 
to redirect flagged mail to a separate folder you set up and see if any legitimate mail is getting caught up by 
the rule. Also, you can create multiple layers of rules to finely sift through the mail and get rid of the genuine 
rubbish. That way if the email gets through one rule, it is subjected to the next one and so forth, and if it 
makes it through several rule checks it should be fine to view. 
 

REMOVE SPLASH SCREEN 

The following is a simple tweak which skips the blue Outlook Express splash screen when Outlook Express 
is loading up. To perform this tweak, open Registry Editor and go to: 
 
[HKEY_CURRENT_USER\Identities\{numbers}\Software\Microsoft\Outlook Express\5.0] 
 
NoSplash=1 
 
Create this new DWORD value and set to =1. Delete the entry if you want to regain the splash screen. 
 

SLOWDOWN ISSUES 

If you have disabled MSN Messenger then you may experience slowdowns when launching Outlook 
Express. To resolve this problem, implement the following change to your Registry: 
 
[HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{FB7199AB-79BF-11d2-8D94-
0000F875C541}] 
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Find this key in the left pane and under it left-click once on the IniProcServer32 key. In the right pane of 
the Registry Editor double-click on the (Default) entry at the top and completely delete the data it 
contains. Now do the same for the LocalServer32 key as well. This prevents the slowdown which some 
users experience with Outlook Express when MSN Messenger has been disabled. 
 
< OTHER EMAIL CLIENTS 

I personally find Outlook Express to be just fine for my everyday email needs, even though I receive a lot of 
emails. However, it is important to understand that if you are not happy with Outlook Express, you do have 
other options. To start with, the standard free webmail sites Yahoo, Hotmail and GMail are not only useful 
in providing you with free email addresses, they also provide good built-in protection against viruses and 
spam and plenty of storage space. However in general I don't recommend relying on an online provider 
only, it's best to still use a local mail client to store emails. 
 
If you want an actual free email program to replace Windows Mail, you can download Windows Live Mail 
which is a more advanced version of the Windows Mail client built into Vista. It's quite advanced and has 
more sophisticated capabilities including automated spam filtering, so it's worth trying out. Another 
alternative is to check out Mozilla Thunderbird, an email client which is both very customizable and also 
offers more methods of blocking spam. 
 
Finally, I strongly suggest once more that you examine the tips provided in the PC Security chapter of this 
guide for ways you can protect yourself from Email-related security risks while also preventing the spread 
of spam and malicious software. 
 
 

http://www.yahoo.com/�
http://mail.live.com/�
http://gmail.google.com/�
http://get.live.com/wlmail/overview�
http://www.mozilla.com/thunderbird/�
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WINDOWS MEDIA PLAYER 
 
Windows Media Player is Window's built-in utility for playing music and movies. It has many useful 
features and is actually a very efficient, feature-packed media player, but is often dismissed as being 
'bloated' or 'spyware'. In actuality it is smaller and more efficient than some popular media players, and if 
configured correctly should provide good privacy. This chapter contains configuration advice and details on 
WMP's features. If you don't like Windows Media Player, some alternative free players are covered at the 
end of this chapter, as well as a discussion of media-related issues including various Codecs.  
 
This chapter assumes that you are using the latest version of WMP which is Windows Media Player 11. This 
is not the version that originally comes with Windows XP, nor does it install as part of SP3, so you should 
download it from the link above. All Windows users are encouraged for both security and functionality 
reasons to upgrade to the latest version. Note, if you're not going to use WMP 11's online music store 
functionality and/or to control any portable media devices connected to your PC via WMP, you can disable 
the 'Windows Media Player Network Sharing Service' - see the Services chapter for details of how to do this. 
 
 
< CONFIGURATION ADVICE 

To access Windows Media Player, go to Start Menu>All Programs>Accessories. To access Windows Media 
Player's menus, in Full View mode right-click on an empty spot on the black command bar, or just press the 
ALT key. To configure Windows Media Player as covered below, first select Tools>Options then see the 
details for each tab as follows: 
 

PLAYER 

Automatic Updates: WMP can automatically check for updates at set intervals. Since it is not updated all that 
often, the 'Once a month' option should be fine. If you tick 'Download codecs automatically', whenever you 
attempt to play a media file for which you don't have the correct codec (and you are online), Windows 
Media Player will automatically try to find and download the required codec and install it so you can play 
the file. This is recommended, and see the Audio and Video Codecs section below for more information. 
 
Player settings: You can set these to suit your taste, however I recommend unticking 'Connect to the Internet' 
if you want to maintain your privacy. 
 
Start the mini player for file names that contain this text: This option allows you to tell WMP to automatically 
launch into Mini Player mode (see further below) for files containing the specified text in their filename. 
 

RIP MUSIC 

Rip music to this location: Ripping music is the process of copying it from an audio CD to a media file on your 
computer. Click the Change button and select the directory where any ripped music or media is placed; by 
default it will be placed under the \Music directory. Click the 'File Name' button to specify the particular 
attributes of the CD/track which will be used to compose the ripped music track's filename. Check the 
preview at the bottom of the box to see how this will look. 
 
Rip Settings: I strongly recommend you untick the 'Copy protect music' option as otherwise each track you 
rip will become DRM protected and this cannot be changed. On the slider below, choose the audio quality 
you prefer for ripped music - 160Kbps or above is recommended for good quality audio, 128Kbps is the 
minimum recommended. The higher the quality the larger the file size of the ripped file however. 
  

http://www.microsoft.com/windows/windowsmedia/default.mspx�
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To use WMP to convert any audio tracks you want from a non-protected Audio CD to .WMA or .MP3 format 
do the following: 
 
1. Insert the Audio CD in your drive. 
2. Close and restart Windows Media Player to make sure it detects the CD. 
3. Maximize WMP so you can see the track listing. 
4. Click the Rip button at the top of the screen. 
5. Put a tick against the track(s) you wish to rip 
6. Click the arrow under the Rip button and you can select the specific Format you wish to use - .MP3 is 

recommended as a good balance between quality, size and compatibility with a wide range of media 
players, Windows Media Audio (.WMA) is good but less compatible, and .WAV provides the best 
quality but is usually too large because it doesn't compress the audio information. 

 
There are better third party ripping tools available, however Windows Media Player is free, quick and easy 
to use, and the audio tracks it produces will not contain any copy protection (as long as you use the options 
further above) so it is well worth using. 
 

DEVICES 

The devices listed under this tab are capable of media playback, whether video or audio or both. Select each 
playback device and click the Properties button. Adjust settings as appropriate, and if in doubt leave at their 
defaults which are fine for most purposes. Note that for your Display properties, you can alter the aspect 
ratio for video/DVD playback if it appears to be too wide or too narrow; the circle shown should be perfectly 
round on your screen. 
  
I recommend that you untick the 'When deleting playlists from devices, also remove their contents' option to 
prevent undesired file deletion. 
 
Click the Advanced button to alter the settings for audio and video file conversions when being transferred 
to/from multimedia devices and set to suit your tastes. 
 

BURN 

Windows Media Player allows you to also burn music or media files to a CD or DVD. Music can be burnt as 
an audio CD, but other media can only be burnt to CD or DVD as data files. Note that for general burning 
purposes a full-featured burning program called Nero is recommended, but it is not free. A useful free 
burning program is Deep Burner. 
 
Burn Speed: Select the burning speed, keeping in mind that if you are continually having errors with burnt 
disks, you should reduce the speed to Medium or even Low to ensure accurate burning. If you want the disc 
automatically ejected after the burn is complete, tick the box. 
 
Apply volume leveling across tracks on the CD: If burning an audio CD, you can tick this option to have WMP 
attempt to set a common volume level for all audio tracks. This can help prevent some tracks from being 
overly loud or soft relative to others. 
 
Use media information to arrange files in folders on the disk: If you are burning a data disk and this option is 
ticked, WMP will sort your media into separate folders using \Music\Artist\Album, \TV, \Video and 
\Picture folders. If unticked, WMP will burn all tracks to the base directory of the disk without sorting. 
 
Conversion: If you select the 'Convert to' option here, you will be able to use a slider which determines how 
the various music files will be resampled for burning to audio CD. I strongly recommended against allowing 
conversion, as most music files will lose quality if converted, especially if it's to 128Kbps or below, and more 

http://www.nero.com/�
http://www.deepburner.com/?r=download�
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importantly WMP automatically converts all files to .WMA format during conversion which is not 
necessarily desirable. 
 
To burn a disk, open WMP in full view, click the Burn button at the top of the screen, and an interface for 
arranging files for burning appears. Click the small arrow under the Burn button to select whether to burn 
an audio CD or a data CD/DVD. You can then drag and drop files into the right-hand pane to add them to 
the list of media to be burnt to disk, and when finished clicked the 'Start Burn' button at the bottom. 
 

PERFORMANCE 

Connection Speed: I recommend the first option, however if WMP consistently has problems detecting your 
connection speed, then set it manually here.  
 
Network Buffering: The 'Use default buffering' option is usually fine to use, but if you find streaming videos 
are constantly disjointed, then experiment with increasing the buffer size. 
 
Video Acceleration: Under this section click the Advanced button. These options affect all DVD and video 
playback, and can be used to help resolve issues with particular videos or DVDs. If your video goes out of 
sync - sometimes due to lack of sufficient bandwidth - tick the 'Drop frames to keep AV In sync' for example. 
Tick the 'Use video smoothing' option if playing back video with low framerate, as WMP will try to 
interpolate frames (fill in the blanks) to provide the appearance of smoother video playback.  
 
In particular, when playing fullscreen video, if the 'Display full screen controls' option is ticked, a set of 
controls will be shown at the bottom of the screen. If you want these removed, untick this box for true 
fullscreen video playback. You can then control playback at any time using your mouse and the following 
keyboard/mouse commands: 
 
§ Play or Pause - Left-click. 
§ Change Volume - Use the mouse wheel to increase or decrease volume. 
§ Mute Volume - Press the middle mouse button. 
§ Fast Forward/Rewind - Press and hold the front and back thumb buttons (if any) for Fast 

Forward/Rewind. 
§ Skip Forward/Back - Click the front or back thumb buttons to Skip Forward/Skip Back. 
§ Command Menu - Right-click. 
§ Return to Full Mode - Press ESC. 
 
If you have a standalone graphics card, tick the 'Turn on DirectX Video Acceleration for WMV Files' option 
to allow your graphics hardware to provide better video playback performance for .WMV video. Finally, for 
videos which don't fill the entire screen due to their aspect ratio being different to your monitor shape, you 
can set the color used to display the surrounding area. For example for playback on a Plasma TV to prevent 
burn-in or uneven phosphor aging, you can set a white background by clicking the Change button. 
 
Finally, if you get black and white video playback for color videos, untick the 'use high quality mode' option 
here. 
 

LIBRARY 

Sharing: If you wish to share the media on your current PC with other machines or devices on the same 
network, click the 'Configure Sharing' button. For instructions on how to configure this, click the 'Learn 
about sharing Online'. It won't be covered here as it's not a feature for the average home PC user. 
 
Update Library: By default when Windows Media Player is first run it checks your personal folders to find 
any media files it can use, and adds them to your Library - a listing of all the media files on your PC. 
Windows Media Player will keep monitoring your personal folders to add or delete listings from the library 
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as you add or delete your media files. You can access the Library listings by category at any time by going to 
WMP and clicking the Library tab. Here you can view the media files in various ways, sorted by categories 
such as Album, Genre, even Rating. You can also create specific Playlists from the listings.  
 
While this is handy, the Library function is not absolutely necessary, it is simply an organisational tool, so if 
you want to stop it or alter it, click the 'Monitor Folders' button, then on the next screen click the 'Advanced 
Options' button. You can now add further folders to monitor if you wish, but you cannot remove the default 
folders WMP monitors; you can only choose to Ignore certain folders. If you want to prevent WMP from 
adding any more files to the Library, enter the maximum values of 9999 for the 'Skip files smaller than' boxes 
at the right side, so that any file smaller than 10MB is not automatically added to the Library. When done 
click OK and WMP will scan for any changes it needs to make to the Library. Finally, back under the main 
Library tab I strongly recommend unticking the 'Delete files from computer when deleted from library' box 
to prevent accidental deletion of files. This allows you to edit or delete items in your Library listing without 
deleting the corresponding media files. 
 
Automatic Media Information: If you want WMP to retrieve information about the particular media you are 
playing from the Internet - such as the name of the Album or Artist for a track - then tick the 'Retrieve 
additional information from the Internet box'; you can then choose to have it fill in the gaps or overwrite all 
existing information for the media. This information can be useful in making searches much easier. You can 
also manually force Windows Media Player to fill in missing information for particular files by clicking the 
Library button in WMP, then right-clicking on a particular track which isn't fully identified and select the 
'Find Album Info' option - a new box will open which loads up the possible matches for this track and you 
can select the appropriate one, or enter the media information manually. 
 
The remaining options here determine how WMP behaves when a track is ripped - see the Rip Music section 
further above. 
 

PLUG-INS 

Plug-ins are various modules which add functionality to Windows Media Player such as Visualizations or 
Digital Signal Processing (DSP) effects. These can be added, removed or configured here. To find more 
plugins to add, click the 'Look for plug-ins on the web' link, and for more visualizations, click the 'look for 
visualizations on the web' link - you will be taken to relevant Microsoft sites where you can download useful 
plugins or visualizations which should be safe to use with WMP. You can remove any added plugin by 
highlighting it and selecting the Remove button, and you can configure any settings they may have by 
selecting the Properties button. Bear in mind that the more plugins you use in WMP, the more resources the 
player may take up, and also the greater the chance for potential problems, so only install plugins you feel 
are genuinely necessary. 
 

PRIVACY 

This is an important area of Windows Media Player which causes users a lot of concern. There is a common 
fear that by using Windows Media Player, Microsoft is spying on your media usage behaviors. This is not 
true, however to ensure that none of the media on your hard drive is altered, or any information about it 
reported back to Microsoft, follow the recommended settings in this section. To begin with untick every 
option on this page. None of them are necessary for normal media playback. If you use DRM-protected 
media, you may want to tick the 'Download usage rights automatically when I play or sync a file' and 
'Automatically check if protected files need to be refreshed' options to prevent problems, but best to do so 
only if you run into a problem playing back such files. 
 
If you don't want your media files altered in any way without your permission, I suggest that you make all 
of your media files (e.g. .MP3, .MPG, .WMB and .AVI files) write protected. To do this, in Windows Explorer 
go to the folders where your media files are stored and highlight all of them, right-click on them, select 
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Properties and place a tick in the 'Read Only' box. By write-protecting all your media, Windows Media 
Player can't alter them or add any additional identifying information without your permission. 
 
Finally, see the Windows Media Digital Rights Management (DRM) option under the Group Policy chapter 
of this guide and enable it if you want to prevent Windows DRM from accessing the Internet when you use 
Windows Media Player. In the end though, at no point does Microsoft truly 'spy' on you, there are no real 
privacy risks to using Windows Media Player. 
 

SECURITY 

Your Internet Explorer security settings will be used when Windows Media Player is browsing any web 
content, so see the Internet Explorer chapter for details. For the remaining boxes here, I recommend you set 
them to suit your taste. You can start off by having them all unticked for maximum security, then if you 
encounter a legitimate website with multimedia content that doesn't function correctly, you can tick these 
options to allow it to do so. None of these options should be necessary to view most online media. 
 

FILE TYPES 

Here you can select the media file types for which Windows Media Player is the default player. Change to 
suit your tastes, and note that if another player keeps becoming the default for a particular media type 
against your wishes, you will have to either open that player and check its settings to ensure it is not 
forcefully changing these options each time it's opened, or go to Control Panel>Folder Options and under 
the File Types tab change the default program association for the relevant file type. 
 

DVD 

If you have a DVD drive on your system and use Windows Media Player to play DVD movies, you can 
adjust the settings in this section to suit your particular tastes and needs. 
 

NETWORK 

Configure this section according to your needs - the defaults should be fine. 
 

GRAPHIC EQUALIZER 

Windows Media Player comes with a fairly decent graphic equalizer which can noticeably enhance audio 
quality if set up correctly. To alter it, go to Full View mode and under the View menu select 
Enhancements>Graphic Equalizer. While you can use a range of presets, I recommend selecting the 
individual slider movement option - the top option on the far left - and then customizing the settings to suit 
your tastes. For reference, my personal settings from left to right for each slider are: 3 6 4 0 0 2 2 5 6 9. Your 
settings will vary both based on your playback device, as well as your any adjustments you may have made 
to the Tone settings for your playback device - see the Sounds and Audio Devices section of the Control 
Panel chapter. 
 
Other options found under the Enhancements section include enabling SRS WOW effects, as well as Video 
Settings to alter the Brightness, Contrast, Hue and Saturation of video, and Crossfading and Auto Volume 
Leveling. You can close the Enhancements box at any time by clicking the small red 'x' at the far right of the 
Enhancements area. 
 

SKINS 

You can customize the way Windows Media Player looks through the use of skins. These skins can change 
the appearance and visible functionality of Windows Media Player. There are some skins which already 
come with the player, and you can view them by opening Windows Media Player, and under the View 
menu select 'Skin Chooser'. In the Skin Chooser box you can click on a skin to see a preview of it in the right 
pane. If you want to try a skin out, click the 'Apply Skin' button. If you want to get new skins online click the 

http://www.srslabs.com/�
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'More Skins' button, or go to a site such as The Skins Factory to download more free skins. Some skins will 
install automatically when you download them, but if you download a skin file in .WMZ format you can 
manually install it so that it appears in the Skin Chooser by putting the .WMZ file into your \Program 
Files\Windows Media Player\Skins directory. Note that using more complex and elaborate skins can take up 
slightly more memory and possible extra CPU power when you run Windows Media Player, so if you want 
to ensure the fastest performance and least resource usage simply use the default WMP appearance - that is, 
under the View Menu select 'Full Mode'. 
 
In fact my preferred look for WMP is to switch to Full Mode and then simply use the resizing button at the 
bottom right of the player to shrink it down to the Compact Mode. In 'Mini Player' mode WMP uses even 
less resources - see below. 
 

MINI PLAYER MODE 

One of the neat features of Windows Media Player which sets it apart from many other media players is the 
ability to shrink it down into a 'Mini Player' interface which sits in the Windows Taskbar. To activate this, 
right-click on an empty area of your Windows Taskbar and under the Toolbars menu select the 'Windows 
Media Player' option so a tick appears next to it. Now open Windows Media Player and click the Minimize 
button on the top right of the player window. The player will minimize and sit in your Taskbar with a handy 
interface that allows access to all the major functions of the player, and whenever you want to maximize it 
again click the Maximize button on the bottom right of the mini player. Not only is this a neat feature, but 
while sitting in the Taskbar the player also uses less resources. You can also access WMP's seek functionality 
by hovering your mouse over the mini player, and using the slider bar which appears. 
 
< AUDIO & VIDEO CODECS 

A Codec (Compressor Decompressor) is a program which allows audio or video to be compressed and 
decompressed to or from the original format for which it is designed. Compressed files use special 
algorithms, and it is the codec which can encode/decode these algorithms. If you can play or record 
audio/video in a particular format, you have a codec for that format already installed on your system. 
 
To view and adjust the codecs already installed on your system, do the following: 
 
1. Go to Control Panel>Sounds and Audio Devices>Hardware 
2. Double-click Audio Codecs or Video Codecs to see the relevant codec lists. 
3. Click on the Properties tab and you will see all the currently installed codecs on your system. To see 

more details about each one, double-click on it. 
4. To disable an audio codec for troubleshooting purposes, double-click on it and select 'Do not use this 

audio codec' and click Apply; to remove it from your system, highlight the codec and click the Remove 
button in the main list. 

5. Video codecs cannot be temporarily disabled, but they can be removed by highlighting them and 
clicking the Remove button in the main list. 

 
If you want to uninstall a non-standard codec, the best way to remove them is to go to Control Panel>Add or 
Remove Programs and look for the codec name in the list shown. More details of common codecs can be 
found in this Codecs for Windows Media Player article. I don't recommend completely removing a codec as 
several programs may be dependent on it. In particular do not remove any unfamiliar or default Microsoft 
codecs. If you do, you can re-download the default codecs for Windows Media Player as a package from 
Microsoft Codecs. 
 
If you want to determine what codec(s) a particular file uses, install the free GSpot utility. If you then want 
to manually find the required codec, try checking WMPlugins first. If the codec you want isn't there, the 
most common third party codec required to play back video found on the web is DivX, however you can 

http://theskinsfactory.com/skinsfactory/?page=portfolio_view&portfolio=2�
http://en.wikipedia.org/wiki/Codec�
http://www.updatexp.com/codec-for-windows-media-player-9.html�
http://www.microsoft.com/windows/windowsmedia/forpros/format/codecdownload.aspx�
http://www.headbands.com/gspot/�
http://www.wmplugins.com/ItemList.aspx?typeid=8�
http://www.divx.com/divx/windows/codec/�
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also download FFDShow which is a filter which decodes most common video and audio formats, including 
DivX, XviD, AC3 and OGG. 
 
There are also certain types of media which won't normally play back on Windows Media Player or other 
common media players due to proprietary issues. The QuickTime .MOV and the RealPlayer .RM formats are 
two types of files which require special codecs and are usually viewable using their respective players: 
QuickTime Player and RealPlayer. If you don't want to install these players and instead want to view these 
audio/video files on Windows Media Player, or other players, you should install the Real Alternative and 
QuickTime Alternative codecs. Usually a Google search for any codec you require should find you a place to 
download it, but very old or proprietary codecs may be difficult to find or may cost money to obtain. 
 
Note that I do not recommend installing any 'Codec Packs', as these often cause all sorts of issues, from 
impeding proper video or audio playback in games, to strange system crashes. Stick with the codecs 
provided above as they cover all the major formats, and download and install/test individual codecs one at a 
time. 
 
< OTHER MEDIA PLAYERS 

If you don't wish to use Windows Media Player to view media, there are several alternatives including the 
following popular free media players: 
 
WinAmp 
QuickTime Player 
DivX Player 
iTunes 
VLC 
 
I can't go into detail about each of these players here, however they are each good players, and it depends on 
your personal preference and specific needs as to whether you choose them over Windows Media Player. A 
specific media player worth noting is below: 
 

MEDIA PLAYER CLASSIC 

There is a free generic media player which can play back most formats, including proprietary formats, and is 
also both easy to use and utilizes very little system resources: Media Player Classic. It requires no installation 
- it is in one .EXE file which launches the player. It also requires no tweaking as such, it is ready to be used 
immediately without any issues. Give it a try as it is a great alternative to the other players, and you may 
even end up preferring it over Windows Media Player or any other media player. 
 

http://www.afterdawn.com/software/video_software/codecs_and_filters/ffdshow.cfm�
http://www.apple.com/quicktime/download/�
http://www.real.com/freeplayer/?rppr=rnwk�
http://www.free-codecs.com/download/Real_Alternative.htm�
http://www.free-codecs.com/download/QuickTime_Alternative.htm�
http://www.winamp.com/�
http://www.apple.com/quicktime/download/�
http://www.divx.com/divx/windows/player/�
http://www.apple.com/itunes/download/�
http://www.videolan.org/vlc/�
http://sourceforge.net/project/showfiles.php?group_id=205650�
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VISUAL & CONVENIENCE TWEAKS 
 
This chapter covers a range of tips and tweaks designed to allow you to further customize the appearance of 
Windows XP, as well as improving XP functionality. None of the tweaks in this chapter is necessary for 
ensuring that you have a fast, stable system, however many of them will save you time or make using 
Windows XP more enjoyable, so they are still worth considering. Please note that some of these tweaks can 
also be performed by a range of tweaking and customization utilities covered elsewhere in this guide, such 
as in the TweakUI chapter, so you don't have to use the Registry Editor for example if you don't want to. 
 
 
< TIPS & TWEAKS 

REMOVE TEXT FROM DESKTOP ICONS 

To remove the text beneath any icon on your Desktop, follow these steps: 
 
1. Right-click on the icon whose title you want to remove and select Rename 
2. Instead of entering any characters in the text box, hold down the ALT key and type 255 (ALT + 2 + 5 + 5). 

Note that you need to use the NUMPAD numeric keys for this to work, that is the numbers to the right 
of your arrow keys, not the ones at the top of the keyboard.  

3. When you release the ALT key the title will be blank, and you can press Enter to accept this. Blank titles 
are usually denied under Windows, but not when done this way as it inserts a special blank character. 

4. For every icon whose title you wish to remove, do the same as above. However since no two icons can 
have the same name, for each subsequent icon you'll have to add an additional ALT 255 to the end of the 
string you enter. E.g. to blank a second icon name you'll need to hold down ALT and type 255, release, 
then hold ALT and type 255 again, then release and press Enter. For a third, you'll have to type ALT 255, 
ALT 255, ALT 255, Enter and so on. 

 
If you want to regain the icon names you will have to manually edit each icon's name to whatever you want. 
 

REMOVE THE BOX AROUND DESKTOP ICON TITLES 

If you have applied the 'Remove text from desktop icons' tweak above and you still see a faint box where the 
text was, you can also remove that box by doing the following: 
 
1. Go to Control Panel>System>Advanced and click the Settings button under Performance. 
2. Tick 'Use drop shadows for icon labels on the desktop' under the Visual Effects tab and click OK. 
3. Check your desktop. The boxes should be gone, regardless of whether you removed the text or not. If 

they're still there, right click on the desktop, look under 'Arrange Icons By' and make sure there's no tick 
against 'Lock Web Items on Desktop'. 

 
CREATE DESKTOP ICONS FOR SHUTDOWN OR RESTART 

Instead of using 'Turn Off Computer' or Restart options on the Start Menu, you can create desktop icons 
which automatically shutdown or restart your PC with just a double-click. This tweak makes use of the 
Shutdown.exe command line to create a new shortcut as follows: 
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Shutdown Icon: 
 
1. Right click on an empty area on your desktop. 
2. Select New>Shortcut. 
3. In the first box of the Create Shortcut Wizard, type "shutdown /s /t 00" (without quotes) and click Next. 
4. Call the shortcut something descriptive like 'Shutdown' and click Finish. 
5. To add the finishing touch, right click on this new icon, select Properties, click the Change Icon button 

and select an appropriate icon. 
 
Reboot Icon:  
 
To create a Reboot icon, follow the same steps as above, but substitute the following steps in place of the 
corresponding ones above: 
 
3. In the first box of the Create Shortcut Wizard, type "shutdown /r /t 00" (without quotes). Click Next. 
4. Call the shortcut something descriptive like 'Restart' and click Finish. 
 
Note that double-clicking on these icons will commence shutdown or restart of the PC straight away without 
any warning. If you want a countdown before a shutdown or restart, substitute a time in seconds in place of 
the '00' entries in the shortcut properties above (e.g. shutdown /s /t 10 gives 10 seconds warning before 
shutting down). Also note that once the shutdown or restart process begins it can't be aborted. If you want 
more command line switches which can be used with the shutdown command, open a command prompt 
and type "shutdown" (without quotes) and press Enter. For example you can use the /h switch instead of /r 
or /s above to create a Hibernate icon instead. 
 

CREATE DESKTOP ICON TO LOCK THE COMPUTER 

Just as you can create Shutdown and Restart icons, you can also create an icon which locks your computer 
immediately and requires that a user login again before gaining access. To do this, follow these steps: 
 
1. Right click on an empty area on your Desktop. 
2. Select New>Shortcut. 
3. In the first box of the Create Shortcut Wizard, type "Rundll32.exe User32.dll,LockWorkStation" (without 

quotes). Note there is no space between the comma and LockWorkStation. Click Next. 
4. Call the shortcut something like 'Lock PC' and click Finish. 
5. To add the finishing touch, right click on the new icon, select Properties, click the Change Icon button 

and select an appropriate icon. 
 
Now whenever you click this icon your PC will instantly be locked, and can only be accessed by the user 
entering a correct password in the Login box. Note you can also lock the computer at any time by pressing 
WINDOWS + L. Also note that if you have an account with no password, locking the desktop is pointless as 
anyone can login by just leaving the password field blank and clicking OK to log back in. 
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SAVE DESKTOP ICON POSITIONS 

This tweak allows you to save the current positions of your desktop icons so that if the icons are rearranged 
or moved you can quickly restore them back to their saved positions at any time. To give you this added 
functionality do the following: 
 
1. Download the file Layout.zip (mirror: here) and extract the contents to an empty directory. 
2. Copy the Layout.dll file to your \Windows\System32 directory. 
3. Double-click on the Layout.reg file to automatically make the appropriate changes to your Registry. 
4. Go to your Desktop and arrange all your icons as you would like them to be saved. 
5. Once done, right-click on the Recycle Bin and select the new 'Save Desktop Icon Layout' option. The 

positions of all the icons are now saved.  
6. You can move the icons around freely and whenever you want them restored to their original saved 

positions, right-click on Recycle Bin again and select 'Restore Desktop Icon Layout'. 
 
This tweak is particularly handy if you're installing new graphics card drivers for example and your 
Desktop icons get messed up, or you change resolutions and they get scrambled around. 
 

CHANGE DESKTOP ICON SIZE 

You can alter the size of Desktop icons by using this tweak as follows: 
 
[HKEY_CURRENT_USER\Control Panel\Desktop\WindowMetrics] 
 
Shell Icon Size=32  
 
The value of this STRING entry determines the size in pixels both for the height and width of desktop icons. 
The smaller the value, the smaller the desktop icon. The default value is 32, which is a 32 x 32 pixel icon. 
Create the entry if it doesn't exist and assign the desired value, then reboot Windows to implement it. 
 

SET SPACING BETWEEN DESKTOP ICONS 

To adjust the spaces between your desktop icons, you can manually move them. However if you've chosen 
automatic spacing (Right-click on the Desktop and select Arrange Icons by>Auto Arrange) then you can 
adjust the automatic vertical and horizontal spaces placed between each icon by doing the following: 
 
1. Right-click on the Desktop and choose Properties to bring up the Display Properties box. 
2. Select the Appearance tab, then the Advanced button. 
3. Under Items select 'Icon Spacing (Horizontal)' and 'Icon Spacing (Vertical)' and edit their values to 

determine how many pixels are placed between the icons. The defaults are 43 pixels between icons. 
Smaller values squeeze them closer together, higher values spread them further apart. 

4. If your Desktop icons are aligned to the Desktop grid, you may have to right-click on your Desktop, go 
to Arrange Icons By>Align to Grid and untick it, then go back and retick it for the icons to reposition to 
the new spacings. 

 
REMOVE 'SHORTCUT TO.. . '  FROM NEW SHORTCUTS 

Whenever you create a new shortcut, the words 'Shortcut to...' appear in front of the shortcut's name. To 
remove this default prefix for new shortcuts, open Registry Editor and change the following: 
 
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer] 
 
Link=00 00 00 00  
 
Create this BINARY value if it doesn't exist and set it equal to 00 00 00 00 to remove the 'Shortcut to...' prefix 
in front of new shortcuts. Reboot Windows to implement the change.  

http://www.pcnineoneone.com/tweaks/layout.zip�
http://www.nthelp.com/proggy/layout.zip�
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CREATE A CUSTOM POPUP MENU ON THE TASKBAR 

To put your favorite shortcuts all under one easy-to-access pop-up menu on the taskbar, do the following: 
 
1. Open Windows Explorer and create a new folder wherever you prefer. 
2. Put shortcuts to all your favorite programs, pictures, documents, songs etc. in this folder. 
3. Right-click on an empty area of your Taskbar, and choose Toolbars>New Toolbar. 
4. In the New Toolbar dialog box, browse to where you created your new folder with all the shortcuts, 

highlight the folder and click OK. 
 
You will now have a new item on your Taskbar with the name of the folder you created earlier. Click on the 
double arrows just above its name and you'll get a popup menu of all the programs you can now quickly 
access. If you want to remove this folder from the Taskbar, right click on an empty area of the Taskbar and 
select Toolbars, and untick the folder's name from the list. 
 
< CUSTOM WINDOWS THEMES 

Windows XP allows you to customize Window's Graphical User Interface (GUI) or 'skin'. By default XP 
comes with two main Visual Styles - 'Windows Classic Style' and 'Windows XP Style'. You can choose either 
of these by going to Control Panel>Display Properties>Appearance and selecting one under the 'Windows 
and Buttons' section. Note that you must have Themes enabled to do this; you can enable Themes by going 
to Control Panel>System>Advanced, click the Settings button under Performance and on the Visual Effects 
tab make sure there's a tick next to 'Use visual styles on windows and buttons'.  
 
Aside from the built-in themes you can also download new official ones like the Zune or Royal Noir themes. 
Royal Noir in particular has many similarities with the Vista theme. These themes provide an attractive 
alternative to the regular Windows themes, and will work without requiring any third party utilities or 
system customization.  
 
Unfortunately Microsoft has not made it easy to modify or install any unofficial styles beyond those which it 
provides. Only Microsoft digitally signed themes - such as those linked to above - can be installed without a 
problem. To install custom themes, you will need specialized tools and some detailed information. Full 
details can be found in this comprehensive Windows Customization Guide, but the main methods are 
covered below. 
 

WINDOWBLINDS 

To install a custom theme quickly and easily, you can use an automated utility called WindowBlinds. The 
basic version of this program is free and implements most aspects of a theme. Once you have installed 
WindowBlinds you can download a wide range of free custom themes from WinCustomize, GetSkinned or 
DeviantArt for example. Note however that WindowBlinds needs to run in the background in Windows for 
the theme to work, and can therefore increase resource usage. For this reason, I generally recommend the 
method below which is trickier but less resource-intensive. 
 

UXTHEME.DLL PATCHING 

If you want to use a manual method which does not involve a program running in the background like 
WindowBlinds, you will have to directly patch the uxtheme.dll file to allow custom themes. This file is held 
under your \Windows\System32 directory, and is a system protected file, so it cannot be altered or 
deleted/replaced without using a special utility. As of Windows XP SP3, many of the older methods to patch 
this file, such as  using the free UXTheme MultiPatcher, may not work properly, so follow the instructions 
below to patch it:  
  

http://go.microsoft.com/fwlink/?LinkID=75078�
http://www.istartedsomething.com/20061029/royale-noir/�
http://www.wincustomize.com/articles.aspx?aid=92719�
http://www.stardock.com/products/windowblinds/�
http://www.wincustomize.com/skins.aspx?libid=31�
http://www.getskinned.org/modules.php?modname=subs&action=showsubs&type=4�
http://browse.deviantart.com/customization/skins/windows/windowblindsxp/?order=9&alltime=yes�
http://www.softpedia.com/get/System/OS-Enhancements/Universal-UXTheme-Patcher.shtml�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  164 
 

V
isual &

 C
onvenience 

1. To start with, you will need a theme file which is in MSStyles format, such the ones listed here at 
GetSkinned. This means the downloaded theme package has to have at least one .MSSTYLES file for 
Windows to see it and use it. Typically you should extract the contents of your custom theme package to 
sit under the \WINDOWS\Resources\Themes\ directory. 

2. Make sure to create a new System Restore point. Also create a backup copy of your original uxtheme.dll 
file found in your \WINDOWS\system32 directory, preferably to another drive or disk. This is an 
important step - see Step 5 below for more details. 

3. Download a replacement uxtheme.dll file which has been modified to allow you to run custom themes. 
You can download a relevant one from here, here or here - check to make sure it matches the build 
version of Windows XP you are using. Also make sure to scan the file for malware just in case. 

4. Download the Replacer utility and run it. Drag your original uxtheme.dll file into the Replacer window 
and press Enter, then drag the modified uxtheme.dll file into the Replacer window and press Enter, then 
press Y to confirm, and reboot as required. 

5. If something goes wrong and you find you cannot reboot your system to get back into Windows, go to 
the Windows Recovery Console and copy your backed up uxtheme.dll to the \Windows\System32 
directory and reboot. If this doesn't work, see the Backup & Recovery chapter for other recovery 
methods. 

6. Go to Control Panel>Display and select the Appearance tab. Under the 'Windows and Buttons' scroll 
box, select the new theme and click Apply - it should immediately come into effect. 

 
Once again, because this procedure involves modifying a core system file, it can cause problems if things go 
wrong. However for the most part it should be safe if you follow these instructions and in particular you 
make sure to create appropriate backups as explained in step 2. Implementing a custom theme using this 
method is the least resource-intensive way of having a custom theme, and best of all it's completely free. 
 

GLASS2K 

If you also want to make any of your themes appear transparent and glasslike, you can download and use 
the free Glass2K program. It allows you to add any level of transparency to any window as well as the 
Taskbar. Give it a try as it is simple to use, however note that it needs to run in the background to work. 
 
 
As a final note, if you have low amounts of system RAM I recommend you steer clear of installing overly 
complex themes as they may make your system less responsive and increase loading times and stuttering in 
applications and games. For most modern systems however, a custom theme, particularly if implemented 
via the Uxtheme.dll method, should provide no discernable drop in performance. 
 
< KEYBOARD & PROGRAM SHORTCUTS 

Most people know that you can use the keyboard to speed up access to common commands and functions in 
Windows XP. Some people use these keyboard shortcuts a great deal, others rely mainly on their mouse for 
everything. On the following pages are some of the most useful Windows XP keyboard shortcuts, and even 
some shortcuts you can type in the Start>Run box to gain quick access to useful utilities and Control Panel 
items in Windows. I recommend you get used to using some of these regularly as they quickly become 
second nature. 
  

http://www.getskinned.org/modules.php?modname=subs&action=showsubs&type=1&offset=0&perpage=10&sortby=Newest�
http://www.neowin.net/forum/index.php?showtopic=633040�
http://www.withinwindows.com/uxtheme-patches/�
http://www.megaupload.com/?d=DIVLBL28�
http://www3.telus.net/_/replacer/�
http://www.chime.tv/products/glass2k.shtml�
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COMMON KEYBOARD SHORTCUTS 

 
Keyboard Combination Function 

  

CTRL + A Select all 
CTRL + C Copy selected item(s) 
CTRL + X Cut selected item(s) 
CTRL + V Paste copied/cut item(s) 
CTRL + Z Undo last action 
CTRL + Y Redo last action 
SHIFT + DEL Deletes item, bypasses Recycle Bin 
CTRL + ESC Open Start Menu  
ALT + TAB Switches between active programs 
CTRL + ALT + DEL Opens Task Manager 
ALT + F4 Closes program or opens 'Shut down computer' 
SHIFT + LEFT CLICK Select multiple items at once within a range 
CTRL + LEFT CLICK Select multiple items at once individually 
TAB Steps forward through screen elements 
SHIFT + TAB Steps backward through screen elements 
F1 Open Help function 
F2 Rename/Enter text for item 
F3 Search key 
F5 Update/Refresh active window 
F11 Toggle Fullscreen mode 
SHIFT + F10 Open Context Menu for item 
ALT + SPACEBAR Open Windows Properties menu 
SHIFT + CD/DVD INSERT Hold Shift while inserting a CD/DVD to prevent Autoplay 
WINDOWS Show Start Menu 
WINDOWS + D Minimize/Restore all Windows 
WINDOWS + E Open Windows Explorer 
WINDOWS + F Open Windows Search 
WINDOWS + L Lock Workstation 
WINDOWS + R Open Start>Run box 
WINDOWS + U Open Accessibility Utility 
WINDOWS + BREAK Open System Properties 
WINDOWS + F1 Open Help & Support 
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PROGRAM & CONTROL PANEL SHORTCUTS 

The following are file names for common Windows utilities and Control Panel items which you can insert 
into shortcuts or in the Windows Run box (Start>Run). 
 

Services.msc Services Utility 
Gpedit.msc Group Policy Editor 
Comexp.msc Component Services 
Eventvwr.msc Event Viewer 
Secpol.msc Local Security Policy 
Perfmon.msc Performance Monitor 
Compmgmt.msc Computer Management 
Cmd Command Prompt 
Calc Calculator 
Cleanmgr.exe Disk Cleanup Utility 
Dfrg.msc Disk Defragmenter 
Notepad Notepad 
Pbrush Paint 
Wmplayer Windows Media Player 
Wordpad Wordpad 
Wupdmgr Windows Update 
  
Control Control Panel 
Sysdm.cpl System Properties 
Devmgmt.msc Device Manager 
Desk.cpl Display Properties 
Main.cpl Mouse Properties 
Timedate.cpl Clock Properties 
Inetcpl.cpl Internet Properties 
Mmsys.cpl Sounds & Audio Devices 

 
 

DIRECTORY SHORTCUT 

If you want to get to a particular directory folder, go to Start>Run and type the name and path of the folder 
in the Run box, then press Enter. Windows Explorer will open up in that directory instantly. If you don't 
specify the full path, Windows Explorer will open up at the first incidence of that directory. You can also 
assign this path to a shortcut and use it to open Windows Explorer there by default whenever the shortcut is 
used - see the Windows Explorer chapter for details. 
 

MICROSOFT ON-SCREEN KEYBOARD 

If you are having problems using your keyboard you can bring up the Microsoft Onscreen Keyboard utility 
by going to Start>Run and typing "osk" (without quotes) then press Enter. The virtual keyboard will be 
displayed, allowing you to use your mouse to click on virtual keys as though you were using a keyboard. To 
make things easier, position the Onscreen Keyboard somewhere convenient and then select 'Always on Top' 
under its Settings menu so you don't constantly have to switch back and forward between tasks to use it. 
 
Note if you can't click the left mouse button to select keys, under the Settings menu select 'Typing Mode' and 
then select the 'Hover to Select' option. Now you can just place your mouse cursor over a key on the 
Onscreen Keyboard and it will register as an entry. Set the length of time needed to hover over a key before 
it registers as an entry (values in seconds between 0.00 and 1.00 second). 
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MOUSEKEYS 

If instead of your keyboard you are having problems using your mouse, you can enable the Windows 
MouseKeys functionality by going to Control Panel>Accessibility Options>Mouse and ticking the 'Use 
MouseKeys' box. Alternatively you can press CTRL + Left SHIFT + NUMLOCK to activate this functionality. 
MouseKeys allows you to use the Numpad keys - the numerical keys on the far right of your keyboard - to 
move the mouse cursor around on screen. 
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OVERCLOCKING 
 
When people want additional performance from their machines, they may undertake a procedure called 
Overclocking. Overclocking is the process of increasing the clock speed of a component in your PC. The 
'clock' referred to is a specialized oscillator pulsing with a frequency that determines the rate at which a data 
processor can perform instructions. A 3 Gigahertz (GHz) CPU for example has a frequency of oscillation of 
around 3 billion pulses per second by default. The theory of overclocking is simple: increase this clock speed 
and you'll increase the rate at which instructions are performed, leading to a faster PC. Overclocking is 
possible on a range of hardware components including CPUs, Graphics cards, Motherboards and RAM. 
 
There is also another way of overclocking which doesn't really involve increasing the clock rate: altering 
timings. Memory-based components such as system RAM and Video RAM have latency timings - rest 
periods between operations measured in nanoseconds. By decreasing the latency time, a memory component 
can be made to wait less between completing specific operations and hence function faster. 
 
So why is overclocking possible or even necessary? Why aren't the hardware components you buy not 
already performing to their absolute maximum potential? Well ironically the reason for that is just the same 
as the reason why Windows has so much scope for optimization and customization: the many different 
circumstances under which the hardware will potentially be used. Because components are expected to work 
in diverse environmental conditions and be put to vastly different tasks, hardware manufacturers ensure a 
safe headroom is provided so that in adverse conditions the component can still operate safely and with 
stability. Overclocking takes up this slack by pushing the component beyond manufacturers' specifications. 
 
Of course when you push a component beyond its recommended specifications the component requires 
ideal conditions to continue operating with stability. That usually means more cooling on/around the 
component, since any cooling device it already uses is only really designed to deal with stock operation. The 
component also requires stable voltage from the Power Supply either directly or through the motherboard. 
Often to achieve a stable overclock the component may also require additional voltage, which in turn can 
add to heat and hence raise the cooling requirements even further. Furthermore, the additional heat being 
dissipated from one component may cause other nearby components to overheat. As you can see 
overclocking is not as simple as it first sounds, and there are often complex interactions involved both at the 
hardware and software level which must be taken into account to achieve proper stability. 
 
 
< BENEFITS AND DRAWBACKS 

Before going into any more detail about overclocking it is important to discuss the advantages and 
disadvantages of overclocking objectively, so you don't undertake it without knowing what you're getting 
yourself into: 
 

BENEFITS 

§ Increased performance - this is of course the primary reason why people overclock. The degree to which 
performance improves depends on the component(s) being overclocked, how far they are overclocked, 
and whether they are the hardware most relied upon by particular games and applications. The 
performance difference can be anywhere from negligible up to 25% or even more. 

§ Bragging rights or 'coolness factor' attached to overclocking - some people gain a great deal of 
satisfaction and prestige in having the fastest machine, or the highest overclocked component, or the 
highest benchmark score. Or they may simply feel they are extracting the most out of their hardware by 
overclocking it. Some people also enjoy the tinkering and hobbyist aspect of overclocking and hardware 
modification. In that way it's a lot like tweaking. 

 
 

http://en.wikipedia.org/wiki/Overclocking�
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DRAWBACKS 

§ There will be costs in providing improved cooling - in almost all cases you will have to purchase more 
effective and/or additional cooling for your system in the form of more efficient heatsinks and/or more 
fans, a case with more space or better airflow, or even specialized equipment like water cooling or 
phase-change cooling units. Of course if you start out by planning your system carefully, you can 
minimize the additional costs by beginning with the right components. 

§ The overclocked component, and therefore your entire system, may become unstable and crash 
randomly - without a doubt the number one cause of problems in games and applications is 
overclocking. People often refuse to acknowledge that their overclocking is the cause of the problem, 
and mistakenly blame Windows, their drivers or the game or application instead. Different programs 
react differently to overclocking. Some can tolerate much higher levels of overclocking on particular 
components, some cannot tolerate any overclocking at all; it all depends on how stressful the game or 
program is, and how stable or unstable the overclock actually is. 

§ Potential data corruption if certain components are pushed beyond their limits - pushing components 
like the CPU or RAM beyond their limits on your system can result in instability leading to data 
corruption, up to and including the loss of all your hard drive data. Often this data corruption can occur 
subtly over time without any indication or warning. 

§ Excessive heat can damage or permanently kill a component - since computer hardware is based on 
sensitive electronic equipment, if a hardware component is not kept adequately cool (and even in some 
cases if it is) it can be permanently damaged or destroyed through overclocking. It happens quite often, 
especially with graphics cards, so it is not as rare as you might think. 

§ Overclocking automatically voids the warranty on the component - most hardware manufacturers make 
it clear that overclocking beyond recommended clock speeds or timings will instantly void your 
warranty. This also goes for any physical modifications to the hardware such as changing its cooling. 
Unless explicitly stated otherwise, a warranty is only designed to cover unmodified hardware operating 
within specifications. 

§ Overclocking reduces the life span of the component - since the component is working beyond 
specification and working hotter and faster than it was designed to handle, most components will have 
reduced life spans. This can vary from a reduction of a few months to a few years, depending on the 
extremity of the overclock, the quality of the components and how well the components are kept cool. A 
mild overclock typically has little or no practical impact on the life expectancy of a component; an 
extreme overclock can drastically reduce the error-free life of a component. 

 
So far the disadvantages appear to far outweigh the advantages of overclocking. This is not strictly true, it all 
depends on how far you overclock a component and how much performance you can gain in return, as well 
as the quality of the hardware itself. Don't get me wrong; I'm not suggesting you categorically shouldn't 
overclock. But I do feel that it's important to point out that it is not a simple or even beneficial procedure at 
all times. Despite everyone urging you to overclock your system you should weigh up the options rationally 
and either choose to avoid overclocking due to potentially modest performance gains and/or the strong 
likelihood of instability/damage; or alternatively research the topic thoroughly and invest appropriately to 
achieve a good balance of performance, stability and safety. 
 
The bottom line is if you can't afford to replace a vital system component should it get damaged, do not 
overclock it. If your CPU or graphics card dies for example and you can't replace it your entire computer 
becomes unusable, so it is not something to be taken lightly just because people egg you on to do it. 
 
< METHODOLOGY 

Below I discuss the theory on how to overclock key system components. The precise details will vary 
depending on your particular hardware configuration and BIOS options. The information below is only 
indicative and should broadly give you an idea of the types of steps involved in overclocking; for more 
detailed information see the guides linked to at the end of this section. Importantly, before commencing any 
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overclocking you must make sure you are totally familiar with the exact brand, model and specifications of 
your major hardware components. If necessary refer to any packaging or manuals which came with your 
system, and more importantly see the System Specifications chapter for links to tools which can help you 
identify your components and their precise capabilities in detail. 
 
Also make sure that before changing any BIOS settings for the purposes of overclocking that you record 
your existing BIOS settings. This is because in some cases when overclocking beyond the point of stability, 
you will have to reset your BIOS (or it may reset automatically) back to its factory default settings, losing any 
customized settings you've put in. So make sure you document what the major BIOS settings are which 
you've altered through any general BIOS customization. 
 

CPU OVERCLOCKING 

Overclocking a CPU on most systems involves entering the BIOS and increasing the speed of the Front Side 
Bus (FSB) or QuickPath Interconnect (QPI) for Intel CPUs, or HyperTransport (HTT) for AMD CPUs. The 
FSB/QPI/HTT is the main pathway (Bus) between your major system components, and as its speed increases, 
information is transferred back and forth more rapidly between all your major components working off this 
bus speed. However there are certain problems with increasing the FSB/QPI/HTT. To start with, some of 
your components may be running off this bus, such as your PCI devices (e.g. a Sound card). These operate at 
a much lower bus speed by default, so your motherboard has special dividers/multipliers or even a Lock to 
maintain the bus speeds at or close to their default. Importantly, your system RAM may rely on the main 
Bus speed to determine its speed in conjunction with some form of divider/multiplier. 
 
Your CPU also has a Multiplier, which as the name suggests sets the CPU speed in MHz as a multiple of the 
main Bus speed. For example on a system with an effective Bus of 200MHz and a CPU that has a multiplier 
of 20 gives you a CPU speed of 20x200 = 4000MHz = 4GHz. Note that some CPUs have their multiplier 
locked at the hardware level, which means you can't actually change it. The Multiplier and the Bus speed 
can be used together to achieve a performance result in conjunction with the RAM speed. 
 

RAM OVERCLOCKING 

Increasing the speed of your RAM is dependent on a number of factors. Overclocking refers to the process of 
increasing the clock speed of a component; in the case of system RAM this involves raising the system Bus 
speed and/or changing the memory divider/multiplier and/or simply raising the RAM's Frequency directly 
to alter the RAM's speed in MHz - depending on your available BIOS options. However you can also alter 
the Timings (or Latency) of a memory chip such that it refreshes faster between operations, meaning less 
waiting time between each operation and hence faster performance. Changing timings is not overclocking 
strictly speaking, since you are not actually increasing any clock speeds, but in general terms it has similar 
performance-boosting potential. 
 
People often ask whether increasing RAM speed or lowering latency is the better option. There is no set 
answer - it all depends on your particular system and the applications and games you most commonly run 
as to the precise combination of RAM speed and RAM latency which will perform best and with greatest 
stability, so you will have to experiment. Generally speaking, applications or games which have large 
amounts of non-graphics information to transfer to the CPU and back will benefit more from greater RAM 
speed, which provides more bandwidth. On the other hand applications and particularly games which 
primarily require very complex calculations with repeated access to information in memory will benefit 
more from lower RAM latency. Obviously some games require both, so there is no clear-cut answer. 
 
RAM overclocking also depends a great deal on how many sticks of RAM you have, their quality, and how 
'matched' they are. Because your RAM sticks work together, if you have two or more sticks of RAM in your 
system, you must try and ensure that firstly they are all equally matched in terms of rated speed and 
timings, and secondly that they should ideally be from the same brand and model of RAM. RAM sticks can 

http://en.wikipedia.org/wiki/Front_side_bus�
http://en.wikipedia.org/wiki/Front_side_bus�
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vary in quality and performance, so having mixed brands or types of RAM can lead to a variety of problems 
- even when running at default speeds. 
 

GRAPHICS CARD OVERCLOCKING 

The following is a modified summary from the overclocking section of my ATI Catalyst Tweak Guide and 
Nvidia Forceware Tweak Guide. It applies to all graphics cards regardless of brand, however if you are an 
ATI or Nvidia graphics card user please read through the relevant guide above for full details. 
 
The modern graphics card is a lot like a small computer by itself. It has a Graphics Processing Unit (GPU) 
which is the graphics equivalent of the CPU, it sits on a motherboard-like Printed Circuit Board (PCB), and 
has its own Video RAM (VRAM). And just like a computer system, the components on a video card can be 
overclocked to increase performance. Overclocking a graphics card involves increasing the frequency of the 
GPU (also called the Engine or Core) and/or the Video RAM (also called VRAM or Graphics Memory). You 
can overclock one or both of these components, with varying results based on a number of factors, but 
generally resulting in an increase in performance the higher you overclock each component. To overclock 
your video card, ideally you'll need a tool which allows you to change the clock speeds of the Core and the 
VRAM - refer to the guides above for links and instructions. 
 
Overclocking your video card is similar to CPU overclocking and RAM overclocking combined - simply 
increase the clock speed of the Core/Engine, and/or the clock speed of the Graphics Memory, both of which 
are measured in MHz. The Core generates graphics data, and depending on your CPU and the rest of your 
system specifications, increasing the core speed can result in a small or large performance improvement. The 
Video Memory transfers information to/from the Core, and increasing its speed can once again improve 
performance either slightly or significantly, in conjunction with your Core speed and the speed of the rest of 
your system. 
 
As a general rule, if you have a fast graphics card and a slow CPU, then overclocking your graphics card 
yields less performance improvements. If you have a fast CPU and a slower graphics card, then overclocking 
the graphics card can show greater improvement. The reason for this is that if the graphics card is the weak 
link (or 'bottleneck') in the equation, and a particular game requires more graphical power and speed, then 
quite clearly overclocking the graphics card can show more of an improvement than in situations where the 
CPU or the rest of your system is the weak point. 
 
Furthermore, all other things being equal, the higher the resolution being used for a game and the higher the 
graphics settings, and the more recent the game, the greater the potential for graphics card overclocking to 
yield bigger improvements in performance. This is because newer and more graphically intensive games 
being run at higher resolutions rely even more heavily on the GPU for their performance. 
 
Remember however that if you have an old or low-end graphics card then overclocking is unlikely to 
improve performance dramatically. The reason for this is that lower end graphics cards simply do not have 
hardware support for the advanced functionality demanded by recent games, such as the latest Pixel 
Shaders and Vertex Shaders. If your card does not have hardware support for a required advanced function, 
overclocking cannot surmount this handicap. 
 

VOLTAGE ADJUSTMENT 

As components are pushed outside specifications with overclocking, they will do more work. Often they can 
accommodate this extra work within their current voltage, however sometimes to gain stability and/or to 
push a component further, you will have to increase the voltage to these components. The three main 
components that can benefit from voltage tweaking are the CPU, the graphics card and RAM. The two main 
voltage adjustments you will find in almost any BIOS are CPU Voltage and RAM Voltage, and these are 
explained below.  
 

http://www.tweakguides.com/ATICAT_1.html�
http://www.tweakguides.com/NVFORCE_1.html�
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CPU Voltage (vCore): This is the amount of voltage applied to the CPU. The base voltage will vary depending 
on the CPU architecture, however make sure to note what your CPU's default voltage is before raising it. The 
only reason to alter the vCore from its default is that when overclocking your CPU you may notice that you 
cannot overclock it beyond a certain point, or that you experience a lot of instability. Raising the vCore 
slightly in your BIOS may allow the CPU to regain stability and/or allow you to push the CPU further. The 
theory behind raising the vCore is more complex than just supplying more juice to the CPU, and you can 
read about it in this CPU Overvolting Article as well as this Wikipedia Article. The most important thing to 
understand is that upping the VCore beyond a certain point can result in permanent damage to your CPU, 
and generally speaking any increase in the VCore can further shorten the life span of a CPU. However for 
the most part a small bump in voltage (e.g. 0.1 or 0.2 volts) can help stabilize an overclocked CPU that is 
acting slightly unstable. Just remember that more voltage equals more heat, which requires greater cooling 
to maintain safe temperatures. 
 
RAM Voltage (vDIMM): Also sometimes called DDR Voltage, this is the amount of voltage for the RAM 
DIMMS (Dual Inline Memory Modules). Just like vCore, increasing vDIMM can improve stability, and RAM 
in particularly can benefit from higher voltages when your system is suffering from stability issues under 
overclocked conditions. This is particularly true if you're experiencing random reboots or sudden crashes to 
desktop as these are almost always RAM related in some way. Once again, increasing the voltage to your 
RAM can result in permanent damage so do not overvolt by a substantial amount without first consulting 
with other owners of the same RAM and motherboard combination to see what a recommended 'safe' 
voltage level would be. As always make sure your RAM has plenty of fresh cool air circulating around it to 
prevent any heat buildup. 
 
There may however be additional voltage settings in your BIOS, and unless you have full knowledge of 
what they do, and what a safe adjustment is, do not alter them as you can permanently damage or kill your 
components this way. 
 

POWER SUPPLY UNIT 

Your Power Supply Unit (PSU) is an essential part of your system, and one that is often ignored, especially 
when overclocking. For basic details regarding PSUs see this PSU FAQ which talks about the common 
output specifications for PSUs and what they mean. A good PSU is essential to the stable operation of any 
PC.  
 
You should consider three key factors when determining whether a PSU is a good choice for your system: 
Wattage, PSU efficiency, and total amps delivered on the +12V rail. These figures should be readily available 
from the PSU's specifications.  
 
In terms of wattage, to work out a rough estimate of the PSU Wattage which is sufficient for a particular 
system, use this Interactive PSU Calculator. It is fairly straightforward to use, however note that there are 
some traps you can easily fall into which will result in overestimating your power usage. For example under 
the 'System Type' box, you should always select 'Single Socket' unless you actually have multiple CPU 
sockets on your motherboard. A Core i7 CPU for example has four cores, but it is still a single socket CPU; 
virtually no desktop system has more than one CPU socket on the motherboard, so pay careful attention to 
the descriptions while going through the calculator. 
 
Once you've determined the correct wattage, the next issue is PSU efficiency. This doesn't represent how 
much of a PSU's power is usable - all good PSUs should provide up to their maximum rated wattage with 
stability if required. Furthermore, contrary to popular myth, whether a high or low wattage PSU, the PSU 
only provides the amount of power the system needs, so buying a larger PSU than you require won't result 
in extra power usage all by itself. PSU efficiency is the proportion of the power the PSU draws from your 
power socket that is relayed to your system. For example a PSU with 80% efficiency providing 400W of 
power to your system will actually draw 500W from the power socket on your wall while doing so. In 

http://www.hardwareanalysis.com/content/article/1482.1/�
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practice efficiency will differ at different levels of load on different PSUs, and it's an important figure to look 
out for. Ideally you want 80% efficiency or higher at your expected load level on the PSU. 
 
The final factor is amperage on the +12V rail, a key factor in system stability. For example if you look at the 
specifications of some graphics cards, they will say that they require a current of a certain number of amps 
on the +12V rail (e.g. 40A on +12V for an Nvidia GeForce GTX 285). You should refer to the specifications of 
the PSU to see if the +12V rail(s) provide that much amperage in total. Note that some PSUs may have 
multiple 12V rails - this is technically a safety requirement to prevent potential overload on a single 12V rail, 
but is not a necessity, and some even consider it undesirable. In practice as long as the amps and total 
wattage supplied along the 12V rail(s) are solid and sufficient for the job required, it shouldn't make a huge 
difference whether you have single or multiple 12V rails. 
 
The problem is that beyond trying to take note of the more obvious factors above, an accurate review is 
required to tell you whether a PSU is genuinely good quality or not. As this article points out, specialized 
measurement instruments are necessary to determine this, not just measuring voltages with a multimeter. 
Hence most PSU reviews are actually inaccurate and effectively useless. Accurate PSU reviews can be found 
at sites like SilentPCReview and JonnyGuru, so start there if you want to know more about a particular PSU. 
 
Do not underestimate the importance of a good quality PSU with sufficient wattage and stable voltages. 
Your entire system can suffer from constant instability unless you have a decent suitable PSU, and note that 
this applies equally to both overclocked and non-overclocked systems. 
 

COOLING 

One of the most common reasons for problems in Windows is actually the hardware-related phenomenon of 
overheating. Overheating hardware can cause all sorts of strange errors and problems, and is often 
misdiagnosed as being a software problem. Most computer hardware generates heat due to the power they 
consume, and this heat needs to be dissipated somewhere. A typical computer case is designed such that it 
traps heat, and hence as heat builds up in a PC, it will cause components to malfunction and even become 
permanently damaged over time. Overheating can occur in both stock systems and overclocked systems; it 
all depends on a range of factors we look at below. 
 
Your CPU and motherboard both have built-in diodes that measure the temperature for these components. 
The CPU temperature monitor is a reasonably accurate measure of the temperature at or near the core of the 
CPU, while the motherboard temperature monitor is a good measure of the general system (or case) 
temperature - the ambient temperature of the air in the immediate vicinity of the motherboard. Most recent 
graphics cards also come with built-in temperature diodes as well, allowing measurement of the 
temperature near the core of the graphics card. Many other components do not come with temperature 
measurement devices, and so you can only tell their heat by touching them, or by using specialized 
equipment such as an electronic thermometer. 
 
To actually see the temperature readings from your components, you can check them in your BIOS typically 
under a 'Hardware Monitor' section or similar. This gives you the CPU and motherboard temperatures, 
perhaps also the PSU temperatures as well. Clearly you need an additional method of checking temperatures 
under Windows, especially when running system intensive applications or games. Most motherboards 
already come with such a software utility, so you should check your motherboard manual and driver CD, or 
the motherboard manufacturer's website for an appropriate monitoring utility. However for the most 
accurate temperature readings I recommend one of the following free utilities which work on any system: 
 
RealTemp 
Core Temp 
SpeedFan 
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Monitoring your graphics card's temperature is possible through your graphics card control panel, generally 
accessed via Control Panel>Display>Settings>Advanced Settings. For more details of the graphics card 
control panel functionality see my ATI Catalyst Tweak Guide or my Nvidia Forceware Tweak Guide. You 
can also use a range of third party utilities such as GPU-Z, or one of the system temperature monitoring 
utilities covered further above. Remember though that the GPU temperature shown is not the same as the 
Video RAM temperature which may be much higher. 
 
Once you have the appropriate utility, monitor your component temperatures at both idle and when your 
system is under load. If particular components reach high or excessive temperatures when under load, then 
it is likely that those components will malfunction while undertaking more strenuous activities on your PC, 
such as playing games. However even when idle, your PC may begin to malfunction if heat steadily builds 
up in your PC case and is not cleared fast enough. Most people will want to know what the 'safe' 
temperature is for particular components on their system. The answer is different based on different 
hardware architectures, as some are designed to run hotter than others, but you can ascertain what a safe 
temperature under full load is by searching on Google using the specific brand and model of the component 
to see if any user feedback or reviews of your hardware states what temperature ranges are normal. 
 
If you are experiencing problems with heat in your system, or if you just want to ensure that you remain 
problem-free, the following basic cooling tips should be observed. This applies equally to overclocked and 
non-overclocked systems: 
 
§ Remove any obstructions from around your case. For example don't obscure any of your case grills/air 

holes, such as having them pressed against a wall, blocked by dust etc. Insufficient flow of air into and 
out of the case is the number one cause of heat buildup and heat-related problems. No matter how much 
cooling you have inside a case, if air can't easily get into and out of the case then your system will 
overheat. 

§ If you have few or no major case fans drawing in cool air and expelling hot air, remove the sides of your 
case so that the fans on the CPU, graphics card and Power Supply can get a fresh supply of cooler air, 
and can expel hot air outside the case. 

§ If you do have several case fans, arrange them so that some are to the front and low in the case, sucking 
air into the case (as the air near the floor is cooler) and some are to the rear and/or the top of the case, 
blowing hot air out of the case (where the hot air expelled will rise away from the case). In this situation 
make sure to keep the sides of your case closed so that the fans have more pressure to suck/blow air 
through the case's contents like a wind tunnel. 

§ Don't position a sucking and a blowing fan(s) too close together as they will 'short circuit' each other - 
that is they will pass air through the shortest line between the two, bypassing your components and 
hence not cooling them as efficiently. As mentioned above, fans sucking air into your case should be low 
and on the furthest side of the case from the blowing fans that expel heat from the case. 

§ If one component is shedding a lot of heat, pay attention to perhaps providing greater cooling to the 
components immediately around it. Often the excess heat from one component can cause another nearby 
component to overheat. 

§ Tidy the internal components of your case. This means all ribbon cables, power cables, etc. should be 
clipped or twisty-tied to be as neatly arranged as possible, primarily to avoid blocking the flow of free 
air around components, especially the CPU and graphics card which are the two hottest components in 
most cases. Secured cabling and snug plug connections also means you can be sure nothing becomes 
accidentally unplugged or short-circuited over time and hence cause mysterious hardware-based errors 
that will confuse you in the future. 

§ If using additional internal cooling like larger heatsinks or fans, make sure they are not too heavy for the 
surface they are mounted on. For example, using extremely large heatsinks on a graphics card can result 
in the card actually bending under the weight and hence becoming permanently damaged. Even a large 
heatsink mounted on a motherboard can cause it to warp or crack, once again damaging the 
motherboard PCB beyond repair. If you feel you require such hefty cooling you should consider instead 
buying a larger case that has better airflow properties. 
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§ Make sure your hard drive(s) are not smothered by cabling or crammed into a stuffy area of the case 
with no nearby cooling or fresh air. Higher speed hard drives in particular (i.e. 10,000 RPM or faster) can 
heat up quite a bit - one touch of their metal casing will tell you just how hot they get. Hard drives are 
often overlooked in cooling, and yet they are a vital system component, and as such you should make 
sure they receive plenty of fresh cool air around them. 

§ Make sure that any heatsinks or heatpipes on the motherboard itself are not covered or blocked by other 
components or cables, or covered in dust. There is a reason why these heatsinks are there: because 
motherboard memory controller chips for example require cooling otherwise they can malfunction due 
to excessive heat just like any other major component. Don't assume a heatsink or heatpipe without a fan 
implies the component requires minimal cooling, as sometimes manufacturers skimp on putting a fan on 
these components, which simply means the heatsinks have to do more work, so keep them well exposed 
to cool air. You may even consider installing a small fan on them if you wish, and this can aid in system 
stability. 

 
The most simple of all of these tips which anyone can undertake is to provide greater access to fresh cool air 
for the case's contents and regularly clean the case to remove dust buildup. Dust in particular can reduce 
airflow significantly, so keep your case dust-free using a barely damp cloth or compressed air. The next time 
you go to upgrade your PC, consider buying a larger case with plenty of ventilation as the single best 
investment in cooling and hence general system stability. 
 

COMPARING OVERCLOCKS 

One of the most common statements I hear when people compare overclocks or are told that their overclock 
is unstable is: "But someone else who has the exact same system can overclock it much higher than me and 
their games don't crash! It must be a game bug!". A comment like that demonstrates a complete lack of 
understanding of some fundamental principles of overclocking: 
 
§ No two components are exactly the same. Even if the two components being compared are an identical 

brand, model and speed, they may have very different tolerances to overclocking depending on which 
factory they were produced in and which revision they are (how early/late into the production run they 
were produced - e.g. for CPUs this is called Stepping). 

§ No two people have the exact same conditions for their overclocking. Your computer room may be hotter 
or cooler than your friend's, your case may provide better or worse cooling, your combination of 
components may include a different PSU or different brand or speed of RAM, etc.  

§ Your Windows settings and software environment will not be identical to anyone else's. You may have 
sub-optimal software settings, background programs that are the source of conflicts, or even malware 
causing problems, or you may even have data corruption.  

§ No two games are identical in the way they stress components on your machine, and hence if all of your 
other games work absolutely fine at a certain level of overclock, it may well be that the latest game you 
are playing has a completely different tolerance to your overclock and will crash 3 times out of 4. 

 
OVERCLOCKING AND STABILITY 

I have a golden rule about troubleshooting any problem on an overclocked system: 
 

Always start by assuming your overclock is the primary source of any problems 
 
Begin the investigation of any problem on your PC by suspecting your overclock as the source of a problem. 
Reset your entire system to its default speeds and see if the problem persists or is as severe. If the problem 
goes away, or doesn't happen as often you can be certain your overclocking is contributing in some way to, 
or is the sole cause of, your problems. You will have to lower or remove your overclock and/or increase your 
cooling. 
 

http://en.wikipedia.org/wiki/Stepping_(version_numbers)�
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Details on how to correctly test your system for stability are covered in the Performance Measurement & 
Diagnostics chapter, but bear in mind that even if your system passes every artificial test there is, the real test 
is having complete stability day-in, day-out even when running stressful games and programs. If your 
system starts behaving strangely, or you are having crashes and problems, don't persist in maintaining your 
overclock. 
 
I know from experience that it is psychologically difficult to lower or remove an overclock because you may 
feel you are losing extra performance that you deserve, but this is something you will have to deal with. 
Virtually every day I receive emails or see forum posts from people who are wondering about some 
'mysterious' problem on their machine, only to eventually find that it was in some way related to their 
overclocking. Subtle data corruption can occur over time on overclocked systems, even seemingly stable 
ones, and this is one of the main reasons why so many people often find they have to reinstall Windows 
every few months. This is not exaggeration or scaremongering - electronic hardware components are highly 
accurate devices, forcing them to run outside their normal operating speeds can increase the potential for 
small errors to creep into their operation. Manufacturers often push a particular component close to its limits 
by default from the factory, so even a small amount of overclocking is enough to cause problems. 
 
If it appears that I'm being overly harsh or biased against overclocking, it is because I've been doing it myself 
since 1999 and I know full well how easy it can be to become lulled into accepting an unstable system as 
somehow being the norm. It is totally false to claim that it is normal to constantly reinstall Windows, or that 
it is normal for your system to crash every few hours. My (non-overclocked) systems have all been rock solid 
every single day for years, even after hours of very stressful gaming. My games do not crash randomly nor 
do my programs or system behave strangely. The point is if you're going to overclock, don't do it at the cost 
of system stability; do it properly. At the first sign of strange behavior, don't be quick to blame everything 
else - suspect your overclock first and foremost. 
 

RESEARCHING OVERCLOCKING 

Having stressed the importance of researching overclocking before you dive into it, I recommend that you 
start by referring to the following guides for more details. This is obviously not a definitive list of places to 
research, nor have I personally tested out all the procedures in these guides - they are simply a good starting 
point: 
 
General Overclocking Guide 1 
General Overclocking Guide 2 
Core2Duo Overclocking Guide 
Core i7 Overclocking Guide 
AMD CPU Overclocking Guide 
 
Take the time to search Google and various tech forums for peoples' experiences with overclocking 
hardware similar to your own. More often than not you will find someone who has a similar setup and who 
has overclocked it with reasonable success, so look out for such information. Be aware however that people 
often have different definitions of 'stable' when it comes to overclocking, and of course as noted further 
above, no two systems are identical so don't just automatically assume you can reach the same results using 
similar hardware. Take the time to research, read and think about overclocking and make sure you have the 
right tools and knowledge to undertake it properly. 
 

http://www.deep-powder.net/OC_Guide/Mem_Mobo_CPU_Overclocking_Guide.htm�
http://www.tomshardware.com/2006/12/11/overclocking-guide-part-1/�
http://forums.hexus.net/showthread.php?t=103676�
http://www.bit-tech.net/hardware/cpus/2008/11/06/overclocking-intel-core-i7-920/1�
http://www.tomshardware.com/reviews/phenom-overclock-athlon,2161.html�
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BENCHMARKING & STRESS TESTING 
 
If you change settings in Windows XP or your BIOS, or if you've applied a new tweak, or perhaps if you've 
overclocked a system component, it is often difficult to tell whether your overall performance or system 
stability has improved or decreased, and by how much. The best way to gauge performance changes and 
system stability is to Benchmark your system and Stress Test it. There are a range of utilities that are 
reasonably valid, objective benchmarking tools, and we will look at them in this chapter. We will also look at 
some reputable stress testing tools. 
 
It is important to understand that some benchmarking tools double as stress testing programs since they put 
your system through a series of relatively rigorous tests to produce their performance figures. These tests 
should assist in highlighting any latent instability in your system, so the simple act of benchmarking can also 
result in stress testing your system. Stress testing plays a critical part in troubleshooting and diagnosing the 
source of system problems. 
 
 
< BENCHMARKING 

To set the actual benchmark - or base level of performance - you should ideally run the benchmarking 
program(s) prior to the majority of performance tweaks or changes you make, and note the initial results 
they provide. That way once you've started tweaking you can run the benchmarks again to confirm that the 
tweaks are having the desired effect, i.e. improving performance. However, many benchmarking tools 
already provide some information on the comparative level of performance of your system; that is, whether 
or not your system is above or below an average level of performance given the type of hardware you are 
using. You can also compare results online with other users with similar systems for example. 
 
You may choose instead to take your base level of performance as being a freshly installed and tweaked 
Windows XP with no overclock for example, then perform additional alterations and perhaps even 
overclock certain components, then retest against the base level to see what impact your changes have had. 
The main point is that for benchmarking to be successful you need a reference point; something to compare 
with down the track to determine whether your performance is going up or down with the changes you 
have made. 
 
Some important notes to keep in mind about benchmarking: 
 
§ Benchmarking programs usually focus on testing the performance of particular components of your 

machine. Graphics benchmarks for example usually test the graphics card and to some extent the CPU's 
performance. That means that if you want to test any tweaks you've made to your hard drive's speed for 
example, a graphics benchmark is not necessarily the best tool to use. 

§ All benchmarking (and stress testing) programs can result in sudden crashes and reboots, and on rare 
occasions data corruption, if used on unstable systems, so as a precaution always make sure any 
valuable data has been recently backed up before doing comprehensive benchmarking. 

§ For optimal results make sure that you do not have any other programs or games running in the 
background when benchmarking, since these can lower your results and introduce significant 
variability. They can also cause a benchmark to crash prematurely, misleading you into believing your 
system is overly unstable. 

§ For the purposes of using a benchmark as a stress test you may want to run other stress testing and/or 
benchmarking programs in conjunction with the benchmark, or other applications/games, to really put 
the pressure on your machine. Of course this can still result in prematurely crashing a system, but it 
would be an extreme test of system stability. 

 
Below are the more popular benchmarking programs available for free, and how to use them correctly - 
including details on the component(s) they primarily focus on testing: 

http://en.wikipedia.org/wiki/Benchmark_(computing)�
http://en.wikipedia.org/wiki/Stress_testing�
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3DMARK  

3DMark is a popular and reasonably accurate Direct3D graphics benchmarking utility that has been around 
for several years. 3DMark 06 primarily utilizes your graphics card and to a lesser extent the CPU, with the 
memory subset a player as well. 3DMark results will give you a good indication of advanced 3D gaming 
performance on your machine, and broadly speaking the higher your results, the faster the performance of 
recent and upcoming games on your system. In very general terms if one system scores higher in the same 
version of 3DMark than another, then it should be better for gaming. Note that only 3DMark 06 or older will 
run on XP; the newer 3DMark Vantage is Vista-only. 
 
To use 3DMark start the program and click the 'Run 3DMark' button. You will see a series of tests running. 
These use various graphical techniques, some of which may not be supported by your graphics card, and 
some of which are only available in the purchased version of the benchmark. At the end of the run the 
benchmark will present a final score. You can then use this score to compare with other people who have 
run the benchmark and this will tell you whether your system is relatively faster or slower, and if compared 
with others who have virtually the same system specifications, it will tell you whether you have room to 
improve on your particular system. Note however that some systems with the same specifications may be 
heavily overclocked just to get a high 3DMark score and are not particularly stable for day-to-day use. 
 
One method of comparing results with others is to simply find an appropriate forum and post your results 
for comparison and discussion. A more reliable method is to use 3DMark's Online Result Browser (ORB) to 
compare results with others who have posted their 3DMarks. Using the ORB means you have a better chance 
of finding a precise match for your system specs since the ORB has many thousands of users. To enter the 
ORB at any time, click the 'Options' button under the Results section of the main 3DMark screen and then 
click the 'Online ResultBrowser' button. Keep in mind that the scores from previous versions of 3DMark are 
definitely non-comparable to the current version. 
 

UNIGINE 

Unigine is a more recent tech demo/benchmark which can be run in either Direct3D or OpenGL mode. 
Extract the contents of the program archive to an empty directory and rain the main.exe file to start the 
benchmark and configure your options. If run in Benchmark mode, when completed the benchmark will 
provide an average FPS and a score - compare it with others running at identical settings. 
 

FURMARK 

FurMark is a recent intensive OpenGL-based benchmark. As with most benchmarks, installing and running 
the program results in a run through a series of tests, with results provided at the end. You can upload and 
compare these results online with other FurMark users. 
 
In terms of general non-graphics benchmarks, the following are the more popular ones: 

 
GAME BENCHMARKS 

The most useful form of benchmarking is through the use of the benchmarking features in many 3D games. 
This is considered 'real world' benchmarking, since for most intents and purposes modern PC games are the 
most system intensive - and system-wide - benchmarks you can use. Many of the more recent games such as 
F.E.A.R, Call of Juarez and Crysis contain built-in benchmarking utilities. For more details of these 
benchmarking functions, as well as how to configure these games for optimal performance, see this list of 
Game Tweak Guides. If you want an automated utility to run the benchmarks for you, then you can 
download a range of free game benchmarking utilities at HardwareOC Benchmarks. Note that they have 
been given explicit permission to use some TweakGuides.com game guide text and descriptions in their 
utilities by me. 
 

http://www.futuremark.com/download/�
http://unigine.com/download/�
http://www.ozone3d.net/benchmarks/fur/�
http://www.tweakguides.com/Games.html�
http://www.hocbench.com/�
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Even if you can't find an automated or built-in benchmarking feature for a game, simply select the most 
strenuous game you have - i.e. the one with the most graphical detail, best artificial intelligence and physics, 
and preferably the most recent - and use the FRAPS utility to measure performance over a set period of time. 
You can assign a key which starts and stops the benchmarking process in FRAPS, or you can tell FRAPS to 
stop benchmarking automatically after a period of time. You can specify the benchmarking stats to save, 
such as minimum, maximum and average frames per second. 
 
To use any strenuous game as a stress tester, play it continuously for a sustained period of time at very high 
settings, such as one or two hours. If the game crashes at any point then this is usually a very good 
indication that your system is not completely stable. 
 

PCMARK 

PCMark is a general benchmarking utility from the makers of 3DMark that has been around for several 
years, and although not as reputable or as widely used as 3DMark, provides a reasonably good benchmark 
of your computer's general performance, not just in 3D gaming. It runs a series of tests based on such things 
as file encoding, disk reads/writes and basic graphics display. To use PCMark run the program and click the 
'Run PCMark' button on the main screen. After several tests it arrives at a score you can compare with others 
online, or again on the ORB. Note that PCMark results are recorded separately from 3DMark results and are 
not comparable. Note further that only PCMark 05 can be used on XP; PCMark Vantage is Vista-only. 
 

SANDRA 

Sandra is discussed in detail under the System Specifications chapter, however it also contains a range of 
modules designed to test certain components of your system, such as the CPU, RAM, or various drives. The 
free version of Sandra is limited in the particular modules you can access and hence the tests you can run, 
however there are sufficient benchmarks in the free version for you to use it as a decent system 
benchmarking tool. 
 
To see the modules of Sandra which have benchmarking functionality, click the Benchmarks tab and you 
will see modules such as the 'Processor Arithmetic', 'Physical Disks' and 'Cache and Memory'. To run a 
benchmark, open the appropriate module and press F5 or click the blue 'opposing arrows' (Refresh) icon at 
the bottom of the module. This will begin a benchmarking run, after which you will eventually see the 
results displayed at the top of the module. You might want to record the score(s) somewhere. You can put 
the benchmarking results in context by looking at the reference figures provided beneath it. You can also 
change the reference data to reflect a variety of hardware to compare against. Note that for the 'File Systems' 
benchmark, by default it does not use the Windows File Cache, and this can give quite low results. To enable 
the file cache, and hence see the real-world results of Windows memory management tweaking on your 
Windows system, click on the Options button at the bottom left of the File Systems benchmark module, 
untick the 'Bypass Windows File Cache' option, click OK then run the benchmark. 
 
Sandra also has a role as a stress tester - that functionality is covered in the Stress Testing section further 
below. 
 

HDTACH 

HDTach is a free hard drive benchmarking utility that allows you to test your hard drive's speed. Launch the 
program, make sure all background programs and applications are closed, select 'Quick Test' then click the 
'Run Test' button and wait for the testing cycle to complete. You will be presented with a graph showing the 
drive speed over the course of the drive. In the right hand pane you can see the various speed statistics and 
CPU usage information for the tested drive. If you want to compare your results to users online, click the 
'Long Bench' option and then 'Run Test', and this time when the benchmarking run is completed you can 
click on the 'Upload Results' button to lodge your results to the database. 
  

http://www.fraps.com/�
http://www.futuremark.com/download/�
http://www.sisoftware.co.uk/�
http://www.simplisoftware.com/Public/index.php?request=HdTach�


 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  180 
 

Benchm
arking &

 Stress Testing 

 
DISCSPEED 

DiscSpeed is a free utility which provides the means to benchmark your CD or DVD drive with a range of 
tests which you can select by going to the 'Run Test' menu, and selecting the relevant test under it. If you 
don't want to select any specific tests, simply launch the program, leave it at default settings, insert a disk 
into the drive to be tested, and click on the Start button. You can save your results in various file formats, 
and you can share these results with others for comparative purposes for example. 
 
< STRESS TESTING 

Stress testing has one primary purpose on a PC: to exaggerate and bring out any instabilities or sub-optimal 
settings as quickly as possible. The reason for this is that instability usually manifests itself at various times 
on your system and in various ways and thus its causes may not be clear. A stress tester accelerates the 
process by placing extreme stress on certain components of your system to quickly and accurately determine 
whether they are the likely cause of system instability. For example, running a program which almost solely 
stress-tests your CPU can give you a good indication of whether it is your CPU which is causing crashes, 
freezes, or Windows errors; or whether another component may be to blame. 
 
However specialized a stress tester may be, it will still not provide you with rock-solid evidence that a 
specific component is to blame. In the case of the CPU tester for example, it must be recognized that if the 
program indicates CPU instability, the causes can still vary. A CPU can appear to be unstable due to one or 
more of the following reasons: 
 
§ A lack of sufficient CPU cooling 
§ A lack of voltage to the CPU 
§ A physical fault with the CPU chip 
§ A specific incorrect software or BIOS setting 
§ A fault with the motherboard 
§ A fault with your Power Supply Unit 
 
The best the stress tester can do is point you in a certain direction - it usually can't provide a precise solution 
for your problem. However often this is enough for you to rule out many other causes and hence save you a 
lot of time and trouble, and even prevent you from wasting money on repairing or replacing another 
component which is not the cause. This is typically the case when you are experiencing game-related 
problems, since it may not be clear which of the many components involved in running a game are the 
actual culprit. Often the graphics card, the drivers, or the game software itself is blamed when the cause may 
be anything from your power supply, to the RAM in your system, to general settings in Windows to dust 
buildup in your case. 
 
Below are the more popular stress testing programs available for free, and how to use them correctly, 
including details on the component(s) they primarily focus on stress testing: 
 

PRIME95  

Prime95 is a small mathematics program which will effectively stress test your CPU and memory. Once 
you've installed the application, to run the actual stress test run Prime95.exe and choose the 'Just Stress 
Testing' button. Next, under the Options menu select 'Torture Test' to start stress testing. Select the test type 
based on the particular components you want to focus on testing: 
 
§ Small FFTs - Select if you want to primarily test your CPU. 
§ In-place Large FFTs - Select if you want to test your CPU for stability under high heat and voltage usage. 
§ Blend - Select if you want a more general 'real word' test which tests both the CPU and plenty of RAM . 
 

http://www.cdspeed2000.com/download.html�
http://www.mersenne.org/freesoft.htm�
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Once you click OK the testing will begin. If the program aborts with an error, you will be notified. If at any 
point you want to stop the test, go to the Test menu and select Stop. Make sure you read the document 
Stress.txt that comes with the program as it will explain more about CPU stress testing and how Prime95 
helps uncover instability. The program recommends running the torture test for between 6 - 24 hours, 
however a PC that is unstable will usually crash much sooner than that, often within a few minutes of 
running the test. In general if your PC lasts for over 2 continuous hours under the Prime95 torture test it 
proves that the CPU and memory subset are quite stable. 
 

SUPER PI 

Super PI is a small utility similar to Prime95, in that it stress tests your CPU and memory subset by 
calculating the mathematical number PI to a certain number of places. Download the program and run the 
super_pi_mod.exe file. Click the Calculate menu item at the top, and select the number of places to calculate PI 
to, ranking from 16 thousand (16k) to 32 million (32M) places - the larger the number of places, the longer it 
will take. In general for a speed test of your CPU, select the 1M option and once the calculation is done, note 
the time in seconds taken for the final loop (e.g. 38.562s). You can then compare this figure to other people to 
see how fast your CPU is. If you want to stress test your CPU, run the full 32M calculation which will take 
longer, and hence is a better stress test of your CPU. Once again you can also compare the time taken to 
complete this with other users. 
 
Note: Both Prime95 and Super PI only run on one core of a multi-core CPU by default. To stress test both 
cores of a dual core CPU for example, you should open up one instance each of Prime95 and SuperPI 
together, then run them both and both CPU cores will be stressed. 
 

SANDRA 

Aside from its other roles covered elsewhere in this guide, Sandra also can be used as a diagnostic tool. To 
use it as a stress tester of specific components on your system, use the relevant modules mentioned under 
the Benchmarking tab. However instead of simply running them once, if you want to stress test the relevant 
component simply refresh the benchmark repeatedly (by pressing F5) whenever it completes each run. 
Alternatively, if you want to stress all your components in turn automatically, Sandra has a 'Burn-in 
Computer' module under the Tools tab which will undertake more thorough stress testing of your machine. 
Start the wizard, tick the components you want to continually stress test, set the number of times for them to 
loop, make sure the 'Monitor your computer's health' and 'Terminate on overheat/failure' boxes are ticked to 
be safe, and then commence the stress testing. 
 

MEMTEST 

MemTest is a Windows-based memory test for all systems and will help in stress testing your RAM to detect 
any errors. Memory-related errors are one of the primary causes of system instability and data 
corruption/errors, so a RAM tester is a necessity. To use MemTest simply launch the program, and I 
recommend manually entering the amount of RAM you wish to test - e.g. enter 512 to test 512MB of RAM, 
1024 for 1GB of RAM and 2048 to test 2GB of RAM. Click the 'Start Testing' button to begin RAM testing and 
allow the test to run until it has reached 100%. Ideally you should run the test for at least an hour or more, or 
even overnight if you want to test for total system stability. If any errors whatsoever are found then you 
have unstable memory which can lead to many types of system problems. 
 

MEMTEST86 

Memtest86 is another good memory test and is better than MemTest in that it tests your memory before 
Windows loads into memory. This is a much more accurate way to test your RAM and memory subset free 
of any memory spaces taken up by the operating system. To use MemTest86 download the latest zip file and 
extract the contents. Run the Install.bat file from the archive and enter a blank 1.44MB floppy as prompted. 
To run Memtest86, leave the floppy in the drive and reboot your system - it will run from the floppy and test 

http://www.xtremesystems.com/pi/index.php�
http://www.hcidesign.com/memtest/�
http://www.memtest86.com/download.html�
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your RAM. Note that some motherboard BIOSes come with MemTest86 built-in, so check your BIOS for this 
option and run it from there, especially if you don't have a floppy drive to use for this procedure. 
 
There is an updated and modified version of Memtest86 called Memtest86+ which you may prefer to use 
since it contains a range of enhancements over the original, including more information and better support 
for newer chipsets. 
 

GOLDMEMORY 

GoldMemory is another memory tester that runs before your operating system and other programs are 
loaded into memory, which is the most optimal condition for memory testing. Usage of GoldMemory is 
similar to MemTest86, and involves running the install.bat file of the package to create a bootable floppy disk 
that can be used for running GoldMemory upon rebooting. 
 

RTHDRIBL 

RTHDribl (Real Time High Dynamic Range Image-Based Lighting) is actually a DirectX9 tech demo and not 
specifically designed as a benchmark or stress tester as such. You must have a graphics card with Pixel 
Shader 2.0 support or higher to run it, such as Radeon 9600 or GeForce FX or higher card. It does not have a 
series of tests to run, so simply start up the program and observe your framerates (top left corner). You can 
turn off the text shown on the screen at any time by pressing F1 and F3. You can also cycle through a range 
of object shown (Press O), the materials used on their surfaces (Press M), and the backgrounds used (Press 
L). You can change the display resolution or increase the size of the program's window, either of which will 
increase the load on your graphics card. 
 
To use it as a stress tester, go to the File menu and select 'Config Display'. In the Direct3D Settings screen 
which opens, click the 'Fullscreen' option, then select a higher resolution such as 1280x1024 or above. If you 
really want to stress your graphics card, select the highest resolution available. You don't need to alter any of 
the other options on this screen unless you know what you're doing. Click Ok and the changes will be 
implemented. Now start the Auto Demo mode by pressing F5 (or Demo>'Enter Planet Demo') and let the 
program run for a while and any graphics instabilities will soon become apparent through crashes, artifacts 
or glitches. You can also manually rotate the objects, change them, their materials and background 
environments often to put further stress on the graphics card. 
 
Remember, you can use any of the benchmarks listed earlier in this chapter as stress testers simply by 
running them at their highest settings in a continual loop for example. 
 

http://www.memtest.org/�
http://www.goldmemory.cz/download.php�
http://www.daionet.gr.jp/~masa/rthdribl/index.html�
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WINDOWS ERRORS 
 
The information throughout this guide is already aimed at helping you configure your system for optimal 
performance and stability. As such the whole guide must be read to allow you to correctly troubleshoot any 
problems you may have. However this chapter contains some specific details on common Windows errors, 
and what they may mean. It is by no means a comprehensive listing of procedures to follow in 
troubleshooting problems, and again, it must be used in conjunction with the information in the rest of this 
guide. 
 
 
< IDENTIFYING WINDOWS ERRORS 

It is import to understand that most Windows and program errors are not easy to diagnose, and often what 
the error message says is the source of a problem, is not the actual source of the problem. For example, a 
DRIVER_IRQL_NOT_LESS_OR_EQUAL error is supposed to occur due to faulty drivers, however most 
commonly it actually occurs due to excess heat and/or overclocking on the graphics card, which then 
generates driver errors due to instability, which Windows then logically reports as a driver error. As you can 
see, if heat is the source of your problems for example, uninstalling and reinstalling new graphics drivers 
will do nothing to resolve this issue. So you need to make sure you follow the steps under the Diagnosing 
Problems area further below to correctly diagnose a problem. 
 

SUDDEN REBOOTS ON ERRORS 

If you find that your system suddenly reboots when you experience an error, and hence you can't see the full 
details of an error, then you will need to disable the automatic reboot on error function in Windows. To do 
this, follow these steps: 
 
1. Go to Control Panel>System>Advanced>Startup & Recovery Settings. 
2. Under the 'System Failure' section untick the 'Automatically Restart' option, as well as the 'Send an 

Administrative Alert'. 
3. When next you receive an error, your system will freeze at the error screen and show the error message. 

Write down the error type and number exactly as shown for future reference. 
4. Manually reboot your system using the restart button on your PC, or by pressing CTRL+ALT+DELETE, 

or by holding down the Shutdown button on your PC for 5 seconds. 
 
If your system still suddenly reboots, then this is a sign of memory-related issues - see the Memory 
Optimization and Overclocking chapters, as this is related to your RAM, virtual memory or CPU Caches, 
especially when overclocked. Important system information held in memory is suddenly corrupted and 
must be dumped, and the system either aborts the program responsible for the corruption - causing an 
instant Crash To Desktop (CTD) with no error - or reboots your system instantly to reset memory and clear 
the error. 
 

EVENT VIEWER 

Another place to view error codes and error listings is in the Event Viewer, accessible under Control 
Panel>Administrative Tools, or by going to Start>Run and typing "Eventvwr.msc" (without quotes) and 
pressing Enter. There are three categories of event logs to view - Application, Security and System. Click on 
each of these in the left pane, and a list of events and errors (shown as red X's) will display in the right pane. 
The first thing to do is not panic if you see Red X's; this is normal on all systems. What is important is the 
details of the error - for example, under System there are commonly lots of DCOM errors if you've disabled 
any services. This is because an application will call for a service to start; if the service has been manually 
disabled, the application reports an error and continues loading. This is not a genuine error or something to 
worry about, unless of course it is the application with which you are having a problem in the first place - in 
which case re-enable the relevant service. 

http://support.microsoft.com/kb/308427�
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To correctly diagnose an Event Viewer error, read the error log text and enter its details into this Microsoft 
Events & Errors Message Center form, and it should provide you with more details and links to help resolve 
your problem. Alternatively you can try this Event ID Site for further research. 
 
< SOLUTIONS TO WINDOWS ERRORS 

I cannot cover all the error numbers and error types in this section, therefore it is necessary that you take the 
initiative and research the particular error code using one of the following trustworthy sources: 
 
Microsoft Knowledgebase 
Microsoft TechNet 
Windows XP Solution Center 
Microsoft Events & Errors Message Center 
Troubleshooting Windows Stop Errors 
Troubleshooting Miscellaneous Windows Errors 
 
Use the search functionality in the sites above and enter your exact error code as shown on screen. To make 
things easier, below are some common Windows error codes, an excerpt from the relevant Microsoft 
document describing the error and a potential fix for the error. Remember, none of these errors has a definite 
cause or specific fix, sometimes a range of unrelated issues can cause Windows to generate a certain error. 
The description  and solution provided is the most generic one for each error: 
 

IRQL_NOT_LESS_OR_EQUAL 

"A Stop 0xA message might occur after installing a faulty device driver, system service, or firmware. If a Stop message 
lists a driver by name, disable, remove, or roll back the driver to correct the problem. If disabling or removing drivers 
resolves the issues, contact the manufacturer about a possible update. Using updated software is especially important for 
multimedia applications, antivirus scanners, and CD mastering tools. 
 
A Stop 0xA message might also be due to failing or defective hardware. If a Stop message points to a category of devices 
(video or disk adapters, for example), try removing or replacing the hardware to determine if it is causing the problem. 
 
If you encounter a Stop 0xA message while upgrading to Windows XP Professional, the problem might be due to an 
incompatible driver, system service, virus scanner, or backup. To avoid problems while upgrading, simplify your 
hardware configuration and remove all third-party device drivers and system services (including virus scanners) prior to 
running setup. After you have successfully installed Windows XP Professional, contact the hardware manufacturer to 
obtain compatible updates." 
 
Suggested Solution: Install the latest drivers, or if already using the latest drivers, do a full driver uninstall in 
Safe Mode and go back one version. If this doesn't work, run through a range of benchmarks and stress tests 
to determine whether a hardware component is faulty. 
 

DRIVER_IRQL_NOT_LESS_OR_EQUAL 

"Stop 0xD1 messages can occur after installing faulty drivers or system services. If a driver is listed by name, disable, 
remove, or roll back that driver to confirm that this resolves the error. If so, contact the manufacturer about a possible 
update. Using updated software is especially important for backup programs, multimedia applications, antivirus 
scanners, DVD playback, and CD mastering tools." 
 
Suggested Solution: Install the latest drivers, or if already using the latest drivers, do a full driver uninstall in 
Safe Mode and go back one version. In particular if this occurs in relation to your graphics driver, make 
absolutely certain your system is not overclocked and is being cooled properly. 
  

http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://www.eventid.net/�
http://support.microsoft.com/search/�
http://technet.microsoft.com/en-us/windowsxp/default.aspx�
http://support.microsoft.com/ph/1173�
http://www.microsoft.com/technet/support/ee/ee_advanced.aspx�
http://aumha.org/win5/kbestop.htm�
http://aumha.org/win5/kberrmsg.htm�
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PAGE_FAULT_IN_NONPAGED_AREA 

"If you added new hardware recently, remove and replace the hardware to determine if it is causing or contributing to 
the problem. Run diagnostics software supplied by the hardware manufacturer to determine if the component has failed. 
 
Stop 0x50 messages can also occur after installing faulty drivers or system services. If the file name is listed, you need to 
disable, remove, or roll back that driver. If not, disable the recently installed service or application to determine if this 
resolves the error. If this does not resolve the problem, contact the hardware manufacturer for updates. Using updated 
drivers and software is especially important for network interface cards, video adapters, backup programs, multimedia 
applications, antivirus scanners, and CD mastering tools. If an updated driver is not available, attempt to use a driver 
from a similar device in the same family. For example, if printing to a Model 1100C printer causes Stop 0x50 errors, using 
a printer driver meant for a Model 1100A or Model 1000 might temporarily resolve the problem." 
 
Suggested Solution: Aside from trying driver updates, test your CPU and RAM in particular, though it may 
even be an issue with your motherboard. 
 

UNMOUNTABLE_BOOT_VOLUME 

"This behavior can occur if either of the following conditions is true: 
§ Your computer uses an Ultra Direct Memory Access (UDMA) hard disk controller, and the following conditions are 

true: 
¨ You use a standard 40-wire connector cable to connect the UDMA drive to the controller instead of the 

required 80-wire, 40-pin cable. 
¨ The basic input/output system (BIOS) settings are configured to force the faster UDMA modes. 

§ The file system is damaged and cannot be mounted." 
 
Suggested Solution: See the Backup & Recovery chapter for use of the CHKDSK /R and possibly also the 
FIXBOOT commands in the Windows Recovery Console to repair this issue. If these fail, do a full reformat 
and reinstall, and if that fails, your drive may be faulty. 
 

BLACK SCREEN ON BOOTUP 

 
"The master boot record (MBR), partition tables, boot sector, or NTLDR file is corrupted." 
 
Solution: See the Backup & Recovery chapter for use of the FIXMBR command in the Windows Recovery 
Console to repair this issue. 
 

DEVICE MANAGER ERROR CODES 

For an explanation of the various error codes you might see for certain devices in Device Manager, read this  
Microsoft Article. 
 

WINDOWS FIREWALL ISSUES 

If you're having problems with the Windows XP Firewall, see this Microsoft Article. 
 

WINDOWS STARTUP PROBLEMS 

For a range of solutions to general Windows XP startup issues, see the following: 
 
Microsoft Article 1 
Microsoft Article 2 
Microsoft Article 3 
Startup Issues & Solutions 
  

http://support.microsoft.com/kb/310123�
http://support.microsoft.com/kb/875357�
http://support.microsoft.com/kb/310353�
http://support.microsoft.com/kb/307545�
http://support.microsoft.com/kb/317277�
http://labmice.techtarget.com/windowsxp/TroubleshootingXP/startup.htm�
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WINDOWS SHUTDOWN PROBLEMS 

For solutions to general Windows XP shutdown issues, see the following: 
 
Windows Support Center Article 
User Profile Hive Cleanup Service 
 
 
That is just a brief list of the more common errors and possible solutions. As always your specific problems 
may be much more difficult to resolve or not found in the list above, therefore I urge you to see the reference 
sources listed further above in this section to research and find the solution to your problem, as well as 
trying the methods covered below to diagnose your problem. 
 
< DIAGNOSING PROBLEMS 

I've noticed that whenever a problem occurs on a PC, new users tend to think everything that's going wrong  
is due to faulty hardware, and that they've just damaged their machine or screwed up thousands of dollars 
worth of equipment by editing their registry or changing a setting in a game. More experienced users go to 
the opposite extreme: they are always convinced that every fault they see on their PC lies with the software, 
despite their overclocking for example, or the fact that they've physically modified their graphics card or 
flashed it with a modified BIOS. The truth lies somewhere in between, and requires that you have some 
patience and try some common steps to diagnose your particular problem.  
 

TROUBLESHOOTING CHECKLIST 

I suggest you follow these general steps, preferably in the order shown: 
 
Remove any overclocking: I cannot stress this point enough - almost all of the problems which I see reported on 
Internet forums and in emails to me are based at least in some part on some form of overclocking. Crashes, 
memory errors, freezing, sudden reboots, garbled graphics or unusual colors or dots on the screen - these are 
all the classic signs of a system which is operating outside its specifications and being over-stressed by a 
particular game or application. Before blaming any software of being at fault, you must first change all your 
hardware back to their default speeds, including such things as RAM timings. Even if every single other 
game or program on your system runs fine at a particular level of overclock, but one game or program 
doesn't, that does not mean the program is at fault; you should still make sure your overclock is not the issue 
by running at stock speeds for a while. If the problem is reduced or completely eradicated by running at 
stock speed then the issue is without a doubt related to your overclock. Note that if you have heavily 
overclocked and/or modified your components in the past you may have already caused them permanent 
damage, so keep this in mind as you try to find the source of the problem. For example, if you have heavily 
overclocked your graphics card for some time it is quite likely that you have permanently damaged the 
Video RAM and this is the cause of any video artifacts you may see in games, even at stock speeds. 
 
Check for Heat Issues: A major cause of most system problems is heat buildup. Even if none of your 
components are overclocked, under certain conditions components such as your CPU and graphics card in 
particular will generate a large amount of heat. This can build up in your case, but even with good case 
cooling the heat may buildup locally near the particular component and cause it to malfunction. The most 
obvious signs of this are random errors, graphical glitches in games, and crashes to desktop. Check the 
Cooling tips in the Overclocking chapter, and as a temporary solution open up your case and clean the dust 
out, then leave the sides of your case open and if possible also place a desk fan pointing into the case, or 
some other method of additional cooling for the internal components. If this helps reduce the frequency of 
errors or problems, then heat is a major cause. 
  

http://aumha.org/win5/a/shtdwnxp.htm�
http://www.microsoft.com/downloads/details.aspx?FamilyID=1b286e6d-8912-4e18-b570-42470e2f3582&DisplayLang=en�
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Optimize your System: In order to rule out a software-based problem you must make sure your general 
system settings are correctly configured. Clearly that is what this guide is designed to do, so follow it in full 
and also make sure to check for application or game-specific tweak guides to make sure the software's 
settings are configured correctly. Sub-optimal Windows and/or software settings and/or out-of-date drivers 
are a major cause of problems on many systems, and even if they are not the primary cause they can 
certainly exacerbate any existing issues. 
 
Optimize your BIOS: Along with any software optimization you must make sure your BIOS settings are 
correct otherwise no amount of software optimization or reduction in overclocking will help. This is another 
important area that is almost always overlooked because it is not easy to do. See the BIOS Optimization 
chapter for details. For example, some game problems can be resolved by disabling Thermal Management, 
or by adjusting your RAM timings to be less aggressive - so make sure your BIOS is optimal. 
 
Read the Manual & ReadMe Files: There are times when particular games have a known issue with a particular 
hardware component or hardware combination. Usually these issues are addressed in patches for the 
program, or by new driver releases for the relevant hardware. However you need to be aware of these 
problems, and the best way to do that is to read the Readme.txt or similar help files which come with the 
program. These are usually located somewhere in the program's directories and a link is typically found for 
them under the program's install folder. You may even find mention of known issues in the program's 
manual or on their website, so make absolutely certain you read these. 
 
The Problem Occurs During Bootup or in the BIOS: If the problem you are experiencing occurs during your PC's 
initial bootup and/or in the BIOS screen then this clearly indicates that it is completely unrelated to your 
Windows settings, drivers or programs, since none of these have even loaded while the BIOS is loading. 
Problems which occur during initial bootup or when you are in the BIOS are always and unequivocally 
either hardware-related faults (including heat and/or overclocking) and/or a BIOS setting which is incorrect. 
 
Benchmark and Stress Test: It is imperative that if you don't know which component(s) are causing a problem, 
that you use several benchmarking and stress testing tools (covered in the Benchmarking & Stress Testing 
chapter) to narrow down the cause. For example if your system is freezing during the playing of games, it 
could be the graphics card, CPU, RAM or even the sound card which are at fault. Using several 
benchmarking or stress testing programs that are specialized in stressing particular components more than 
others will tell you which component is the likely candidate for further investigation. There is no easy way 
for anyone to know what the cause is on your system unless you specifically test for it yourself. 
 
Check your Cabling and Components: If you feel comfortable in doing so, turn off your system at the power 
switch (but don't unplug it) and open up your case. Check the Hardware Handling Tips section below first, 
then: 
§ Check to ensure that your component fans are not covered with dust or debris. 
§ Check to ensure all the cables to and from your components are firmly plugged in and not damaged 

along their length. 
§ Check your motherboard manual to make sure all the switches on the motherboard are set correctly, and 

that all plugs are going into the right source. 
§ Check for signs of extreme heat such as scorch marks or a burnt smell: these indicate heat damage to 

particular components. 
§ Check to make sure metallic surfaces are not in contact with each other as this can short-circuit 

components. 
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HARDWARE HANDLING TIPS 

If you have to physically handle the hardware components in your system at any time, such as removing or 
installing a component, checking component connections, or cleaning components, you should make sure to 
follow these tips to prevent any permanent damage to the components through mishandling: 
 
§ Before opening your case and/or handling any of your components, always shut down your PC and turn 

off the power directly at the wall socket - the electricity in your PC can kill or injure you, especially the 
dangerous voltages contained in your Power Supply. Even when switched off at the wall, the PSU can 
retain a lethal charge for quite some time, so on no account should you ever open your PSU or insert any 
metal objects into its casing. 

§ Once you've turned off your system at the wall, press and hold the PC power button for several seconds 
to discharge any residual energy in the motherboard's capacitors. 

§ While handling computer components, make sure you regularly discharge any static electricity in your 
body by touching any 'earthed' object - that is any object that can harmlessly dissipate static electricity. 
Typically if you leave your Power Supply Unit plugged into the wall socket (but switched off) then 
periodically touching the side of the metal PSU case will harmlessly discharge any static electricity. You 
can also purchase an anti-static wrist strap if you handle components regularly. If you are going to 
handle components try to minimize how much artificial fabrics and materials you are wearing as these 
can help to build up a significant electrostatic charge in your body. An electrostatic discharge from your 
body can damage or kill an electronic component, so do not take this lightly as it can actually happen.  

§ Do not use a vacuum cleaner to clean the inside of your computer and its components, precisely because 
vacuum cleaner nozzles can discharge static electricity and zap your components. Use a clean barely 
damp lint-free cloth to wipe dust from most surfaces, making sure you don't rub or scrape the Printed 
Circuit Board (PCB). Don't use any detergents on the cloth and most certainly don't spray any onto the 
components. Ideally if it is available to you, use a can of compressed air (or an air compressor) to blow 
dust from hard-to-reach or sensitive surfaces as this is much safer and far more effective. 

§ Do not force any plugs, cables or components into sockets that do not appear to be accepting them. Even 
if the two ends appear to be matched, the pin arrangements may be slightly different or out of alignment 
and hence forcing a fit may actually bend or break some of the pins and make the connection useless or 
permanently damaged. Computer hardware interfaces are designed to fit together with firm but not 
excessive force. This includes components like the CPU chip which fits into the appropriate socket on the 
motherboard - align all the pins perfectly and press evenly but not too hard and they will mate safely. 
Force the fit and you may just end up permanently ruining your CPU. 

§ Most devices in your PC require a source of power, however the voltage they require is very specific. If 
you connect the wrong plug to the component (which is hard to do), or forget to attach a power 
connector then the component will appear to be dead or may malfunction. You will have to check your 
component documentation and especially the motherboard manual to ensure that all components are 
plugged in correctly and firmly to receive sufficient power. 

§ Most hardware components are sensitive to physical impact and strong vibrations. Avoid situations 
which result in the bumping or banging of these components, or for example mounting heavy fans onto 
them insecurely which can pass vibrations to these components or warp them under the weight. 

§ Do not handle liquids around electronic components. Any spillage can result in disastrous short-
circuiting. This also includes any thermal or adhesive compounds which can conduct electricity and 
hence cause a short-circuit - apply them cautiously and don't just assume that any excess will dry up and 
disappear; remove all excess thermal compounds thoroughly with a cloth. 

§ Do not place excessive weights on PCBs as this can crack or warp them such that they will be 
permanently damaged. Don't even rest a large object temporarily on the motherboard or a component 
for example, put them on another surface until you need to use them. 

 
Most importantly, make sure you invest in a good quality Surge Protector for your PC and all your other 
sensitive electronic devices. Aside from letting you plug in multiple devices into one outlet, surge protectors 
serve an important function: they prevent spikes in voltage which can occur for a range of reasons from 
harming your components. Voltage surges needn't be sudden or catastrophic; even minor increases in 

http://www.millbury.k12.ma.us/~hs/techrepair/ESD.html�
http://www.howstuffworks.com/surge-protector.htm�
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voltage can reduce your component's lifespan over a period of time. Note that most surge protectors will not 
protect your equipment from the surge generated by a direct lightning strike on or near your house, so 
during heavy thunderstorms it is strongly recommended that you turn off your PC and any other expensive 
electronic products and disconnect their power plugs from the wall socket. This also includes any phone 
lines used for DSL for example. 
 
Electronic components these days are quite hardy, and can withstand some abuse, but given how valuable 
they are I suggest that you don't take any risks when handling them and in their general usage, so the tips 
above are best observed if you want to maintain your PC and your electronic components in good condition. 
 
 
In the end, if you really can't find a solution to your problem, try contacting Microsoft Technical Support, or 
the tech support for the particular game, application or hardware you are having issues with. Their contact 
details are listed on the product box, in the manual or on their website. Make sure to provide them with your 
correct system specifications - as covered in the System Specifications chapter of this guide - as well as full 
details of the error. You can also post your specifications and error code(s) along with the things you have 
already tried on an Internet forum. Usually however, the person best suited to solving a problem is you - all 
you need is some patience and some knowledge, and in the long run you will save yourself a great deal of 
time, and indeed come to be able to prevent a great many problems, if you make the effort to become 
proficient in identifying and diagnosing PC problems yourself instead of relying on others. 
 

http://support.microsoft.com/contactussupport/?ws=support�
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REGULAR MAINTENANCE 
 
Keeping Windows XP and your PC in optimal working order requires regular system maintenance. Any 
operating system will degrade over time if not properly maintained, so you must arrive at some regular 
method of undertaking such maintenance using the tools and methods in this guide. It also cannot be done 
on a rigid schedule; it depends on your usage patterns, how often you install patches and updates, install 
new software and move files around, etc. 
 
Below is a list of the actual things I regularly do to maintain my PC, the rough order they are done in, and 
the frequency with which I do them. You may consider some steps or their frequency as overkill, but I've 
found that by doing these procedures at least once a week I not only keep Windows as fresh as the day it 
was installed, I also weed out any undetected malware or unnecessary programs, keep my drive space 
optimal and quickly get wind of any potential problems before they ruin my data or unstabilize the system. 
 
This is only an example, and you will need to customize it to suit your particular circumstances, but it is a 
good starting point for the average PC user: 
 
 

STEP 1 -  SCAN FOR MALICIOUS SOFTWARE 

Action: Update malware scanners then run a full manual scan on each one. 
Frequency: Once a week at least. Scan individual suspicious files such as new downloads or saved 
attachments as often as required. 
 
See the PC Security chapter for details. 
 

STEP 2 -  CHECK FOR NEW STARTUP PROGRAMS & SERVICES 

Action: Use MSConfig to quickly check under the Startup and Services tabs for any newly installed startup 
programs or non-Microsoft services. Identify any new ones and disable unnecessary ones as required. 
Frequency: Once a week at least. Usually after each new program or game install. 
 
See the Startup Programs and Services chapters for details. 
 

STEP 3 -  CLEAN WINDOWS 

Action: Run the Disk Cleanup utility, then CCleaner. Do a manual clean out of remaining unnecessary files. 
Only empty the Recycle Bin if certain no important files will be removed, otherwise leave it for the moment. 
Frequency: Once a week at least. Also after any major program or game installs. 
 
See the Cleaning Windows chapter for details. 
 

STEP 4 -  CLEAN & COMPACT THE REGISTRY 

Action: Use the registry cleaner in CCleaner or JV16 PowerTools to run a thorough clean of the Registry, then 
use NTRegOpt to compact it. 
Frequency: Once a week. 
 
See the Windows Registry chapter for details. 
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STEP 5 -  RUN A DISK CHECK 

Action: Use the Disk Check utility to do a full disk scan/repair of the hard drive - right click on your drive 
letter in Windows Explorer, select Properties>Tools>Check Now, tick 'Automatically fix file system errors', 
then click Start and reboot to implement. 
Frequency: Once a week, or done automatically when using a third-party defragmenter (see Step 6 below). 
 
See the Drive Optimization chapter for details. 
 

STEP 6 -  DEFRAGMENT THE DRIVE(S) 

Action: Use a disk defragmenter - either the default Windows Disk Defragmenter or a commercial package 
like Diskeeper - to run a full defragmentation of the hard drive. 
Frequency: Once a week at least. Usually after every major program or game install/uninstall, or any manual 
game or Windows patching. 
 
See the Hard Drive Optimization chapter for details. 
 

STEP 7 -  BACKUP IMPORTANT FILES 

Action: Create a System Restore point. Backup the Registry using Erunt. Do a full manual backup of 
important files and folders to DVD. Also backup extremely important files again to ISP webspace via FTP as 
an added precaution. 
Frequency: Once a week at least. If working on something extremely important, backup every couple of days 
both to ensure it's not lost, and also to have several versions in case current version is corrupted or 
accidentally deleted. 
 
See the Backup & Recovery chapter for details. 
 
 
If done correctly, all of the above shouldn't take longer than an hour - with most of that time taken up by 
Step 1 due to manual scanning times. Please note that unfortunately there are no automated maintenance 
programs which can do proper PC maintenance for you. Though many tools many claim they can do this, 
there are several important steps which require active decision making and irregular frequency of 
application. There is no magic wand which will clean and optimize your machine for you. At best most will 
simply remove a few unnecessary files or registry entries; nothing genuinely thorough or useful. 
 
Just as a human mechanic is required to actually inspect, tune and maintain a motor vehicle, rather than any 
totally automated process, so too a PC requires that you be aware of how things work and to actually think 
and act based on particular circumstances to keep both the hardware and the software running optimally. 
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CONCLUSION 
 
That brings The TweakGuides Tweaking Companion to a close. I hope you've found the information in this 
guide valuable as a reference source. As I say at the end of all my guides: Until next time, take care! 
 
Cheers, 
Koroush Ghazi 
 
 
< VERSION HISTORY 

The table below shows all the major revisions made to this guide since first released. 
 

Version Release Date Pages Revised 
1.00 22 December 2004 Nil – First Release. 

 
1.01 23 December 2004 pp.55, 98 - RegCleaner links fixed. 

pp.101 - Reference to /Windows/Prefetch fixed. 
 

1.02 10 January 2005 All pages - Formatting altered (e.g. inserted section name on side of each page). 
All pages - Numerous typographical /grammatical errors fixed. 
pp.13 - XPTC problem reporting link changed. 
pp.40 - Internet connection advice clarified in Driver Installation Order. 
pp.42 - Added XGI graphics card driver download link. 
pp.49 - Added 2GB+ RAM example for Virtual Memory. 
pp.54 - Prefetcher tweak clarified. 
pp.56, 99 - Correct RegCleaner version clarified. 
pp.86 - Mention how to re-enable User Names column in Task Manager. 
pp.104 - Recycle Bin rename/delete tweak fixed. 
pp.121 - Windows Update repair tweak fixed. 
pp.145 - AMD CPU Thermal Limiting mentioned. 
 

1.03 15 February 2005 All pages - Numerous typographical/grammatical errors fixed. 
pp.41, 62, 140 - Added Nvidia Forceware Tweak Guide link. 
 

1.04 10 March 2005 pp.34 - Corrected IRQ Priority tweak. 
pp.41 - Changed ATI Catalyst download link.  
pp.50 - Clarified Position of Pagefile using Diskeeper tweak. 
pp.53 - Clarified/corrected LargeSystemCache and IOPageLockLimit tweaks. 
pp.54 - Clarified the Windows Prefetcher advice. 
pp.102 - Instructions for Prefetch files in /Windows/Prefetch folder clarified. 
pp.121 - Changed the Firefox Tweak Guide link. 
 

1.05 10 April 2005 All pages - Several typographical/grammatical errors fixed. 
pp.23 - Ad-Aware TweakSE plugin linked. 
pp.29,87 - Erunt & NTRegOpt links fixed. 
pp.56,100-101,157 - All WinOptimizer advice and links replaced by CCleaner. 
pp.145 - Throttlewatch link fixed. 
pp.148 - PSU Guide link fixed. 
pp.160 - Electrostatic Discharge Article link fixed. 
 

1.06 18 April 2005 pp.38 - Provided alternate links for XP Home and Pro Installation Guides. 
pp.82-83 - Provide alternate links for XP Services Guide. 
 

1.07 22 April 2005 pp.41 - Fixed Intel software download links. 
 

2.0 18 August 2005 Guide renamed from The Windows XP Tweaking Companion to The TweakGuides Tweaking Companion as 
requested by Microsoft. 
Guide edited throughout to fix some grammatical/spelling errors and fix dead links.  
Otherwise contents remain the same as the previous version(s). 
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Version Release Date Pages Revised 
3.0 4 January 2006 Major revision and rewriting of the guide - too many changes to list individually:   

- Revision/clarification/addition of a wide range of advice. 
- Shifting/merging/renaming of a large number of chapters and creation of new ones. 
- Fixing/removing a range of dead links, and provision of many new links. 
- Format and grammatical corrections and adjustments. 
All previous TweakGuides Tweaking Companion/Windows XP Tweaking Companion users should update to this 
latest version as soon as possible. 
 

3.1 8 June 2006 All pages - Several typographical/grammatical errors fixed. 
All pages - Fixed all dead or inaccurate hyperlinks. 
pp.19,164,167 - Updated Sandra instructions for new version. 
pp.29 - Repair install instructions link added. 
pp.43 - Removed reference to .NET 1.1 
pp.89,93 - ProcessLibrary site link added. 
pp.90 - Added Autoruns instructions. 
pp.92 - HID Service removed from Disabled list. 
pp.97 - $hf_mig$ details added 
pp.100 - Imagecfg instructions fixed. 
pp.119 - Updated Internet Explorer section for IE7 Beta. 
pp.130 - Switched order of Registry compacting & cleaning. 
pp.108 - Low Disk Space instructions fixed. 
pp.116 - Context Menu Editor link added, CMenu details fixed. 
pp.136 - Updated Windows Media Player section for WMP11 Beta. 
pp.139 - Quicktime and Real Alternative Codecs added. 
pp.144 - Shortcut To instructions fixed. 
pp.167 - Added SuperPI instructions. 
 

3.2 22 August 2006 All pages - Several typographical/grammatical errors fixed. 
All pages - Fixed all dead or inaccurate hyperlinks. 
All pages - Updated the TweakGuides Logo. 
pp.25 - Corrected KeyPass reference to KeePass. 
pp.47 - A-Squared instructions updated. 
pp.55-56 - Prefetch instructions further clarified. 
pp.62 - I-FAAST & NTFSDisableLastAccessUpdate Registry key conflict. 
pp.69 - Added link to Gamer's Graphics & Display Settings Guide. 
pp.95 - Added Advanced Disk Cleanup options. 
pp.100 - Added AMD Dual Core Optimizer Utility link. 
pp.106 - Updated NTFSDisableLastAccessUpdate details. 
pp.145 - Corrected Windows Blinds references to WindowBlinds. 
 

3.3 20 November 2006 All pages - Several typographical/grammatical errors fixed. 
All pages - Fixed all dead or inaccurate hyperlinks. 
pp.19 - Sandra Service names updated. 
pp.40 - Intel Matrix Storage Manager link added. 
pp.43 - .NET reference updated to 3.0. 
pp.46 - AVG Free instructions updated. 
pp.47 - A-Squared Free instructions updated. 
pp.47 - Microsoft Antispyware renamed to Windows Defender. 
pp.49 - Sophos Anti-Rootkit link & instructions added. 
pp.61-63 - Diskeeper advice updated. 
pp.73 - USB Mouserate tweak clarified. 
pp.91 - HijackFree link & instructions added. 
pp.120-123 - Internet Explorer chapter revised to suit both IE6 & IE7 final. 
pp.137-141 - Windows Media Player chapter revised to suit both WMP10 & WMP11 final. 
pp.146 - Zune & Royale Noir theme links added. 
pp.172 - User Profile Hive Cleanup Service link added. 
 

3.4 1 March 2007 Cover - TGTC Logo changed. 
All pages - Fixed any dead or inaccurate hyperlinks. 
pp.102 - Added SetAffinity utility. 
pp.149-157 - Overclocking chapter heavily edited. 
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Version Release Date Pages Revised 
3.5 1 July 2007 All pages - Fixed any dead or inaccurate hyperlinks. 

All pages - Minor layout changes. 
pp.47 - Updated A-Squared Free advice. 
pp.47-48 - Ad-Aware 2007 instructions added. 
pp.49 - HijackThis advice updated. 
pp.157 - Added new link for AMD overclocking. 
pp.136 - Added Windows Live Mail link. 
 

3.6 22 September 2007 All pages - Fixed any dead or inaccurate hyperlinks. 
pp.97-98 - Updated CCleaner advice. 
pp.102 - Updated SetAffinity link and advice. 
pp.103 - Updated RegSupreme advice. 
pp.138 - Added fix for black & white video playback. 
 

4.0 1 May 2008 This is a major revision of the guide. It has been thoroughly revised throughout, not just for SP3. There are a 
large number of changes, but only the more significant ones are listed below: 
All pages - Fixed any dead or inaccurate hyperlinks. 
All pages - Fixed any typographical/grammatical errors. 
pp.19 - Updated advice for Sandra 2008. 
pp.20 - Added GPU-Z utility. 
pp.36-37 - Updated slipstreaming & nLite advice for SP3. 
pp.39 - Updated multi boot advice for XP/Vista dual boot. 
pp.39 - Expanded RAID advice. 
pp.43-44 - Updated Service Pack details and installation advice for SP3. 
pp.43-49 - Expanded/clarified Driver Installation chapter. 
pp.51-52 - Updated advice for AVG 8.0. 
pp.54-55 - Added Phishing section. 
pp.56-59 - Updated general security tips. 
pp.62 - Added Video Memory Watcher utility. 
pp.63-65 - Updated Virtual Memory advice. 
pp.66-67 - Added Drive Controllers section. 
pp.67-68 - Added Master File Table section. 
pp.69-70 - Updated advice for Diskeeper 2008. 
pp.96-100 - Expanded/revised Startup Programs chapter. 
pp.98 - Updated MSConfig details for new Tools tab added by SP3. 
pp.101-106 - Expanded/revised Services chapter. 
pp.103-104 - Added full table of XP Services, including noting four new SP3 services. 
pp.111 - Added Cleanup Up After Service Pack 3 section. 
pp.111 - Added Delete 'In Use' Files section. 
pp.114 - Added Windows Dual Core Hotfix. 
pp.115 - Added Process Explorer section. 
pp.124 - Added Disable Automatic System Restore Checkpoints tip. 
pp.139-142 - Expanded/revised Internet Explorer chapter solely for IE 7. 
pp.148-153 - Expanded/revised Windows Media Player chapter solely for WMP 11. 
pp.158-159 - Revised custom themes advice for SP3. 
pp160-161 - Consolidated and improved formatting for Keyboard & Programs shortcuts tables. 
pp.163-171 - Expanded/revised Overclocking chapter. 
pp.173 - Added Unigine graphics benchmark. 
pp.174 - Updated advice for Sandra 2008. 
pp.177 - Added Memtest86+ utility. 
pp.178-184 - Expanded/revised Windows Errors chapter. 
 

4.1 1 July 2008 All pages - Fixed any dead or inaccurate hyperlinks. 
All pages - Fixed any typographical/grammatical errors. 
pp.47 - Updated Driver Sweeper instructions. 
pp.50-51 - Updated AVG Free Edition 8.0 advice. 
pp.53 - Updated Ad-aware 2008 advice. 
 

4.2 2 October 2008 All pages - Fixed any dead or inaccurate hyperlinks. 
All pages - Fixed any typographical/grammatical errors. 
pp.19,174,176 - Update advice for Sandra 2009. 
pp.46 - Added ASUS Audio Drivers link. 
pp.50-51 - Updated AVG Free Edition 8.0 advice. 
pp.142 - Added Google Chrome link. 
pp.154 - Added VLC link. 
 

  



 T H E  T W E A K G U I D E S  T W E A K I N G  C O M P A N I O N  

 

Copyright © 2009 Koroush Ghazi  195 
 

C
onclusion 

4.3 6 April 2009 All pages - Fixed any dead or inaccurate hyperlinks. 
All pages - Fixed any typographical/grammatical errors. 
pp.45 - Added AHCI reference. 
pp.46 - Added Auzentech audio driver link. 
pp.50-51 - Updated AVG Free Edition 8.5 advice. 
pp.52-32 - Updated Ad-Aware advice. 
pp.67 - Added AHCI Mode details. 
pp.118-119 - Added JV16 PowerTools section, replacing RegSupreme & RegCleaner. 
pp.133-147 - Revised Internet Explorer chapter for IE8. 
pp.168-176 - Revised Overclocking chapter with updated information. 
pp.178 - Added FurMark benchmark, removed outdated Codecreatures, Aquamark and GLExcess. 
 

 
[End of Guide] 


